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CloudPortal Business Manager 2.3

Citrix® CloudPortal™ Business Manager 2.3 is a cloud services delivery and operations
platform for delivering self service IT-as-a-service to consumers. It enables enterprises and
service providers to unify the commerce, user management, service provisioning and
operational aspects of running a cloud interface for delivering anything as a service (XaaS).

It provides a wide range of business operations features that include availability, system
health, performance, account status, utilization, billing, helpdesk, and alerts. It also
leverages the partner ecosystem and newly available SDKs and APIs to seamlessly deliver
any service (IaaS, PaaS, storage, and so on) while broadening the portfolio of services to
differentiate and increase the value of the cloud.

In addition, CloudPortal Business Manager has features uniquely designed for the needs of
enterprises such as AD Integration and approval based workflows. CloudPortal Business
Manager is also localized and can operate in 8 languages and 160+ currencies, making it
readily deployable in global environments.

In This Section
Release Notes

Installation Guide

Administration Guide

Migration Guide

Extend and Customize CloudPortal Business Manager

Citrix CloudPlatform Connector Guide

CloudPortal Services Manager Connector Guide

User Guide

Utilities

Frequently Asked Questions

http://support.citrix.com/proddocs/topic/cpbm-23-map/cpbm-release-notes-23-wrapper-con.html#cpbm-release-notes-22-wrapper-con
http://support.citrix.com/proddocs/topic/cpbm-23-map/cpbm-iag-wrapper-con.html#concept_058F004ED9A34104A92ED5AED928A27C
http://support.citrix.com/proddocs/topic/cpbm-23-map/cpbm-admin-wrapper-con.html#concept_058F004ED9A34104A92ED5AED928A27C
http://support.citrix.com/proddocs/topic/cpbm-23-map/cpbm-21-migration-wrapper-con.html#concept_058F004ED9A34104A92ED5AED928A27C
http://support.citrix.com/proddocs/topic/cpbm-23-map/cpbm-extend-customize-cpbm-wrapper-con.html#concept_B28EA9E8F3E6441D907847F41E208A91
http://support.citrix.com/proddocs/topic/cpbm-23-map/ccpb-ccp-conn-wrapper-con.html#concept_058F004ED9A34104A92ED5AED928A27C
http://support.citrix.com/proddocs/topic/cpbm-23-map/cpbm-cpsmconn-22-wrapper-con.html#cpbm-cpsmconn-wrapper-con
http://support.citrix.com/proddocs/topic/cpbm-23-map/cpbm-userguide-wrapper-con.html#concept_058F004ED9A34104A92ED5AED928A27C
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Overview of CloudPortal Business
Manager

CloudPortal Business Manager is a cloud services delivery and operations platform for 
delivering self service IT-as-a-service to consumers. It is targeted towards both Service 
Providers and Enterprise IT organizations and provides a wide range of business operations 
features include built in billing and spend tracking engines, product and catalog 
management, self serviceability of resources, integrations with payment gateways and 
fraud control systems. In addition, CloudPortal Business Manager has features uniquely 
designed for the needs of enterprises such as AD Integration and approval based workflows. 
CloudPortal Business Manager is also localized and can operate in 8 languages and 160+ 
currencies, making it readily deployable in global environments.

Originally developed as a B/OSS suite for delivering Infrastructure as a service, CloudPortal
Business Manager provides a powerful platform for packaging, delivering and metering a
custom set of cloud services to users. As an open and extensible platform, cloud operators,
and administrators can leverage the newly available SDKs to offer cloud services beyond
IaaS, and seamlessly integrate with existing business and operations systems. CloudPortal
Business Manager is going to help cloud builders in three main ways:

• Deliver Anything-as-a-Service from a customizable catalog of services capable of
delivering IaaS, PaaS, SaaS, 3rd party cloud services and enterprise.

• Empower users with self-service access to the cloud and IT services, infrastructure and
account management tools they need from an easy to use cloud services "storefront".

• Simplify cloud services management by unifying and automating services provisioning,
B/OSS systems, billing and metering and user management under a single, extensible
platform.
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Release Notes

Release notes describe the enhancements, changes, bug fixes, and known issues for a
particular release of CloudPortal Business Manager software. Release notes are categorized
into:

• Main Release

• Maintenance Release

http://support.citrix.com/proddocs/topic/cpbm-23-map/cpbm-release-notes-23-wrapper-con.html#cpbm-release-notes-22-wrapper-con
http://support.citrix.com/proddocs/topic/cpbm-23-map/cpbm-maintenance-release-23-wrapper-con.html#cpbm-maintenance-release-wrapper-con
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Main Release

This section describes the enhancements, changes, bug fixes, and known issues for the
release of Citrix® CloudPortal™ Business Manager (CPBM) 2.3.

• New Features in CloudPortal Business Manager 2.3

• Defects Fixed

• Known Issues and Limitations

http://support.citrix.com/proddocs/topic/cpbm-23-map/cpbm-about-this-release-23-con.html#cpbm-known-issues-23-con
http://support.citrix.com/proddocs/topic/cpbm-23-map/cpbm-known-issues-23-con.html#concept_B28EA9E8F3E6441D907847F41E208A91
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What's new in CloudPortal Business
Manager 2.3



New Features
• Enhanced reseller features

• Channel-specific branding

Cloud Service Providers (CSPs) can now customize a number of CloudPortal Business
Manager (CPBM) elements. Customers can be resellers and market the cloud
services under their own brand. The elements that can be customized include:

• Logo

• Favicon

• Cascading style sheets

• Content templates

• Email addresses used in "To" and "From" addresses
This feature allows resellers, each of whom have their own channel, to have their
own branding. A channel can be associated with a unique Fully Qualified Domain
Name (FQDN). The branding configuration that CPBM uses is based on the FQDN that
is used to access CPBM. When CPBM is accessed with an FQDN that is not associated
with a channel, the system-wide branding is used.

Channel-specific branding is possible through channel-level configurations that
include:

• URL for user login

• Logo, Favicon, and Style sheets

• Communication through modified content templates

• Help, support, and other such URLs

• White lists and black lists of domains and countries to control access

• Default time zone for new accounts
In addition, you can now open and close a channel for self-registration.

Channels belonging to a reseller (or having some common characteristics) can be
grouped to form billing groups.

• Channel-specific usage and spend aggregation

CPBM now provides usage and spend aggregation at a channel level to support the
reseller feature. Where CSPs sell their cloud services to cloud consumers via
resellers, this aggregated usage data forms the basis for billing of clients by the
resellers. Aggregated usage data is provided for:

• All accounts in a channel (all accounts that belong to a given reseller)

• All channels in a billing group (all resellers that belong to a given distributor)
• New reporting functionality

What's new in CloudPortal Business Manager 2.3
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Reseller/channel specific product usage reports are now available. Product usage is
aggregated for channels and billing groups. This usage data can be utilized by resellers
to bill their clients.

• Usability enhancements

• Convert to subscription

When a resource cannot be associated to any purchased subscription, you can
convert such active resources to subscriptions. A wizard-based workflow is available
to convert any active resource that is not tied to a subscription, either to an
existing unused subscription or purchase a new subscription for it. This functionality
replaces the 'Change subscription' feature for active subscriptions, available in
earlier releases.

• Subscription Initiation and termination workflow for service provider

Out-of-the-box workflow customization can be made without compiling the
customization bundle.

• Compliance with the EU cookie law

CPBM now enables you to comply with the EU cookie law without affecting the user
experience. You can enable or disable the cookie warning.

• Connector improvements

A connector can now be enabled to inform, through appropriate messages, when the
service is down or when there is a network disruption.

• CloudPortal Services Manager Connector update

The CPSM Connector now supports:

• SharePoint 2013

• Lync Hosted 2013

• Lync Enterprise 2013

• DNS
• Reference Connector for OpenStack

A reference connector for OpenStack is now available and supports the OpenStack
2014.1 (Icehouse) release.

• Browser support

• Microsoft Internet Explorer 8, 9, 10, and 11

• Mozilla Firefox 30

• Google Chrome 35.0.1916.153

• Apple Safari 7.0.5
• Upgrade paths

What's new in CloudPortal Business Manager 2.3
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The following upgrade paths are available for this version of CloudPortal Business
Manager:

• CloudPortal Business Manager versions 1.4.3 through 1.4.7 to CloudPortal Business
Manager 2.3.

• CloudPortal Business Manager 2.1.x and 2.2.x to CloudPortal Business Manager 2.3.
• CPBM backward compatibility support matrix

For information on backward compatibility for Citrix CPBM adaptations, refer to CPBM
backward compatibility support matrix. This section gives details about changes
between a release of CPBM with its adaptations and the earlier releases, and how to
manage these changes.

What's new in CloudPortal Business Manager 2.3
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Defects Fixed

This section describes the defects fixed in the release of CloudPortal Business Manager
(CPBM) 2.3.

Defect ID Sever
ity

Category Description

CPBMD-19506/
DE7652

Block
er

Job Workflowjob trigger is a simple trigger instead of
a cron trigger.

CPBMD-18832/
DE6957

Block
er

Localizati
on

The Enabling Cloud Platform Service operation
fails if localized characters are used in the first
name and last name of an account owner or in
the channel name.

CPBMD-19821/
DE7976

Block
er

Billing In certain cases, for a given billing period and for
a given product, the entitlement is calculated
incorrectly when the same is increased in that
billing period.

CPBMD-20543/
CPBM1397

Major Job Notification emails are sent several days after a
resource is created.

CPBMD-20453/
CPBM-1389

Major CCP
Connector
UI

The CPBM UI displays the Edit VM option in the
VM tab even when there are no VMs present.

CPBMD-20258/
DE8416

Major Account M
anagemen
t

Search based on Account ID in accounts page does
not work.

CPBMD-20232/
CPBM-1372/DE
8391

Major CCP
Connector
UI

Port Forwarding tab of the IP Addresses page is
displayed for a VPC acquired IP even if there is no
tier created for it.

CPBMD-20116/
CPBM-1367/DE
8255

Major Billing When a new provisioning constraint is added to a
bundle and an existing subscription is
reconfigured to use the new constraint, an
"Incompatible resource type detected" email is
sent to the user and therefore, entitlement does
not take effect.

CPBMD-20055/
DE8205

Major Upgrade After upgrade from CPBM1.4.x to CPBM 2.x, a
subscription invoice gets created for a
subscription that has been created in the current
billing period and cancelled due to a "launch VM"
failure.

CPBMD-20005/
CPBM-1350/DE
8135

Major Localizati
on

The CPBM catalog UI does not display fractional
digits in product bundle prices for German locale.



CPBMD-19992/
CPBM-1354/DE
8150

Major CCP
Connector

The "Destroy VM" option in CPBM resources UI
does not have an "Expunge" option. As a result, if
the Destroy VM operation fails in CCP, the VM
remains stuck in an expunging mode.

CPBMD-19980/
CPBM-1345/DE
8116

Major Product M
anagemen
t

The active unused subscriptions of unpublished
bundles have usability issues such as showing
disallowed actions and not showing subscription
charges.

CPBMD-19931/
CPBM-1338/DE
8076

Major Catalog M
anagemen
t

Browse Catalog page does not load when the
number of characters in the URL parameter
exceeds the browser limit for URL params (1024
characters).

CPBMD-19930/
CPBM-1340/DE
8075

Major Upgrade The path of the TermsAndConditions file is not
retained in cloud.properties when you migrate
from CPBM 1.4.7 to CPBM 2.2.1.

CPBMD-19908/
CPBM-1321/DE
8030

Major CCP
Connector
UI

In the CCP resources UI, the ability to disable
snapshots has been improved.

CPBMD-19899/
CPBM-1330/DE
8046

Major UX Alert page graph does not reflect the change
when the budget is set back to zero %. Also, the
set budget option is not displayed till the page is
refreshed.

CPBMD-19893/
CPBM-1327/DE
8044

Major Upgrade When you upgrade CPBM 1.4.x to CPBM 2.x, the
Usage marker (for CCP) is initiated to an
incorrect value.

CPBMD-19884/
CPBM-1318/DE
8026

Major UX In the Launch VM workflow, for a custom disk
offering option, there is no text field to specify
the exact disk size.

CPBMD-19766/
DE7908

Major Billing Billing export job is unable to upload
"billing-export" files to an FTP server.

CPBMD-19714/
DE7839

Major UX Incorrect message is displayed when you recover
a VM that has been destroyed.

CPBMD-19703/
DE7846

Major Security When CAS is enabled for authentication, the
CPBM's authentication cookie is not reset on
successful login.

CPBMD-19654/
DE7790

Major CCP
Connector
UI

The ACL sub-tab exists in the IP Address tab of
the VPC page.

CPBMD-19637/
CPBM-1213/DE
7773

Major Billing The Billing Export Job fails on the next day of the
billing day if a subscription to a service bundle
exists.

CPBMD-19573/
DE7697

Major Catalog When a zone on CCP is disabled for maintenance,
the Browse Catalog page keeps loading
indefinitely.

CPBMD-19554/
DE7689

Major CCP
Connector
UI

The Delete VM dialog box does not give an option
to terminate the associated subscription.

Defects Fixed

22



CPBMD-17339/
DE5445

Major Product M
anagemen
t

The provisioning constraints details in the Add
Product Bundle wizard does not have zone
information for resource components that are
available in all zones.

CPBMD-19667/
DE7808

Major CCP
Connector

The Resource Sharing mode setting for CCP
connector that has been applied during an
account creation does not get applied if the
setting is overridden at the account type level at
a later point in time.

CPBMD-19708/
DE7837

Major Subscripti
on Provisi
oning

Power user is not able to re-provision an active
unused subscription of the Master user.

CPBMD-19749/
DE7882

Major UX While uploading a template from CPBM to CCP,
the CPBM UI does not give you an option to
specify if the template is dynamically scalable.

CPBMD-19831/
DE7975

Major CCP
Connector

Volume tags reported in usage for data disk
contain irrelevant information.

CPBMD-19854/
DE7990

Major Billing The billing feed export does not contain tenant
details.

CPBMD-19985/
DE8137

Major Billing Two invoices get created for single resource
deployment in some race conditions.

CPBMD-20008/
DE8155

Major CCP
Connector

In CCP Connector configuration settings, if the
cloud usage JDBC host name is not provided in
the advanced settings, then it defaults to public
host name instead of cloud JDBC host name.

CPBMD-19745/
DE7893

Major Upgrade After upgrading from CPBM 1.4.X to CPBM 2.2.1,
LDAP configurations are not migrated.

CPBMD-19746/
DE7896

Major Upgrade After upgrading from CPBM 1.4.x to CPBM 2.2.1,
Form2Email does not get enabled, although it has
been configured in CPBM 1.4.x.

CPBMD-20602 Major Account M
anagemen
t

After adding accounts, if you change the billing
period type and configuration then the CPBM user
accounts do not work.

CPBMD-19902/
DE8035

Major CCP
Connector
UI

The VM details page loading gets slower with an
increase in the number of networks.

CPBMD-20208/
DE8335

Major CCP
Connector
UI

The Anonymous catalog page shows disabled zone
for CCP instance.

CPBMD-20282/
DE8431

Major Account M
anagemen
t

When you convert a trial account to a retail
account, if initial deposit is required for a retail
account type, then the account does not get
charged for it.

CPBMD-20323/
DE8469

Major Administr
ation

In certain situations, although an account does
not receive an invoice email, the root user gets a
notification that an invoice email has been sent
to that account.

Defects Fixed
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CPBMD-20337 Major Billing Account does not get suspended even after the
number of payment failures crosses the threshold
limit.

CPBMD-20587 Major Subscripti
on Provisi
oning

When an active unused subscription is
reprovisioned, the bundle constraints are
incorrectly displayed.

CPBMD-20598 Major Security In certain situations, when an error occurs in the
server due to an user's UI request, the error's
stacktrace is displayed in the browser.

CPBMD-20606 Major Security On the account signup page, csrf tokens are
displayed in the browser's URL.

CPBMD-20243/
DE8415

Major Fraud
Control

The CPBM Admin user does not receive an email
notification if the Maxmind license used in CPBM
is invalid or has expired.

CPBMD-20274/
DE8445

Major Administr
ation

In AD push mode, the root user is unable to
change his password.

CPBMD-20292/
DE8454

Major Account M
anagemen
t

The final warning email, before trial account is
set to expire, is not being sent to the user.

CPBMD-19586/
DE7723

Major CCP
Connector

CCP end point API displayed in the user's API
credentials tab is incorrect.

CPBMD-20595 Major Quality In certain situations, when a service instance is
enabled for a tenant the service instance account
representation is duplicated.

CPBMD-20230/
DE8392

Major Workflow The subscription activation workflow is not
displayed on Master account subscription page.

CPBMD-20445 Major Security Server version is displayed in telnet response.

Defects Fixed
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Known Issues and Limitations

1. The CPBM UI displays junk characters instead of localized Japanese text when you enter
the credit card details in the Billing and Payment section of the Company Setup page.
This issue is seen if you have configured Authotize.Net or CyberSource as a payment
gateway. This issue occurs because the Japanese character set is not supported by
Authorize.Net or CyberSource.

2. After terminating a purchased bundle subscription, the subscription state in UI shows up
as Expired (Unused). However no actions are allowed for these subscriptions unlike
ACTIVE (Unused).
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Maintenance Release

This section describes the enhancements, changes, fixed issues, and known issues provided
in the maintenance releases of the CloudPortal Business Manager software.

• 2.3.1

http://support.citrix.com/proddocs/topic/cpbm-23-map/cpbm-release-notes-2-3-1-con.html#concept_B28EA9E8F3E6441D907847F41E208A91
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2.3.1

This section describes the enhancements, defects fixed, and known issues in the
maintenance release of the CloudPortal Business Manager version 2.3.1.

Enhancements
• Service providers can now decide what time zones should be made available to their

customers or end users. The timezoneCustomIds.properties file contains all time zone
IDs and it can be edited as per requirement.

• The BSS APIs now support custom fields for accounts, users, and subscriptions.



Defects fixed
Defect ID Severi

ty
Category Description

CPBMD-2101
7

Critica
l

Customization
SDK

Validation does not work while editing a
tenant and incorrect error message is
displayed for custom fields in the Create
user/ tenant wizard.

CPBMD-2089
5/

CPBM-1594/

CPBMD-2086
8

Critica
l

Account Managem
ent/Billing

In certain cases, if the number of
subscriptions is very large, the Activity tab
of Usage and Billing either gives an error or
takes a long time to load.

CPBMD-2087
6/

CPBM-1544

Critica
l

UX CloudStack/CloudPlatform connector's API
proxy does not support POST API calls.

CPBMD-2087
1/

CPBM-1556

Critica
l

Administration/Se
curity

If the root user attempts to simultaneously
edit more than one account by using
different tabs, one customer's information
gets incorrectly overwritten by the edits
made to another customer's account.

CPBMD-2086
7/

CPBM-1553

Critica
l

CCP Connector Although a user uploaded template is
marked as public and featured by the
CloudStack/CloudPlatform administrator,
CPBM treats it as a user defined template.

CPBMD-2086
2/

CPBM-1555

Critica
l

CCP Connector The Instances tab (of the CCP connector's
manage resources UI) breaks when a VM
gets stuck in expunging state.

CPBMD-2078
9

Critica
l

Billing Daily billing job skips processing of usage if
it is unable to insert usage data attributes
due to size constraints.

CPBMD-2066
8/

CPBM-1456

Critica
l

CCP Connector The options to manage static routes for a
Private Gateway are not displayed in the
VPCs tab of CCP connector's manage
resources UI.

CPBMD-2098
1

Major Account
Management

If a tenant user account gets locked, the
email to reset password is not sent when
you request a password reset from the login
page.

CPBMD-2096
4

Major Subscription If there is no compute service offering
available the compute offering page of the
browse catalog keeps loading indefinitely.
As a result, the user is unable to navigate to
storage or network offerings

2.3.1
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CPBMD-2095
2/

CPBM-1479

Major Subscription
Provisioning

When the root user browses the tenant's
catalog, the browse catalog pages display
the currency of the root instead of that of
the tenant.

CPBMD-2095
1

Major Customization Although a custom field is defined to accept
only unique values, you can provide
duplicate values for it.

CPBMD-2093
5/

CPBM-1579

Major UX No message is displayed in the CPBM UI to
indicate that changes to service controls are
applicable only to new users.

CPBMD-2092
8/

CPBM-1605

Major CCP Connector UI In CCP connector's UI, the data volume
resize option is not available for a volume
that is attached to a VM which is in "running
state" and is with "VMware hypervisor".

CPBMD-2089
4/

CPBM-1595

Major Administration The root user is not able to edit those roles
of a profile that are specific to a cloud
service.

CPBMD-2088
4/

CPBM-1577

Major CCP Connector UI During subscription provisioning if
subscription creation fails from back-end
cloud service due to insufficient resources,
the CPBM UI does not display error message
immediately at the first instance.

CPBMD-2086
9

Major Billing If a quarterly or annual bundle entitlements
change during the day and get subscribed to
on the same day, all entitlements get
calculated incorrectly from the second
billing period onwards till the subscription is
renewed.

CPBMD-2086
0

Major CCP Connector In certain cases, the
CloudStack/CloudPlatform connector's
usage collector returns cached values if
there are multiple instances.

CPBMD-2079
3

Major Upgrade Upgrade form CPBM 2.2.x to CPBM 2.3 fails
if the database character set for email
templates is not UTF-8.

CPBMD-2079
2/

CPBM-1422

Major CCP Connector If a VM is launched in a shared network, the
CloudStack/CloudPlatform connector treats
the VM's IP as a public IP, even if the IP
belongs to a private subnet.

CPBMD-2068
1

Major CCP Connector The VPN_USERS usage from
CloudStack/CloudPlatform connector does
not contain zone information.

CPBMD-2067
8

Major CCP Connector UI In the Networks tab of CCP connector's
manage resources UI, if an error occurs
during a resize volume operation, then the
T&C checkbox is already checked when the
resize volume dialog is reopened.

2.3.1
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CPBMD-2067
6

Major Billing For an account, if the account has
terminated subscriptions, the billing job
errors out partially if the job did not run at
the end of previous billing period.

CPBMD-2067
3

Major UX The footer of preview emails and test email
of a channel display incorrect values for
support email/phone.

CPBMD-2067
1/

CPBM-1452

Major Subscription
Provisioning

Email notifications for Subscription
activation and Bundle subscription are
getting delayed.

CPBMD-2066
4/

CPBM-1234

Major UX In the Instances tab of the CCP connector's
manage resources UI, the VM information
popover is not displayed correctly.

CPBMD-2066
3

Major Security DOM based Cross Site Scripting issues in
Administration settings UI.

CPBMD-2065
8

Major CCP Connector In CCP connector, the running VM and
allocated VM usages do not report
ha-enabled attribute.

CPBMD-2065
5

Major Upgrade After upgrading from CPBM 2.1.x or lower
versions, multiple resource components for
network offering are incorrectly shown
during network product bundle creation.

CPBMD-2064
4

Major BSS API In BSS APIs, the count parameter returns an
incorrect count.

CPBMD-2061
1

Major Account
Provisioning

The input validation for certain fields during
self-signup is insufficient, which incorrectly
allows a user to insert javascript into
certain fields, although the scripts are not
executed.

CPBMD-2054
2/

CPBM-1425

Major CCP Connector UI In the VPC tab of CCP connector's manage
resources UI, the description of the selected
VPC is not displayed in the details pane.

CPBMD-2099
8

Minor UX Since the fontawesome.css is not available
to connector's UI, the font-awesome icons
cannot be used.

CPBMD-2098
0

Minor UX Although a product bundle logo is changed,
due to browser caching the logo does not
get updated and the old logo is still
displayed in the UI.

CPBMD-2093
8/

CPBM-1479

Minor Upgrade Upgrade from CPBM 1.4.x to CPBM 2.3 .0
fails if CCP does not have any VPC network
offering enabled.

2.3.1
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CPBMD-2091
4/

CPBM-1600

Minor Upgrade The /etc/init.d/cloud-portal script does not
work because the hard coded java path is
invalid.

CPBMD-2087
5/

CPBM-1571

Minor Connector For a given account type, the CPBM UI does
not display service control settings that are
specific to the selected cloud service
instance version.

CPBMD-2085
8/

CPBMD-2066
1

Minor CCP Connector Although custom compute offerings are not
supported through the CPBM UI, the
CloudStack/CloudPlatform connector lists
custom compute offerings during VM
deployment and change service.

CPBMD-2064
9

Minor Subscription
Provisioning

In the CPBM UI, the state of a terminated
subscription is shown as "EXPIRED (Unused)"
instead of "EXPIRED".

CPBMD-2060
9

Minor Portal
Administration

If an invalid value for "lang" parameter is
passed in the CPBM URL, the exception is
not handled correctly.

CPBMD-2054
5

Minor Account
Management

While adding credit card details, if some
characters such as "-" are used in tenant
details, you get an error.

CPBMD-2022
2

Minor BSS API An incorrect error message is displayed if a
master user attempts to create another
master user using the BSS API.

CPBMD-1970
7/

CPBM-1244

Minor CCP Connector A user without CloudStack Domain
Administrator or CloudStack User role is
able to access My Services and Catalog
pages resulting in an error.

CPBMD-2096
3

Minor CCP Connector UI An empty Error Message Box is displayed
when you attempt to create a compute
bundle when there is no compute service
offering in CCP.

Known Issues and Limitations
1. The CPBM UI displays junk characters instead of localized Japanese text when you enter

the credit card details in the Billing and Payment section of the Company Setup page.
This issue is seen if you have configured Authotize.Net or CyberSource as a payment
gateway. This issue occurs because the Japanese character set is not supported by
Authorize.Net or CyberSource.

2.3.1
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Upgrading CloudPortal Business Manager

The supported upgrade paths to CloudPortal Business Manager (CPBM) are as follows:

• CPBM versions 1.4.3 through 1.4.7 to CPBM 2.3.x.

For information on the upgrade steps, refer to the Migration Guide.

• CPBM 2.1.x to CPBM 2.3.x.

• CPBM 2.2.x to CPBM 2.3.x.

• CPBM 2.3.x (any earlier version) to CPBM 2.3.x (any later version)

The following are the migration steps.

Important Notes:

• From CPBM 2.3.0 onwards, the workflows.xml and transactionWorkflowMap.xml XML
files are moved from citrix.cpbm.custom.common bundle to
/usr/share/vts3/repository/prop directory. If you have customized these files then you
must merge new changes made into these files. New version of these files are saved
with ".rpmnew" extension under /usr/share/vts3/repository/prop directory.

• From CPBM 2.1.1 onwards, a new directory connectors_ext has been created under
/usr/share/vts3/ directory. This directory contains the
com.citrix.cpbm.connector.ext.plan and the connector-ext.properties file. Customers
must deploy their connectors into this directory and edit the appropriate plan. Contents
of com.citrix.cpbm.plan and com.citrix.cpbm.connector.plan must not be modified.

• In CPBM 2.1.0, if you had deployed your own connectors instead of CPBM connectors
such as, Apache CloudStack, Citrix CloudPlatform under the connectors/ directory, then
move the deployed connector bundles to the connectors_ext directory and edit the plan
appropriately.

Example:

1. Move your connector artifact, for example:

<artifact type="bundle" name="<bundle.artifact.id>" version="[<x.x.x>, <x.x.x>]"/>

from com.citrix.cpbm.connector.plan located at /usr/share/vts3/connectors and add it
to com.citrix.cpbm.connector.ext.plan located at /usr/share/vts3/connectors_ext after
the line:
<artifact type="configuration" name="connector-ext"/>

2. Copy the connector OSGi service bundle in the Virgo's
/usr/share/vts3/connectors_ext directory.

• As part of the upgrade, the contents of the /usr/share/vts3/patches/ directory is
removed because the latest version includes all the fixes. After the upgrade, the
/usr/share/vts3/patches/ directory contains the patches.plan along with the

http://support.citrix.com/proddocs/topic/cpbm-23-map/cpbm-21-migration-wrapper-con.html#concept_058F004ED9A34104A92ED5AED928A27C


patches.properties file. It is recommended that you back up the patches folder before
the upgrade.

• If you are already on CPBM 2.3.x and wish to upgrade to newer maintenance release
along 2.3.x lines, then you need to extract the CPBM tar ball, run install.sh, and select
option U from the menu.

Note: Do not delete the patches.properties and connector-ext.properties files.

Prerequisites

• Before upgrade, if the cloud.properties file contains encrypted values of any property,
they must be replaced by the clear-text (or decrypted) values. These properties can be
replaced by encrypted values post upgrade. The cloud.properties file path is:

• Citrix CloudPlatform management server must be up and running while performing the
CPBM upgrade.

• Make sure that you have taken a backup of CPBM database (DB).

• If upgrade fails, automatic system rollback is not supported. It is therefore strongly
recommended to take the complete Virtual Machine (VM) backup or snapshot of the
CPBM server and DB.

• In a clustered environment, code upgrade must be performed on all the servers, but the
DB upgrade (Shell script) must be run only on one of the nodes.

• Make sure that the cloud-portal service is stopped before the upgrade is performed. In
a clustered setup, the cloud-portal service must be stopped on all the nodes before
upgrade.

• If there is any customization done in your setup, then merge your changes with the
latest customization code before upgrade. For more information, refer to Installing and
building custom components.

Requirements

Requirement Version

CloudPortal Business Manager (old) 2.1.x (any) or 2.2.x (any) or 2.3.x (any earlier
version)

CloudPortal Business Manager (new) 2.3.x (any later version)

Python Default with CentOS (Python 2.4 for CentOS 5.6
and Python 2.6 for CentOS 6.3)

Use the following commands:

yum -y install MySQL-python

yum -y install unzip

yum –y install mysql

if you want to:
• install the required packages, if they do not exist.

Upgrading CloudPortal Business Manager
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• update the packages with their respective latest version.

Steps to upgrade CloudPortal Business Manager 2.1.x / 2.2.x / 2.3.x (any earlier version)
to CloudPortal Business Manager 2.3.x

Perform the following steps to upgrade CPBM 2.1.x / 2.2.x / 2.3.x to CPBM 2.3.x:

1. Download the CPBM v2.3.x tar ball from the CPBM download site.

2. Stop the cloud-portal service on all the active nodes using the command:

service cloud-portal stop

3. Go to the console of your primary node and perform the following steps:

4. Copy and extract the CPBM tar ball in any location <untar_location>

tar -zxvf CloudPortal-2.3.x-centos.tar.gz

5. cd <untar_location>

6. Run the installer using:

./install.sh 2>&1 | tee installer.log

Note: Make sure that you take a backup of CPBM and DB (preferably, the complete
CPBM VM).

7. Read and accept Citrix End User License Agreement.

8. From the Install options available in the menu, select U to upgrade.

9. Follow the instructions that appear in the Upgrade wizard.

10. Select the option Q to quit.

11. Check if any ".rpmsave" or ".rpmnew" file is created under directories
"/usr/share/vts3/repository/prop", "/usr/share/vts3/pickup/",
"/usr/share/vts3/patches", "/usr/share/vts3/connectors_ext", and
"/usr/share/vts3/connectors".

If the ".rpmnew" file is created for any configuration file, then it means the new CPBM
version has some changes in the configuration file and the new file is saved as
".rpmnew" without touching the existing configuration file. In such a case, compare
these files to find out the updates and modify the configuration file accordingly.

If the ".rpmsave" file is created for any configuration file, then it means that the file is
being replaced by new CPBM version and the existing file has been saved as ".rpmsave".
In such a case, update the configuration file with the changes that you made
previously.

Once the files are merged, you must delete these backup files: ".rpmsave" and
".rpmnew".

12. Following are the commands for the database upgrade of CPBM, that must be run only
once (on any one node in the clustered environment):

Upgrading CloudPortal Business Manager
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Note: This step is not required if you upgrade from CPBM 2.3.x.

a. If the current version of CPBM is 2.1.x:

cd <untar_location>/migration/2.3/from/2.1/scripts
./dbupgrader.sh 2>&1 | tee dbupgrader.log

b. If current version of CPBM is 2.2.x:

cd <untar_location>/migration/2.3/from/2.2/scripts
./dbupgrader.sh 2>&1 | tee dbupgrader.log

13. After the steps 1 to 12 are successful, start the CPBM server by using the command:

service cloud-portal start

14. In a clustered environment, repeat steps 4 to 11 for each of the secondary nodes.

15. If the cloud.properties file contains encrypted values of any property then, after the
upgrade follow these steps:

a. Replace these properties by the encrypted values.

b. Modify the file /etc/init.d/cloud-portal:

Replace the text ' IS_CLOUD_PORTAL_ENCRYPTED=0 ' with '
IS_CLOUD_PORTAL_ENCRYPTED=1 '

16. Start the cloud-portal service on each of the secondary nodes using the command:

service cloud-portal start

Note: Make sure that the browser cache is cleaned after upgrade.

Note: If you have customized CCP connector UI on any earlier release of CPBM 2.x, and
wish to upgrade to 2.3.x, you need to redo the customization using
CCP-connector-customization package that has been shipped with 2.3.x and deploy the
connector in /usr/share/vts3/custom_connectors.

Note: After upgrading to CPBM 2.3, an account Dashboard displays a fewer number of
active subscriptions than before the upgrade. This reduction in number is because in
CPBM 2.3 only purchased subscriptions (or subscriptions that are associated with a
product bundle) are considered as Active subscriptions, while utility subscriptions are no
longer counted as active subscriptions.

Upgrading CloudPortal Business Manager
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Connector Upgrade

Upgrading CloudPortal Business Manager without
upgrading the cloud service connectors

If you have the customized CPBM 2.x Citrix CloudPlatform Connector fragment then upgrade
to CPBM 2.3.x will automatically retain the customized and dependent connectors, and will
back up the new connectors into directory /usr/share/vts3/backup_connectors/.

If you want to update your customized Citrix CloudPlatform Connector fragment then refer
to section "Customizing the CCP Connector UI" under Installing and building custom
components.

If you want to use new version of Citrix CloudPlatform connectors without any
customization then follow the steps below, after upgrading CPBM:

1. Stop the cloud-portal service on all the active nodes using the command:

service cloud-portal stop

2. Copy the following connectors from /usr/share/vts3/backup_connectors/ to
/usr/share/vts3/connectors/

a. cloud.apachecloudstack.fragment

b. cloud.apachecloudstack

c. cloud.cloudplatform.fragment

d. cloud.cloudplatform
$ cp /usr/share/vts3/backup_connectors/cloud.apachecloudstack-<new.cpbm.version>.jar /usr/share/vts3/connectors/
$ cp /usr/share/vts3/backup_connectors/cloud.apachecloudstack.fragment-< new.cpbm.version>.jar /usr/share/vts3/connectors/
$ cp /usr/share/vts3/backup_connectors/cloud.cloudplatform-<new.cpbm.version>.jar /usr/share/vts3/connectors/
$ cp /usr/share/vts3/backup_connectors/cloud.cloudplatform.fragment-<new.cpbm.version>.jar /usr/share/vts3/connectors/

3. Move the customized and dependent connectors to backup directory
/usr/share/vts3/backup_connectors

$ mv /usr/share/vts3/custom_connectors/cloud.apachecloudstack-<old.cpbm.version>.jar /usr/share/vts3/backup_connectors/
$ mv /usr/share/vts3/custom_connectors/cloud.apachecloudstack.fragment-<old.cpbm.version>.jar /usr/share/vts3/backup_connectors/
$ mv /usr/share/vts3/custom_connectors/cloud.cloudplatform-<old.cpbm.version>.jar /usr/share/vts3/backup_connectors/
$ mv /usr/share/vts3/custom_connectors/cloud.cloudplatform.fragment-<old.cpbm.version>.jar /usr/share/vts3/backup_connectors/

4. Follow the steps 2 and 3 on each of the CPBM nodes.

5. Start the cloud-portal service on each of the nodes using the command:

service cloud-portal start



Upgrading the cloud service connectors on
CloudPortal Business Manager 2.3.0 without
upgrading CPBM

CPBM 2.3.0 cloud service connectors can be upgraded to the latest maintenance versions of
CPBM 2.3.x connectors without upgrading CPBM. The example provided is specific to the
Citrix CloudPlatform Connector.

1. Stop the cloud-portal service on all the active nodes using the command:

service cloud-portal stop

2. On each of the nodes, replace the following CCP connector jars under
<virgo_home>/connectors folder with the new CCP connector jars of CPBM 2.3.x

a. cloud.apachecloudstack.fragment

b. cloud.apachecloudstack

c. cloud.cloudplatform.fragment

d. cloud.cloudplatform
3. Start the cloud-portal service on each of the nodes using the command:

service cloud-portal start

Note: Similarly use the steps above for other cloud service connectors as well. You must
replace the appropriate jar files for the other connectors.

Connector Upgrade

37



38

Installation Guide

This guide provides detailed instructions for installing the CloudPortal™ Business Manager.

System requirements

Installing and configuring CPBM

Verifying - Starting and stopping CPBM

http://support.citrix.com/proddocs/topic/cpbm-23-map/cpbm-sys-req-22.html#ccpb-sys-req-20
http://support.citrix.com/proddocs/topic/cpbm-23-map/cpbm-install.html#ccpb-install
http://support.citrix.com/proddocs/topic/cpbm-23-map/cpbm-verifying-con.html#ccpb-verifying-20
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System Requirements

System requirements for the server:

• 4 vCPU , 8 GB RAM with 40 GB HDD

• 64-bit Operating System (any of the following):

• CentOS 5.6, 6.0, 6.2, 6.3, 6.4, 6.5

• RHEL 5.6, 6.3, 6.4, 6.5
• Java 1.6

• MySQL Server 5.0.95, 5.1.x

• Internet connectivity: The following features require internet connectivity for the
system to be able to use them:

• CAPTCHA verification

• Gravatar

• Installation

Note: Intranet mode: You can run CloudPortal Business Manager (CPBM) in the intranet in
secure enterprises. You can operate CPBM seamlessly when the environment does not
have access to Internet. In such a case, the reCAPTCHA and Gravatar features are
disabled.

Note: By default, Java 1.7 is installed with CentOS 6.5 and RHEL 6.5. The CPBM
installation will not work with Java 1.7 and therefore, you must remove Java 1.7 using
the command:

yum remove java-1.7.0-openjdk

Note: By default, Java 1.4.2 is installed with CentOS 5.6 and RHEL 5.6. The CPBM
installation will not work with Java 1.4 and therefore, you must remove Java 1.4 using
the command:

yum remove java-1.4.2

Browser support

The following browsers are supported:

• Microsoft Internet Explorer 8, 9, 10, and 11

• Mozilla Firefox 30

• Google Chrome 35.0.1916.153

• Apple Safari 7.0.5
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Installing and Configuring CloudPortal
Business Manager

Download
Download the CloudPortal Business Manager software.

System Preparation
All the operations listed below should be run as root.

Unarchive Install Package

To unarchive the install package tarball, run (where x.y.z is the version you have
downloaded):

# tar -xvf CloudPortal-x.y.z-centos.tar.gz

Then navigate into the newly created CloudPortal-x.y.z-centos folder:

# cd CloudPortal-x.y.z-centos

Installing MySQL
The MySQL database may be installed on the same node as CloudPortal Business Manager or
a different node.

Note: You must have a MySQL database administrator tune the MySQL database for
optimal performance. MySQL’s default configuration will use a small amount of RAM and
does limited amount of caching. CloudPortal uses the InnoDB storage engine.

1. Run the ./install.sh script and choose option "D" to install the MySQL database server.

Accept the license agreement before selecting the "D" option.

# ./install.sh
Welcome to the Citrix CloudPortal Business Manager Installer. What would you like to do?
D) Install the database server
I) Install & Configure CloudPortal Business Manager
C) Integrate with Citrix CloudPlatform
Q) Quit
> D



2. When prompted, provide a user name and password. You can set these to any desired
value that is valid for a MySQL database. This step creates a new user account that
CloudPortal will use to access the database.

Note: Database password is mandatory.

3. Exit the installation setup:

Welcome to the Citrix CloudPortal Business Manager Installer. What would you like to do?
D) Install the database server
I) Install & Configure CloudPortal Business Manager
C) Integrate with Citrix CloudPlatform
Q) Quit
> Q

4. Stop mysql service:

service mysqld stop

5. Make the my-huge.cnf values as default:

cp /usr/share/mysql/my-huge.cnf /etc/my.cnf

6. Change the MySQL DB encoding format to UTF-8:

Edit the file /etc/my.cnf and add the following lines under the [mysql] and [mysqld]
sections:

[mysql]
default-character-set=utf8

[mysqld]
default-character-set=utf8
default-collation=utf8_unicode_ci
character-set-server=utf8
collation-server=utf8_unicode_ci

7. Edit the file /etc/my.cnf and add the following line under the [mysqld] section:: 

max_connections=400

8. Start the MySQL service.

# service mysqld start 

Note: Use the following command to check if the database encoding format is UTF-8:

mysql>show variables like  "%char%"; 

mysql>show variables like  "%coll%";
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Language Settings for Linux
The default language setting for CloudPortal Business Manager is English.

To set the language

1. Open the file /etc/sysconfig/i18n

2. Set the value LANG="en_US.UTF-8"

Installing CloudPortal Business Manager
For each CloudPortal Business Manager node, run the install.sh script from the package.
Select option I:

Accept the license agreement before selecting the "I" option.

# ./install.sh
Welcome to the Citrix CloudPortal Business Manager Installer. What would you like to do?
D) Install the database server
I) Install & Configure CloudPortal Business Manager
C) Integrate with Citrix CloudPlatform
Q) Quit
> I

Enter Y if you want Central Authentication Service (CAS) installed along with CloudPortal
Business Manager, and N if you want to install only CloudPortal.

Would you like to install CAS with CloudPortal (Y/N)?
> Y

If yes, refer to Enabling CAS authentication.

Installation begins. CloudPortal Business Manager checks for the Java version in the system
and installs the required version (1.6) if it is not available.

JAVA_HOME path is automatically updated.

Note: If you install Java manually, update JAVA_HOME path in the
/etc/init.d/cloud-portal script.

It is recommended to run all servers on UTC. This server is currently running on IST.

Do you wish to change this server to run on the UTC timezone (y/N)?

Select the required option.
CloudPortal Business Manager installation is complete.

The Configuration Tool starts automatically once the installation is complete.
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If you have skipped the configuration step, use the command below to start the
Configuration Tool.

You've successfully installed CloudPortal Business Manager. 
Now proceed to configure the CloudPortal Business Manager. 

Welcome to the Citrix CloudPortal Business Manager Configuration Tool. 

D) Install the database server
G) Configure CloudPortal Business Manager
C) Integrate with Citrix CloudPlatform
Q) Quit

> G

1.
Do you want to configure CloudPortal startup Encryption Key [y/N]:

Configure the CloudPortal Start-up Encryption key. Length of the encryption key must be
16 characters. For security reasons, you need to provide the encryption key during
CloudPortal start-up. This key will be used to encrypt password fields in cloud.properties
file.

Note: If you select the encryption key option, then you must remember the
encryption key because you will need to enter the key every time you start the
CloudPortal Business Manager. The start-up CloudPortal option will be disabled as
mentioned below: However, if you do not select the encryption key option, you will
NOT be asked to enter the key when you start CloudPortal. The following startup
cloud-portal options are enabled as mentioned below running mode. So, when you
reboot the system, Cloud-Portal service will start by default in the following
mentioned running modes ( 3,4,5).

2. Provide CloudPortal database configuration details:

• CloudPortal Database encryption key. Length of the encryption key must be 16
characters.

• Host name or IP

• Database user

Note: Enter the user name that you have specified while installing MYSQL
database.

• Database password - <Your Password used for cloud_portal DB user>

Note: Database password is not visible. Enter the password that you have
specified while installing MYSQL database.

3. Provide mail sender (SMTP/SMTPS) configuration details:

• Mail protocol - smtp

• Mail host
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• Mail port

• Mail user

• Mail password

Note: If SMTPS is enabled, ensure that the following lines are present in
cloud.properties:

mail.smtps.auth=true
mail.debug=false
mail.smtp.starttls.enable=true
mail.smtp.starttls.required=true

4.
Do you want to configure LDAP [y/N]:

By default, it is N. If you select the option "y", then provide the following information:
• LDAP Host Name[localhost]

• LDAP Base[dc=cloud,dc=com]

• LDAP Userdn[cn=Manager,dc=cloud,dc=com]

• LDAP Password
5. Enter the tax percentage:

Tax Percentage[10.00]: 

This is the tax percentage applied while billing the customers/tenants for the use of cloud
services.

6. Provide all the active currencies (maximum six active currencies):

For example: USD, INR, GBP, EUR

7. Select one default currency for your installation from the active currency code
displayed.

8. Enter the recaptcha configuration details (you can proceed with the default values, if
required):

• Recaptcha public key

• Recaptcha private key
You can generate your own recaptcha keys (public key and private key) from
http://www.google.com/recaptcha using your Google account.

9. Quit the installation:

Welcome to the Citrix CloudPortal Business Manager Configuration Tool. 

D) Install the database server
G) Configure CloudPortal Business Manager
C) Integrate with Citrix CloudPlatform
Q) Quit

 Installing and Configuring CloudPortal Business Manager

45



> Q

The initial setup of CloudPortal Business Manager is completed.

Note: Post-installation requisite: This task is required only if you have just installed
CPBM 2.3.0. Edit the cloud-portal file in the following way:

vi /etc/init.d/cloud-portal

Search for "/usr/lib/jvm/java-1.6.0-openjdk-1.6.0.0.x86_64/jre" and replace it with
"/usr/lib/jvm/jre".

There are four occurences of /usr/lib/jvm/java-1.6.0-openjdk-1.6.0.0.x86_64/jre in the
file. Replace all such occurrences with /usr/lib/jvm/jre.

You can start CPBM using the command:

service cloud-portal start

(If you have configured the CPBM startup encryption key, you will be prompted for the key.)

Note: Post-installation requisite: After CPBM installation, you have to configure the
CloudPortal public server information, such as the public Host name or IP and public host
port, from Administration > Configuration > Portal > Settings > protocol, host, and
port.

Ensure that the hostname provided is a valid hostname and is resolvable either in
/etc/hosts or in DNS.

Note: CPBM Log file: The CPBM log file is located at
/var/log/cloud/portal/cpbm-server.log. You can use this file to debug any issues with the
installation and also for further debugging.

Enabling Network Security for Administrator Login
CloudPortal Business Manager provides a security mechanism using which login to
CloudPortal Business Manager for administrators can be restricted to only a fixed set (or
range) of IP addresses.

1. Log in as root to the host running CloudPortal Business Manager.

2. Edit the file /usr/share/vts3/repository/prop/cloud.properties and set value to the
property "network.ip.address.range" :

For example: network.ip.address.range=10.147.18.1/24,10.103.1.1/24.

You can specify comma separated list of CIDR. An empty value allows all ranges of IP
addresses.

3. Save the file.

4. Restart CloudPortal Business Manager.

# service cloud-portal restart
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Enabling CAS Authentication
CloudPortal supports the use of Central Authentication Service (CAS) for single sign-on,
which enables access to multiple password-protected systems after logging in just once. To
make this work, you need to update CAS with the location of the cloud_portal database and
list the services with which CAS will be used.

1. Log in as root to the host running CloudPortal Business Manager.

2. Edit the file /usr/share/vts3/repository/prop/cloud.properties and set these
parameters.

• Replace localhost:8080 in the following lines with the <public Host name or
IP>:<public host port> as shown below:

# URL to the CAS login page used for single sign on.
cas.login.url=http://<public Host name or IP>:<public host port>/cas

# URL for CAS single sign out.
cas.logout.url=http://<public Host name or IP>:<public host port>/cas/logout

# Callback URL used by CAS to redirect back to CloudPortal.
cas.service.url=http://<public Host name or IP>:<public host port>/portal/portal/j_spring_cas_security_check

• Un-comment the following property to enable CAS. By default, native
authentication is enabled.

vmops.authentication.service=cas

• cas.login.url: Full public URL (including http:// or https://, hostname, optional
port, and path) of the login page displayed to the user for single signon. For
example, http:// mypublichostname:8080/cas.

• cas.logout.url: Full public URL of the page where a user can log out of single
sign-on. For example, http://mypublichostname:8080/cas/logout.

• cas.service.url: Full public callback URL used by CAS to redirect back to CloudPortal
Business Manager. For example,
http://mypublichostname:8080/portal/j_spring_cas_security_check.

• cas.validator.url: Full private URL used in internal calls from CloudPortal Business
Manager server to CAS server to validate the CAS ticket. This should be a URL that
is not accessible from outside. your installation. If using HTTPS, this site must have
a valid certificate issued by a trusted certificate authority. For example,
http://myprivatehostname:8080/cas.

3. If any other application needs to be authenticated via CAS, then edit the
/usr/share/vts3/repository/prop/deployerConfigContext.xml file. Refer to Adding a
new service to CAS.

4. Restart CloudPortal Business Manager.

# service cloud-portal restart
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Integration with CloudPlatform
On each CloudPlatform server, run the ./install.sh script and select Integrate with
CloudPlatform from the menu. This will place files within CloudPlatform that are needed
for single sign-on integration with CloudPortal. Note that after the files are copied over for
integration, you will no longer be able to access the CloudPlatform management server
using http://<hostname>:8080/client. It is recommended to access the CloudPlatform
management UI by first logging into CloudPortal and clicking the "Launch Cloud Console"
button on the dashboard. As an alternative, the CloudPlatform management UI can be
accessed directly by using http://<hostname>:8080/client/?direct=true.

# ./install.sh
Welcome to the Citrix CloudPortal Business Manager Installer. What would you like to do?
D) Install the database server
I) Install & Configure CloudPortal Business Manager
C) Integrate with Citrix CloudPlatform
Q) Quit
> C 

Multinode Installation
For multinode installation:

Note: Installation of database server is not required for subsequent installation of CPBM
because all the CPBM servers use the same database server.

1. Install CPBM on the required servers

2. After installation, make sure that configuration values provided under "Citrix
CloudPortal Business Manager Configuration Tool" are same across all the servers

3. Log in to the OS console of each CPBM server and change the following lines in
/usr/share/vts3/repository/prop/cloud.properties

vmops.jms.url=tcp://<Your IP or hostname>:9125
vmops.jms.client.url=failover:(tcp://<your IP or hostname>:9125, 
tcp://< CPBM Server 1 IP or hostname>:9125, 
tcp://< CPBM Server 2 IP or hostname>:9125)

where <your IP or hostname> is the IP/hostname of the server from where you
are entering the value and you must specify the IP/hostname of all the CPBM servers
separated by comma.

Make sure that port 9125 is open on all the CPBM servers.

 Installing and Configuring CloudPortal Business Manager

48



Setting up a Proxy Server
In order to add a proxy server to front CloudPortal servers, the steps given below must be
followed.

The proxy server can be added in a variety of ways. The steps given below illustrate one
typical technique using Apache HTTP Server running on CentOS 5.x and CentOS 6.x.

• On the Apache server, install the module that provides SSL and TLS support.

# yum install httpd mod_ssl

• Create the file /etc/httpd/conf.d/cloud.conf, and add proxying (and, if needed, load
balancing) directives

For a two-node installation where Apache and CloudPortal are run on separate nodes,
use rules like the following. Replace CloudPortalNode with the private hostname or IP
of your own machines.

HTTP Proxy configuration:

ProxyPreserveHost on
ProxyPass /portal http://CloudPortalNode:8080/portal
ProxyPass /cas http://CloudPortalNode:8080/cas
ProxyPassReverse /cas http://CloudPortalNode:8080/cas
ProxyPass / http://CloudPortalNode:8080/portal
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AJP Proxy configuration:

ProxyPass /portal ajp://CloudPortalNode:20410/portal
ProxyPass /cas ajp://CloudPortalNode:20410/cas
ProxyPass / ajp://CloudPortalNode:20410/portal

Note: CloudPortalNode will display 8009 as the default value. Edit the file
/usr/share/vts3/config/tomcat-server.xml and change the value of the port from
8009 to 20410 at this line:

<Connector port="20410" protocol="AJP/1.3"
redirectPort="8443"
URIEncoding="UTF-8"/>

For a three-node installation where Apache is on one node and CloudPortal is on two
additional nodes, use directives like the following. Replace the CloudPortalNode
placeholders below with the private hostnames or IPs of your own machines.

<Location /portal> 
Header add Set-Cookie "rte=.%{BALANCER_WORKER_ROUTE}e; path=/portal; HttpOnly"
env=BALANCER_ROUTE_CHANGED
</Location> 
<Proxy balancer://portalcluster> 
BalancerMember ajp://CloudPortalNode1:20410 route=ps1
BalancerMember ajp://CloudPortalNode2:20410 route=ps2
</Proxy> 
ProxyPass /portal balancer://portalcluster/portal stickysession=rte

If SSL is enabled on the proxy server, then add the below configuration to redirect all
requests made over HTTP to HTTPS:

RewriteEngine On
RewriteCond %{HTTPS} off
RewriteRule ^/?(.*) https://%{SERVER_NAME}/$1 [R,L]

Recommended settings: These settings are to mitigate attacks pertaining to POODLE
(Padding Oracle On Downgraded Legacy Encryption).

You need to edit the Apache configuration located at /etc/httpd/conf.d/ssl.conf.

1. Add the following line to your Apache configuration with other SSL directives.

• For httpd version 2.2.23 and newer, specify all protocols except SSLv2 and
SSLv3:

SSLProtocol ALL -SSLv2 -SSLv3

• For httpd version 2.2.22 and older, only specify TLSv1. This is treated as a
wildcard for all TLS versions:

SSLProtocol TLSv1
2. Once done, restart your Apache HTTP Server:
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sudo service httpd restart

In order to check that the connection does not go through via SSLv3, run:

openssl s_client -connect <ip-address>:<port> -ssl3

• Add the following lines to configure CAS

<Location /cas>
Header add Set-Cookie "rte=.%{BALANCER_WORKER_ROUTE}e; path=/cas; HttpOnly"
env=BALANCER_ROUTE_CHANGED
</Location>
ProxyPass /cas ajp://CloudPortalNode:20410/cas

• Add the following line to avoid CSRF related errors:

ProxyPreserveHost on

• If you modify the configuration later, such as to add more nodes, use this command to
reload the configuration:

# apachectl graceful or # service httpd restart

Note: If you front the Tomcat server with an Apache proxy, set the
ProxyPreserveHost parameter to ON to avoid logon issues.

Recommended settings: The KeepAlive parameter is set to ON in the
/etc/httpd/conf/httpd.conf file.

• [Optional] Add the lines given below to enable compression of the response:

SetOutputFilter DEFLATE
AddOutputFilterByType DEFLATE text/html text/css text/plain text/xml text/json application/x-javascript

It is recommended that you enable compression of response at reverse proxy server
(web server). It improves the page load time.

Logging In
You should now be able to access CloudPortal from the Web browser. Go to http://<your IP
or hostname>:8080/portal/. Use the following credentials to login:

User name: root

Password: Portal123#
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Export invoice PDF
If there is a need to export the invoice pdf in Korean, Japanese, or Chinese language, then
install that particular language:

For Japanese fonts:

# yum install "@Japanese Support"

For Korean fonts:

# yum install "@Korean Support"

For Chinese fonts:

# yum install "@Chinese Support"

Configuring LDAP
Refer to Integrating the Directory Server.
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Verifying - Starting and Stopping
CloudPortal Business Manager

To start, stop, or restart CloudPortal Business Manager, log in as the root user to the host
where CloudPortal Business Manager is running and use the following commands.

Starting CloudPortal Business Manager
# service cloud-portal start

Stopping CloudPortal Business Manager
# service cloud-portal stop

Restarting (stop, then start again) CloudPortal
Business Manager

# service cloud-portal restart
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Administration Guide

CloudPortal™ Business Manager allows you to take up several administrative tasks. There is
an exclusive Administration module where you can set various parameters and manage the
administrative tasks.

When CloudPortal installation is set up, you can change the set of available configuration
parameters depending on your business needs. Each CloudPortal customer can have a
different set of parameters as well as have different values set for the same parameter.

The configuration parameters can be used to control everything from the URL of your
company's home page to the number of failed login attempts you allow users before locking
their accounts.

To modify configuration parameters, you can use the UI or edit the file
/etc/cloud/portal/cloud.properties.
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Configuring Portal Settings

1. To configure portal setting parameters, log in to CloudPortal Business Manager UI as
Root user.

2. Click the drop-down menu icon in the top right corner next to ROOT USER.

3. Click Administration > Configuration > Portal.

4. Click Settings > Configure.

5. Click Edit and set the following values:

Settings - Parameter
Name

Description

public.protocol Public-facing protocol used for URLs embedded in text of
outgoing email.

public.host Public-facing DNS host name (or IP address) used for URLs
embedded in text of outgoing email.

Ensure that the hostname provided must be a valid
hostname and resolvable either in /etc/hosts or DNS.

public.port Public-facing port used for URLs embedded in text of
outgoing email.

context.path Context path of portal server (default is /portal)

helpdesk.phone Main Help desk phone number.

helpdesk.url Help desk URL

errorNotification.prefix Prefix to use in Subject line of error notification email,
to indicate the origin of environment error.

default.currency Default currency for new customer accounts. It has to be
one of the active currencies in the system. Use an ISO
4217 currency code, such as USD, INR, SGD, EUR, JPY.

image.path Path to images that are used in automatically generated
emails. Specify the absolute path of the image.

search.customFields The custom fields for tenants which can be used in
advanced search.

temp.path Path to temporary directory for placing zip files before
downloading or sending in email.

default.timezone Default preferred time zone for users. New users will
have this time zone as their default time zone.



images.uploadPath Absolute path to images directory for storing custom
image logos, favicon etc.

Note: Set the value to a valid existing path in your
server file system.

proxy.server.ipList Proxy server/load balancer IP addresses of the Cloud
Portal setup, separated by commas.

record.outgoing.email Enables saving of all outgoing emails into database table
"sent_emails".

services.datapath This is the path where service related files like
serviceDefinition.xml, images, external jsp files, and
terms and conditions file are copied from the OSGi
connector bundle.

company.name Company/Service Provider name.

support.email Support Email address that is used in links/message, on
portal for assistance.

allow.signup Set it to "true" to mark channels as open for registration.

cookies.warning.enabled Set this to "true" to enable cookie warning.
6. Click Save and then, click Close.
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Configuring Billing Settings for the Portal

1. To configure your billing settings, log in to CloudPortal Business Manager UI as Root
user.

2. Click the drop-down menu icon in the top right corner next to ROOT USER.

3. Click Administration > Configuration > Portal.

4. Click Billing > Configure.

5. Click Edit and set the following values:

Parameter Name Description

spendBudget.firstAlert First Spend Budget alert (in percentage of Spend
Budget).

spendBudget.secondAlert Second Spend Budget alert (in percentage of Spend
Budget)

spendLimit.creditAlert Send Credit Limit alert to internal Credit personnel when
this percentage of Credit Limit has been used.

billingPeriod.type Set to 1 to bill every <x> days, 2 to bill on a certain day
of the month, 3 to bill monthly on the account creation
date. Set
com.citrix.cpbm.portal.billing.billingPeriod.config to the
desired <x> or day of the month.

Note: After setting the configuration in
com.citrix.cpbm.portal.billing.billingPeriod.type, it
must not be changed.

billingPeriod.config Billing day(s) for use with
com.citrix.cpbm.portal.billing.billingPeriod.type.
Allowed values: 1-28. For example, set to 28 if
com.citrix.cpbm.portal.billing.billingPeriod.type is 1, 15
if com.citrix.cpbm.portal.billing.billingPeriod.type is 2.
Leave empty if
com.citrix.cpbm.portal.billing.billingPeriod.type is 3.

Note: After setting the configuration in
com.citrix.cpbm.portal.billing.billingPeriod.config, it
must not be changed.

generate.BillingActivity Setting it to Y will enable detailed logging of the usage,
rating and billing activity, on a daily basis. Valid Values
("Y", "N").

invoiceHandle.sequence Invoice Handle Sequence Name used for the sequence
generation.



export.fileExtension File extension for export file of usage details.

subscription.preAuthoriza
tionFactor

Credit Card Pre-authorization factor.

alerts.maxSpendAlertNoti
fications

Maximum number of spend alert notifications sent on
each alert trigger.

generate.InvoiceEmail Send the invoice PDF as an attachment in the mail to the
Master User and Billing Admin when the invoice
generation job runs.

roundingMode.charge Set this rounding mode if charges need to be rounded to
currency precision. Value should be one of these (UP,
DOWN, CEILING, FLOOR, HALF_UP, HALF_DOWN,
HALF_EVEN).

roundingMode.discount Set this rounding mode if discounts need to be rounded
to currency precision. Value should be one of these (UP,
DOWN, CEILING, FLOOR, HALF_UP, HALF_DOWN,
HALF_EVEN).

roundingMode.tax Set this rounding mode if taxes need to be rounded to
currency precision. Value should be one of these (UP,
DOWN, CEILING, FLOOR, HALF_UP, HALF_DOWN,
HALF_EVEN).

hoursIn.month Number of hours in month.

export.URL Remote location to which the generated fille will be
transfered for eg.
sftp://username:password@host/directory_path.

export.directory Local system directory where the exported file gets
stored before billing stream is uploaded to remote
system.

6. Click Save.

7. Click Close.

Configuring Billing Settings for the Portal
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Configuring Marketing Settings for the
Portal

1. To configure the portal marketing setting parameters, log in to CloudPortal Business
Manager UI as Root user.

2. Click the drop-down menu icon in the top right corner next to ROOT USER.

3. Click Administration > Configuration > Portal.

4. Click Marketing Wrapper > Configure.

5. Click Edit and set the following parameters:

Parameter Name Description

home.url URL of your company home page.

marketing.url URL of the home page of the marketing wrapper for your
cloud service.

support.url Support URL to be shown at the bottom of the CloudPortal
page.

blog.url URL of the blog of your organization to be shown at the
bottom of the CloudPortal page.

forum.url URL of the user forum to be shown at the bottom of the
CloudPortal page.

contact.url Information about how to contact your organization to be
shown at the bottom of the CloudPortal page.

privacy.url URL of privacy policy of your organization to be shown at the
bottom of the CloudPortal page.

tou.url URL of Terms of Use of your organization to be shown at the
bottom of the CloudPortal page.

help.url URL to the Help documentation.
6. Click Save.

7. Click Close.
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Configuring Appearance Settings for the
Portal

1. To configure the portal appearance parameters, log in to CloudPortal Business Manager
UI as Root user.

2. Click the drop-down menu icon in the top right corner next to ROOT USER.

3. Click Administration > Configuration > Portal.

4. Click Appearance > Configure.

5. Click Edit and set the following parameters:

Parameter Name Definition

currency.format Display format for the currency.

currency.precision The maximum number of digits to show after decimal
point across all currencies.

currency.roundingMode Rounding mode to use in case of scaling a currency to a
strictly lower precision. Use 0 for rounding up, 1 for
rounding down, 2 for ceiling, 3 for floor, 4 for half up
or 5 for half down.

6. Click Save and then, click Close.
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Configuring Server Settings for the Portal

1. To configure the server settings for the portal, log in to CloudPortal Business Manager
UI as Root user.

2. Click the drop-down menu icon in the top right corner next to ROOT USER.

3. Click Administration > Configuration > Portal.

4. Click Server > Configure.

5. Click Edit and set the following parameters:

Parameter Name Description

username.duplicate.allowed Setting this to true will enable suffixes where
usernames will have to be disambiguated with
suffix. The suffix field will show up in login
and the user will have to type it in to
determine which account the username is tied
to. See also
login.screen.tenant.suffix.dropdown.enabled.

login.screen.tenant.suffix.dropdow
n.enabled

At time of login, show drop down for suffix.
Values can be true or false.

signature.timeout Validity of signature timestamp (seconds).

channel.enable.caching Enable Channel Caching (true/false).

date.format Date Format (yyyy-MM-ddTHH:mm:ss.SSSZ).

catalog.payAsYouGoMode Show "Pay As You Go" Mode only, while
browsing catalog. Expected values true/false.

Note: If
com.citrix.cpbm.catalog.payAsYouGoMode
is set to "true", the value must not be
changed to "false".

use.intranet.only Set this to "true" if CloudPortal does not have
internet access and needs to run within the
company intranet. The default value is "false".

6. Click Save and then click Close.

Note: If the use.internet.only parameter is set to true, then:

• B/OSS services that require Internet access must be disabled.

• The system cannot fetch the user's profile image, if available in gravatar.

• Google ReCaptcha gets disabled.
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Configuring Internal Email Addresses

1. To configure your internal email addresses, log in to CloudPortal Business Manager UI as
Root user.

2. Click the drop-down menu icon in the top right corner next to ROOT USER.

3. Click Administration > Configuration > Portal.

4. Click Address book > Configure.

5. Click Edit and set the following values:

Parameter Name Value Description

addressbook.adminEmail <email-id> Admin email address to
display in the From field of
outgoing Emails sent to
customers.

addressbook.accountApprovalE
mail

<email-id> Email address to which
account activation request is
sent.

addressbook.salesSupportEmail <list of
email-ids>

E-mail Distribution List for
Sales Support team.

addressbook.helpDeskEmail <email-id> Email address to be used to
support the mail2case
functionality.

addressbook.financeEmail <email-id> Email Alias for finance team.
6. Click Save and then, click Close.
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Configuring CRM Email Addresses

1. To configure Email addresses for customer relationships, log in to CloudPortal Business
Manager UI as Root user.

2. Click the drop-down menu icon in the top right corner next to ROOT USER.

3. Click Administration > Configuration > CRM > Notifications.

4. Click Configure and set the following parameters:

Parameter Name Value Description

supportEmail <email-id> Email address for the
support team. This value
is used in FROM field of
outgoing emails to
customers.

internalEmail <email-id> Email address list for the
internal team. This value
is used in FROM field of
internal emails.

accountsOutboundEmail <email-id> Email address to receive
the notifications on
payments failure and on
crossing the spend limit
thresholds.

salesEmail <email-id> Email address to display in
FROM field of email sent
to customer, when Retail
Postpaid accounts exceed
credit limits.

5. Click Save and then, click Close.
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Integrating the Directory Server

The integration of CloudPortal Business Manager with Directory server (specifically Active
Directory) can be done in both modes, PUSH & PULL. CloudPortal Business Manager supports
either the PUSH or the PULL mode for any of the installations. However, these modes have
to be configured during deployment.

Note: No change in the mode is supported once the configuration of CloudPortal Business
Manager server is completed.

Pre-configuration for PUSH Mode (even for PULL mode, if LDAPS is to be used)

1. Install the security certificate exported from directory server to security keystore -
Sample Command (needs modification based on system configuration):

• keytool -import -alias <alias> -keystore <path-to-jre>/jre/lib/security/cacerts -file
<cer-file-location-and-name>

• keytool -import -alias alias -keystore /usr/lib/jvm/jre/lib/security/cacerts --file
certfromtheAD.cer

2. Restart the CloudPortal Business Manager server post certificate install.

Pull Mode
In the PULL mode, CloudPortal Business Manager can import the user details from the
Directory server. Once user is imported & created in the CloudPortal Business Manager, user
gets an email for verification. After user verifies the email, he will be able to log into the
CloudPortal Business Manager system. While logging in, user credentials are passed to
Directory Server for authentication. Upon successful authentication from the Directory
server, CloudPortal Business Manager allows the user to log in. CloudPortal Business
Manager does not store any password in its database once this setting is enabled.

Note: In Pull mode, user password reset, forgot password, and Signup links are disabled.
Any password related change needs to happen on the directory server directly.

Configuring PULL mode

1. Log in as Root user to change administration settings.

2. Go to Administration > Configuration > B/OSS Integration.

3. Click Directory Server > Configure.



4. Change the mode to pull and directory server enable to true. Configure the Details to
map to the Directory server configuration.

5. Directory server URL can be ldap or ldaps & corresponding ports (for example, ldap:389,
ldaps:636).

Integrating the Directory Server 
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Any other details in the same configuration page are not used for the PULL mode.

Configuration to allow the Duplicate Username

1. Log in as Root user to change administration settings.

2. Go to Administration > Configuration > Portal.

3. Click Server > Configure.

Integrating the Directory Server 

66



Note: Change the setting "username.duplicate.allowed" to true. If suffix dropdown is
required, change "login.screen.tenant.suffix.dropdown.enabled " to true, false for
this field results in a text box appearing instead of dropdown for the user log in page.

PUSH Mode
In the PUSH mode, CloudPortal Business Manager can add the user & user details to the
Directory server. Once user is created in CloudPortal Business Manager, his details will be
listed in the Directory server. Upon email verification, user is asked to set the password,
which is set in the Directory server. CloudPortal Business Manager supports edit user, reset
password & user sign-up operations through PUSH mode. As in case of PULL, even in PUSH
mode, user passwords are not stored in CloudPortal Business Manager DB.

Note: When PUSH mode is enabled, channels on which accounts can be created are to be
configured in CloudPortal Business Manager (even channels are created in Directory
server).

For PUSH mode, Directory server URL has to be ldaps & port has to be 636.

Change the first.name.mapping property to givenName which by default comes to cn to
avoid multiple values of cn.

CloudPortal Business Manager does not store any password details when directory server is
enabled.

Configuring PUSH Mode

1. Log in as Root user to change administration settings.

2. Go toAdministration > Configuration > B/OSS Integration.

Integrating the Directory Server 
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3. Click Directory Server > Configure.

Sample configuration for connecting the Directory server (specifically Active Directory)
to CloudPortal Business Manager 2.x

If the Directory server is Active Directory, make sure the set " is.active.directory" flag to
true.

Integrating the Directory Server 
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User.additional.attributes is an optional field. If you want any key to have any particular
value on directory server when user is getting created you can mention here.

User.enablement.attributes is an optional field. If you want any key to have any particular
value on directory server when user is verifying himself from the activation link, you can
mention here.

Make sure is.ssl.on is true if you are using ldaps protocol.

Integrating the Directory Server 
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Enabling Anonymous Browsing

As a service provider, you can enable anonymous browsing so that potential customers can
view the product catalog and understand the products and product bundles that are being
offered.

1. Log in to CloudPortal Business Manager UI as Root user.

2. Click the drop-down menu icon next to ROOT USER in the top right corner and click
Administration.

3. In the Configuration pane, click Server.

4. In the Anonymous Browsing area, click Configure.

5. Click Edit and set the value of catalog.display to true.

6. Click Save and then, click Close.
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Configuring Trial Management Settings

As a service provider, you can configure the settings to handle trial accounts.

1. Log in to CloudPortal Business Manager UI as Root user.

2. Click the drop-down menu icon next to ROOT USER in the top right corner and click
Administration.

3. Click Configuration > Trial Management.

4. Click Configure > Edit.

5. Set the following parameters:

Parameter Name Description

first.warning Send first warning email to customer these many days
before expiration of trial period.

second.warning Send second warning email to customer these many days
before expiration of trial period.

final.warning Send last warning email to customer these many days
before expiration of trial period.

trial.termination Send Trial Termination email to customer these many
days after expiration of trial period.

termination.threshold Send email to customer these many days after a trial
account expires, if it is not converted to a paying
account.

6. Click Save and then, click Close.
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Configuring Google Analytics settings

You can integrate CloudPortal Business Manager with Google Analytics and track your web
traffic.

1. Log in to CloudPortal Business Manager UI as Root user.

2. Click the drop-down menu icon in the top right corner next to ROOT USER.

3. Click Administration > Portal > Integration.

4. Click Configure and then, click Edit.

5. Set the value of the parameter integrations.analytics to True to enable the google
analytics.

6. Click Save and then, click Close.

7. Click Configuration > B/OSS Integration.

8. Click Google Analytics > Configure.

9. Click Edit and set the following parameters:

Parameter Name Description

analytics.account Google analytics account name.

analytics.domain Domain name for Google analytics.
10. Click Save and then, click Close.
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Configuring geo restriction

You can grant or deny access to customers based on their geographic location. CloudPortal
Business Manager comes integrated with a geolocation application that is used to arrive at
the geographic location of users. The country is identified from the IP address of the user.
You can provide a list of countries that are either blacklisted or whitelisted. You can
specify ISO 3166-1 alpha-2 codes for countries and either allow or deny users from these
countries to sign up. These lists are used for users of all account types. You can specify the
lists from the Account Management pane of the CloudPortal Business Manager UI.

The settings are enforced during the following events:

• When a user attempts to sign up from the Sign Up page.

• When a Root User attempts to sign up a user.

If a user tries to access the portal from a country that you have marked as blacklisted, the
geolocation application rejects the login attempt and directs the user to the CloudPortal
support page. A country whitelist always takes precedence over a country blacklist. For
example, If a country is marked in the whitelist and also in the blacklist, the country is
treated as whitelisted.

If you define whitelist and blacklist of countries at a channel level, the channel level
settings get precedence and are used. If channel-specific lists are not defined, then these
global white and black lists are used.

1. Log in to the CloudPortal Business Manager UI as Root user.

2. Click the drop-down menu icon next to ROOT USER in the top right corner and click
Administration.

3. Click Configuration > Account Management > Onboarding.

4. Click Configure, and then click Edit.

5. In the Value box for the parameter counrty.whitelist, enter the lSO 3166-1 alpha-2
country codes separated by commas. This is the whitelist of countries from which users
are allowed to sign in. For more information on 3166-1 alpha-2 ISO country codes, go to
http://en.wikipedia.org/wiki/ISO_3166-1_alpha-2.

6. In the Value box for the parameter country.blacklist, enter lSO 3166-1 alpha-2 country
codes separated by commas. This is the blacklist of countries from which users are not
allowed to sign in.

7. Click Save to save your changes and then click Close to close the dialog box.
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Understanding B/OSS subsystems

Operational Support Systems are the systems used by service providers. It deals with the
supporting processes such as maintaining network inventory, provisioning services,
configuring network components, and managing faults.

Business support system refers to systems dealing with customers, supporting processes
such as taking orders, processing bills, and collecting payments.

The two systems together are often abbreviated as BSS/OSS or B/OSS.

B/OSS contains processes and systems that support back-office activities within a network
or customer facing activities.

This section enable you to understand some of the basic B/OSS configuration tasks in detail.
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Configuring Fraud Control Settings

CloudPortal Business Manager comes integrated with a fraud control provision that can
assess fraud risk associated with the user’s credit card. You can determine the admissible
fraud risk level for credit card users by entering values for certain parameters as shown in
the table below.

1. Log in to CloudPortal Business Manager UI as Root user.

2. Go to Administration > Configuration > Portal > Integration.

3. Click Configure and set the following parameter values.

Parameter Name Parameter Value Description

creditcardfrauddetection.
threshold

Any numerical value This is the minimum fraud
threshold that you set in
numerical units. The value
that you set here
determines the extent of
fraud risk that you are
willing to accept. A lower
threshold value would
mean that your ‘trust’
level is higher than that
for a higher threshold
value. The recommended
default value for this
parameter is 3.

creditcardfrauddetection.
emailthreshold

Any numerical value
greater than <integration.
fraudcontrol.threshold>

Enter a value greater than

<creditcardfrauddetection
.threshold>. For any risk
score that lies between <c
reditcardfrauddetection.e
mailthreshold> and <credi
tcardfrauddetection.thres
hold>, an Email alert for
credit card fraud check
violation is sent to the
admin support.

The recommended default
value for this parameter is
25.

4. Click Save and then, click Close.
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Configuring credit card fraud control using
MaxMind minFraud

You have to integrate CloudPortal Business Manager with MaxMind minFraud for fraud
detection for online transactions. The possibility of an online transaction being fraudulent is
determined. The minFraud service is available through an API. To use this service, you must
have a valid MaxMind license key.

A risk score is returned that tells you the likelihood of the transaction being fraudulent. You
can specify the admissible threshold level that MaxMind minFraud will accept for credit
card users. For more information on specifying these thresholds, refer to Configuring fraud
control setings.

1. Log in to CloudPortal Business Manager UI as Root user.

2. Click Home > All Services.

3. Click B/OSS.

4. Select MaxMind minFraud and click Configure.

5. Accept the Terms and Conditions to proceed.

6. Enter the API license key and click Add.

7. Enable the MaxMind minFraud service by selecting the On toggle button.

http://support.citrix.com/proddocs/topic/cpbm-23-map/cpbm-configuregeolocationfraud-con.html#ccpb-configure-geolocation-fraud
http://support.citrix.com/proddocs/topic/cpbm-23-map/cpbm-configuregeolocationfraud-con.html#ccpb-configure-geolocation-fraud
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Configuring Saleforce

CloudPortal™ Business Manager is integrated with Salesforce.com Service Cloud. This is used
by customers to log service requests for support (tickets). The connection between
Salesforce and CloudPortal Business Manager must be set up as described is the following
sections.

Procuring Account in Salesforce

Setting up Salesforce within CloudPortal Business Manager
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Procuring Account in Salesforce

Developer Force.com
You can procure an account in Salesforce by performing the following steps.

1. Go to http://www.developerforce.com/events/regular/registration.php

2. Specify the following details:

a. First Name

b. Last Name

c. Email

d. Job Role

e. Company

f. Country

g. Postal Code

h. Username: Select a unique username in the form of an email by which you will
access your Developer Edition account

3. Click the checkbox beside I have read and agreed to the Master Subscription Agreement

4. Click Sign me up

You will receive an email verification.

5. Click on the URL provided in the email verification to set up your account in Salesforce

You will be prompted to set a password and a question for the password when you login
for the first time.

6. Login to Salesforce.com

7. Click the arrow beside your name

8. From the dropdown menu, select My Settings

9. In the left navigation pane, Expand Personal

10. Click Reset My Security Token

A confirmation screen appears and the Security Token is sent to your email address.

Note: The security token is required while setting up the Salesforce account in CPBM.
Refer to Setting up Salesforce within CloudPortal Business Manager



Salesforce.com
In the production environment, you need to get an Enterprise Edition account of
Salesforce.com, as follows:

Product ServiceCloud

Edition Enterprise Edition

Pricing URL http://www.salesforce.com/crm/editions-pricing-service.jsp

Min # of Licenses 2

Min Subscription Term 12 months

CapEx / One-off /
On-boarding charges

None

OpEx / Recurring /
Subscription Charges

Approx. $3,240 per year @ $135/user/month for a 2-user
license

PAYG / Utility Charges NA

Notes License to SalesCloud is NOT needed for the ticketing
functionality

Procuring Account in Salesforce
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Setting up Salesforce within CloudPortal
Business Manager

The Salesforce account procured is integrated with CPBM in the configuration parameters
described as follows.

1. Log in to CloudPortal Business Manager as Root user

2. Click Home > All Services

3. Click B/OSS

4. Go to Salesforce.com and click Configure

5. In the Terms and Conditions dialog box that appears, select the I Agree checkbox and
click Accept

6. Enter the following details in the Salesforce.com Configuration window that appears:

UI Element Description

Username Your username in Salesforce.com

Endpoint URL The endpoint URL for SOAP webservice requests that
is https://login.salesforce.com/services/Soap/c/27.0

Note: Make sure that you provide the Salesforce
API version "27" in the endpoint URL

Password Your password in Salesforce.com

Salesforce.com token The auto-generated security token that you received
by email from Salesforce.com

Timeout Set a value less than the timeout value set within
Salesforce

More information required If set to true, it allows you to save the additional
information like Tenant/user address, telephone
number to Salesforce.com

7. Click Add

The system saves the specified details and the message "Instance Added Successfully"
appears in green on top of the dialog box

8. Enable Salesforce.com by selecting On in the On/Off slider

9. Click OK

10. Click the Support > Tickets to verify whether the Salesforce.com developer account is
integrated with CPBM



You can view the tickets that are retrieved from your Salesforce.com account

Setting up Salesforce within CloudPortal Business Manager
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Configuring Payment Gateway

You can integrate CloudPortal™ Business Manager with CyberSource or Authorize.Net
payment gateway system.

Note: You have to sign up for a Authorize.Net or CyberSource account before you can use
these payment gateways for processing your business transactions. During your payment
gateway account activation and configuration, you have to specify the currencies that the
payment gateway will support. Because the Authorize.Net payment gateway supports
only one currency, ensure that only that currency is enabled in CloudPortal Business
Manager when you use Authorize.Net. If you have multiple currencies enabled in CPBM,
ensure that you use the CyberSource payment gateway.

Perform the following steps to configure the payment gateway.

1. Log in to CloudPortal Business Manager UI as Root user.

2. Click Home > All Services.

3. Click B/OSS.

4. Select Payment Gateways on the left pane. CloudPortal Business Manager supports:

• CyberSource payment gateway.

• Authorize.Net payment gateway.
5. Select the desired payment gateway. Click Configure.

Note:

• Only one payment gateway can be enabled.

• The payment gateway cannot be changed after an account is created.
6. Accept the Terms and Conditions to proceed.

7. In the Configuration window, enter the following details:

• Server URL / Authorize.Netwsdl: Specify the URL of the payment gateway's
endpoint.

• Merchant name: Specify your unique merchant name for accessing the payment
gateway.

• Transaction Key: Specify your unique API transaction key for accessing the
payment gateway.

8. Click Save.

9. Enable the payment gateway by choosing "On" toggle button. An information window
appears with the message - "Instance Updated successfully."

Note: Once a payment gateway is enabled, you should not disable or deactivate it.
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Configuring IP geolocation using
MaxMInd GeoIP

You have to integrate CloudPortal Business Manager with MaxMind GeoIP to discover
information about a specific IP address. The application enables you to identify a user's IP
address and look up the information of that IP address such as country, country of
registration and so on. You can grant or deny access to customers based on their geographic
location. You can provide a list of countries that are either blacklisted or whitelisted from
Administration > Configuration > Account Management > Onboarding.

You can use the GeoIP service and look up information about a given IP address using an
API.

1. Log in to CloudPortal Business Manager UI as Root user.

2. Click Home > All Services.

3. Click B/OSS.

4. Select MaxMind GeoIP and click Configure.

5. Enter you unique API key.

6. Specify the DB location and click Add.

7. Enable the MaxMind GeoIP service by selecting the On toggle button.
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Configuring device-based fraud control
using ThreatMetrix

To assess fraud risk associated with the user device, you have to integrate CloudPortal
Business Manager with ThreatMetrix. When a user attempts to sign up, based on the risk
rating, the account can either get created, get created but locked, or not get created.

1. Log in to CloudPortal Business Manager UI as Root user.

2. Click Home > All Services.

3. Click B/OSS.

4. Select ThreatMetrix and click Configure.

5. Accept the Terms and Conditions to proceed.

6. In the Configuration window, enter the following details:

a. API key: Unique API key for ThreatMetrix

b. APi Hostname: ThreatMetrix hostname

c. Profiling Hostname: ThreatMetrix porfiling hostname

d. Organization ID: Unique ID associated with your organization (provided by
Threatmetrix)

e. API TImeout: ThreatMetrix API request timeout
7. Click Add.

8. Enable the ThreatMetrix service by selecting the On toggle button
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Configuring TeleSign Phone Verification

CloudPortal™ Business Manager is integrated with TeleSign service cloud for the phone
verification. This is used to verify the identity of telephone users in real-time.

To configure this service:

1. Log in to CloudPortal Business Manager UI as Root user.

2. Click Home > All Services.

3. Click B/OSS.

4. Select the TeleSign. Click Configure.

5. In the Configuration window, enter the following details:

• Customer ID: Specify the TeleSign customer ID.

• Authentication ID: Specify the TeleSign authentication ID.

• Language: Specify the language in which the user gets the verification call.

• Allowed Phone Types: Specify the supported phone devices. For more information,
refer to Phone Type Codes.

• Help Desk Phone: Specify the number of the help desk.

• Help Desk Email: Specify the mail ID of the help desk.
6. Click Save.

7. Enable TeleSign by choosing "On" toggle button and then, click OK. An information
window appears with the message - "Instance Added successfully."

Note: When "Phone Verification" is

• Enabled: The user cannot edit the ISD field and the ISD number is derived from the
selected country. This is because the ISD code must be the code of the country of
address of the account

• Disabled: The user can edit the ISD field because the phone number is not verified

http://support.citrix.com/proddocs/topic/cpbm-23-map/cpbm-phonetypecodes.html#ccpb-appendix-phonetypecodes
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Phone Type Codes

The following is a list of phone type codes <TypeofPhone> returned by the TeleSign API,
along with their descriptions.

Cod
e

Descripti
on

Risk Level Recommended
Action

Detail

300 Undeter
mined

Medium Flag This is either an invalid phone
number or a very new number.
Because of its newness, TeleSign is
not yet able to determine the phone
type. This could potentially be a
VOIP phone, so there is some risk
involved with this type of phone
number.

301 Fixed
Line

Low Allow Fixed-line phones include traditional
landline phones and VOIP phones that
can be traced back to a particular
address and cannot be obtained by a
user outside the phone number’s
designated country. Because these
phone numbers are traceable, they
are low-risk.

302 Mobile Medium-Lo
w

Allow Mobile telephones are provided by
companies such as Verizon, Cingular,
or Sprint. Users of these phones must
sign contracts, making these
telephone numbers traceable. These
phone numbers are generally
low-risk. However, some prepaid
mobile phones will be identified as
Mobile.

Internationally, phones identified as
mobile may also include TETRA
mobile phones, cordless access
systems, proprietary fixed radio
access, and fixed cellular systems.



303 Pre-paid
Mobile

Medium-Hi
gh

Flag These telephones can be purchased
anonymously at many department
stores. They work like other mobile
phones, but their users are not
contracted with a mobile phone
company. Prepaid mobile phones
generally cost between $30 and
$100, making them unattractive for
most fraudsters, but we still
recommend flagging transactions
made with this type of telephone due
to a user’s anonymity. Also, not all
prepaid mobile phones will be
identified as prepaid; some will be
identified as Mobile.

304 Toll-Fre
e

High Block Toll-Free numbers are numbers
starting with toll-free area codes,
such as (800) numbers. Although
sometimes used by legitimate users
calling from companies, fraudsters
can easily obtain toll-free numbers
that either forward to their
telephone which is located in
another country or toll-free numbers
that terminate at an Internet
voicemail box. Toll-free numbers
always forward to non-toll-free
numbers. For this reason, any
legitimate user who provides a
toll-free number and is asked to
provide a non-toll-free number will
be able to do so. We therefore
recommend blocking users of tollfree
numbers.

305 Non-Fixe
d VoIP

High Block Voice Over Internet Protocol (VOIP)
phone numbers are Internet-based
telephone numbers. Non-fixed VOIP
telephone numbers can easily be
obtained by users who are not
located in the country associated
with the telephone number. They are
untraceable and disposable; some
can even be obtained for free. This
means that a fraudster in Romania
could easily obtain a US-based
telephone number using a non-fixed
VOIP service and receive a call to
this number in his/her home in
Romania.

 Phone Type Codes
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306 Pager High Block This phone number rings to a pager.
Because pagers cannot receive
verification calls, it’s best to block
calls to these numbers. These calls
are most likely requested by
fraudsters who are inputting invalid
phone numbers.

307 Payphon
e

High Block Calls to a payphone cannot be traced
back to any one person; therefore,
we recommend blocking verification
calls to these numbers.

308 Invalid High Block The telephone number entered is not
a valid number or is a number
originating on a Carribean island (i.e.
Jamaica, St. Lucia, etc.)

309 Restricte
d
Number

High Block The telephone number entered is a
restricted number. In the US,
restricted numbers include numbers
that begin with 0 and numbers with
the following area codes:

• 900

• 911

• 411

Internationally, the following phone
numbers are restricted:

• Audiotext

• Carrier selection

• National rate

• Premium rate

• Shared cost

• Satellite

• Short Code

 Phone Type Codes
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310 Personal Medium-Lo
w

Allow A “Personal” phone number is a
phone number which allows a
Subscriber to receive calls at almost
any telephone number, including a
mobile number. The “Personal”
number forwards to another phone
number, which is determined by the
subscriber. Because the “Personal”
number can forward to either a
landline or mobile number, it’s
impossible to determine what type of
phone the subscriber is using.
However, because “Personal” phone
numbers must be obtained from a
phone company, there is little risk of
fraud associated with this phone
type.

311 Voicema
il

Medium-Hi
gh

Block Voicemail phone numbers will ring
directly to a user’s voicemail.
Although this phone number was
likely purchased through a phone
company and may be traceable, it
will be impossible to reach the user
live at this phone number. In
addition, any user providing a
Voicemail number should also have a
valid landline or mobile phone
available. Therefore, we recommend
blocking this type of phone.

320 Other Medium-Hi
gh

Block Phone numbers labeled “Other” are
all various types of phones that
originate in non-US countries. The
following types of phones may be
included under the “Other” category:

• Global title address

• Inbound routing code

• Videtext

• VPN

Because clients should not be
requesting calls to these phone
types, we recommend blocking
verification calls to these numbers.
Any phone number entered that falls
under the “Other” category was
probably either entered incorrectly
or was entered by a fraudster testing
various phone numbers.

 Phone Type Codes
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Adding a new service to CAS

As a service provider, if any application needs to be authenticated using CAS, you can add a
new service to CAS.

After enabling CAS Authentication, follow the steps given below to add new service to CAS.

1. Log in as root to the host running CloudPortal Business Manager.

2. Edit the /usr/share/vts3/repository/prop/deployerConfigContext.xml file as follows:

a. Search for the bean "serviceRegistryDao" in the xml file.

b. Add a new bean to the property "registeredServices" of the above bean.

c. The template is as follows:

<bean class="org.jasig.cas.services.RegisteredServiceImpl">
     <property name="id" value="<Unique id>" />
     <property name="name" value="<Name of the application>" />
     <property name="description" value="<description of the application>" />
     <property name="serviceId" value="<Callback URL used by CAS to redirect back to the new application>" />
 </bean>

3. Restart the cloud-portal service.

Note: Property Id should be unique in the list of registered services only. And you
need separate service for both http and https protocols.
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Customizing the Service Provider Logo
and Favicon

As a service provider, you can have your custom logo displayed in CloudPortal Business
Manager. For the custom logo to appear, follow these steps:

1. Log in to CloudPortal as the Root User.

2. Click the drop-down menu icon in the top right corner next to ROOT USER.

3. Click Administration > Configuration > Portal.

4. Click Settings > Configure.

5. Set the parameter images.uploadPath to specify the absolute path to the images
directory for storing custom image logos, favicon, and so on. Set the value to a valid
existing path in your server file system.

The path to upload logo on the server should have valid write permissions.

6. Go to Customize Logo (in the drop-down menu on the top right corner).

7. Browse to Company Logo.

8. Browse to Favicon.

9. Click Submit.

Custom Logo in Email Templates
For the custom logo to appear in Emails, follow these steps:

1. Log in to CloudPortal as the Root User.

2. Click the drop-down menu icon in the top right corner next to ROOT USER.

3. Click Administration > Configuration > Portal.

4. Click Settings > Configure.

5. Set the parameter image.path to specify the path to the images that are used in
automatically generated emails. Specify the absolute path of the image.

6. Restart the CloudPortal service. To restart the CloudPortal service, enter service
restart cloud-portal on the VM console.
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Complying with Cookie Law

CloudPortal Business Manager provides a configuration to enable "Cookie Law Warning". The
name of configuration is "cookies.warning.enabled". It takes values as "true" or "false" and
the default value is "false".

This configuration enables the customer to comply with the "Cookie Law". When this
configuration is enabled, a warning popup box is displayed on successful login of every user
when the user has not already accepted the warning. If user chooses to

• Reject the warning: User is logged out of CloudPortal Business Manager

• Accept the warning: Popup box is closed and user is able to access CloudPortal Business
Manager user interface

When the configuration is enabled, this warning is displayed even for existing users except
"root" user. This warning is not displayed on anonymous pages, such as login, signup, and
anonymous browse catalog.

Note: The warning is displayed only available after user is successfully authenticated.

Enabling Cookie Law Warning

To enable the cookie law warning, perform the following steps.

1. Log in to CloudPortal Business Manager UI as Root user

2. Click the drop-down menu icon in the top right corner next to ROOT USER

3. Click Administration > Configuration > Portal

4. Click Settings > Configure

5. Click Edit

6. Set the following parameter:

Parameter Name Description

cookies.warning.enabled Set this to "true" to enable cookie
warning. The default value is "false".

7. Refer to Configuring Portal Settings

8. Click Save

9. Click Close

To customize the content of the warning pop up refer to Customizing Cookie Law Warning.
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Creating Service Provider Users

Service provider users are users that are part of the organization operating the cloud. These
are members of your organization who will manage various aspects of supporting the users
of the cloud.

Note: All these users will have access to sensitive information across all accounts in your
system and therefore should only be provided access if they have the appropriate
privileges in your organization. These users cannot use the resources of your cloud
services, but only operate and help your consumers with their use of the cloud.

As a Root User of your setup, you can add Service Provider users to your own account.

1. Log in to CloudPortal Business Manager UI as Root user.

2. Go to Administration > Service Provider Users. List of all the users in your account will
be displayed in the left pane.

3. Click Add New.

4. Enter the user name and email id of the user you want to create.

5. In the Profile field, select the profile name that corresponds to the new user's role in
the organization. Each profile has a set of permissions associated with it.

Note: The selection of a profile is very important, because it determines what the
user will and will not be able to do on the portal.

6. Select the Time Zone and Preferred Language fields.

7. Click Customize Welcome Email to change the text of the notification mail that will be
sent to the new user.

8. Click Finish. The user will receive a Welcome Email that contains a link to verify his
email and to set the password. The service provider user must log in through this link
for the first time to confirm the validity of the email address.

Note:

• There is no expiry period for the verification link sent in the Welcome email.

• Also, the expiry period for the verification link cannot be configured or changed.
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Managing service provider user
information

As root user, you can edit all service provider user information such as profile image, first
name, last name, contact phone number, time zone, and language preferences.

You can specify the email addresses to which notifications must be sent. You can request
the user for a password reset.

1. Log in to CloudPortal Business Manager UI as Root user.

2. Click the drop-down menu icon in the top right corner next to ROOT USER and click
Administration.

3. In the Service Provider Users tab, select the user whose information you want to
manage.

4. Place your cursor over the manage icon (that looks like a gear wheel) and click Edit.

5. Make the desired changes. You can modify any of the user properties such as time zone,
language, user details, and user password.

6. To add an image, click Manage your profile image at Gravatar and follow the
instructions to upload a photo to gravatar.com.

7. To change the time zone and preferred language, follow these steps:

a. Click Edit in the Preferences pane.

b. Select the new time zone and preferred language and click Save.
8. To change the user details, follow these steps:

a. Click Edit in the Details pane.

b. Make the required changes and click Save.
9. To request the user for a password reset, follow these steps:

a. Click Reset Password in the Login Information pane.

b. Click Confirm to send a mail to the user to reset the password.
10. To configure the notification settings, click Notifications and if required, specify

additional email address to use for notifications.
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Deactivating a service provider user

As a root user, you can deactivate a service provider user. Such a user cannot log in to
CloudPortal Business Manager and manage the cloud services.

1. Log in to CloudPortal Business Manager UI as Root user.

2. Click the drop-down menu icon in the top right corner next to ROOT USER and click
Administration.

3. In the Service Provider Users tab, select the user you want to deactivate.

4. Place your cursor over the manage icon (that looks like a gear wheel) and click
Deactivate.

5. Click Confirm.



97

Deleting a service provider user

As a root user, you can deactivate a service provider user.

1. Log in to CloudPortal Business Manager UI as Root user.

2. Click the drop-down menu icon in the top right corner next to ROOT USER and click
Administration.

3. In the Service Provider Users tab, select the user you want to delete.

4. Place your cursor over the manage icon (that looks like a gear wheel) and click
Remove.

5. Click Confirm.
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Managing Content Templates

CloudPortal™ Business Manager sends a variety of automatically generated emails to
internal personnel and customers.

You can modify the content of the emails by editing the email templates in the portal.
These templates support variable data substitution, and can be used to send out
personalized emails. To modify the content of these emails:

1. Log in to CloudPortal Business Manager as the Root User or Ops Admin.

2. Click the drop-down menu icon in the top right corner next to ROOT USER.

3. Click Administration > Content Templates > Emails.

4. Select the template you want to edit.

5. Place the cursor over the gear wheel icon and click Edit.

6. Modify the content in the editor.

7. Click OK.

You can click Preview to view the edited template.

You can also modify the font styles, header, footer, and signature in your emails. Select the
respective tabs, and modify them as explained above.

To verify the changes, click the Send test mail icon at the top right corner of the screen.
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Email Templates and Notification Triggers

CloudPortal Business Manager sends out email alerts and notifications to users in certain
instances. Given below is a list of email alerts sent, when they are triggered, and who they
are sent to.

Template name When is the email sent Who is it sent to

Welcome Email On sign up Customer Master User

Verify Email When users sign up or new users
are added

Any user

Verify Alert Email For verification of email for
Alerts

Any user

Reset Password On request for resetting
password

Any user

Trial service expiry
warning

When Trial accounts are nearing
expiry

Master user

Trial service expired When Trial account expires Master user

Trial service expired
notification

For expired trial accounts Sales alias

Credit Limit Crossed
Service Suspended
Notification

For service suspension caused by
credit limit breach

Sales alias

Spend Budget Warning When the spend budget
threshold is reached

Any user

Credit Limit Credit
Notify

For credit limit alert Billing update alias

Credit Limit Breach
Alert

On breaching the credit limit
and if the Breach Action is in
Alert / Alert internal

Sales alias

Credit Limit Crossed
Service Suspended

When the final credit limit is
breached and the service is
suspended.

Master user

Payment Received On receipt of payment Master user

Payment Failed On payment failure Master user

Payment Failed Notify On breach of payment failure
alert threshold

Billing update alias

Payment info change
requested

On payment information change
request

Sales support and Finance
alias

Deposit Received On receipt of deposit Master user

Support Ticket Notify On creation of ticket Help desk alias



Corporate Account
Request

On new corporate account
request

Sales support and Finance
alias

Credit Exposure Marker
Level

When credit exposure marker is
crossed

Sales alias

Send Promotional Token Invoked by customization done
by service provider

Applicant of Trial account

Account Restrict On account restriction Master user

Account Activate On account activation Master user

Account Suspend On account suspension Master user

Account Terminate On account termination Master user

Account_reactivate On account reactivation Master user

Account Converted On account conversion Finance alias and Master
user

Account Converted
Admin

After account conversion Finance alias

Pending Change
Rejected

When pending changes are
rejected

Master user

VM Creation On VM creation Any user

Report On send report request Customer user

Job Failed On failure of any scheduled job admin_support alias

Destroy VM Failed When destroy virtual machine
command fails

vmops_error_notification_
to alias

Orphaned VM Created When orphaned virtual machines
are created

vmops_error_notification_
to alias

Credit card Fraud Check
Event

When MaxMind credit card fraud
check is enabled and credit card
transaction fails

admin_support_email alias

Account Activation
Request

When manual activation is
required

approval_alias

Device Fraud Detection
Event

When ThreatMetrix fraud check
is enabled and transaction is
deemed unsafe

admin_support_email

Credit Limit Warning When the credit limit threshold
is reached

Customer user

Invoice Email When invoice is generated Customer user

User Deactivate Email When Master user deactivates a
user in his account

Customer user

User Activate Email When Master user activates a
user in his account

Customer user

Internal Approval Sent by workflow activity, when
a task is created from the
workflow that requires an action
to be taken

Recipient email address is
configurable

Email Templates and Notification Triggers
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Tenant Admin Approval When admin approves the user
account creation request

Customer user

New Resource Type When new resource type is
detected in system

Owner of the resource and
Master user

Incompatible Resource
Type

When the resource type is not
compatible with existing
subscription

Owner of the resource and
Master user

Missing Product When there is a missing product
for usage data in system

admin_support

Provision Resource
Failed

When resource provisioning fails user

Subscription Activated
Admin

On activation of subscription product bundle
owner/sales support list

Subscription terminated
Admin

On termination of subscription product bundle
owner/sales support list

Subscription Activated On activation of subscription Customer user

Subscription terminated On termination of subscription Customer user

Job Warning When any scheduled job status
is "warning"

admin_support alias

VM Password Reset On resetting the password for
the Virtual Machine

User and Master user

Cloud Service Enabled On enabling of the service
requested by account owner

Master user

Email Templates and Notification Triggers
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Sending test mails

CloudPortal Business Manager sends a variety of automatically generated Emails to internal
personnel and customers. You can send test mails to check the recipient addresses and the
content. You can also modify the font styles, header, footer, and signature in your emails.
To verify the changes, you can use the send test mail functionality.

1. Log in to CloudPortal Business Manager as the Root user.

2. Click the drop-down menu icon in the top right corner next to ROOT USER.

3. Click Administration > Content Templates > Emails.

4. Select the email template. If required, modify the template as needed.

5. Place the cursor over the gear wheel icon and click Send test mail.

6. Click OK.
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Modifying the Header, Footer, and
Signature in content templates

As a service provider, you can modify and format the header, footer, and signature that
appear in the content templates.

1. Log in to CloudPortal Business Manager UI as Root user.

2. Click the drop-down menu icon in the top right corner next to ROOT USER.

3. Click Administration > Content Templates > Includes.

4. Select the language from the dropdown list.

5. To modify the header, click Email Header.

6. Place your cursor over the manage icon (that looks like a gear wheel) and click Edit.

7. Make the changes as required and click OK. You can click Preview to view the modified
header. You can modify the footer and signature by selecting the respective option and
following Steps 4 - 6.
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Modifying Invoice Templates

You can modify the invoice templates to suit your needs.

1. Log in to CloudPortal Business Manager UI as Root user.

2. Click the drop-down menu icon in the top right corner next to ROOT USER.

3. Click Administration > Content Templates > Invoices.

4. Select the language from the dropdown list.

5. Select the invoice template you want to edit.

6. Place your cursor over the manage icon (that looks like a gear wheel) and click Edit.

7. Make the changes as required and click OK. You can click Preview to view the edited
template.
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Objects and Properties in Invoice PDF
template

The following table provides a list of available objects and properties that can be
referenced in the Invoice PDF template. The properties can be directly used. For example,
${dateFormat} for the property dateFormat. The objects in the template are used to get
the property values within them for the template. For example, ($ tenant.name): to get
the name of the tenant, use the object tenant.

Template name Object Properties

INVOICE_PDF_TEMPLATE AccountStatment : :
accountStatment

dateFormat

Parent Object    

AccountStatment Tenant :: tenant

SalesLedgerCreditRecords ::
salesLedgerCreditRecords

Invoice :: subscriptionInvoices

Invoice :: renewalInvoices

billingPeriodStartDate
billingPeriodEndDate

balanceForwardAmount

credits

newCharges
(subscriptionCharges +
utilityCharges + taxes -
discounts)

finalCharges

subscriptionCharges

utilityCharges

discounts

taxes
The following table provides details of the properties/child objects:

Object Child Objects Properties

SalesLedgerCreditRe
cords

  transactionAmount

createdAt



Invoice   serviceStartDate

serviceEndDate

rawAmount

discountAmount

subTotal

taxAmount

amount

Tenant Channel :: sourceChannel

AccountType :: accountType

User :: owner

Address :: address

Address :: secondaryAddres

CurrencyValue :: currency

TrialAccount :: trialAccount

DepositRecord :: deposit

name

spendLimit

prepaidBalance

initialDeposit

spendBudget

syncBillingAddres

state

memo

paymentAlertsCounter

accountSuspensionCounter

usageQuery

remoteAddress

isManualActivation

Address   street1

street2

city

state

postalCode

country

Objects and Properties in Invoice PDF template
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AccountType   name

displayName

description

paymentModes

trial

paymentInfoRequired

autoPayRequired

instantpayRequired

notionalBilling

manualActivation

manualRegistrationAllowed

defaultSelfRegistered

defaultRegistered

maxUsers

accountRestrictionGracePeriod

preAuthRequired

depositRequired

CurrencyValue   currencyCode

currencyName

rank

longCurrencyName

sign

altSign

active

conversionFactor

Objects and Properties in Invoice PDF template
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Modifying Content Template Styles

The content templates have styles defined to help you maintain uniformity in the emails.
You can modify the styes to suit your needs. You can also modify the custom information
such as support email, support phone, and so on. These changes get reflected across all
templates.

1. Log in to CloudPortal Business Manager UI as Root user.

2. Click the drop-down menu icon in the top right corner next to ROOT USER.

3. Click Administration > Content Templates > Styles.

4. Select the language from the dropdown list.

5. To modify the style defined, click Styles.

a. Click Edit and make the changes as required.

b. Click OK to save your changes.
6. To modify the custom information, click Custom.

a. Click Edit and make the changes as required.

b. Click OK to save your changes.
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Modifying the Approval Templates

The approval templates provide the content for the different approval mails that are sent.
The service provider can specify the content that is added to such approval mails, by
modifying the template content.

The approval templates include the following:

• Tenant State Change Finance Admin Approval

• Account Conversion Finance Admin Approval

• Payment Info Change Finance Approval

• Subscription Activation Tenant Admin Approval

• Service Activation Approval

1. Log in to CloudPortal Business Manager UI as Root user.

2. Click the drop-down menu icon in the top right corner next to ROOT USER.

3. Click Administration > Content Templates > Approvals.

4. Select the language from the dropdown list.

5. Select the invoice template you want to edit.

6. Place your cursor over the manage icon (that looks like a gear wheel) and click Edit.

7. Make the changes as required and click OK.
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Profile Management

A profile is a set of permissions that is saved under a name, such as Administrator or
Manager. Every user of your portal is assigned a profile, including yourself. The profile is
assigned when the user is added to the portal.

Profiles are useful for saving a frequently-used set of permissions so that they can be easily
granted to a user in a single step. This is easier and less error-prone than setting each
individual permission for every user.

Profiles also ensure that multiple users with equivalent duties and needs are all granted the
same permissions. For example, you might want to grant the "Create Customer Account"
permission for the Sales profile but not for the Help Desk profile. This section describes
about roles and how you can create and manage profiles.

What are roles

Understanding CloudPortal Business Manager Profiles

Manage Profiles

http://support.citrix.com/proddocs/topic/cpbm-23-map/cpbm-roles-22-con.html#ccpb-roles-20
http://support.citrix.com/proddocs/topic/cpbm-23-map/cpbm-profiles-con.html#concept_056442DE3DE14C279FF2AF6D0DACADC1
http://support.citrix.com/proddocs/topic/cpbm-23-map/cpbm-manageprofiles-con.html#ccpb-manageyourprofile
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What are roles

Roles are customary functions that are created to accomplish certain tasks. The following
list is the default set of roles available in CloudPortal Business Manager.

Service Provider roles

• Account create: This role has the ability to create, read, update, and delete any
customer account.

• Account manage: This role has the ability to view and update information on any
customer account.

• User: This role is the default role for any registered user.

• User create manage: This role has the ability to create, read, update, and delete a
user belonging to any customer account. This role depends on "account create" or
"account manage" role and on "config manage" to create/manage service provider users.

• Finance create manage: This role has the ability to create, read, update, and delete
financial information of any customer account (Account). For example, make payment,
issue credit. Depends on "account create" or "account manage" role.

• Ops Comm: This role has the ability to create, read, update, and delete status updates
that are published through the Cloud Health page.

• Profile create manage: This role has the ability to create, read, update, and delete
profiles on the CloudPortal.

• Config manage: This role has the ability to view and update global configuration
properties. Depends on "user create manage".

• Product create manage: This role has the ability to create, read, update, and delete
any product.

• Tickets Manage: This role has the ability to create, read, update, comment on, and
close support tickets across all customer (tenant) Accounts.

• Reports Admin view/download/email: This role has the ability to view/generate
reports.

Customer Roles

• Account User create manage: This role has the ability to create, read, update, and
delete a user in customer account.

• User: This role is the default role for any registered user.

• Billing Admin manage: This role has the ability to manage tenant billing.



• Account manage: This role has the ability to view and update information on his/her
own customer account.

• User Tickets Manage: This role has the ability to create support tickets within his/her
own user account (User) and be able to read, update and comment on his/her own
support tickets.

• Account Tickets View: This role has the ability to create, read and comment on
support tickets raised by all users within his/her own customer account.

• Account Tickets Manage: This role has the ability to create, read, comment on, and
close support tickets raised by all users within his/her own customer account.

A profile is defined using a combination of one or more of these roles. A root user is
enabled with all these roles by default. You can also customize the profiles by defining
their roles.

What are roles
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Understanding CloudPortal Business
Manager Profiles

CloudPortal™ Business Manager ships with a predefined set of profiles. You cannot add or
delete a profile. If you have the "Create/Manage Profile" permission, you can select which
permissions to grant under each profile name. Given below are the profiles in CloudPortal
Business Manager.

Service Provider Profiles

• Root

• Ops Admin

• Finance Admin

• Sales Support

• Help Desk

• Product Manager

Customer Profiles

• Master User

• Billing Admin

• User

• Power User
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Managing Profiles

As Service Provider root user, you can manage your profile and also other users' profiles.

1. Log in to CloudPortal Business Manager UI as Root user.

2. Go to Administration > Profiles and select Service Provider or Customer tab, based on
the profile that needs to be updated.

You can see the default list of profiles in the left pane. The description of the available
roles for each profile are visible in the right pane.

3. Select the checkboxes under Allow for the roles that you would like to set for the
profile.

4. Click Save.

Note: Before changing profile permissions, make sure you have discussed it with the
relevant decision makers within your organization.
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Cloud Service

A cloud service is a resource that is provided over the Internet. The most common cloud
service resources are Infrastructure as a Service, Platform as a Service, and Software as a
Service.

A cloud service can dynamically scale to meet the needs of its users, because the service
provider supplies the necessary resources for the service, there is no need for a company to
deploy its own resources to manage the service.

CloudPortal™ Business Manager uses bootstrapping process to provision machines for
managing the services required to deploy applications.
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Onboarding and Managing a service

Onboarding a service refers to the process of:

• Deploying a cloud service connector into CloudPortal Business Manager.

• Enabling a cloud service connector and adding a cloud service instance.

Cloud Service Connector
A connector is a Java based OSGi bundle which:

• Implements the semantics prescribed by the Cloud Service Connector SDK.

• Defines the following metadata:

• Endpoint and credential parameters

• Account Configuration

• Account Controls

• Resource Metadata: Various resources that can be provisioned and metered

• Custom UI Views for Account configuration, Subscription provisioning
The following connectors are supported:

• Citrix CloudPlatform

• CloudPortal Services Manager

• Reference connector:

• Apache CloudStack

• OpenStack
The connector implements set of hooks and CloudPortal Business Manager invokes these
hooks at appropriate stages. The stages include:

1. Account Creation

2. User Creation

3. Resource provisioning

4. Product definition

5. Usage collection

6. Event collection



Deploying a cloud service connector into CloudPortal
Business Manager

The cloud service connector will be deployed into VIRGO's directory. If there are no errors
in the connector, then, CloudPortal Business Manager extracts the information from the
connector and copies the serviceDefinition.xml, logo, terms and condition files, and UI
implementation files to /usr/share/cloud/portal/data directory.

Now you can enable the cloud service connector from the UI.

Enabling cloud service connector and adding an
instance

To enable the cloud service connector:

1. Log in to CloudPortal Business Manager UI as Root user.

2. Go to Home > All Services.

3. Click Enable.

4. Accept the Terms & Conditions defined by the Cloud Service.

5. After enabling the cloud service, roles defined by the cloud service are mapped to
appropriate CloudPortal Business Manager profiles.

Note: The service onboarding for customer and customer's users depends on these
role mapping. Ensure that roles are appropriately mapped to profiles.

6. Click Submit and then click Close.

Adding an instance to the service

1. Go to Home > All Services > Cloud Services.

2. Select the Service and click Add.

The Add Service Instance wizard opens.

3. Specify the identifying information for the instance such as name, code, and description
and click Next.

4. In the Configuration page, specify the details that are specific to the connector for the
service.

5. Click Next.

The Default Product Selections page is displayed. This is a list of products based on
defined UsageTypes.

6. Select the products that you want to create at the time of creation of the service
instance.

Onboarding and Managing a service
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You can also edit the name and code for each of the default products.

7. Click Next and specify the utility charges for the products that you have selected.

8. Review and confirm the details.

9. Click Add and then, click Close.

Editing an instance

1. Go to Home > All Services > Cloud Services.

2. Select the cloud service and click the cloud icon to view all instances of the selected
service.

3. Click the gear wheel icon next to the instance and select Edit Configuration.

4. Make changes as required and click Save.

Onboarding and Managing a service
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Workflow Management

In CloudPortal™ Business Manager, user can perform certain actions to achieve a desired
business purpose. These actions can be considered as business transactions that help in
achieving this business purpose. A workflow is a multi-stage process that consists of
multiple phases. Every phase consists of a set of activities, (smallest unit of work in a
workflow) that should be completed successfully in order to complete the phase. All phases
should be completed to complete a business transaction.

A business transaction contains certain details. CloudPortal Business Manager checks these
details and decides which workflow is suitable to complete the business transaction. A
workflow is considered successful only if it satisfies the rule that all the activities in the
configured buckets are successful. When the workflow is complete, the business transaction
would also be completed successfully.

All the phases are executed in a sequential order. A phase consists of activities that are
customer driven, service provider driven, and system driven.

The activities in a given phase occurs in parallel. System-driven activities occur
automatically. However, others require manual input for the workflow to complete.
Activities have built-in capabilities to retry. You can configure the number of times an
activity can retry. The activity is run for a specified number of times and gets completed
only if the conditions are satisfied.

A task is created by an activity when it requires some human intervention. Each task has a
role associated to it and any user with that role can act on the task if it still pending.
Following are the instances in which a task is created:

• InternalApprovalActivity- Creates a task for the users with role mentioned in the
property to approve or reject the business transaction.

• CollectPaymentInfoActivity - Creates a task for user having the
ROLE_ACCOUNT_BILLING_ADMIN role requesting for credit card information.

• TenantOwnerApprovalActivity - Creates a task for users having the
ROLE_ACCOUNT_ADMIn role to approve or reject the business transaction.

In the out-of-the-box configuration, there are pre-defined workflows. In general, activities
can be customized. It is also possible to create custom activity types.

Consider an example of changing the state of an account from new to active. If this state
conversion has a mandatory approval activity to be performed by a administrator,
CloudPortal Business Manager generates a task for the person responsible to approve and
sends a mail requesting them to approve. The related activity ensures that the task is
completed by indicating that there are pending tasks for the administrator. Once the
administrator checks the pending tasks and approves or rejects based on the business
transaction details, the workflow proceeds to the next phase or gets completed if it reaches
the last phase.



As shown in the figure below, let us consider a business transaction is raised to change the
tenant state from New to Active. CloudPortal Business Manager will check for the suitable
workflow which is mapped in transactionWorkflowmap.xml. This file defines the
requirement to match the workflow with the business transaction and the suitable workflow
is triggered. You can find the details of the workflow defined in workflows.xml file. In the
workflow, there will be various activities running in parallel in various phases (represented
as 1, 2, 3 and 4 in the figure). Figure 1. Example of a workflow for Tenant State change
from NEW to ACTIVE
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How workflows work

In CloudPortal™ Business Manager, the following types of business transactions initiate a
workflow:

• Tenant activation: This transaction is triggered when a new tenant is created.

• Account type conversion: This transaction is triggered when a tenant requests
conversion of his account type.

• Subscription activation: This transaction is triggered when a new subscription is created
by a tenant.

• Payment information change transaction : This transaction is triggered when an account
changes its payment information .

• CloudService activation transaction: This transaction is triggered when a request for
enabling any cloud service is made.

These transactions are triggered from CloudPortal™ Business Manager and may or may not
initiate a workflow.

The rules or conditions to initiate a workflow depending on transaction details are defined
in transactionWorkflowMap.xml. This file is available at /usr/share/vts3/repository/prop
directory.

<TransactionWorkflowMap>
  <Match type="paymentInfoChange" workflow="manual-activation-type-payment-info-change">
    <Rule>{#transaction.tenant.accountType.manualActivation == true}</Rule>
  </Match>
</TransactionWorkflowMap>

Important properties in this file -

• Type: This is an attribute to element "Match" and defines the type of business
transaction on which the rule needs to be applied. Possible values are:

• tenantStateChange Transaction

• tenantAccountTypeConversion Transaction

• subscriptionActivation Transaction

• paymentInfoChange Transaction

• cloudServiceActivation
• Workflow: This is an attribute to element "Match" and it is the name of the workflow

that will be initiated when the defined rule is matched for the transaction. All the
workflows are defined in workflows.xml. This file is available at
/usr/share/vts3/repository/prop directory.



• Rule: This is a sub-element under "Match" and defines the rule to be applied on the
transaction.

If multiple rules are matched then first "Match" will be successful and workflow associated
with this "Match" will be returned. If there is no matched workflow, then the transaction
will be completed.

Workflow name returned from transactionWorkflowMap.xml is used to read the workflow
definition from workflows.xml. This file has the complete definition for all the workflows,
which include how many phases are there in a workflow, what all activities are there in
each phase.

For example:

<Workflows>
  <Workflow name="account-activation-retail">
    <Bucket name="Phase-1" order="1">
      <Activity name="account-activation-retail.verifyMasterUserEmailActivity" ref="verifyMasterUserEmailActivity" />
    </Bucket>
    <Bucket name="Phase-2" order="2">
      <Activity name="account-activation-retail.collectCreditCardInfoActivity" ref="collectCreditCardInfoActivity" />
      <Activity name="account-activation-retail.createOSSAccountActivity" ref="createOSSAccountActivity" />
    </Bucket>    
  </Workflow>
</Workflows>

Important properties in this file -

• Workflow: This is an element which contains complete definition of a workflow.

• Name : This is a reference to the workflow name referenced in
transactionWorkflowMap.xml.

• Phase : This is sub-element to "Workflow" element and contains a set of activities that
need to be initiated in parallel.

• Activity : This is sub-element to "Phase" element and has an attribute "ref" which refers
to the bean, that need to be invoked for this activity. the bean reference of the activity
is defined in applicationContextworkflow-customizations.xml.

Workflow definition fetched from “workflows.xml” are used to instantiate the workflow
into the database. When a workflow is initiated then it is in NEW state. Different states of a
workflow are given below and are defined based on the status of activities in the workflow:

• New - Indicates that the workflow is yet to be initiated.

• Running - Indicates that there are pending activities in this workflow.

• Completed - Indicates that all the activities are successfully completed and the
workflow was successful.

• Failure - Indicates that the workflow is partially complete with an error message, as
one or more activities in the workflow could not be completed due to business logic
failure. A business logic failure could be rejection of associated task or has reached the
threshold of number of retries etc.
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• Error - Indicates that the workflow is partially complete with an error message, as one
or more activities in the workflow could not be completed due to some issue.

Note: If a workflow fails, you can restart the workflow. In that case, the workflow will
reset the erroneous or failed activity.

Different states of an activity are given below:

• New - Activity is yet to begin.

• In-Progress - Activity is running.

• Waiting - User input is required.

• Success - Activity has been successfully completed.

• Failure - Activity was declined or rejected.

• Error - There has been some unexpected behavior or exception that needs to be fixed.

Workflows available in the CloudPortal Business Manager out of the box are as follows:

• Trial account activation

• Phase one - Identity verification

• Verify master user email activity
• Phase two – Accounts creation

• OSS Accounts creation activity
• Credit card account activation (For retail accounts)

• Phase one - Identity verification

• Verify Master User Email Activity
• Phase two - Billing verification and account creation

• Collect credit card information activity

• OSS Accounts creation activity
• Manual account creation

• Phase one - Identity verification

• Verify Master User Email Activity
• Phase two - Approval and account creation

• Finance admin approval activity

• OSS Accounts creation activity
• Account conversion to manual activation

• Phase one

• Finance admin approval activity
• Account conversion to credit card payment
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• Phase one

• Verify credit card information activity
• Subscription activation with pre-authorization

• Phase one

• Pre authorize the subscription
• Payment information change for manual activation account

• Phase one

• Finance admin approval activity
After the instantiation of a workflow, it is picked by workflow engine.

How workflows work
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Workflow while enabling a service

By default, no workflow is present for enabling a service by an account admin/master user.
If manual steps are required to enable a service or if there is a need to control the sign-up
process, the service provider can enable a workflow that is triggered when the master user
enables a service. This can be achieved by uncommenting the rule in
transactionWorkflowMap.xml and workflow definition in workflow.xml. For more
information, refer to How workflows work.

The rules or conditions to initiate a workflow, depending on transaction details, are defined
in transactionWorkflowMap.xml. For example:

<TransactionWorkflowMap>
  <Match type="cloudServiceActivation" workflow="cloud-service-activation-approval">
    <Rule>{#transaction.type.name == 'cloudServiceActivation'}</Rule>
  </Match>
</TransactionWorkflowMap>

Workflow name returned from transactionWorkflowMap.xml is used to read the workflow
definition from file workflows.xml:

<Workflow name="cloud-service-activation-approval">
    <Bucket order="1">
      <Activity name="serviceActivationApprovalActivity" ref="serviceActivationApprovalActivity" />
    </Bucket>
  </Workflow> 

Uncommenting the above XML snippets will enable a workflow having one approval activity
(assigned to operational users with the role " ROLE_ACCOUNT_MGMT ") and it is enabled for
all service instances.

Note: The above two snippets are available out of the box and the service provider
should change it according to the requirement. For more information, refer to
Customizing Workflows.

http://support.citrix.com/proddocs/topic/cpbm-23-map/cpbm-workflow-work-con.html#ccpb-workflow-work
http://support.citrix.com/proddocs/topic/cpbm-23-map/cpbm-customizingwf21-tsk.html#ccpb-manage-tasks
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Viewing workflow status

Tenant scope workflow

For a Service Provider

A service provider user can view tenant scope workflows for any tenant by following the
below steps:

1. Log in to CloudPortal Business Manager UI as Root user.

2. Click Accounts.

3. Click All Accounts.

4. Select an account on the left side pane. You will see the details of the account on the
right side pane.

5. Click History tab on the right side pane. You can view the workflows for this account.

6. Click View under Workflow. You can see the status of the selected workflow in the
Workflow Status window.

For a tenant user
The master user can view all tenant scope workflows by navigating to Company Setup >>
History.

Note: An active tenant scope workflow is visible as a red bar under the primary menu.

Subscription activation workflow
For a service provider user

1. Log in to CloudPortal Business Manager UI as Root user.

2. Click Accounts.

3. Click All Accounts.

4. Select an account on the left side pane. You will see the details of the account on the
right side pane.

5. Click the gear wheel icon on the right side pane.

6. Select View Billing History from the list. Usage and Billing dashboard is displayed.

7. Click Subscription. You can see Workflow option next to Status field.



Note: This option is visible only if a workflow exists for a subscription.

For a tenant user

Any tenant user can view subscription activation workflow by following below steps:

1. Log in to CloudPortal Business Manager UI as Master user.

2. Click Home.

3. Select Usage & Billing>> Subscriptions.

4. Select any subscription. If there is any workflow created for the subscription, then you
will see a View Workflow link in the Status field.

Viewing workflow status
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Available activities and their properties

All the activities that can be used in a workflow are defined in the
applicationContext-workflow-customizations.xml file.

Available activities and their properties are listed in the table below:

Activities Properties

VerifyMasterUserEmailActivity:
To check whether master user's
email has been verified.

• failureThresholdInHours: Number of hours for which an activity
will wait for a user to verify his email before activity errors out.

CollectCreditCardInfoActivity:
Creates a pending task for the
tenant to enter credit card
information.

• failureThresholdInHours: Number of hours for which the task
will remain pending before activity errors out.

collectPaymentInfoActivity:
Creates a pending task for the
tenant to enter payment
information.

• failureThresholdInHours: Number of hours for which the task
will remain pending before activity errors out.

CreateOSSAccountsActivity:
Creates account on the OSS
services enabled in the system.

• noOfRetries: Maximum number of attempts to complete the
activity.

• timeBetweenRetriesInHours: Number of hours a system will wait
before retrying to complete the activity.

InternalApprovalActivity: Creates
a pending task to approve or
reject the business transaction
for one of service provider user
based on the role mentioned.

• taskType: Type of approval to distinguish from other internal
approval activities.

• ui.task.type.<value of the task type>.name : Name of the
i18n property which defines the name to the task.

• ui.widget.task.type.<value of the task type>.name: This
takes tenant name as an argument and name of the task
appears along with the tenant name.

• actorRole: The pending task will be created for service provider
users having this role.

• toEmails: The email address to which a transaction notification
email will be sent. This can be CSV of EmailAlias or email id;
combination is allowed

• noOfRetries: Maximum number of email notifications that will
be sent.

• timeBetweenRetriesInHours: Interval in the time when the two
notification emails were sent.

verifyDepositActivity: Checks
whether a deposit has been
made for a tenant.

• failureThresholdInHours: Number of hours for which an activity
will wait for the service provider to make a deposit for the
tenant before the activity errors out.



SubscriptionPreAuthActivity:
Preauthorizes subscription
amount against the available
credit card through payment
gateway.

• noOfRetries: Maximum number of attempts to complete the
activity.

• timeBetweenRetriesInHours: Number of hours a system will wait
before retrying to complete the activity.

TenantOwnerApprovalActivity:
Creates a pending task for the
master user to approve or reject
a business transaction.

• taskType: Type of approval to distinguish from other internal
approval activities

• ui.task.type.<value of the task type>.name : Name of the
i18n property which defines the name to the task.

• ui.widget.task.type.<value of the task type>.name: This
takes tenant name as an argument and name of the task
appears along with the tenant name.

• noOfRetries: Maximum number of email notifications that will
be sent.

• timeBetweenRetriesInHours: Number of hours a system will wait
before retrying to complete the activity.

verifyCreditCardInfoActivity:
Verifies whether credit card
information has been added to
the account.

• failureThresholdInHours: Maximum amount of time in hours a
system will wait before the activity errors out.

Available activities and their properties
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Managing your tasks

A user can view all tasks if the user has the required role for which the task is created.

Following task types are provided by CloudPortal™ Business Manager as default for POPUPs.

• FINANCE_APPROVAL

• TENANT_ADMIN_APPROVAL

To view a task, perform the following steps:

1. In the main menu, click All Tasks.You can view all the tasks on the left side pane

2. Select a task on the left side pane. You will see the details of the task on the right side
pane.

You can filter the list of tasks to view all the tasks or to see if there are any pending or
completed tasks.

Pending actions are also displayed on dashboard under My Tasks widget and you can directly
click the task to act on it.

Service provider user can view tasks for any tenant by following below steps:

1. Log in to the CloudPortal Business Manager UI as Root user.

2. Click Accounts.

3. Click All Accounts.

4. Select an account on the left side pane. You will see the details of the account on the
right side pane.

5. Click Tasks tab on the right side pane. You can view the pending tasks.

Any user can take action on the visible tasks. Follow below steps to act on any pending
task:

1. View the task by following the steps mentioned in the above section.

2. If the task is in pending state, then you will see Click to Complete link. Click it.

The Review and Confirm window appears.

3. Enter your observation in the Memo field.

4. Click Reject or Approve to take action on the task accordingly.

Note: If you enter more than 255 characters in the Memo field while rejecting a Finance
Approval task, then you get an error.
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Account Management

Accounts or tenants are customer billable entities. An account is the entity for which usage
is aggregated and invoices are generated. Accounts are created for the channel or selling
avenue to which they belong. Every channel has its accounts or customers. Typically, there
is one account per customer. Each account has users, who are actual people who interact
with the system and consume resources. CloudPortal Business Manager tracks resource
usage at a user level, but billing is done at an account level.

An account can be created by the administrator or by a customer through self-registration.
Once the account is created, the customer identity is verified. Depending on the account
type, verification of billing information and further approvals may be required. Once these
activities are completed, the account gets activated.

As a service provider, you can manage your customer accounts. There are a host of actions
that you can perform such as manage users of an account, edit customer account details,
issue credit to customers, view billing history of accounts, change account state, and so on.

This section explains how to manage accounts:

Account Types

Account Lifecycle

Account Properties

Configuring Accounts

Managing Accounts

Monitoring Accounts

http://support.citrix.com/proddocs/topic/cpbm-23-map/cpbm-accounttypes-con.html#ccpb-accounttypes
http://support.citrix.com/proddocs/topic/cpbm-23-map/cpbm-customeraccountlifecycle-22-con.html#ccpb-accounttypes
http://support.citrix.com/proddocs/topic/cpbm-23-map/cpbm-accountproperties-ref.html#ccpb-accounttypes
http://support.citrix.com/proddocs/topic/cpbm-23-map/cpbm-configureaccounts-con.html#ccpb-accounttypes
http://support.citrix.com/proddocs/topic/cpbm-23-map/cpbm-manageaccounts-con.html#ccpb-accounttypes
http://support.citrix.com/proddocs/topic/cpbm-23-map/cpbm-monitoraccounts-con.html#ccpb-accounttypes
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Account Types

The Account Type usually reflects the payment arrangement that has been agreed upon
with the customer and the relationship that the service provider has with the customer.
The signup process varies in parts depending on the Account Type.

CloudPortal Business Manager provides a special account type called SYSTEM. The System
account type represents the Service Provider and root user and can be customized in an
installation. In addition, CloudPortal Business Manager offers the following three default
account types:

• Retail Account: This account type is periodically billed to a credit card on file.

• Corporate Account: These accounts are assigned to corporates with established credit.
This account type requires additional processing and hence additional time to activate.

• Trial Account: This is a Trial account type.

As a service provider, you need not use these default account types. You can create custom
account types that suit your business requirements, during the CloudPortal Business
Manager implementation.

CloudPortal Business Manager assigns default parameter values to accounts that you create.
You can edit the default account type parameter values for account types that you have
defined. The System account type properties are view-only and cannot be edited.
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Account Lifecycle

An account can be moved automatically or manually through various states from Active to
Terminated, not necessarily in the order shown below. After the account has reached the
final Terminated state, the customer can no longer interact with CloudPortal Business
Manager, but the account data is retained. If you want to completely remove the account,
see Removing Accounts. To handle payment failures when the autopay feature is in use, see
Handling payment failures.

State Description

New The account is just created and has not yet been activated
by the user.

Active Operational. The customer can log in, create users, enable
services and manage and start using resources.

Restricted The only customer user who can log in is the Master User.
Existing services continue to run but the customer cannot
provision any new service.

Suspended All services are shut down and cannot be restarted. The
only customer user who can log in is the Master User. The
customer cannot start any new services, but can view and
modify financial information; for example, provide a new
credit card number.

Terminated The customer relationship has ended. The account still
exists but is disabled and the customer cannot use it. All
services are shut down and removed. The account's users
are all deleted. All domains for this customer are deleted
from the cloud. However, the account is not deleted from
CloudPortal Business Manager. The account data is
retained in the CloudPortal Business Manager database.
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Account Properties

All accounts have properties and default values are defined for each of these properties
based on the account type. Each new account, of an account type, is created with these
default values. You can modify these values when you want the changes reflected in all
accounts of an account type. You can also over-ride some of these values for individual
accounts.

The various account properties are grouped into the following:

Account Details
Parameter Parameter Definitions

Description Description of the account type.

Max users Maximum number of users that are allowed
for this account type.



Onboarding Control Parameters
Parameter Parameter Definition

Self Registration Allowed Set this to True if you want to allow self-registration by
users registering from the Sign Up page. Self and
Manual registration values can be True simultaneously.

Manual Registration Allowed Set this to True if you want to allow manual
registration, that is, if you want an administrator to be
able to sign up new users. Manual and Self registration
values can be True simultaneously.

Manual Activation Set this to True if you do not want to allow the account
to be activated automatically, and want to allow only
administrators to activate the account.

Default Self Registered This is an add-on to the Self Registration Allowed
parameter. The prerequisite for setting this parameter
to True is that Self Registration Allowed must be set to
True. Set 'Default Self Registered' to True if you want
this account type to be selected by default.

Default Registered This is an add-on to the Manual Registration Allowed
parameter. The prerequisite for setting this parameter
to True is that Manual Registration Allowed must be set
to True. Set 'Default Registered' to True if you want this
account type to be selected by default.

Account Restriction Grace
Period

Numerical value in days. Set the grace period that users
must get after the payment due date to make any due
payment. The account gets restricted if no payment is
made within the account restriction grace period. If the
account has the "Auto Pay" flag enabled then the grace
period starts after reaching the payment failure
threshold. A "-1" value signifies that the grace period
has no limit. This is the only required field in this
group.

Initial Deposit Required Set this value to True if Initial Deposit is a mandatory
requirement (for this account type).

Payment Info Needed Set this to True if you want to save the payment
information on file.

Service Control Parameters
The service control parameters are specific to an instance of the cloud service that the
service provider is providing.
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Billing Control Parameters
Parameter Parameter Definition

Notional Billing Set this to True if you want the rated usage to get
accrued to the credit balance.

Auto Payment Needed Set this to True if automatic payment is required. The
prerequisite for setting this value is that Payment Info
Needed must be True. If set to True, all subscriptions
are charged immediately on subscribing and payment
is deducted from the user.

Credit Exposure Breach The action to be taken when an account breaches its
credit limit. The options are: No Action, Alert Internal,
Alert, Auto-pay, Suspend, and Restrict.

Extend Credit Set this to True if no credit balance is required for
using the account.

Credit Card PreAuthentication
Required

CloudPortal Business Manager uses your credit card on
file to obtain approval from your issuing authority
(bank or other financial institution). The amount for
which approval is sought is equal to your invoice
amount. The expected charge on your credit card is
secured (also called 'held') by your approving
authority. Your approval authority then allocates an
approval code with which CloudPortal Business
Manager realizes the transaction amount.

Note: Note that pre-authorized transactions appear
with a minus sign on your credit card detail till such
transactions are realized.

Credit Exposure Parameters
This is a list of supported and available currencies.

Account Properties
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Configuring accounts

As a service provider, you can add your customer accounts, edit account properties, and
configure the onboarding settings. You can configure access based on geographic locations
and email domains. You can also configure lockout settings and payment failure settings for
the accounts.

Editing default account properties

Configuring onboarding settings

Configuring account lockout settings

Configuring payment failure settings

Configuring account resource limits

Enabling initial deposit for an account type
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Editing default account properties

As a service provider, you can assign default parameter values to the customer accounts
that you create. Each new account, of a particular type, is created with these default
values. You can edit the account properties and specify new values for the parameters from
the Account Types tab of CloudPortal Business Manager.

The various account parameters are grouped into the following types:

• Details

• On-boarding Controls

• Service Controls

• Billing Controls

• Credit Exposure

For more information on the parameters, refer to Account Properties.

You cannot edit the properties of the Service account type.

1. Log in to the CloudPortal Business Manager UI as Root User.

2. Click the drop-down menu icon in the top right corner next to ROOT USER, and then
click Administration.

3. Click Account Types and select the account type whose property parameter values you
want to modify.

4. Click Details. This page displays the description of the account type and the default
number of users that are allowed for this account type.

5. Click Edit.

6. Specify the maximum number of users allowed for the account type and click OK.

7. Click On-boarding Controls. You can view the list of the editable parameters grouped
in this category.

8. Click Edit, make the changes as required, and then click OK.

9. Click Service Controls. You can view the list of the editable parameters grouped in this
category.

10. Click Edit, make the changes as required, and then click OK.

11. Click Billing Controls. You can view the list of the parameters grouped in this category.

12. Click Edit. You can edit only two parameter values in the Billing Controls category.



13. If required, modify the action to be taken when an account breaches its credit limit,
specify if credit card pre-authentication is required, and then click OK.

14. Click Credit Exposure. This is the numerical currency value that denotes the credit
limit for this account type. The prerequisite for setting this value is that Extend Credit
must be True. You see a list of supported and available currencies.

15. Click Edit, make the changes as required, and then click OK.

Editing default account properties
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Configuring Onboarding Settings

You can configure the onboarding settings for customer accounts by specifying whitelist and
blacklist for countries and email domains and the default channel name to be used on
account signup. You can specify the ISO 3166-1 alpha-2 codes for countries and specify
email domains to grant or deny access to customers. You can manage your onboarding
settings from the Account Management pane of the CloudPortal Business Manager UI.

1. Log in to the CloudPortal Business Manager UI as Root user.

2. Click the drop-down menu icon next to ROOT USER in the top right corner and click
Administration.

3. In the Configuration tab, click Account Management.

4. In the Onboarding area, click Configure, and then click Edit.

5. Configure the geolocation settings by specifying the whitelist and blacklist for
countries.

6. Specify the whitelist and blacklist for email domains.

7. Specify the default channel name to be used on account sign up. By default, the first
channel, that you configure, is considered as the default channel. All accounts that are
created by self-registration are created under this default channel. However, you can
specify any channel as the default channel.

8. Click Save to save your changes and then click Close to close the dialog box.

Also see Configuring access based on geographic location and Configuring access based on
email domains.
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Configuring access based on geographic
location

You can grant or deny access to customers based on their geographic location. CloudPortal
Business Manager comes integrated with a geolocation application that is used to arrive at
the geographic location of users. The country is identified from the IP address of the user.
You can provide a list of countries that are either blacklisted or whitelisted. You can
specify ISO 3166-1 alpha-2 codes for countries and either allow or deny users from these
countries to sign up. These lists are used for users of all account types. You can specify the
lists from the Account Management pane of the CloudPortal Business Manager UI.

The settings are enforced during the following events:

• When a user attempts to sign up from the Sign Up page.

• When a Root User attempts to sign up a user.

If a user tries to access the portal from a country that you have marked as blacklisted, the
geolocation application rejects the login attempt and directs the user to the CloudPortal
support page. A country whitelist always takes precedence over a country blacklist. For
example, If a country is marked in the whitelist and also in the blacklist, the country is
treated as whitelisted.

1. Log in to the CloudPortal Business Manager UI as Root user.

2. Click the drop-down menu icon next to ROOT USER in the top right corner and click
Administration.

3. Click Configuration > Account Management > Onboarding.

4. Click Configure, and then click Edit.

5. In the Value box for the parameter counrty.whitelist, enter the lSO 3166-1 alpha-2
country codes separated by commas. This is the whitelist of countries from which users
are allowed to sign in. For more information on 3166-1 alpha-2 ISO country codes, go to
http://en.wikipedia.org/wiki/ISO_3166-1_alpha-2.

6. In the Value box for the parameter country.blacklist, enter lSO 3166-1 alpha-2 country
codes separated by commas. This is the blacklist of countries from which users are not
allowed to sign in.

7. Click Save to save your changes and then click Close to close the dialog box.
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Configuring access based on email
domains

You can grant or deny access to customers based on their email domains. Users who
attempt to sign up with an Email domain that you mark as blacklisted will have their sign up
process aborted with a message 'Your email domain is not supported. Kindly contact
Support.' You can specify a whitelist and blacklist for the email domains to either allow or
deny users to sign up. These lists are used for users of all account types. You can specify
the lists from the Account Management pane of the CloudPortal Business Manager UI.

The settings are enforced during the following events:

• When a user attempts to sign up from the Sign Up page.

• When a Root User attempts to sign up a user.

• When a Root User or a regular user attempts to edit an existing email domain.

If a user tries to access the portal from an email domain that you have marked as
blacklisted, the application rejects the login attempt and directs the user to the
CloudPortal support page. An email domain whitelist always takes precedence over an
email domain blacklist. For example, If an email is marked in the whitelist and also in the
blacklist, the domain is treated as whitelisted.

1. Log in to the CloudPortal Business Manager UI as Root user.

2. Click the drop-down menu icon next to ROOT USER in the top right corner and click
Administration.

3. Click Configuration > Account Management > Onboarding.

4. Click Configure, and then click Edit.

5. In the Value box for the parameter emailDomain.blacklist, enter a comma separated
list of email domains for which you want to deny access.

6. In the Value box for the parameter emailDomain.whitelist, enter a comma separated
list of email domains for which you want to allow access.

7. Click Save to save your changes and then click Close to close the dialog box.
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Configuring account lockout settings

CloudPortal Business Manager an implement an account lockout to prevent unauthorized or
invalid access. You can configure account security settings and specify the number of failed
login attempts before a user account gets locked and the number of failed login attempts
before a CAPTCHA challenge has to be met for every additional login attempt. CAPTCHA
challenges are issued to prevent unauthorized login attempts by automated or malicious
software. This prevents brute force attacks.

You can specify values for the logins.lockThreshold and logins.captchaThreshold properties.
The logins.lockThreshold property determines the number of failed login attempts after
which a customer's account is locked. After customers cross the number of login attempts
indicated by this property, their account gets locked. They have to request for a reset of
the password and unlock their user account.

The logins.captchaThreshold property determines the number of failed login attempts that
customers are allowed before the sign in process requires a CAPTCHA challenge to be met.
After customers have crossed the number of login attempts indicated by this threshold,
they will be required to satisfy a CAPTCHA challenge for every additional login attempt. If
they fail to clear the CAPTCHA challenge, the login will not proceed.

1. Log in to CloudPortal Business Manager UI as Root user

2. Click the drop-down menu icon in the top right corner next to ROOT USER, and then
click Administration

3. Click Account Management

4. In the Security pane, click Configure, and then click Edit

5. Specify the values for logins.lockThreshold and logins.captchaThreshold

6. Click Save to save your changes and then click Close to close the dialog box.

Note: The configuration logins.captchaThreshold becomes redundant if the value of the
use.intranet.only parameter is set to true in the Server Settings
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Configuring payment failure settings

CloudPortal Business Manager uses a feature called auto-pay where the system
automatically changes the credit card of a customer when an invoice is due for payment.
You can configure your settings to handle payment failures, from the Account Management
pane of CloudPortal Business Manager UI. These settings are applicable for those accounts
where the Auto Payment Needed parameter is set to True.

1. Log in to CloudPortal Business Managet UI as Root user.

2. Click the drop-down menu icon next to ROOT USER in the top right corner and click
Administration.

3. Click Configuration > Account Management > Thresholds.

4. Click Configure, and then click Edit.

5. Specify the settings to handle payment failures.

Parameter Name Description Action taken

thresholds.maxPayme
ntAttempts

<number> The number of times CloudPortal attempts to
collect payment before taking any corrective
action.

paymentFailure.susp
ensionThreshold

<number> When payment is not received, CloudPortal
waits these many days before suspending the
account and sending an email to the
customer.

paymentFailure.term
inationThreshold

<number> When payment is not received, CloudPortal
waits these many days before terminating the
account and sending an email to the
customer. The value should not be less than
paymentFailure.suspensionThreshold.

6. Click Save to save your changes and then click Close to close the dialog box.
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Configuring account resource limits

You can configure the number of email addresses that a user can provide to receive
notifications. This is in addition to the primary email alert address that the user has already
specified. The secondary email addresses can be added by editing the user details. This
setting is applicable to all account types that are created by the service provider.

1. Log in to the CloudPortal Business Manager UI as Root user.

2. Click the drop-down menu icon next to ROOT user in the top right corner and click
Administration.

3. In the Configuration pane, click Account Management.

4. In the Resource Limits area, click Configure and then, click Edit.

5. Specify the number of address that a user can specify for receiving email notifications.

6. Click Save to save your changes and then click Close to close the dialog box.
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Enabling initial deposit for an account
type

As a service provider, you can decide what account types require an initial deposit for
account activation and enable the initial deposit setting.

1. Customize the account activation workflow to include the activity verifyDepositActivity
for account type for which we want to enable initial deposit. For more information on
customizing workflows, refer to Customizing Workflows.

2. Log in to the CloudPortal Business Manager UI as Root user.

3. Click the drop-down menu icon in the top right corner next to ROOT USER, and then
click Administration.

4. Click Account Types and select the account type for which you want to enable initial
deposit.

5. Click On-boarding Controls > Edit.

6. Select the check box for Initial Deposit Required.

7. Click OK.

http://support.citrix.com/proddocs/topic/cpbm-23-map/cpbm-customizingwf21-tsk.html#ccpb-manage-tasks
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Managing accounts

As a service provider, in addition to adding your customer accounts and configuring them,
you have to manage the accounts. You can edit your customer accounts, change account
states, issue credit to customers, and manage users of an account.
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Adding accounts

As a service provider, you can create accounts for your customers based on the market
segments they belong to. Suppose your sales team has landed a deal with a new customer
who wants to use your cloud service. After receiving the contact details of the customer
and other information from sales, you create an account. Once you create accounts, they
can utilize the resources and can be billed accordingly. You can create accounts from the
Accounts tab of the CloudPortal Business Manager administration UI.

You must have account create permission to add an account.

1. Log in to the CloudPortal Business Manager administration UI as Root user.

2. Click Accounts > Add New Account. The Add New Account wizard opens.

3. Select the channel with which this account will be associated.

4. Click the type of account that you want to create. For more information on account
types, see Account Types.

5. Click Next.

6. Specify the information as requested by the wizard.

7. Review and confirm the details and click Next to add the account.

The account activation depends on the onboarding settings configured for the account type.
Identity verification, billing details verification, and other approvals (as required) are
obtained before account gets activated.
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Creating self-registered accounts

Customers can create their own accounts from the CloudPortal Business Manager UI. If the
service provider enables self registration for a particular account type, a customer can
create a user account of that account type.

Self-registration must be enabled for the account type.

When you create an account by self registration, it is associated with the default channel
specified. You can also create an account that is associated with a specific channel. If there
is a promotional code associated with a channel, you have to add both the promotional
code and the channel code to the end of the URL of the first page of the "Create a new
account" wizard. The account is created in the channel specified by the channel code.

If the promotional code is associated with a single channel, you need to provide the channel
code (for example, &channelcode=usa) in the URL extension. You can also access CPBM with
channel specific FQDN prefix instead of providing the channelcode in URL.

If the promotional code is associated with multiple channels and one of those associated
channels is the default channel, the account is created in the default channel. If none of
the above conditions are satisfied, then account creation fails.

1. Open the service portal and click Sign up now!

2. Select the type of account that you want to sign up for.

3. Specify the account details as requested by the Create a new account wizard and click
Submit.

Depending on the settings specified by the service provider, an email is sent to the Email
address that the user has provided. The Email contains a link that the user must click to
activate the account. The user is asked to enter and confirm a password. After the user
enters and confirms a new password, the user is shown the login page. The user can then
log in to the portal with these credentials. As an administrator, if you notice that the user
has not activated the account, you can send a re-verification email to the user.



150

Editing accounts

As a service provider, you can edit customer account information such as address details. In
addition, you can specify the discount and credit limit for the account, and the number of
users that are allowed for the account. You can edit account information from the Accounts
tab of the CloudPortal Business Manager UI.

You must have root or administrative privileges to edit accounts.

1. Log in to the CloudPortal Business Manager UI as Root User.

2. Click Accounts.

3. Select the account that you want to edit and click the edit icon.

4. Make the changes as required.

5. Click Save to save the changes you have made or click Cancel to close the dialog box
without saving your changes.
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Removing accounts

When you remove a customer account, the Master User for the account is removed. All the
other users are removed when the account is terminated. An account ceases to appear in
the All Accounts page after it is removed, while accounts of all other states appear in the
All Accounts page.

You must have Account Create permission to remove an account.

1. Log in to CloudPortal Business Manager UI as Root user.

2. Click Accounts > All Accounts.

3. Select the account that you want to remove.

4. Move the cursor over the gear wheel icon. Click Change State, and then click
Terminated.

5. Click Save.

6. Select the account that you have just terminated.

7. Place the cursor over the manage icon (that looks like a gear wheel), click Remove, and
then click Confirm.
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Changing account states

You can activate an account and also change the account state to restricted, suspended, or
terminated and thereby progressively limit customer privileges. You can change an account
state from the CloudPortal Business Manager UI.

You must have the necessary permissions to change account states.

1. Log in to the CloudPortal Business Manager administration UI as Root user.

2. Click Accounts and select the account whose state you want to change.

3. Move the cursor over the manage icon (that looks like a gear wheel) and click Change
State.

4. Select the required account state and specify the reason for doing so in the Notes box.

5. Click Save to save the change you made or click Cancel to close the dialog box without
saving the change.
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Payments and refunds

The payments tab of the Usage and Billing section of the customer dashboard lists all
payments made by or on behalf of the customer. As service provider, you can view the
payment activity, record payments for corporate accounts, and issue charge back or credits
to the customers, and cancel payments.

Recording payments
A root user or a user with Finance Create/Manage permissions can make/record payments
on behalf corporate customers. Also, the master users of retail accounts can make
payments.

To record/make a payment for a corporate account:

1. Log in to CloudPortal Business Manager as root user.

2. Click Accounts > All Accounts.

3. Select the desired customer in the list and click the dashboard icon.

4. Click Usage and Billing > Payments in the customer dashboard.

5. Move your cursor over the gear icon and click Record Payment.

6. Enter the amount and click OK.

Making refunds
Who Can Make a Refund

If you have the Finance Create/Manage permission, you can make a refund or cancel a
payment.

How to Make a Refund

There are two ways to give money back to customers: credits and charge backs/cancel
payments. For retail accounts you can issue charge back and for corporate accounts you can
cancel payments.

Credit

A credit adds funds to the customer's balance in CloudPortal Business Manager. Any future
charges incurred by the customer will be paid for first out of this credit balance.

To issue a credit:

1. Log in to CloudPortal Business Manager as root user.



2. Click Accounts > All Accounts.

3. Select the desired customer in the list.

4. Move your cursor over the gear icon and click Issue Credit.

5. Enter the amount and the reason for doing so, and click Issue Credit.

Issue charge back or cancel payments

A charge back returns funds through the customer's credit card at the request of the bank
that issued the card. The charge back is processed through the same payment gateway that
is used for routine invoice payments. For corporate accounts, the service provider can
cancel payments made.

To issue a charge back or cancel a payment:

1. Log in to CloudPortal Business Manager as root user.

2. Click Accounts > All Accounts.

3. Select the desired customer in the list.

4. Click the dashboard icon.

5. Click Usage and Billing > Payments in the customer dashboard.

6. Select the desired payment and click Issue Charge Back for a retail account or click
Cancel Payment for a corporate account.

7. Click OK.

Note: For new and terminated corporate accounts, you cannot cancel payments.

Payments and refunds
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Issuing credit to customers

You can add funds to a customer's balance in CloudPortal Business Manager. Any future
charges incurred by the customer will be paid for, first out of this credit balance.

You must be authorised to issue credit to a customer.

1. Log in to the CloudPortal Business Manager UI as Root user or as a user with the
appropriate permission.

2. Click Accounts > All Accounts.

3. Select the customer account to whom you want to issue credit.

4. Place your cursor over the manage icon (that looks like a gear wheel) and click Issue
Credit.

5. Specify the credit amount and enter the reason for issuing the credit.

6. Click Issue Credit.
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Managing users' information of a
customer account

You can view the user information of a customer account, edit the user information,
deactivate a user or remove a user. You can manage the user information such as user
details, reset user passwords and preferences, email addresses for notifications.

1. Log in to CloudPortal Business Manager UI as Root user.

2. Click the Accounts tab. You can view all accounts along with the account details.

3. Select the account whose user information you want to manage.

4. Place your cursor over the manage icon (that looks like a gear wheel) and click View
Users. You can view all users of that account.

5. Select the user whose information you want to manage.

6. Place your cursor over the manage icon (that looks like a gear wheel) and click Edit.

7. Make the desired changes. You can modify any of the user properties such as time zone,
language, user details, and user password.

8. To add an image, click Manage your profile image at Gravatar and follow the
instructions to upload a photo to gravatar.com.

9. To change the time zone and preferred language, follow these steps:

a. Click Edit in the Preferences pane.

b. Select the new time zone and preferred language and click Save.
10. To change the user details, follow these steps:

a. Click Edit in the Details pane.

b. Make the required changes and click Save.
11. To request the user for a password reset, follow these steps:

a. Click Reset Password in the Login Information pane.

b. Click Confirm to send a mail to the user to reset the password.
12. To deactivate or remove the user, follow these steps:

a. In the selected user page, click the gear wheel icon and then click the appropriate
action.

b. Click Confirm to confirm your action or click Cancel to cancel your action.
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Changing the primary email address of a
user

As an administrator, you can change the existing primary email address of a user, if
required, and provide a new email address as the primary email address.

1. Log in to CloudPortal Business Manager UI as Root user.

2. Click Accounts.

3. Select the account of the user whose primary email address you want to edit.

4. Place your cursor over the manage icon (that looks like a gear wheel), click View Users
and select the user.

5. Place your cursor over the manage icon (that looks like a gear wheel) and click Edit.

6. Click the Notification Preferences tab and provide the new email address.

7. Verify the secondary email address.

8. Navigate to User > Edit > Email Addresses.

9. Click Make Primary.
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Monitoring accounts

As a service provider, you can monitor your customer accounts. You can view and monitor
customer account customer account information such as active users and subscriptions,
service health, notifications, and customer spend. You can review and monitor the billing
history of a customer account. You can also monitor and manage the portal resources of the
customer accounts.
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Viewing customer account dashboard

You can view the dashboard of a customer account and monitor the account. You can view
account information such as the number of active users and subscriptions, tasks,
notifications, tickets, service health, and spend information.

1. Log in to CloudPortal Business Manager as Root user.

2. Click Accounts. You can view the list of all accounts.

3. Select the account whose dashboard you want to view.

4. Click the dashboard link that appears as a clock icon. The dashboard of the customer
account is displayed.
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Viewing customer account information

You can view the customer account details and manage the account information. You can
filter and view the accounts based on account state, search for accounts based on company
name, master user and account ID.

1. Log in to CloudPortal Business Manager UI as Root user.

2. Click Accounts. You can view the list of all accounts along with the account details.

3. To view the account information of a customer, either select the account or search for
the account by specifying the company name, master user, or account ID.
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Viewing account users

You can view the users that are associated with a customer account and review the user
information.

1. Log in to CloudPortal Business Manager UI as Root user.

2. Click Accounts. You can view the list of all accounts along with the account details.

3. Select the account whose user information you want to view.

4. Place your cursor over the manage icon (that looks like a gear wheel) and click View
users. You can view the list of all users of the selected customer account. By default,
the master user of the account is selected and the master user details are displayed in
the right pane. You can select a user and view the user details.
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Viewing billing history of an account

You can view the billing history details of an account such as credits issued, discounts,
subscription charges, renewal charges, current balance, and so on. You can also view the
invoices and payments received.

You must have permission to view billing history of an account.

1. Log in to CloudPortal Business Manager as Root user or as a user with the appropriate
permission.

2. Click Accounts. You can view the list of all accounts along with the account details.

3. Select the account whose billing information you want to view.

4. Place your cursor over the manage icon (that looks like a gear wheel) and click View
Billing History.

5. To view the billing activity details, subscriptions, invoices, and payments, click the
appropriate tab.
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Operating your cloud

The CloudPortal™ Business Manager interface provides user friendly dashboard which allows
an easy access to manage all the activities on the portal. This section describes how to
operate the portal.

Understanding the dashboard

Service Health

Notifications

Tickets

Jobs and Job Management

Reports

http://support.citrix.com/proddocs/topic/cpbm-23-map/cpbm-dashboard-con.html#ccpb-maintain
http://support.citrix.com/proddocs/topic/cpbm-23-map/cpbm-servicehealth-tsk.html#cpbm-editaccount-tsk
http://support.citrix.com/proddocs/topic/cpbm-23-map/cpbm-notifications-con.html#ccpb-notifications
http://support.citrix.com/proddocs/topic/cpbm-23-map/cpbm-tickets-con.html#ccpb-tickets
http://support.citrix.com/proddocs/topic/cpbm-23-map/cpbm-reports-wrapper-con.html#cpbm-reports-wrapper-tsk
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Understanding the dashboard

The dashboard provides a summary view which varies depending on which user is logged in.
When your CloudPortal installation is first set up, the gadgets and displays that are included
in the dashboard for each user in your company are customized depending on your business
needs.

Who Can Use the Dashboard
Every user, no matter their role, has a dashboard. The content varies depending on which
user is logged in. For example:

• The Master User of a customer account can see the users in that customer account.

• Customers can see spend vs budget and spend by type reports.

• The service provider's root user or Ops Admin user sees reports on new registrations and
top customers.

How to Use the Dashboard
• Log in to CloudPortal, and the dashboard is the first screen that is displayed.

• At any time while using CloudPortal, you can return to the dashboard by clicking Home
> Dashboard.

• In Customer Summary, you can view graphs of statistics about customer activity. Click
the tabs New Registrations, Top Customers to see different summary graphs. Click
Complete Report to get more details on the reports.

• In Service Health, you can get an at-a-glance summary of your cloud infrastructure's
status. Click View Details to find out more.

• In Notifications, see a summary list of recent alerts about events in your cloud. Click
View all notifications to see the notifications for events and issues that are visible to
your user role. Click Manage Notification Preferences to configure where your
notifications will be delivered:

• In My Tasks, you can see all the pending tasks (if any).

• In Tickets, you can see the summary of the support tickets based on the ticket status.
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Terms and Conditions

The terms and conditions information such as licensing terms and conditions of use is
displayed to users to at various points in the CPBM UI so that the users can view and accept
them. The following table tells you where and when you see the terms and conditions pages
in the CPBM UI.

Where stored Where seen in the UI Upgrade impact on
customization

In a text file pointed by the location in the cloud.properties
Configuration namely 'vmops.termsAndConditions'

• On clicking the T&C link in signup page in Step 2.

• On clicking the T&C link in the Enable Service wizard for a
tenant (Irrespective of which service is selected).

• On clicking the T&C link in the 'Catalog' page for the end user.

• (CCP Only) Clicking the T&C link under the dialog boxes which
are shown to a user in any of 'Manage Resources' tabs.

Will not be impacted
if the file pointed is
stored in a location
not
cleaned/overridden
by upgrade.

Location:

'com.citrix.cpbm.portal.settings.services.datapath'/serviceName +
"_" + serviceVendorVersion/ TermsAndConditions.txt

• When Root user enables (not adds an instance) a service for the
very first time, shown in the step 1 (of 4) of the Enable Service
wizard.

Will not be deleted.
But if the respective
connector is
upgraded, then the
data folder for the
new version (which
will contain defaults)
will take priority.
Custom changes need
to be copied
manually.

Value for the following ApplicationResources key:
'resources.agree.tnc.message.new'

• (CCP Only) T&C box that is shown above the T&C link in dialog
boxes shown under 'Manage Resources'.

• T&C box that is shown above the T&C link in enable service
dialog for tenant (Irrespective of which service is selected).

• T&C box that is shown above the T&C link in 'Catalog' page for
end user.

Will not be impacted
if the string is
customized through
the customization
framework.

If it was updated in
DB manually, it will
be overwritten by any
CPBM version
upgrade.
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Launching the console

As a service provider, you can manage your cloud service instances. You can access the
cloud service instance UI and provision, view, and manage the cloud infrastructure,
configuration settings, and so on. You can log in with administrator privileges.

1. Log in to CloudPortal Business Manager as Root user.

2. Click Launch Console > cloud service instance.

The console opens in a different tab and you can view the administrator dashboard.
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Service Health

The status of your portal can be summarized in an overall rating called "health." The health
status is set manually. It is visible to customer users and users within your organization who
have the required permissions. Service health is a quick way to let your own personnel and
customers know how the system is doing. Most users can see the service health.

You must have root or administrative privileges to set the service health.

1. Log in to the CloudPortal Business Manager UI as Root User.

2. Click Home, and you will see the Service Health icon in your dashboard.

3. Select an entry in the status history list to see more details about that event.

4. Click Add Status to change the current status of the service.

5. Select the Service Instance that the status applies to.

6. Select the degree of severity from the Type list: Issue for the yellow icon, Disruption
for the red icon, or Resolution for the green icon. Provide a descriptive Subject and
Description to communicate the status with users. When finished, click Add Status.

Timezone Setting for Scheduled Maintenance
To ensure that scheduled maintenance activities get created correctly, set the appropriate
timezones for users.

Timezone Setting in the CloudPortal UI

1. Log in to CloudPortal as the root user.

2. Go to Administration > Configuration > Server.

3. Filter the Server parameters by Portal.

4. Set the desired value for vmops.portal.default.user.timezone. For example, set Japan if
you want the timezone setting to be JST.

Timezone Setting in the Database

If you have several users in an account, and if you wish to run a single SQL query to set
the timezone for these users in the database, you can change the the timezone setting
in the database. Timezones are set in the user_time_zone column of the
cloud_portal.users table in the database.

Note: In addition to running the SQL query above, you must change the default
timezone in the UI as explained above to ensure that new accounts have the correct
timezone.



Adding a Scheduled Maintenance
When you need to take a zone offline for necessary modifications, you can schedule a
maintenance window. The maintenance window schedule is visible to customer users and
users within your organization who have the required permissions. This provides a way to
let your own personnel and customers know when to expect possible service interruptions
as well as improvements in the service.

1. Select Administration > Service Health.

2. Select Add Scheduled Maintenance. .

3. In Service Instance, select the instance where the maintenance will take place.

4. In Start and End, set the time window during which maintenance will take place. In
each field, use the calendar control and time sliders, then click Done.

5. In Subject and Description, provide information for your users to explain what is going
on during the maintenance window. Typically, either an issue is being repaired or an
upgrade is being performed to provide new features.

6. Click Schedule. The new event is displayed under Scheduled Maintenance in the Service
Health screen.

7. If you want to change the timing or delete the maintenance window, click Edit or
Delete under Scheduled Maintenance in the Service Health screen.

Service Health
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Notifications

CloudPortal™ Business Manager provides a variety of notifications for both the routine
events and issues that require attention. Notifications are displayed in the UI and also sent
to the specified emails. Notifications come from two sources:

• CloudPortal Business Manager events and alerts, such as the creation of a new account.

• CloudStack events and alerts which are passed through from the underlying
infrastructure.

Viewing Notifications

Most users at a CloudPortal service provider can view at least some of the notifications. The
notifications that are displayed vary according to who is logged in. For example, a user with
the Ops Comm permission will see notifications about system health, whereas a user with
the Account Manage permission will see notifications related to customer activity.

Click Home, and you will see a summary of recent notifications on your dashboard.

Click the More link to display the All Notifications screen. Click the Notifications link in the
top menu bar. This also displays the All Notifications screen.

If you have subscribed to receive notifications in Email, view them in your Inbox.

Subscribing to Notifications

Click the Notifications link in the top menu bar.

Click Manage Notification Preferences.

Fill in your Email address.

Click Add Email.
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Configuring notification settings

CloudPortal™ Business Manager allows you to configure the notification settings to control
the ways in which you can receive or post the notifications about any events or alerts. To
configure the notification settings:

1. Log in as root user.

2. Select Administration .

3. Scroll using < or > in the Configuration tab and select Server.

4. Select Notifications .

5. Click Configure.

6. Click Edit.

7. Update notification.to field. This is the email address to which error notification mails
will be sent.

8. Click Save.
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Managing Notification Preferences

CloudPortal™ Business Manager allows you to determine how you view notifications by
setting a notification preference. You can override the default by modifying the notification
preference.

1. Login as a root user.

2. Click Home > Manage Notification Preferences.

3. Select the delivery channel where you want the notifications to be delivered. It can be
either SMS or Email.

4. If you want to add an email address, Click Add/Delete Email Address.

5. Specify the email address you want to add and Click Add Email.
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Tickets

About Tickets in CloudPortal
CloudPortal™ Business Manager provides features to help you manage customer
relationships.

CloudPortal is integrated with Salesforce Service Cloud. This is used to log requests for
support (trouble tickets) from customers. The CloudPortal trouble ticketing UI, allows you
to view and submit trouble tickets that are stored in Salesforce. Trouble tickets that were
created in either CloudPortal or Salesforce are visible in both locations.

The connection between Salesforce and CloudPortal is set up using configuration
parameters, as described in Configuring Salesforce.

http://www.salesforce.com
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Filing a Ticket

You can file a trouble ticket on behalf of a user, either using the CloudPortal™ Business
Manager UI or directly in Salesforce.com using your Salesforce login credentials.

If you have the Account Create or Account Manage permission, as well as the Trouble Ticket
Manage permission, you can file a trouble ticket on behalf of a user.

1. Login as Root.

2. Click Accounts, and select the account you want to work with.

3. In the Tickets area of the dashboard, click Submit Ticket.

4. Click Add New Ticket.

5. Click Submit.
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Closing a Ticket

When the issue described in a trouble ticket is solved, it is customary to close the ticket.
You can close the trouble ticket on behalf of a user, either using the CloudPortal™ Business
Manager UI or directly in Salesforce.com using your Salesforce login credentials. To access
the Tickets screen through a customer's Dashboard :

1. Click Accounts, Select the account you want to work with.

2. In the Tickets area of the dashboard, click View All Tickets.

3. Select the ticket you want to close.

4. Click Close.
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Jobs and Job Management

Jobs are system-generated tasks to run in a given time period to accomplish certain
activities like billing. Jobs are used to perform routine tasks such as tracking usage,
mediation, generating invoices, account statements, and so on. You can configure custom
jobs, schedule jobs, view status of jobs, and view exception reports when jobs fail.

Jobs are scheduled to run at a particular time and recur at a set interval. Batch jobs are
implemented as JavaBeans
(http://www.oracle.com/technetwork/java/javase/tech/index-jsp-138795.html) and are
run using the Spring (http://www.springsource.org/) platform. The batch jobs are
scheduled in two XML files in the CloudPortal installation path: applicationContext-jobs.xml
and applicationContext-scheduler.xml. You can edit these files to change the job schedule.
After editing the files, you must restart CloudPortal server for the changes to take effect.

You can create custom jobs based on your business needs. For information on configuring
custom jobs, refer to the Customization SDK guide.

http://www.oracle.com/technetwork/java/javase/tech/index-jsp-138795.html
http://www.springsource.org/


176

CPBM Jobs

Jobs are system-generated tasks to run in a given time period to accomplish activities such
as billing.

The jobs in CloudPortal Business Manager include the following:

Batch Job
Name

Start
time

Depende
nce on
others

See
n in
UI

Job succ
essful
sign

Overview Notice mail
when job
fails



Manager (
dailyBillin
gJob)

1:00 A
.M.ev
ery
day

None Yes Status is 
displaye
d in UI
as compl
eted,
with
adjacent
blue
circle.
Check
the desc
ription in
the UI in
case of
error
status.

All billing processing is
done by
"DailyBillingJob". By
default, this job is
scheduled to run at
1:00 A.M. server time.
There are two
sub-processes in the
DailyBilling job:

•First sub-process
scans through all the
service instances and
fetches their usage
data for the previous
day. This data is
converted into useful
information which
CloudPortal Business
Manager can
understand and is
persisted.

•Second sub-process
scans through all the
tenants, picks up the
information from the
previous sub-process,
uses it to update or
post account
statements, and make
payments.

Both of these
sub-processes are
transactional; if any of
the service instance
fails during the
reporting of daily
usage, it is skipped
and the next service
instance is requested
for its usage data.
Similarly, if the second
sub-process fails for a
tenant, say during
processing payment, it
is once again skipped
and the second tenant
is processed.

Yes. Mail is
sent to
Admin
support -
on error,
partial
error, and
warning.
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Trial
Expiry Job

(trialExpir
y)

3:10
A.M.
every
day

None Yes Status is 
displaye
d in UI
as compl
eted,
with
adjacent
blue
circle.
Check
the desc
ription in
the UI in
case of
error
status.

This job runs once
every day and checks
all trial accounts and
calculates the time
left for expiry of each
account. Depending on
the configuration,
mails are sent to
inform the customer of
the days left until the
trial expires. On expiry
of the trial period, if
the account is not
converted to a paying
account, the account
is suspended. After
account suspension, if
the account is not still
converted to a paying
account within the
configured number of
days, then the account
is terminated.

Yes. Mail is
sent to
Admin
support -
on error,
partial
error, and
warning.

Cloud
Service
Event
Processing
Job (clou
dServiceE
ventProce
ssing)

Every
6 min
utes

None.
This job
does not
run
when
the daily
Billing
job is
running.

See
n in
UI
only
if
job 
fails
.

Check
the desc
ription in
the UI in
case of
error
status.

This job polls
connectors for every
service instance and
provides a list of
events that
CloudPortal Business
Manager can
understand. As a
service provider, you
can subscribe to these
events and run any
process that you want,
such as monitoring,
and so on. This job
does not run when the
dailyBilling job is
running.

No mail is
sent.
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Work
Flow Job (
workflowJ
ob)

Every
5 seco
nds

None See
n in
UI
only
if
job 
fails
.

Check
the desc
ription in
the UI in
case of
error
status.

This job runs every 5
seconds and is
responsible for running
the workflow engine
which picks up any
workflow in NEW and
RUNNING state and
runs it. Only one
instance of this job
runs at one moment of
time. For more
information on
workflow engine, refer
to the Workflow
Management section in
the Administration
Guide.

Yes. Mail is
sent to
Admin
support -
on error,
partial
error, and
warning.

Subscripti
on
Validation
Job (subsc
riptionVal
idationJo
b)

Every
1 hour

None See
n in
UI
only
if
job
fails

Check
the desc
ription in
the UI in
case of
error
status

This job runs every
hour and checks if
resource handle is
active for each active
subscription. If the
resource handle is not
active, it marks the
subscription as free to
re-provision another
resource.

Yes. Mail is
sent to
Admin
support -
on error,
partial
error, and
warning.
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Billing
Export
Job

4 A.M.
every
day

None Yes Status is 
displaye
d in UI
as compl
eted,
with
adjacent
blue
circle.
Check
the desc
ription in
the UI in
case of
error
status.

This job runs once
daily and generate
billing feed of the
following types:

1. DailyAccountStatem
entStream: Account
statements posted the
day before

2. DailyInvoiceStream:
Invoices posted the
day before

3. DailyPaymentAndCr
editStream: Payments
and credits made the
day before

4. DailyPaymentFailur
eStream: Payment
failures that occurred
the day before

This file is stored
locally in the
export.directory and
exported to the
export.URL as
specified in
Configuration > Billing.

For more details on
the Billing feed, refer
to Customizing Billing
Exports.

Yes. Mail is
sent to
Admin
support -
on error,
partial
error, and
warning.

Daily
Custom
Job (daily
JobTrigge
r)

10:15
A.M.
every
day

None Yes Status is 
displaye
d in UI
as compl
eted,
with
adjacent
blue
circle.
Check
the desc
ription in
the UI in
case of
error
status.

This job runs once
every day and
generates all custom
reports if any such
implementation is
done.

Yes. Mail is
sent to
Admin
support -
on error,
partial
error, and
warning.
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Monthly
Custom
Job (mont
hlyJobTrig
ger)

10:15 
A.M.e
very
first
day of
the
month

None Yes Status is 
displaye
d in UI
as compl
eted,
with
adjacent
blue
circle.
Check
the desc
ription in
the UI in
case of
error
status.

This job runs once
every first day of the
month and generates
all custom reports if
any such
implementation is
done.

Yes. Mail is
sent to
Admin
support -
on error,
partial
error, and
warning.

Billing resiliency job

Whenever old usages are collected from the backend cloud service, CPBM sends a
notification to the administrator. The administrator can run the billing resiliency job to
process such usages that have not been reported and billed. Administrators can decide how
to handle these old usages by configuring the parameter old.usage.process.config (found
under Administration > Configuration > Portal > Billing > Configure) to one of the
following:

Parameter
value

Action

0 Do not process these usages.

1 Export invoice feeds separately for these usages and do not apply the
charges for these in the system. These feeds (csv/xml) can be used
externally by the administrator for offline settlements.

2 Apply the charges for these old usages into the current billing period
for each account.

3 Apply the charges for these old usages in the billing period to which
they actually belong. This will affect the total charges, net amount
and balance forward amounts of all the billing periods since the date
of the usage up to the current period.

Total spend and total charges may increase if the job is run using configuration value 2 or 3
because usages or consumption not accounted for earlier get processed. This may cause
some accounts to hit the spend limits and spend budgets in the current month. Hence it is
advised to adjust these limits before running the billing resiliency job.

The billing resiliency job can be triggered by running the following mysql query from
database:

update cloud_portal.QRTZ_TRIGGERS set NEXT_FIRE_TIME = (((UNIX_TIMESTAMP()+15)*1000)+1) where TRIGGER_NAME='billingResiliencyJobTrigger';

CPBM Jobs
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Viewing batch jobs

As a service provider, you can view the status of the batch jobs and also view the exception
report for failed jobs. To view the status of batch jobs that are running now or have run in
the past, you can use the CloudPortal Business Manager UI.

1. Log in to CloudPortal Business Manager UI as Root user.

2. Click the drop-down menu icon next to ROOT USER in the top right corner and click
Administration.

3. Click Batch Jobs and view all jobs along with their details. For jobs that fail, you can
view the exception report in the description section for the report.
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Reports

The CloudPortal Business Manager reports help you get an overview of what is going on in
your service. These reports are displayed in a graphical form and can be exported in various
formats such as PNG, JPEG, PDF, and SVG vector.

CloudPortal Business Manager provides the following reports:

• New Registrations: By default, this report displays the new registrations in the current
month. You can generate and view this report for a particular period by specifying the
start date and end date.

• Top Customers: By default, this report displays the top customers in the current month.
You can generate and view this report for a particular month by specifying the month
and year.

• Spend: These reports display monthly usage of utilities and bundles. There are two
types of reports categorized by utility and bundle. By default, these reports display the
spend in the current month. You can generate and view a report for a particular month
by specifying the month and year.

• Product Usage: These reports provide data on the product usage and spend aggregated
for a channel and billing category for a time period. You can generate these reports by
specifying the channel and the time period or by specifying the billing category and
time period. To view the information, generate and download these reports as CSV
files.

• Custom Reports: These are reports that you have defined based on your business needs
for information, reporting, and monitoring. You can generate and view these report by
selecting a report and generating it. You can also download these reports and forward
them via email.

Custom Reports

When first installed, CloudPortal Business Manager provides a set of built-in reports. With
the help of CloudPortal Professional Services, you can add custom reports to meet your
specific reporting needs. Custom reports are generated as ad-hoc reports through the
CloudPortal Business Manager UI, and can accept input parameters.

Note: The out of the box reports display the monetary values in default currency (value
of the config com.citrix.cpbm.portal.settings.default.currency). In order to convert
values from other currencies to default currencies CPBM uses conversion factor (column
"conversion_factor") available in table "cloud_portal.currency_value". This conversion
factor is multiplied by the amount in the corresponding currency to get appropriate value
in the default currency. Service provider must update this column directly into the
database.

For more information on customizing reports, refer to the Customization SDK guide.
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Configuring report settings

You can configure general report settings such as the directory to which the daily
registration reports are exported, specify whether aggregation is based on product or
category in daily usage reports, and the email address to which reports are exported.

1. Log in to CloudPortal Business Manager UI as Root user.

2. Click the drop-down menu icon next to ROOT USER in the top right corner and click
Administration.

3. Click Configuration > Reports.

4. To specify the directory to which the daily registration reports are exported:

a. Click Exports > Configure.

b. Click Edit and enter the value for registrations.reportpath. This is the directory
where daily registration reports are exported.

c. Click Save.
5. To specify the basis for aggregation for daily usage reports:

a. Click Mediation > Configure.

b. Click Edit.

c. Enter the value for aggregation.category. This is the aggregation type of usage that
is recorded in daily usage reports. It can either have P (By Product) or C (By
Category) as its values.

d. Click Save.
6. To specify the email address to which the reports are exported:

a. Click Notifications > Configure.

b. Enter the value for reports.email. This is the email address to which you can send
the reports.

c. Click Save.
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Viewing reports

As a service provider, you can view the reports to get an overview of your service and to
monitor your service offerings. You can generate reports to view trends

1. Log in to CloudPortal Business Manager UI as Root user.

2. In the Reports tab, click the report type you want to view. By default, the reports
display data for the current month.

3. To generate the report for a particular period, either specify the time or month and
year, and click Submit.

4. To generate and view custom reports:

a. Click Custom Reports.

b. Select the report that you want to generate and click Generate. You can view the
report, download it, and send it via email.
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Product Management

CloudPortal Business Manager has a comprehensive Product Management module. The
product management feature allows a product manager to design and manage a catalog of
products and product bundles. These products and bundles are then purchased and
consumed by the end user.

The product manager can create products, package them into product bundles which can be
purchased, and manage catalogs that can selectively expose the product bundles that are
available for the end user to purchase. The product manager can also provide specialized
pricing on a per channel basis across multiple currencies. The product management
capabilities of CloudPortal Business Manager are accessible to any service operator user
with the 'Manage Products' role.

This section describes how to create products, product bundles, product catalogs, and
manage them.

Products

Product Catalogs

Product Bundles

http://support.citrix.com/proddocs/topic/cpbm-23-map/cpbm-catalogs.html#ccpb-catalogs
http://support.citrix.com/proddocs/topic/cpbm-23-map/cpbm-product-bundles-con.html#ccpb-productbundles
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Products

A product is a basic unit of consumption in CloudPortal Business Manager. Every product has
a utility or unit price associated with it. Every product has a name, a unique code (to
identify it uniquely) and a description that helps the consumer understand the product
better. Each product has a unit of measure which is the unit at which this product is
charged for consumption and a set of mediation rules that help CloudPortal Business
Manager classify usage into the various products defined for a particular service.

The service provider may or may not explicitly provision resources based on the roles.
Sometimes a particular usage, that is not explicitly defined, gets accrued in conjunction
with the use of a product and can, therefore, be charged to the customer. A product is
created for anything a service provider wishes to charge a different price. Also, products
are defined for a specific instance of a service.
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Understanding products

Products represent anything that can be charged for. The usage data generated gets
converted into a form that is suitable for billing. The service provider defines one or more
mediation rules for every product.

Mediation rules

When Service is integrated with CloudPortal Business Manager, the service metadata
describes all the resource consumption measured by the service, and any attributes that
describe the resources being consumed. A service operator can use this information to
define products with rules to that determine how much of the usage collected for a specific
resource is classified as usage of the defined product. This process is known as mediation
and the rules are called mediation rules.

For example, we can consider the mobile service where phone calls is the measured service
being consumed. The service would then return the number of minutes (or the unit of
measure) of each call and who used it. We can consider this usage type as CALL. The
service will also describe the call based on certain pre-determined attributes such as:

• TimeOfDay: daytime/night time/evenings/weekends

• Destination: local/long distance/international

• Origin: roaming/local

A service operator can determine, based on the business needs, if all calls are charged the
same rate or if a different rates are applicable for weekends and evenings, local or long
distance, and so on. The service provider would create different products for each
classification. They may charge all calls the same, but have another product called daytime
surcharge, which has an additional price per unit for only the daytime minutes. These
classifications are decided by the service provider and will vary depending on the business
needs served by each installation.

The following is an example of how mediation rules can be defined for mobile calls.

• All calls are the same price regardless of other characteristics:

Usage Type = CALL

Since there is no subclassification, this is all that needs to be declared. The product
creation wizard enables you to create this product.

• Evenings, nights & weekend calls and daytime calls as separate products:

Mobile call (evenings, nights and weekends) = Usage Type = CALL (TimeOfDay excludes
daytime)

Mobile call (daytime) = Usage Type = CALL (TimeOfDay includes daytime)



• Evenings, nights & weekend calls and daytime calls as separate products for local
and all long distance and international calls are the same price regardless of time of
day:

Mobile local call (evenings, nights and weekends): Usage Type = CALL (TimeOfDay
excludes daytime, destination includes local)

Mobile local call (daytime): Usage Type = CALL (TimeOfDay includes daytime,
destination includes local)

Mobile long distance and international calls: Usage Type = CALL (destination excludes
local)

Unit of Measure

When a service measures usage, it does so in a specific unit. However, an operator may
choose to price things in other scales. For example, while the mobile service measures call
duration in seconds, but the operator wants to charge in minutes. To achieve this, a
product can have a conversion factor which is used to convert usage for a particular
product from the unit of measure of the usage to the unit of measure of the product.
Services typically declare common scales to scale up or down their unit of measure. A
service provider may also specify a custom conversion factor and provide a corresponding
unit of measure. For example, the mobile service may measure calls in seconds and may
define scales such as 6secconds, half-minute, or minute. The operator could then choose
whichever unit they want to price the calls. Alternatively, they could create a custom unit
called 15 seconds and specify the appropriate conversion factor.

Note: If the discrete attribute is set to true, the uom will not have any scales and will be
ignored, if specified. You cannot specify the conversion factor for discrete products.

Combining and Excluding Usage

In some cases, it may be necessary to combine multiple usage types. For example, assume
that the service measures incoming calls and outgoing calls separately. The operator can
either price incoming and outgoing calls separately, each having products as described
earlier or charge for both incoming and outgoing calls the same way. In this case, the
operator could add both usage types with the COMBINE operator to the product (with their
corresponding mediation rules) and combine the two usages. Alternatively, if the service
measures all calls and outgoing calls separately and if an operator wishes to charge for
incoming calls separately, they could COMBINE (or add) all calls into this product and
EXCLUDE (or subtract) outgoing calls to derive the value of incoming calls. The exact
definitions depend on what the service measures and what the operator wants to charge
for.

Usage Processing

A given source usage record will be processed as follows:

• A single usage record can match multiple products based on the rules for individual
products. All matching products will accrue usage as described in the rule.

• Two rules can target the same product (this allows two source usage records to be
added or combined).

Pricing

Understanding products
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Once a product is defined, reference prices in all supported currencies may be set for the
product. These prices can be overridden on a per channel basis.

Charge override functionality in channels

Every channel can override price or charge from the reference catalog for a product or
product bundle. However, mediation rules, entitlements, and provisioning constraints
cannot be over-ridden.

Discrete Products
Products that are sold based on quantities are referred to as discrete products. These
products are for applications delivered as a service, such as mailboxes, GoToMeeting, and
so on. The discrete products are:

• Counted in whole numbers and not in fractions

• Entitled in whole numbers and not in fractions. For example, If you get five mailboxes
per month, you will not get 2.5 for half the month

• A unit is consumed in monthly units with no fractions, which means that if you use it
only for a second, you will be charged for a month

• Usage levels are reset once a month

You cannot specify the conversion factor when adding or editing a discrete product in the
UI. The Mediation Rules > Conversion Factor tab displays integral value for discrete
products. Entitlement calculations are not prorated for discrete products. The closeout
invoice displays the integral value for the quantity and chargeable unit columns.

Understanding products
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Adding a product

You can create a new product to target new resources or to replace a retired product. If it
is a fresh product, you can add the product to the very first revision of the Reference
Catalog and to the current revision of all the channel catalogs. The price that you set for
the product remains in the channel catalogs. If you would like to change the price at the
channel catalog level, you can do so only in the future plan of the channel catalog.

1. Log in to CloudPortal Business Manager as the service provider user having "Product
create manage" role.

2. Click the Catalog tab and choose Plan Next from the drop-down.

3. Select the service instance for which you want to create the product.

4. Click Add New in Products dashboard to add a product.

5. Add Product wizard appears. Enter the details to define the product and select the
product category from the drop down list.

6. Click Next.

7. Select the usage types, from the drop down list, that will impact this product. Choose
the appropriate aggregation handling or operator (combine or exclude) for every usage
type.

8. Click on "+" sign to enter the next usage type. After entering the details for the next
usage type, click Next.

9. Enter the mediation rules for the usage type. The mediation rule will be applied on how
usage needs to be collected. Click Next.

10. Specify the conversion factor for the product units and click Next.

Note: The Conversion Factor tab is disabled for discrete products. This is because the
system sets the value for the conversion factor to one for discrete usage types.

11. Enter the utility or product charges for the active currencies and click Next.

12. Review the details you entered and click Add.

13. Click Close.

Note: The product is added to the first revision of the reference catalog. The product
also appears in historical revisions of the reference catalog. However, the charges of the
new product will be copied over in all the channels in their respective current revisions.
The charges can be over-ridden in the channels only in the next (or future) revision.
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Replacing an existing product with a new
product

1. Log in to the portal as the service provider user having "Product create manage" role.

2. Click the Catalog tab and choose Plan Next from the drop-down.

3. Click on Add New button in Products dashboard to add a product.

4. Add Product wizard appears. Enter the appropriate details to define the product.

5. Select the checkbox "Do you wish to make this product available in all catalogs
immediately? "

Note: If you do not check this option, then the product will be visible in a catalog
only upon syncing. You may want to do this if this product is redefining some retired
products, so that both changes are visible to the catalog simultaneously.

This check box is selected by default. To replace the product uncheck the check box.

6. Click Next.

7. Select the usage types, from the drop down list, that will impact this product. Choose
the appropriate aggregation handling or operator (combine or exclude) for every usage
type.

8. Click the "+" sign to enter the next usage type. After entering the details for the next
usage type, click Next.

9. Enter the mediation rules from the drop down list for the usage type. The mediation
rule will be applied on how usage needs to be collected. Click Next.

10. Specify the conversion factor for the product units and click Next.

11. Enter the utility or product charges for the active currencies and click Next.

12. Review the details you entered and click Add.

13. Click Close.

Post requirements: Activate the changes so that the product appears in the reference
catalog.
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Editing a product

1. Log in to CloudPortal Business Manager as the service provider user having "Product
create manage" role.

2. Click the Catalog tab and choose Plan Next from the drop-down.

3. You can view the products on the left pane as shown below. Select the product that
needs to be edited.

4. You can view the details of the selected product on the right pane. Place your cursor
over the Manage icon (that looks like a gear wheel) and click Edit.

5. In the Edit Product wizard, update the product description.

6. Click Save after you have made all the changes and click Close.

Note: You cannot add or remove a usage type that is already defined for the product. In
case of discriminators, only if you have one or more discriminators for the usage type,
you can add more discriminators. If there were none defined, then you cannot add any
new discriminator.The Conversion Factor tab is disabled for discrete products. This is
because the system sets the value for the conversion factor to one for discrete usage
types.
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Retiring a product

You can either retire a product or replace it with a new product. If you only retire the
product, it will remain active in CloudPortal and charge the users based on the usage that
accrues in the active subscriptions. If there are any entitlements in any subscribed bundles,
they will still remain for the product.

You retire an existing product and replace it with a new product. This replaced product will
not be charged from next plan of a channel catalog after it syncs with the reference
catalog.

You cannot retire a product, that is being used as entitlement unless it is removed from all
the bundle entitlements.

Note: A channel syncs with the current plan of the reference catalog. In case of changes
in the reference catalog, the channel must sync with the reference catalog (when its
future plan becomes active), so that the changes that take effect in the future revision of
the reference catalog appear in the future revision of the channel catalog.

1. Log in to CloudPortal Business Manager as the Root user.

2. Click the Catalog tab and choose "Plan Next" from the drop-down.

3. You can view the products on the left pane. Select the product that you wish to retire.

4. You can see the details of the selected product on the right pane. Place your cursor
over the Manage icon (that looks like a gear wheel) and click Retire.

5. If you do not wish to replace the product by other products, click "No" in the "Retire
Product" dialog box. The product will not appear in the future reference catalogs.

Note:

• A retired product cannot be added as an entitlement in a product bundle.

• A retired product will continue to be charged based on the usage if it is not being
replaced.

• A retired product will not appear in the catalog from the future plan. Therefore, no
new use of the product is possible.

Replace an existing product
1. Perform the steps 1 to 3 as mentioned in the above section "Retiring a product".

2. Select "Yes" if you wish to replace the existing product in the "Retire Product" dialog
box.
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Editing product pricing

Depending on your business needs, it may be necessary to edit the product prices. The
changes that you make to the product prices are visible in the current reference catalog
only after activation.

1. Log in to CloudPortal Business Manager UI as Root user.

2. Click Catalog > Plan Next.

3. Select the service instance for which you want to edit the product pricing.

4. Click Products > Plan > Edit Charges. The Edit Planned Charges dialog box opens.

5. Make the changes as required to the product prices and click OK.

You have to activate the changes to make them visible in the current reference catalog.
Refer to Scheduling activation.

To see a new revision of product definitions, a catalog needs to 'Synchronize' the catalog to
the revision. Refer to Synchronizing with reference catalog.

Price changes to existing products and bundles are not synchronized up to a channel catalog
and have to be explicitly managed. When managing prices for a catalog (both products and
bundles) the reference price of the product or bundle is visible to the product manager (in
parentheses) in the product management UI.
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Product Catalogs

A catalog is a set of product bundles and prices that can be offered to customers.
CloudPortal Business Manager enables you to define multiple catalogs with different
products and prices. The default catalog is called the Reference Catalog.

You can define a different catalog for each channel (which is called channel catalog). Each
catalog has an associated utility rate card that helps to calculate the charge when the
customer exceeds the entitlements in the purchased product bundles. For example, assume
that a customer has purchased a product bundle that includes an entitlement of 20 GB of
storage per month. If the amount of storage used goes above 20 GB, you can charge a
certain amount for each additional 100 KB.

Reference Catalog revisions

Revising a catalog includes the following:

• Adding a product or product bundle

• Editing a product or product bundle

• Editing pricing for a product or product bundle

• Retiring a product

• Replacing an existing product with a new product

When a reference catalog is revised, every channel must synchronize with the reference
catalog, so that the changes are visible in the channel. After synchronization, each channel
decides when the changes become visible to the customers. In case a new product or
bundle is added to the reference catalog, the new product will appear in the catalog only
after the catalog is activated.
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Understanding current, next, and
historical revisions of the catalog

You can view the current, next, and earlier versions of your reference catalog from the
Catalog tab.

Current: This refers to the current version of your reference catalog. Click Catalog > View
Current to view the current version. Any changes that you make, have to activated before
they become a part of the current version of the catalog.

Next: This refers to the future revision of the catalog. Any changes that you make in the
reference catalog will become effective in the future (on the date when the changes are
scheduled to be activated). Click Catalog > Plan Next to create a new version of the
catalog.

History: This refers to all versions prior to the current version of the catalog. Click Catalog
> View History, and then click the date and time stamp from the drop down list to view the
version of the catalog on that date.
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Product Bundles

Product bundles represent the package a customer buys. Product bundle can be compared
to subscription plans. When a consumer buys a subscription plan, the system has to
provision the plan (perform activities such as activate the plan, associate it with a phone,
give it a phone number, and so on). Once provisioned, the consumer would make calls, send
SMS messages, and consume internet data. In addition, the service may also provide other
services such as broadband data or cable service.

A product bundle has a name, a code, and a couple of attributes. These include the
following:

• Recurrence: If bundle has recurring charges and if so, what is the frequency. This is also
known as charge frequency. Charge frequency can be one of the following:

• Monthly, with no minimum recurring charge: Pay for what you use, along with a one
time subscription charge

• Monthly: Besides one time, subscription renewal charges need to be paid every
month.

• Quarterly: Besides one time, subscription renewal charges need to be paid every
quarter.

• Annual: Besides one time, subscription renewal charges need to be paid every year.
• Publish: Whether the bundle is published or not.

• Service Instance: The service instance for which the bundle is created.

• Resource type: The resource type selected for a bundle determines what gets
provisioned for that bundle. This will determine what will actually get provisioned when
the customer buys this bundle.

• Provisioning constraints: A resource type may be provisioned with one or more
configurations. For example, internet data might have the 2G, 3G, or 4G option and
phone service may be local only, local-cum-ISD, and so on. Provisioning constraints
describe the qualified (or disqualified) configurations that are valid for this bundle. For
example, you could define a bundle that is valid only for 2G Internet data. When a
customer wishes to use 3G data, this bundle will not be presented as a possible choice
for subscription (other bundles may be presented depending on their configuration). As
a service provider, you will be presented with available configuration options when
defining constraints and you can either explicitly include certain configurations (for
example, data option includes 2G, 3G) or exclude certain configurations (for example,
data option excludes 4G).

• Business constraints: Describe operator business rules for a particular bundle. These
determine how many subscriptions of this bundle is allowed per account and per user.
Note that the available business constraints are sometimes limited by what is
technically feasible. For example, mobile phone plans can be subscribed only once per
user, so the multiple per user option will not be available. They include the following:



• No limit: No limits at the account or user level

• User level: One per user

• Account level: One per account

• Account level: No limits

Entitlements

Entitlements determine how much of what product is included as part of a subscription to a
bundle. These are described as the amount of units of one or more products included in the
subscription. It is possible to include entitlements to other services as part of entitlement
of a bundle For example, three pay-per-view movies free when you buy the mobile phone
plan to facilitate cross-selling. The operator can give unlimited entitlements to products
(for example, unlimited internet data) that can be consumed by a given resource such as a
phone plan. CloudPortal Business Manager is aware of what resources can be consumed
directly by a given resource, so it will allow unlimited entitlements only to such products.

Bundle Pricing

Bundles can have two prices defined per active currency, a one time charge and a recurring
charge. As with products, the actual prices can be overridden on a per channel basis.

• One time charge: This is charged immediately when the consumer subscribes to a
bundle.

• Recurring price: This price is charged periodically based on the recurrence defined for
the bundle. For monthly bundles, the recurring charge is pro-rated to the remainder of
the billing period and charged in full, in advance, for every future billing period. For all
other recurrences, the charge is, in full, in advance, and will be repeated at the
specified frequency.

Revisioning of Products and Product Bundles

Any changes, additions or deletions made when managing products and bundles are made
visible to the consumer in a controlled manner. This ensures accurate billing for the
consumer based on the then prevailing rates for a product or bundle. In order to ensure
accuracy and auditablity, all changes made to product and bundle definitions are revised. A
revision is made visible (or activated) on a date specified by the operator.

At any given time (except when the product is first installed), there is a currently active
revision. In addition, there is always a revision that is being planned. Whenever a revision
becomes activated, a new revision is automatically ready for planning. To activate a
revision, you can either schedule the activation for a particular date or activate it
immediately. When there are multiple revisions for any day (if revisions are created and
activate immediately, it is possible to have multiple revisions for a given day), only the last
revision for that date is used by the rating system. Therefore, the option of activating a
revision immediately should be used only to correct errors, as consumers may see one price
(before activating the new revision) when subscribing, but be charged another price (the
new revision price) when being rated.

Channel Synchronizing

Synchronizes the channel catalog with the current plan of the reference catalog. Charges
are copied for the new products that come into being. Any new bundles created can now be
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consumed in the channel catalog. Also, retired products are marked retired in the channel
catalog. Since syncing is a modification to the channel catalog plan, the changes will take
effect only in the next plan of the channel catalog.

Product Bundles

200



201

Adding a product bundle

Product bundles represent the package a customer buys to provision a resource. As a
service provider, you have to create product bundles which include specifying a service
instance, resource type, entitlements, and charge frequency. You can create product
bundles for your customers from the CloudPortal Business Manager.

1. Log in to the CloudPortal Business Manager UI as Root user.

2. Click Catalog > Plan Next.

3. In the Products Bundles tab, click Add New. The Add Product Bundle wizard appears.

4. In the Bundle Description page, enter the bundle details and click Next.

5. Specify the bundle details such as resource type, subscriptions allowed, and charge
frequency. You can select from the following based on your requirement:

• Allow subscriptions: number of subscriptions supported - no limit, one per account,
any number per account, and one per user.

• Charge frequency: monthly with no minimum recurring charges, monthly, quarterly,
or annual.

6. Select the checkbox "Eligible for Trial" if this bundle is for a trial account. A trial
customer will see only these bundles.

7. Clear the checkbox "Enable notification" if you do not want email notifications to be
sent on the subscription or unsubscription of this product bundle. By default, whenever
a user subscribes or un-subscribes to this product bundle, email notification is sent to
the user who has subscribed to the product bundle, the product bundle owner, and the
sales support alias. Any user who has a Product Management role can turn off this
setting. The sales support alias is specified in Administration > Portal > Address book >
addressbook.salesSupportEmail settings.

8. Click Next.

9. In the Provisioning Constraints page, set the provisioning constraints for the resource
components and click Next.

10. Enter the bundle charges and set one-off and recurring charges to be used as reference
for this bundle and click Next.

11. Review and confirm the bundle details and click Add to add the product bundle.

12. Select the product bundle from the list of product bundles and click the Entitlements
tab.

a. Select the product from the product list.

b. Enter the number of included units per month. If you want to provide unlimited
entitlements, select the checkbox to specify it.



Note: While creating a product bundle for a Resource Type, only products which are
based on usage types generated by that Resource Type can be given as unlimited
entitlement in that bundle.

If you select the checkbox for unlimited entitlement and then select the product, you
are able to give unlimited entitlement even for a product that is not set to give
unlimited entitlement.

Note: Entitlement is based on subscription activation date for the first billing period.
From second billing period onwards, it is based on invoice start date. For monthly, it
would be as on last billing cycle's last date, but for quarterly it could be up to three
months back.

Post requirements: You have to publish the bundle and activate it for the bundle to be
visible to the channels

Adding a product bundle
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Editing a product bundle

You can edit a product bundle and modify bundle description, details, and provisioning
constraints. You have to schedule the activation of these changes so that they are visible in
the current reference catalog.

1. Log in to CloudPortal Business Manager as Root user.

2. Click Plan Next > Product Bundles.

3. Select the product bundle that you want to edit.

4. Place the cursor over the manage icon (that looks like a gear wheel), and click Edit.

5. Make the changes as required.

6. Click Save and then, click Close.
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Customizing product and product bundle
images

As a service provider, you can provide custom images for products and product bundles.
These custom images are visible to users when they browse the product catalog.

1. Log in to CloudPortal Business Manager UI as ROOT user.

2. Click Catalog > Plan Next.

3. Select the service and the instance.

4. Click Products and select the product for which you want to add a custom image.

5. Click Edit Image, upload your custom image for this product, and then click OK.

6. Follow Steps 4 - 5 for uploading a custom image for a product bundle.
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Publishing and unpublishing product
bundles

When you create a product bundle, you have to publish it and then activate it to make it
visible to the channels. When you unpublish a product bundle, it is no longer visible to the
channels. However, it is still a part of the reference catalog.

1. Log in to the CloudPortal Business Manager UI as Root user.

2. Click Catalog > Plan Next.

3. Select the service instance for which the product bundle is created and click Product
Bundles.

4. Select the product bundle that you want to publish or unpublish.

5. Place the cursor over the manage icon (that looks like a gear wheel), and click Publish
or Unpublish, as required.

6. Click OK.
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Editing product bundle pricing

Depending on your business needs, it may be necessary to edit the product bundle prices.
The changes that you make to the product bundle prices are visible in the current reference
catalog only after activation.

1. Log in to CloudPortal Business Manager UI as Root user.

2. Click Catalog > Plan Next.

3. Select the service instance for which you want to edit the product bundle pricing.

4. Click Product Bundles > Plan > Edit Charges. The Edit Planned Charges dialog box
opens.

5. Make the changes as required to the product bundle prices and click OK.

You have to activate the changes to make them visible in the current reference catalog.
Refer to Scheduling activation.

To see a new revision of bundle definitions, a catalog needs to 'Synchronize' the catalog to
the revision. . Refer to Synchronizing with reference catalog.

Price changes to existing products and bundles are not synchronized up to a channel catalog
and have to be explicitly managed. When managing prices for a catalog (both products and
bundles) the reference price of the product or bundle is visible to the product manager (in
parentheses) in the product management UI.
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Entitlement Behavior and Calculation

Unlimited entitlement:

Only those products can be given as unlimited entitlement whose usage types are generated
by resourceType of the product bundle. Please check specific connector document to check
which usage types are generated by a specific resourceType. Unlimited entitlements are
always subscription scoped and cannot be used across subscriptions of a user.

Limited entitlement and resource isolation is true:

Entitlements are user scoped and all entitlements of a specific product are added up for a
user.

Limited entitlement and resource isolation is false:

Entitlements are account scoped and all entitlements of a specific product are added up for
an account.
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Removing an entitlement

Entitlements for a product can be removed from a product bundle effective from next
revision of catalog. You can edit or remove an entitlement using the following steps:

1. Log in to CloudPortal Business Manager as Root user.

2. Click Catalog > Plan Next.

3. Select the required cloud service.

4. Click Product Bundles.

5. Select the product bundle that you want to update.

6. Click Entitlement.

7. Edit/Remove the desired product entitlement.
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Scheduling activation

When you make changes to your catalog such as adding new product bundles or products to
replace existing ones or edit product or bundle pricing, these changes do not appear in the
current reference catalog. You have to schedule the activation of the changes to update
the reference catalog.

1. Log in to CloudPortal Business Manager as the Root user.

2. Click Catalog > Plan Next > Schedule Activation.

3. In the Set Plan Date dialog box, enter the date by when you want to make the catalog
effective. On this date, the changes become effective and are visible in the reference
catalog.

4. Click OK.
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Channel Management

Channels represent customer segmentation in CloudPortal Business Manager. They may
refer to geographies, selling channels, resellers, partners, and so on. Every account is tied
to a specific channel. Service providers may choose to segment their accounts in any way
they wish. Channels are associated with a catalog. A catalog contains channel specific
prices for all the products in the system along with an operator determined set of bundles
that are available to that catalog, which can also have channel specific prices. Consumers
may purchase only the bundles available in the catalog that is configured for their channel.

Rather than have uniform branding across all channels, you can have channel-specific
branding and provide a customized experience to the tenants/customers of a channel. With
channel-specific branding, the reseller functionality is provided with CloudPortal Business
Manager. Each channel can be branded to distinguish it from other channels.

This section describes how to create channels, channel catalogs, channel-specific branding,
manage channels, and handle campaigns and promotions.

Channels

Channel-specific reseller branding

Campaigns and Promotions

http://support.citrix.com/proddocs/topic/cpbm-23-map/cpbm-channels-con.html#concept_B28EA9E8F3E6441D907847F41E208A91
http://support.citrix.com/proddocs/topic/cpbm-23-map/cpbm-campaignsandpromotions-con.html#ccpb-campaigns
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Channels

Channels represent groups of accounts. Every account is tied to a specific channel.
Operators may choose to segment their accounts in any way they wish. Channels could
represent geographies or they could represent market segments. Channels are associated
with a catalog. A catalog contains channel specific prices for all the products in the system
along with an operator determined set of bundles that are available to that catalog, which
can also have channel specific prices. Consumers may purchase only the bundles available
in the catalog that is configured for their channel. Operators have to explicitly add the set
of bundles that are available to a catalog. This is done using the add bundle action. Only
published bundles that are visible to the catalog can be added. Any changes made to a
catalog have to be explicitly activated at which point it is visible to consumers associated
with the corresponding channel.

Channel Catalog

Every channel has a catalog that lists the bundles being sold in that channel. You can add
any number of bundles to a catalog.

Note: Only published bundles can be added in a channel catalog.

Channel Currencies

You may want to sell offerings only in a subset of currencies active in the system.

Note: You can add currencies that we want to support in the channel, but once the
channel catalog is active, the currency can be supported only in the future revision.

Product and Bundle Prices

There are separate revisions of product and bundle prices in the channel catalog. When a
channel is created, prices of all the active products are copied in the channel. As regards a
bundle, the prices are copied over when you attach a bundle to the channel catalog. There
is a separate price revision which is independent of the price revision in the reference
catalog.

Channel Synchronizing

To see a new revision of product and bundle definitions and prices, a catalog needs to
synchronize the catalog to the revision. This allows the catalog to see all the changes made
in the definitions. Once synchronized, an operator may then override prices before
activating a new revision of the catalog. Price changes to existing products and bundles are
not synchronized with the channel catalog and have to be explicitly managed. When
managing prices for a catalog (both products and bundles) the reference price of the
product or bundle is visible to the product manager (in parenthesis) in the product
management UI.

After synchronizing, retired products are marked retired in the channel catalog.

Note: Product Mediation Rules and Bundle Provisioning constraints are modified only in
the reference catalog. If you synchronize, only then can you can get the changes
reflected in the channel catalog.



Channel-specific Branding
Rather than have uniform branding across all channels, you can have channel-specific
branding and provide a customized experience to the tenants/customers of a channel. With
channel-specific branding, the reseller functionality is provided with CloudPortal Business
Manager. Each channel can be branded to distinguish a channel.

Channels
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Adding a channel

You can add a channel to represent a market segment and serve a particular customer
base. You can add channels from the CloudPortal Business Manager UI. You can configure
channel-specific branding so as to serve better the customers of that channel.

You can over-ride the settings configured at the portal level and specify settings at the
channel level (for more information see Channel specific branding). You can specify the
FQDN prefix.

1. Log in to CloudPortal Business Manager as Root user.

2. Click Channels > Add New. The Add Channel wizard opens.

3. Specify the channel details such as name and description for the channel, code, FQDN
prefix, billing group, and click Next.

The FQDN prefix is unique to a channel. The FQDN prefix is a prefix to the CPBM Host
URL. Since a channel is identified by the FQDN, tenants can directly use the FQDN to
access that channel. When a user accesses the CPBM host URL using the FQDN, the
FQDN is used to resolve the channel context for the user. For FQDN configuration, see
Configuring FQDN.

A billing group corresponds to channels belonging to a distributor or a group of channels
that can be grouped for billing purpose.

4. In the Select Currencies page, specify the currencies for the channel and click Next.
The products and product bundles, in this channel, are sold in the specified currencies.

5. In the Default Settings page, specify the default settings that will apply to accounts
created under this channel and click Next.

If these are not set, then the global system level default values are used. The default
settings include settings for language (default locale for accounts), time-zone, help
desk email address, help desk phone number, channel is open or closed for registration,
and country and email domain white list and blacklist. If you specify black and white
lists for countries, it is recommended that you enable GeoIP protection service. A white
list always takes precedence over a blacklist. When you do not define a white list for a
channel, if a global white list has been defined, it takes precedence.

By default, the value of the parameter "allow.signup" from Administration > Portal >
Settings specifies whether the channel is open or closed for registration. You can
over-ride this setting and specify a value that is different from the default.

6. In the Custom URLs page, specify the custom URLs such as support URL, home URL,
terms of use URL, and so on, and click Next. These URLs are used to create hyperlinks
in footer section when a tenant user created under this channel logs in. These settings
enable resellers/channels to point the users to their own URLs. If these are not set,
then the global system level default values are used.

7. Review and confirm the channel details.

http://support.citrix.com/proddocs/topic/cpbm-23-map/cpbm-configure-fqdn-con.html#concept_B28EA9E8F3E6441D907847F41E208A91


8. Click Add and then, click Close.
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Editing a channel

You can modify channel details and the currencies that a channel supports from the
CloudPortal Business manager UI.

1. Log in to CloudPortal Business Manager as Root user.

2. Click Channels and select the channel that you want to edit.

3. Place the cursor over the manage icon (that looks like a gear wheel) in the top right
corner, and click Edit Channel.

4. Make the required changes.

5. Click Save and then click Close.
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Deleting a channel

You can delete a channel when it is no longer serves a market segment and there are no
customer accounts associated with the channel. You can delete a channel if no active
tenants exist in the channel.

1. Log in to CloudPortal Business Manager as Root user.

2. Click Channels and select the channel that you want to delete.

3. Place the cursor over the manage icon (that looks like a gear wheel) in the top right
corner, and click Delete Channel. This option is visible only if there are no active
tenants in the channel.

4. Click OK.
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Synchronizing with reference catalog

To see a new revision of product and bundle definitions, a catalog needs to 'Synchronize'
the catalog to the revision. The latest version of reference catalog is then visible to the
channel. On synchronization, any changes to bundle provisioning constraints get reflected in
the channel catalog, retired products are not displayed in the channel catalog, and newly
added bundles and pricing changes become visible to the channel.

1. Log in to CloudPortal Business Manager as Root user.

2. Click Channels and select the channel.

3. Click the Catalog tab in the details pane.

4. Place the cursor over the manage icon (that looks like a gear wheel), and click Sync
with Reference Price Book.

5. Click OK.

Note: Price changes to existing products and bundles are not synchronized up to a
channel catalog and have to be explicitly managed. When managing prices for a
catalog (both products and bundles) the reference price of the product or bundle is
visible to the product manager (in parentheses) in the product management UI.
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Configuring Channel Specific Settings

A cloud service may require certain information to be defined at the channel level. You can
specify these settings for a specific service instance, from the Channels page.

1. log in to CloudPortal Business Manager UI as Root user.

2. Click Channels > Channel Catalogs.

3. Select the channel that requires the information to be specified and click Service
Controls.

4. Select the Cloud service instance and click Edit.

5. Specify the settings and click OK.
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Adding product bundles to a channel
catalog

Each channel is created to serve a particular customer base and has its own catalog of
product bundles that is specific to its customer requirements. You can add published
product bundles to your channel catalog from the CloudPortal Business Manager UI.

1. Log in to CloudPortal Business Manager as Root user.

2. Click Channels and select the channel.

3. Click the Catalog tab in the details pane.

4. Place the cursor over the manage icon (that looks like a gear wheel), and click Add
Bundle(s) to Catalog. You can add only published product bundles. You have to
synchronize with the reference catalog to get the latest version of the reference
catalog so that you can view any changes that have made to the reference catalog since
the last synchronization.

5. Select the bundles that you want to add to the channel catalog and click OK.
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Editing product and product bundle prices
in channel catalog

Based on your business needs, you can provide specialized pricing on a per channel basis
across multiple currencies. You can override the prices in the reference catalog on a per
channel basis. When managing prices for a catalog (both products and bundles) the
reference price of the product or bundle is visible to the product manager (in parentheses)
in the product management UI.

1. Log in to CloudPortal Business Manager UI as Root user.

2. Click Channels and select the channel.

3. Click the Catalog tab in the details pane.

4. To edit product prices, click Utility Rate Card. To edit product bundle prices, click
Bundles and select the bundle.

5. Place the cursor over the manage icon (that looks like a gear wheel), and click Edit
Pricing.

6. Make the changes as required and click OK.
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Scheduling activation

When you make changes to your channel catalog, you have to activate the changes so that
the changes are visible to the customers of that channel. When you add bundles to your
channel catalog or make any pricing changes, schedule activation to make the changes
effective on the date specified.

1. Log in to CloudPortal Business Manager as Root user.

2. Click Channels and select the channel.

3. Click the Catalog tab in the details pane.

4. Place the cursor over the manage icon (that looks like a gear wheel), and click
Schedule Activation.

5. Specify the date on which the revision of the catalog becomes effective and click
Proceed.
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Previewing the channel catalog

A channel catalog contains channel specific prices for all the products in the system along
with an operator determined set of bundles that are available to that catalog, which can
also have channel specific prices. As a service provider, you can view the product catalog
that is specific to any channel. You can view the catalog in the same way as any user of
that channel sees it.

1. Log in to CloudPortal Business Manager as Root user.

2. Click Channels and select the channel.

3. Click the Catalog tab in the details pane.

4. Place the cursor over the manage icon (that looks like a gear wheel), and click Preview
Catalog. You can view the catalog for that channel.
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Adding currencies to a channel

A channel can support multiple currencies. You may want to sell offerings only in a subset
of currencies active in the system. As a service provider, you can specify the currencies in
which the products and bundles are sold in a channel during channel creation. You can add
other active currencies at any time.

1. Log in to CloudPortal Business Manager as Root user.

2. Click Channels and select the channel to which you want to add currencies.

3. In the Currencies tab, place the cursor over the manage icon (that looks like a gear
wheel), and click Add Currencies.

4. Select the currencies and click OK.
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Channel-specific reseller branding

With channel-specific branding, the reseller functionality is provided with CloudPortal
Business Manager. Service providers can now offer their cloud services through resellers.
Resellers can give a customized experience to their tenants, with tenants being able to use
the cloud services under a reseller brand. A different look and feel can now be incorporated
to distinguish a channel or reseller and enable resellers to target and serve different
customers in a better way.

Channel-specific branding is done by providing channel-specific logos, CSS, and favicons and
modifying the interfaces, headers, footers, and so on. You have the capability to over-ride
portal-wide settings and specify default time zones, locales, email addresses, phone
numbers, and custom content templates for a channel. Resellers can point the users to
their own URLs. Personalized communication at the channel level is also possible. In
addition, you can set up channel-specific black and white lists for email domains and
countries. You can also open and close a channel for registration.

As a service provider, you are responsible for branding the channels and perform the
functions of a channel administrator. The CloudPortal Business Manager UI enables you to
configure channel-specific branding. Some additional configuration is required at the back
end to enable channel-specific branding. At any time, you can revert to the default global
settings configured for the portal.

As part of channel-specific branding, the service provider can assign a unique FQDN prefix
for a channel. The FQDN prefix is a prefix to the CPBM Host URL. The FQDN is used to
resolve to the channel-specific sign-up page, login page, and anonymous catalog. When a
user accesses the CPBM host URL using the FQDN, the FQDN is used to resolve to the
channel context for the user. When the FQDN prefix has been configured, users should
access portal using the FQDN prefix that has been configured on their channel. Service
provider users have to log in using the CPBM host URL only.

You can provide reseller/channel specific communication by overriding the default
global-level content templates such as invoices, customer facing emails, support ticket
notification to help desk, and so on.

Reseller/channel specific URLs for Help, Support, Contact, and so on can be specified.
These URLs are used across the system and each reference will resolve to the channel's
overridden URL. Global URLs are used only if they are not defined for a channel.

At a channel level, you can grant or deny access to customers based on their geographic
location by providing black and white lists. It is recommended that you enable the GeoIP
protection service when you define white and black lists for a channel. A white list always
takes precedence over a blacklist. When there is no white list defined for a channel and if a
global white list has been defined, it takes precedence.

At a channel level, you can grant or deny access to customers based on their email
domains. Users who attempt to sign up with an email domain that you mark as blacklisted
will have their sign up process aborted. An email domain white list always takes precedence
over an email domain black list.



The service provider can open and close a channel for registration. Self-registration is not
allowed if a channel is closed for registration. By default, the value of the parameter
"allow.signup" specifies whether the channel is open or closed for registration. The service
provider can over-ride this setting for every channel and specify a value that is different
from the default either during channel creation or by editing a channel's settings. The
default channel always reflects the value that is globally defined. If you designate a
channel as the default channel, then the channel-specific setting for signup is ignored. If
the global allow.signup value is true, then the default channel is open for registration even
if the channel has been configured as closed for registration.

When an account is created in the channel, the channel's default time zone and locale are
set for the account, unless these settings are overridden during the account creation
process. At any time, the user can change the time zone and locale by editing the user
profile.

Channel-specific reseller branding
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Configuring the FQDN settings

A channel can be identified by the FQDN, so that tenants can use it to access the channel.
As part of channel-specific branding, the service provider can assign a unique FQDN prefix
to a channel. This FQDN prefix is a prefix to the CPBM Host URL. When a user accesses the
CPBM host URL using the FQDN, the FQDN is used to resolve the channel context for the
user. The FQDN is used to resolve to the channel-specific Sign-up page and Anonymous
Catalog.

Additional configuration is needed to use the FQDN.

1. Modify public.host setting to the appropriate hostname.

a. Log in to CloudPortal Business Manager as Root user.

b. Click the drop-down menu icon in the top right corner next to ROOT USER.

c. Click Administration > Configuration > Portal.

d. Click Settings > Configure.

e. Click Edit.

f. Modify the public.host setting to the appropriate hostname.

g. Click Save and then, click Close.
2. Configure the DNS settings to redirect incoming traffic to the correct host based on

subdomain of all the channels.

3. For CAS:

a. Edit the cloud.properties file to give the correct hostname in cas.service.url that
you have specified in Step 1.

b. Modify the cas.service.url (specified in Enabling CAS Authentication) as given
below:

http://*<hostname>:<port>/portal/portal/j_spring_cas_security_check

http://support.citrix.com/proddocs/topic/cpbm-23-map/cpbm-install.html#ccpb-install__cas-authentication
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Specifying the channel look and feel
(branding) settings

As a service provider, you can allow reseller or channel-specific branding. You can alter the
appearance of a channel by using stylesheets, logos, and favicons so that the CPBM UI
represents the look and feel of the reseller brand instead of the service provider.

Note: Before you upload the stylesheets, logos, and favicons, modify the
images.uploadPath setting to the appropriate destination. This is the absolute path to the
images directory for storing custom image logos, favicons, and so on. In a multinode
environment, this path should be accessible from all the CPBM nodes.

1. Log in to CloudPortal Business Manager as Root user.

2. Click the drop-down menu icon in the top right corner next to ROOT USER.

3. Click Administration > Configuration > Portal.

4. Click Settings > Configure.

5. Click Edit.

6. Modify images.uploadPath setting to the appropriate destination. Ensure that you have
the necessary read and write permissions on the directory mentioned here.

7. Click Save and then, click Close.

Editing/specifying the channel or reseller look and feel (branding) files:

1. Log in to CloudPortal Business Manager as Root user.

2. Click Channels.

3. Select the channel whose look and feel settings you want to edit.

4. Click the Look and Feel tab in the lower pane.

5. Place the cursor over the manage icon (that looks like a gear wheel), and click Edit.

6. To specify or change the CSS file for the channel, browse to the appropriate CSS file
and upload it.

7. To specify or change the logo for the channel, browse to the logo file and upload it.

8. To specify or change the favicon for the channel, browse to the favicon file and upload
it.

9. Click Save. You are now in the preview mode. At any time you can exit the preview 
mode by clicking the exit link at the top right corner. An icon appears next to the 
channel name in the left pane that indicates you have made changes to the look and



feel of the channel. The changes that you have made take effect only when you publish
them. Two links are displayed in the Look and Feel tab: Current and Unpublished.

You can click the links to see the CSS, logo, and favicon currently specified for the
channel and the unpublished changes. Wherever the defaults are used, the word
default is displayed in parenthesis next to the file name.

10. Click Unpublished. The tab displays details such as the name of the CSS file, the logo,
and the favicon. The Preview Link moves you to the preview mode. The Anonymous
Preview Link logs you out and allows you to preview the anonymous pages with the look
and feel (branding) changes.

11. If you are satisfied with the look and feel of the channel, publish the changes:

a. Click Unpublished. If you have exited the preview mode, select the channel and
click Look and Feel > Unpublished.

b. Place the cursor over the manage icon (that looks like a gear wheel), and click
Publish.

Specifying the channel look and feel (branding) settings

228



229

Downloading the channel CSS

You can incorporate channel-specific branding by providing channel-specific CSS. You can
download this CSS from the channel page.

1. Log in to CloudPortal Business Manager as Root user.

2. Click Channels and select the channel whose CSS you want to download.

3. Click the Look and Feel tab in the lower pane. If you have uploaded a CSS for the
channel, then the file name appears as a clickable link

4. Click the channel CSS file name and download the CSS.
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Resetting channel look and feel
(branding) settings to defaults

You can reset the channel-specific branding settings back to the default settings that have
been configured for the portal.

1. Log in to CloudPortal Business Manager as Root user.

2. Click Channels.

3. Select the channel whose look and feel (branding) you want to reset.

4. Click the Look and Feel tab in the lower pane.

5. Place the cursor over the manage icon (that looks like a gear wheel), and click Reset to
defaults.

6. Click Yes.
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Opening and closing a channel for
registration

As a service provider, you can mark a channel as open or closed for registration. When a
channel is closed for registration, self registration is not possible.

The service provider sets the global default value of the parameter allow.signup to true or
false in the portal settings to allow or disallow signup. During channel creation, this value is
picked from the global settings defined for the portal. You can override this setting during
channel creation for any specific channel or you can edit the channel settings at any time.
The default channel always reflects the value (of allow.signup) that is globally defined. For
more information on configuring portal settings, refer to Configuring portal settings.

1. Log in to CloudPortal Business Manager as Root user.

2. Click Channels and select the channel that you want to open or close for registration.

3. Place the cursor over the manage icon (that looks like a gear wheel) in the top right
corner, and click Edit Channel.

4. In the Default Settings page, either select the Allow Signup check box to open the
channel for registration or or unselect the Allow Signup check box to close the channel
for registration.

5. Click Save and then click Close.

http://support.citrix.com/proddocs/topic/cpbm-23-map/cpbm-confportalsetting-con.html#ccpb-configure-billing
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Overriding content templates at a channel
level

You can provide reseller/channel specific communication by overriding the default
global-level content templates such as invoices, customer facing emails, and so on. The
content templates support variable data substitution, and can be used to send out
personalized channel-specific emails. You can modify the content of the email, invoice, and
approval templates, change the header, footer, and styles, and customize them for a
channel or reseller.

When you override the content templates at a channel level, an icon appears next to the
template name indicating that the template is overridden.

1. Log in to CloudPortal Business Manager as the Root user.

2. Click the drop-down menu icon in the top right corner next to ROOT USER.

3. Click Administration > Content Templates.

4. To override email templates, follow these steps:

a. Click Emails.

b. Select the channel from the channel drop-down list. Only the customer facing email
templates are listed.

c. Select the language from the drop-down list.

d. Select the template whose content you want to override.

e. Place the cursor over the gear wheel icon and click Edit.

f. Override/modify the content in the editor.

g. Click OK. You can click Preview to view the edited template.
5. To override the Header, Footer, and Signature in content templates, follow these steps:

a. Click Includes.

b. Select the channel from the channel drop-down list.

c. Select the language from the drop-down list.

d. To modify the header, click Email Header.

e. Place your cursor over the manage icon (that looks like a gear wheel) and click
Edit.

f. Make the changes as required and click OK. You can click Preview to view the 
modified header. You can modify the footer and signature by selecting the



respective option and following Steps d - f.

6. To override Invoice Templates, follow these steps:

a. Click Invoices.

b. Select the channel from the channel drop-down list.

c. Select the language from the drop-down list.

d. Select the invoice template you want to edit.

e. Place your cursor over the manage icon (that looks like a gear wheel) and click
Edit.

f. Make the changes as required and click OK. You can click Preview to view the
edited template.

7. To override the Content Template Styles, follow these steps:

a. Click Styles.

b. Select the channel from the channel drop-down list.

c. Select the language from the drop-down list.

d. To override the style defined, click Styles.

i. Click Edit and make the changes as required.

ii. Click OK to save your changes.
e. To override the custom information, click Custom.

i. Click Edit and make the changes as required.

ii. Click OK to save your changes.

Overriding content templates at a channel level
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Resetting channel content templates to
defaults

You can reset the channel-specific changes made to the content templates back to the
default settings that have been configured for the portal.

1. Log in to CloudPortal Business Manager as Root user.

2. Click the drop-down menu icon in the top right corner next to ROOT USER.

3. Click Administration > Content Templates.

4. Click the appropriate tab.

5. Select the channel from the drop down list and then select the template that you want
to reset.

6. Place the cursor over the manage icon (that looks like a gear wheel), and click Reset to
defaults.

7. Click Yes.
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Channel-specific product usage and
spend data

Cloud service providers generally sell their cloud services through resellers and resellers
then sell these cloud services to their tenants through channels. The service provider can
map a channel or multiple channels to a specific reseller. While resellers sell subscriptions
to various product bundles and bill their tenants accordingly, the cloud service providers
bill the resellers for the product usage or consumption at utility rates. The service providers
need usage data per product or for all products together to be able to charge their resellers
and/or distributors. CPBM generates channel level usage reports that form the basis of
billing the resellers by the service provider. Product usage data by channel is also essential
to understand the consumption patterns.

Aggregated usage and spend data is provided for:

• All accounts in a channel (all accounts that belong to a given reseller)

• All channels in a billing group (all resellers that belong to a given distributor)

Product usage reports
Two types of product usage reports can be generated:

• On a per channel basis

• On a per billing group basis (the billing group corresponds to a group of channels that
belong to a reseller/distributor)

The product usage report by channel provides the usage of products during the period
specified for the selected channel. The aggregation is done on a per product basis. Where
some channels are grouped (for example, those that belong to a distributor), the product
usage report by billing group gives the usage of products aggregated across all channels
belonging to that distributor during the period specified. You can download the usage
information as a CSV file.

For information on reports, refer to Reports.

Channel-specific billing data
The billing export job runs daily and generates the following information:

• Account statements posted the day before

• Invoices posted the day before

• Payments and credits made the day before

http://support.citrix.com/proddocs/topic/cpbm-23-map/cpbm-reports-wrapper-con.html#cpbm-reports-wrapper-tsk


• Payment failures that occurred the day before

After the billing export job runs successfully, all posted account statements of any
particular channel get created inside a folder having name same as channel code at the
location mentioned in the export.directory and exported to the export.URL as specified in
Configuration > Portal > Billing. For example,/tmp/cloud/portal/billing-export/DailyAccoun
tStatementStream/target/<channel_code>/. Similarly, invoices, payments and credits, and
payment failures also get stored in the respective folders. The service provider can use this
information for further processing.

Channel-specific product usage and spend data 
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Creating billing groups

A billing group is a group of channels (that belong to a reseller or distributor) formed for
the purpose of billing. Cloud service providers usually sell their cloud services through
resellers. A reseller could own more than one channel and the service provider has to bill
the reseller/distributor for the aggregated usage. The cumulative usage of all products
across all channels belonging to a billing category helps the service provider to bill the
reseller/distributor for the actual product consumption. To facilitate this, you have to
create billing group of all channels belonging to a reseller. You can assign a channel to a
billing group either during channel creation or on editing a channel's settings. In case, the
billing group does not exist, you can create a billing group either during channel creation or
while editing a channel.

1. Log in to CloudPortal Business Manager as Root user.

2. In the Channels page, click Add New.

3. In the Channel Details page, specify the billing group that the channels belongs to
either by selecting from the list of existing groups or create a new billing group by
typing its name in the text box.

4. Follow the on-screen instructions to complete the wizard.

Similarly, while editing channel settings, you can either select the billing group or type the
billing group name to create a new billing group to which the channel will belong.
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Filtering channels by billing group

As a service provider, you can view the various channels and filter them based on the billing
group. A billing group usually corresponds to a group of channels that may belong to a
distributor, a geographic location. and so on. The channels are grouped based on common
characteristics, which is helpful when you would like to see the product usage for a
particular region, distributor, or reseller, and so on.

1. Log in to CloudPortal Business Manager as Root user.

2. In the Channels page, select the billing group from the drop down list.

3. View the channels that belong to the selected billing group.
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Campaigns and Promotions

A campaign is a marketing program that you create in CloudPortal Business Manager to
introduce new products to customers who sign up during the campaign period to expand the
customer pool, or to retain customers by giving them additional offerings.

Trial users who sign up during the campaign period are given a promotional code that they
use to sign up. This is a required code that trial users should provide. These customers are
assigned a Trial account type and they can sign up by entering the promotional code in the
text box provided in the Sign-up page.

Other users (Retail and Corporate users) who sign up during the campaign period can also
enroll for campaigns and promotions that are on offer. However, for non-trial users, the
promotional code is not required in the Sign-up page.

Note: Trial users avail themselves of a full discount by default (100%), whereas the
discounts on offer for non-trial users are governed by rules set by an administrator.

When the trial period expires, the account owner is notified by Email. The account's
resources like running VMs, templates, snapshots, storage etc. are stopped. These resources
are released into the system after a certain period of time, which can be configured.
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Adding a campaign

Pre-requisite: You must have the Product Create/Manage permission to add a new
campaign.

1. Log in to CloudPortal as the Root User or Ops Admin.

2. Click Channels > Campaigns.

3. To add a campaign, click Add New Campaign. The Add Campaign page is displayed.

4. Update the fields with the relevant details.

5. Specify the promotion code for the campaign.

6. Specify the start date and end date of the campaign. The end date decides when the
campaign ends. No user can register after this date. However, if the end date is not
specified, the campaign will run forever.

7. Check the Trial option, if you want this campaign to be eligible only for trial users. If
you leave the Trial option unchecked, it implies that this campaign is exclusively for
non-trial users.

Note: Percent Off and Amount Off options appear only when the Trial option is
unchecked. If the Trial option is checked, it indicates that the campaign is
exclusively for trial users, and as such the campaign offers a 100% discount.

8. Check the Unlimited Signups option if the campaign is not limited only to a specific
number of active users.

9. Check the Unlimited Duration option if the promotion offer is available forever to a
registered trial user.

10. If you do not select the Unlimited Duration option for the campaign, specify the
Duration of entitlement of the campaign. This denotes the duration of the entitlement
available through this particular campaign and is specified in the number of days for a
trial user and number of billing periods for a non-trial user.

11. Select the channels in which you want this campaign to feature. To ensure this
campaign features in multiple channels, press Ctrl key while selecting the channels.

12. For non-trial users, if you want to give a discount of a certain percentage on this
campaign, select the Percent Off option and enter the percentage in the Percent text
box.

13. For non-trial users, instead of a flat percentage off, you might want to give different
amounts as discounts across different currencies. Select the Amount Off option and
specify the amount of discount that you want to give in various currencies.

14. Click Submit.
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Understanding Billing in CloudPortal
Business Manager

In CPBM 2.0, the billing engine and book keeping model was fully redesigned to make it
more accurate and easy to understand in addition to supporting some additional
capabilities. This section describes the billing and book keeping module for CPBM 2.x.
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Billing Periods

From a billing perspective, CPBM reconciles its books every billing period. Depending on an
implementation's need, the definition of a billing period can be changed. CPBM supports
three models for defining billing periods. There are two configuration properties in CPBM
that control this behavior, namely billingPeriod.type and billingPeriod.config. The billing
type determines which model CPBM uses to compute billing periods. The
billingPeriod.config is interpreted differently depending on the billingPeriod.type. The
different billing mode types are:

• FIXED_DAYS: This model defines a billing period as a fixed number of days. The
billingPeriod.config in this case determines the number of days that make a billing
period. This is counted from the 'anniversary date' of an account, which is the date on
which the account is registered. CPBM will then compute every billing period as x
(determined by billingPeriod.config) number of days from the end of the last billing
period (or from anniversary date for the first time). The common value for
billingPeriod.config between 28 and 31.

• FIXED_DATE: This model defines a billing period as a calendar month ending the day
before a fixed date every month. The billingPeriod.config in this case is the date on
which the billing period is reconciled (in other words, the books are closed for the
month ending the day before). For example, if billingPeriod.config is 1 (a common
setting), then the account statements are posted on the 1st of every month. In the
fixed date model, the billingPeriod.config cannot be greater than 28.

• ANNIVERSARY_DATE: This model is a variation on the FIXED_DATE model and defines a
billing period as a calendar month ending the day before a fixed date every month, but
the date being determined by the anniversary date (that is the date the customer
registered) of each customer independently. This means customers who registered on
the 5th will have their billing periods end on the 4th of every month, but a customer
who registers on the 12th will have the billing period end on the 11th of every month.
Customers who register on dates after the 28th get reset to the 28th starting the
second month. In this model, the billingPeriod.config is ignored.

For all practical purposes, CPBM uses the term MONTH to be synonymous with billing
period, for user friendliness.
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Account Statement

Every billing period, CPBM posts an account statement that provides information about the
current state of the account from a billing perspective. In the 'current' billing period, CPBM
attempts to keep an accurate record of the user's spend on a daily basis. However, until the
account statement is posted, the information in the current account statement should be
considered subject to modification. In this state, the account statement is considered to be
in a PROVISIONAL state. Once posted, the account statement is in a POSTED state. All
POSTED account statements are read only and will not be modified by the system ever
again.

Balance Forward
Every month, an account statement is initialized in a PROVISIONAL state with its opening
balance the same as the Net Balance of the previous month's POSTED account statement,
essentially carrying the previous account statement's balance forward. This amount is
represented as the *Balance Forward*. This is always guaranteed to be the same as the
previous month's posted account statement.

The only exception is to this rule is that on the date of invoicing, there is a lag between
midnight and the time the account statement is computed and posted, during which the
account balance of the current month will not reflect the last day's charges. This will be
corrected once the previous account statement is posted.

Payments and Credits
All payments made and service credits issued to the customer are recorded and aggregated
in this section. Automated payments for the previous account statement will be credited in
the current account statement, as payments are made against posted account statements
only.

Charges
All charges to the account are accrued and aggregated in this section. All accrued charges
are recorded as invoices in CPBM.
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Invoices

Invoices have invoice line items that detail the charges that make up the invoice. In
addition, each invoice, when posted will show the discounts applied and the taxes owed for
that charge. The number of discount line items and the number of tax line items that are
presented in the invoice will depend on the discount and tax engines configured in the
system and may produce zero or more line items. Because utility prices for cloud resources
can sometimes be less than the smallest currency unit (for example, microcent pricing in
USD, such as 0.0032 USD per GB of bandwidth), invoice line items will be based on the
appropriate precision as determined by the pricing of the purchased product. However, the
billing system works only in currency precision. Therefore, all sub totals (charges, total tax,
total discount, and net amount) of an invoice are in currency precision only. How these
subtotals are rounded (up, down, ceiling, floor, and so on) is dependent on configuration
and can be modified. The default rounding in the system is HALF_UP, which means 0.0050
and above will get rounded to 0.01.

There are three kinds of invoices. They are described in the following sections.

Subscription invoices
These are invoices for any user subscriptions to bundles. These are categorized by
subscription type and are tied to the subscription and the user that owns the subscription.

In 1.x, CPBM used to create charge line items for each subscription in the invoice for the
month. In 2.x, CPBM correctly creates invoices for each subscription, which details the
charges for each subscription. In addition, CPBM creates an invoice for each subscription's
renewal separately.

Close Out invoices
Close out invoices are posted every day and record utility spend (i.e, spend for any usage
that are not covered by entitlements provided by the subscriptions to bundles) on a per
user basis. Note that these invoices are also tied to specific users. In other words, there will
be one close out invoice per day per user in the tenant. This allows the system to
accurately record the spend of each user.

In 1.x, CPBM used to accrue only month to date information on per product basis. When
consolidated at the end of the month, CPBM would apply taxes and discounts to each
product's usage for the month. In 2.x, in order to ensure accurate daily spend and to ensure
that daily pricing was reflected in the charges, CPBM moved to a model of tracking daily
spend. Due to this, close out invoices are now recorded on a daily basis, which means while
it is still possible to get actual month to date usage of a given product, that amount does
not account for discounts and taxes. Instead discounts and taxes are applied on a daily basis
for the aggregate of all utility spend for the day.



Debit Notes
Debit notes are applied whenever a simple amount (i.e, no taxes, discounts, and so on)
need to be charged to the account. This can happen for various reasons, but out of the box,
debit notes are created only when a payment is cancelled. In CPBM, you can cancel any
past credit (automated, recorded, manual, or service credits). It is important to note that
while payments and credits for past account statements can be cancelled, the debit note
will always appear as a charge in the current account statement. When automated
payments to credit cards are cancelled, they are also charged back to the credit card.

Renewal Charges
In addition to the invoices mentioned, invoices for any renewals that are due in the current
billing period are created at the beginning of the billing period (or immediately in case the
subscription itself occurred in the middle of this billing period). These renewal invoices are
posted when they become due. Monthly renewals are due at the end of the previous month,
and therefore get posted just before the account statement is posted. Renewal invoices for
all other renewal periods (such as quarterly or annual) are posted on the day they are due.
Renewal invoices will be cancelled if the subscription is cancelled before the renewal
becomes due. Once posted, the customer owes the amount of this invoice and this cannot
be revoked or canceled. For example, if you subscribed for a quarterly subscription on the
15th of January (assuming fixed date billing mode, with date set to the first of every
month), in the beginning of March, that is March 1, the system will create the renewal
invoice for that subscription. That invoice will be posted on the 15th (i.e, as of the 14th).
Cancelling the subscription before March 15th will cancel the renewal invoice, but
canceling it on the 15th and beyond will not. The customer will owe the amount after that
point (even if the actual payment will be done after the account statement is posted on
April 1.

This allows the customer to see the renewal charges that will be posted to the account in
any given month, even if they only become due later, so they have an opportunity to cancel
the subscription.

Invoices
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Accounting for Entitlements

Entitlements are accounted either to usage accrued to a given subscription or in a
consolidated manner at the user level. Whether usage is accrued to a subscription or to the
user is dependent on the specific product being entitled and the specific type of the bundle
being subscribed to. For example, VM running time, can be accrued to a virtual machine,
but data transfer is usually not attributable to the virtual machine as it shares the network
on which the traffic is being generated and accounting for data transfer is done at the
router. So, when purchasing a virtual machine, data transfer entitlements in the associated
bundle will be added to the user's overall entitlements for data traffic, whereas when
purchasing a network, the data transfer on that network will be tied specifically to that
subscription.

Note: This above model of accruing entitlements is different from CPBM 1.x, where
entitlements were accrued at the account level and not on a per user basis. In 1.x this
meant that unused entitlements from one user's subscriptions spilt over to other users.
That implied, that CPBM could not keep accurate track of individual spend of a given
user, as it got diluted with entitlement data from other users.

Price Selection
Since prices can be revisioned in CPBM, it is important for CPBM to charge appropriately
based on pricing changes. For all utility pricing, CPBM will pick up the latest prices on a
daily basis to apply to any utility charges. This allows operators to change the prices and
have the updated prices passed on to the consumer by the next day. For all subscriptions,
pricing will be the latest price on the date the renewal invoice is posted. Note that this
means that if the prices change between renewal invoice generation and posting, the new
price will be reflected at the time of posting (but at the time of posting only).

Prorating
For monthly invoices only, subscription charges are always prorated when subscriptions are
created to pay only for duration of the month that the subscription was active. This is done
at the granularity of a single day. In addition, all entitlements will also be prorated
accordingly.
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Subscriptions

Terminating Subscriptions
Subscriptions can be terminated. When a subscription is terminated, there is no proration
of charges, and no credit is given. This is because subscriptions are charged in advance for a
committed period of time. However, since the subscription is fully paid for that period, all
entitlements (except unlimited entitlements that are dependent on the resource existing)
that are eligible for that period continue to be accounted for during billing.

Changing Subscriptions
Subscriptions can be changed to shift from one bundle to another. In this case, the system
will treat this action as terminating the first subscription and subscribing to the new
subscription. Note that this means that while the new subscription will be prorated for the
remainder of the month, if monthly and there will be no credit for unused entitlements
from the original bundle. However, as before, entitlements will also be provided based on
what the original bundle provided in addition to any prorated entitlements that will be
available from the new bundle.
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Instant Payment

When instant pay is turned on for any account type, the first invoices for any bundle
subscription will be paid for immediately. This is applicable only to account types that
require payment information that can be used to automatically charge the customer. These
payments will be accrued in the current account statement as well since it was made in the
current billing period.
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Billing for Discrete Products

Every usage consumed of discrete products is billed for the whole billing period even if it is
used partially. This is a crucial difference between metered and discrete usage type. The
mailbox is an example of a discrete product. One day usage for a mailbox will be charged
for the whole month in which it was created.

Note: If the mailbox is destroyed, it will be charged only for the billing period in which it
existed and will not be charged from the subsequent billing period.

Usage pattern for discrete products
Example 1: Consider a three day billing period for the mailbox usage as an example.
Assuming that the usage of maiboxes, m0, m1,.....,m7 are follows:

• Day 1: m0 is carried forward from the previous billing period; m1, m2, m3 created; m0
destroyed.

Day 1 is the start of a new billing cycle. Mailboxes m1, m2, and m3 are created in this
billing period and hence will be charged for the entire billing period. Though the
mailbox, m0, which was carried from the previous billing period is destroyed it will be
charged because it was active at the begining of Day 1. The usage will be four because
four mailboxes were active during the day.

• Day 2: m4 created; m1 destroyed.

The usage will be one because the new mailbox, m4 is created. The usage of the
mailbox, m1 is already considered in Day1 and hence is not taken into account

• Day 3: m2, m3 destroyed.

The usage will be zero because no new mailbox is created. This is the last day of the
current billing period.

• Day 4: m5, m6, m7 created; m5 destroyed.

Day 4 is the beginning of a new billing period. The mailbox, m4 is carried over to this
current new billing period and is therefore charged in this billing period too. Mailboxes
m1, m2, and m3, were created and destroyed in the last billing period and will not be
charged in this billing period. Mailboxes m5, m6, and m7 are newly created in this
billing period and hence will be charged for the entire billing period. The usage for Day
4 will be four because four mailboxes were active during the day.

Example 2: Consider a billing period of 30 days for mailbox usage. Assuming that the usage
of mailboxes, a,b,c,.....,j are specified in the following table.

Note: The alphabets are active mailboxes during day (one in square brackets are the
mailboxes that got destroyed during the day)



Day 27 Day 28 Day 29 Day 30 Day 1 Day 2

a a a a a a

b b [b] e e e

c c [c] f f f

d [d] d g g g

e h h h

f i i

g j j

h
• Case 1:Suppose usage marker(u) is set to end of day (EOD) of Day 27. And for some

reason collection is not able to run from Day 28 to Day 1, then on Day 2 inventory
will be called with start_marker as 'u' and billingPeriodStartDate as EOD of
Day 1. Expected result in this case will be as follows:

• Day 1: +7 (2 new mailboxes got created and 5 existing )
Hence on Day 2, inventory will return 7 and the usages for 28, 29, and 30 will be
ignored.

• Case 2: Suppose usage marker(u) is set to EOD of Day 27. And for some reason
collection is not able to run from Day 28 to Day 30, then on Day 1 collect will be
called with start_marker as 'u' and end_date as EOD of Day 30. Expected result in
case will be as follows:

• Day 28: 0 (Nothing new got created)

• Day 29: +4 (4 new mailboxes got created)

• Day 30: 0 (Nothing new got created)
Hence on Day 1, collect will return 4.

Billing for Discrete Products
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Operating CloudPortal Business Manager
in Intranet

As a service provider, you can run CloudPortal Business Manager (CPBM) in the intranet in
secure enterprises. This means that you can operate CPBM seamlessly when the
environment does not have access to Internet.

However, third party web services require Internet access. Therefore, you must make sure
that the B/OSS services that require Internet access are disabled.

The following are affected, if CPBM runs within the organization's intranet:

• ReCaptcha: Google ReCaptcha will get disabled. Refer to Configuring account lockout
settings

Note: ReCaptcha will not appear for self-registrations of user accounts.

• Gravatar: The system cannot fetch the user's profile image, if available in Gravatar

Configuring Intranet Mode Settings
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Configuring Intranet Mode Settings

To configure CloudPortal Business Manager to run in the intranet mode, perform the
following steps.

Note: As a service provider, you can perform the following steps to disable ReCaptcha.

1. Log in to CloudPortal Business Manager UI as Root user

2. Click the drop-down menu icon in the top right corner next to ROOT USER

3. Click Administration > Configuration > Portal

4. Click Server > Configure

5. Click Edit

6. Set the following parameter:

Parameter Name Description

use.intranet.only Set this to "true".

The default value is "false".
Refer to Configuring Server Settings for the Portal

7. Click Save

8. Click Close
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Migration Guide

This guide describes the upgrade mechanism for CloudPortal™ Business Manager (CPBM)
2.3.x release from CPBM versions 1.4.3 through 1.4.7. It provides the insight into supported
upgrade paths, migration strategy, assumptions in existing system before upgrade and
impact on customization.

Supported upgrade paths:

1. CloudPortal™ Business Manager (CPBM) versions 1.4.3 through 1.4.7 to CPBM 2.3.x.

2. Customers who have CPBM version lower than 1.4.3 have to upgrade first to CPBM 1.4.3
in order to upgrade to CPBM 2.3.x.
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Upgrade Mechanism

In a multinode environment, code upgrade (execute the command ./install.sh with option
U) must be performed on all the servers, but the shell script for database (DB) upgrade has
to be run on one of the nodes only.

It is assumed that the earlier setup of CloudPortal Business Manager (CPBM) v1.4.3 through
1.4.7 is upgraded to CPBM v2.3.x on the same setup where it was running earlier. No
changes to the setup are made during the process of upgrade.

Rollback mechanism
On upgrade failure, none of the automatic restoration is supported. However, CloudPortal
Business Manager database (DB) dump is automatically backed up and stored at
/usr/share/cloud/portal/upgrade-dump/. After successful upgrade, the dump file can be
moved to some other location.

Note: It is strongly recommended to save these backup file(s) for longer time in case of
any data issue discovered after migration.
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List of Pre-checks

Following list describes some of the pre-conditions required for CloudPortal™ Business
Manager upgrade.

• All Products should have some price set in reference catalog.

• Product Bundle can have unlimited entitlement only for the following products -
RUNNING, ALLOCATED_VM

• Upgrade should happen on same machine where CloudPortal Business Manager 1.4.x was
installed.

• Authorize.Net and CyberSource are the only supported payment gateways for upgrade.
One of them has to be configured in the system for upgrade.
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Upgrade steps

Note:

• CCP management server must be up and running while performing the CloudPortal
Business Manager (CPBM) upgrade.

• Make sure that you take a backup of CPBM database (DB).

• If upgrade fails, automatic system rollback is not supported. It is therefore strongly
recommended to take the complete VM backup or snapshot of the CPBM server and DB.

Pre-requisites:

• Make sure that the cloud-portal service is stopped before the upgrade is performed. In
a clustered setup, the cloud-portal service must be stopped on all nodes before
upgrade.

• Before upgrade, if the cloud.properties file contains encrypted values of any property,
they must be replaced by the clear-text (or decrypted) values. These properties can be
replaced by encrypted values post upgrade. The cloud.properties file path is:
/etc/cloud/portal/cloud.porperties.

• The value of the following MySQL variables must be 1:

• auto_increment_increment

• auto_increment_offset
Use this MySQL command to check the value of the variables:

 mysql> show variables like '%increment%'

If current value of these variables is anything other than 1, then use the following
command to update their values:

 mysql> SET @@auto_increment_increment=1;
 mysql> SET @@auto_increment_offset=1;

Requirements

Requirement Version

CloudPortal Business Manager
(old)

1.4.3 to 1.4.7 (any)

CloudPortal Business Manager
(new)

2.3.x (any)

Python Default with CentOS (Python 2.4 for CentOS 5.6 and
Python 2.6 for CentOS 6.3)

Use the following commands:

yum -y install MySQL-python



yum -y install unzip

yum –y install mysql

if you want to
• install the required packages, if they do not exist

• update the packages with their respective latest version

Steps to upgrade CloudPortal Business Manager 1.4.3 through 1.4.7 to CloudPortal
Business Manager 2.3.x

Perform the following steps to upgrade CPBM 1.4.3 through 1.4.7 to 2.3.x

1. Download the CPBM version 2.3.x tar ball from the CPBM download site.

2. Stop the cloud-portal service on all the active nodes using the command service
cloud-portal stop

3. Go to the console of your primary node and perform the following steps:

4. Copy and extract the CPBM tar ball in any location <untar_location>.

tar -zxvf CloudPortal-2.3.x-centos.tar.gz

5. cd <untar_location>

6. Run installer using ./install.sh 2>&1 | tee installer.log

Note: Make sure that you take a backup of CPBM and DB (preferably complete CPBM
VM).

7. Read and accept Citrix End User License Agreement.

8. From the Install options available in the menu, select U to upgrade.

9. Follow the instructions that appear in the Upgrade wizard.

10. Select the option Q to quit.

11. Following are the commands for the database upgrade of CPBM, that must be run only
once (on any one node in the clustered environment):

cd <untar_location>/migration/2.3/from/1.4/scripts
./dbupgrader.sh 2>&1 | tee dbupgrader.log

12. After the steps 1 to 11 are successful, start the CPBM server by using the command
service cloud-portal start

13. Repeat steps 4 to 10 for each of the secondary nodes.

14. If the proxy server is configured with port 20410. then make the changes given below in
the tomcat-server.xml file:

Upgrade steps
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<Connector port="20410" protocol="AJP/1.3"
redirectPort="8443"
URIEncoding="UTF-8"/>

15. Additionally execute the following command for each of the secondary node:

cd <untar_location>/migration/2.0/from/1.4/scripts
./ copy-connector-resources.sh

16. If the cloud.properties file contains encrypted values of any property then, after the
upgrade follow these steps:

a. Replace these properties by the encrypted values.

b. Modify the file /etc/init.d/cloud-portal:

Replace the text 'IS_CLOUD_PORTAL_ENCRYPTED=0' with
'IS_CLOUD_PORTAL_ENCRYPTED=1'

17. Start the cloud-portal service on each of the secondary nodes using the command:

service cloud-portal start

Note: Make sure that the browser cache is cleaned after upgrade.

Upgrade steps
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Impact on customization

Magnitude of impact on customization depends on the degree of customization. Some of the
very obvious points are reported below.

1. Any dependency on service layer methods of CloudPortal™ Business Manager core code
base is not guaranteed to be backward compatible.

2. Many new UI screens are built in CloudPortal Business Manager 2.x and some of the
existing ones are changed. This means any customization done for UI requires a careful
review.

3. Some of the features, which were not present in CloudPortal Business Manager product
earlier and required customization in past to achieve the same, may be supported in
product itself now. Refer CloudPortal Business Manager 2.x features for the same.

4. Customization written based on assumption of some columns in database tables may
undergo huge impact. Refer to new schema structure for the same.

5. Configuration file to set log levels (log4j.xml) is no longer in use now. New file to
configure log levels is located at/usr/share/vts3/config/serviceability.xml. New logging
mechanism supports both Log4j and Logback. However, transformation from old
configuration file (log4j.xml) to new configuration file (serviceability.xml) is not
supported. You have to reconfigure log levels in serviceability.xml.

6. Authorize.Net and CyberSource are the only supported payment gateways. If different
payment gateway is used, one needs to write CloudPortal Business Manager connector
for the same. For more information, please refer CloudPortal Business Manager
Connector Developer guide.

7. All resource strings are persisted in database now. The mechanism to create custom
resource strings is described in customization section in the Administration guide.

8. CloudPortal Business Manager now supports multi-level approvals for custom actions
(workflows) such as account provisioning, subscription provisioning and account
conversions. Any customization done prior should be rewritten using concept of
customization bundle, where you can define and customize workflow and activities in
structured manner in xml files. CloudPortal Business Manager will process these files
and will instrument the customized workflows and activities. For more information
refer, creating customized bundle section.

9. If any phase of usage collection and mediation is customized in CloudPortal Business
Manager 1.4.x, same needs to be re-implemented using the product features of
CloudPortal Business Manager 2.3.x.

10. Impact on CAS: If additional services are added in deployerConfigContext.xml, they
need to be re-written after upgrade.

11. Impact on SSL Certificate: After upgrade to CPBM 2.4, re-import the SSL certificate
using the command:



/usr/java/latest/bin/keytool -import -alias alias -keystore
/usr/java/latest/lib/security/cacerts --file cert1.cer

 Impact on customization
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Migration to Cloud Service, OSS and
associated Service Instances

Concept of IaaS, Payment Gateway and Ticketing, Fraud control etc. is abstracted to Cloud
Services and OSS in CloudPortal™ Business Manager 2.x. To setup the system to use this
multi-service model, upgrade script automatically reads properties from cloud.properties
and relevant tables. With help of this configuration setup in past, it creates service
instance automatically. It automatically creates service instances for IaaS, Ticketing, and
Payment Gateway, Credit card fraud control, Device fraud control, IP locator and Phone
verification. If any of them is not enabled in the system before upgrade, script will not
create any instance of the same.

Migration of properties in cloud.properties file
Following list details the properties that are migrated in cloud.properties file:

• Names of many properties in cloud.properties file are changed and some of them are
migrated to database from properties file. Upgrade takes care of them automatically.

• Location of the cloud.properties file is changed from
/etc/cloud/portal/cloud.properties to
/usr/share/vts3/repository/prop/cloud.properties. Upgrade takes care of change of
location for the cloud.properties file.

• Some of the properties are now specific to service instances, and will be moved to
database after upgrade. Upgrade takes care of them.

Migration of Workflows
Workflow is a new feature in CloudPortal™ Business Manager 2.x. All the pending changes
such as account creation and account conversion etc. will be migrated in form of "workflow"
and "tasks". Any customization done for the same should be revisited in customization
bundle to configure relevant xml files.

Migration of Billing
Billing has undergone metamorphosis in CloudPortal™ Business Manager 2.x. Both functional
and technical implementations are changed to a large extent. Some of the points are
highlighted below -

• Creation of each subscription will create an invoice. As soon as the subscription is
created, a new invoice is generated. This invoice is called 'Subscription' invoice, which
is accompanied by 'Renewal' invoice in case of monthly subscription.



• Even though invoice is created instantly on creation of subscription, payment of any
invoice is not forced instantly unless it is configured to do so before upgrade. i.e., In
CloudPortal Business Manager 1.4.x, Autopay & Instant invoicing should be on for the
account types to make sure, instant pay is on in CloudPortal Business Manager 2.x.

• Depending on the state & renewal date of subscriptions, necessary "Subscription" and
"Renewal" invoices will be created.

Note: Make sure all the billing related jobs are successful for the previous run and system
is in stable state on the day of migration.

Migration of Products and Product Bundles
Functionalities for Products and Product Bundles are augmented. In order to support
migration for the same, default constraints are assumed. New products and product bundles
created after upgrade can use the new features of CloudPortal™ Business Manager 2.x.

 Migration to Cloud Service, OSS and associated Service Instances
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List of behavioral changes

Following list describes the list of features where behavior is changed in CloudPortal™
Business Manager 1.4.x. This list is addition to all the design changes stated in the earlier
sections in this document. For more information on the feature list, refer to CloudPortal
Business Manager 2.x documentation.

• If any bundle has more than one revision in current billing cycle & has an active
subscription corresponding to it, then the subscription will be charged based on the
most recent subscription charge of that bundle in the channel.

• Subscription has been decoupled from resource provisioning in CloudPortal Business
Manager 2.x onwards. For example, destroying the resource does not terminate the
subscription to which that resource was tied to. The subscription will continue to be
charged, and user can re-provision a resource under that subscription.

• There is no restriction on launching a VM for a specific service offering and template
group combination. On the contrary, in CloudPortal Business Manager 1.4.x, there were
some constraints based on combination of service offering and template groups.

• Payment need not be done for a specific invoice. That means payments are now
account wise and can be made even if there is no invoice due. Payments are decoupled
from invoice. All payments are credited to account balance which is reflected in
Account statement.

• In CloudPortal Business Manager 1.4.x, the entitlements are shared across all the users
of the account whereas in CloudPortal Business Manager 2.x. onwards, the entitlements
are user specific.

• Product Bundles cannot be removed from CloudPortal Business Manager 2.x. onwards.

• CloudPortal Business Manager 2.x will track the daily usage and daily spend per user,
per day by default. It is not so in the older versions (unless configured). However, even
if CloudPortal Business Manager 1.4.x is configured to use user daily usage data, the
user usage data will not be migrated on daily basis. Adjustment invoice will be created
for each user for the earlier usage while migrating.

• Logs of CloudPortal Business Manager from versions 2.x onwards are present in
/usr/share/cloud/portal/logs/cpbm-server.log.

• Service Provider will no longer be able to set up Service Health status and Maintenance
specific to a CCP zone. These will have to be set for specific service instance
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Known issues

Following list describes some of the conceptual changes and observations along with
workaround:

• In CloudPortal™ Business Manager (CPBM) 1.4.x, when an account is created, the
domain is also created simultaneously in Cloud Stack. After upgrade, even if the
account has any pending workflow such as email not verified or credit card details not
entered, user still sees that the service instance to the cloud portal is enabled.

• For all inactive catalogs, prices will be null. You need the Catalog to synchronize with
reference Catalog.

• Non Billing Admin Tenant users will no longer be able to see charges incurred to them
for past Billing Periods.

• Non Billing Admin Tenant users will be able to see discounts and taxes on charges
incurred by them for the current period.

• If there are any terminated accounts in the system, then billing job after migration
might give partial error for terminated account.

• For products, types do not exist in CPBM 2.x. Instead, categories are introduced. Right
now all the categories are shown as uncategorized after upgrade.

• If autopay is disabled & instant invoicing is enabled, then the autopay flag gets
enabled. However, this is an unsupported configuration.

• After upgrade, the details page, of existing invoices, displays empty fields for
description, quantity, and chargeable units.

• After upgrade from CPBM 1.4.x to CPBM 2.x, network offering is displayed twice in the
Provisioning Constraints page of the Add Product Bundle wizard.

• After upgrade from CPBM 1.4.x to CPBM 2.3, any customization of the signature in
content template is lost.

• After upgrade from CPBM 1.4.x to CPBM 2.x, the "hours.in.usage.units.of.month" billing
parameter gets reset to 744.

Workaround: In case you have set the value for the configuration
"hours.in.usage.units.of.month" in CPBM 1.4.x, then after upgrading to 2.x, you have to
reset it back to its original set value from Administration > Configuration > Portal >
Billing > hoursIn.month.

Warning: CPBM upgrade is not supported on the physical server and is only supported on
the VMs.
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Extending and Customizing CloudPortal
Business Manager

CloudPortal Business Manager can be extended and customized to meet you business needs.
Refer to the following sub-sections to understand in detail what are the options available to
extend and customize CPBM:

BSS API Guide

BSS API Reference

Connector Development Kit

Customization Guide

CPBM Backward Compatibility Suppport Matrix

http://support.citrix.com/proddocs/topic/cpbm-23-map/cpbm-21-bssapi-wrapper-con.html#concept_058F004ED9A34104A92ED5AED928A27C
http://support.citrix.com/proddocs/topic/cpbm-23-map/cpbm-bss-api-reference-wrapper-ref.html#concept_B28EA9E8F3E6441D907847F41E208A91
http://support.citrix.com/proddocs/topic/cpbm-23-map/cpbm-cust-wrapper-con.html#ccpb-ccp-conn-wrapper-con
http://support.citrix.com/proddocs/topic/cpbm-23-map/cpbm-backward-compatibility-support-matrix-con.html#concept_B28EA9E8F3E6441D907847F41E208A91
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BSS API Guide

The BSS API Guide is a task-oriented explanation of how to write, preprocess, compile, and
link database applications using the BSS Applications Programming Interface (API).

In This Section
Intended Audience

Overview of BSS API

REST Architecture

BSS API data model

Simulating PUT and DELETE

Custom Actions

Requesting data formats

Standard query parameters

Root API path and versioning

Sample responses

Localization

Using the API

Known issues

http://support.citrix.com/proddocs/topic/cpbm-23-map/cpbm-audience-con.html#concept_78B2E207822049E28D10AEE7652A778D
http://support.citrix.com/proddocs/topic/cpbm-23-map/cpbm-overview-con.html#concept_62085A803EC4496F93B3166EBE59BACB
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Intended Audience

This guide is for the software developers who want to develop customer portal for CPBM
that can interact with BSS API.

To use this guide, you should have a working knowledge of the following subjects:

• Knowledge of JSON and/or XML data serialization formats

• Knowledge of a programming language for example, Java

• Knowledge of REST web services
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Overview of BSS API

Citrix® CloudPortal™ Business Manager Business Support System (BSS) API (henceforth
referred to as the BSS API) is a platform that allows developers to create new management
solutions or integrate existing systems with CloudPortal. The BSS layer focus towards
customers and business partners. This BSS API provides a ReSTful (Representational State
Transfer) web service interface. The BSS API supports four possible actions (Get, Put, Post,
and Delete) on exposed resources and supports responses in either XML or JSON response
formats. This API represents the set of business-related services exposed by the CPBM that
are used to implement a cloud service.
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REST Architecture

Representational State Transfer (REST) is an architecture that provides a consistent
approach to request and modify the data. In this architecture, resources are stored in a
data store, and when the client sends a request to the server for a particular action, the
server performs the action and sends a response in the form of a representation of the
specified resource. It is possible to invoke the API via HTTP or HTTPS through a certified
authentication.
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BSS API data model

A resource is an individual data entity with a unique identifier. The BSS API follows the
conventions detailed below:

• All APIs are written in lower case.

• For a given resource, the API will reference the plural form of the word. For example,
for resource Account, all APIs will reference it as accounts.

• The date value arguments will expect value in ISO 8601 format i.e.,
YYYY-mm-ddTHH:mm:ss.[mmm]TZ. Please refer the following document
http://www.w3.org/TR/NOTE-datetime

http://www.w3.org/TR/NOTE-datetime
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Supported Operations

Operations are the actions you perform within your account. Creating, deleting or updating,
retrieving. Operations are performed through the ReST web service API.

For every resource exposed, the base URL is fixed to be the name of the resource (in plural)
and for referring to single entities of a given resource type, the base URL is appended with
the UUID of that resource. For example, given a resource Order. The base URL will be:

/orders

And for a single order, the base URL will be:

/orders/<uuid>

Operation /orders /orders/<uuid>

GET Gets all the orders Get this order

POST Create new order Create this order (Not
supported)

PUT Update all orders (Not
supported)

Update this order

DELETE Delete all orders (Not
supported)

Delete this order
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Nested Resources

For nested resources, the base URL of that resource should be appended to the parent
resource base URL.

For example, for line items of order ID 32 the base URLs will be

/orders/32/line_items

/orders/32/line_items/21
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Simulating PUT and DELETE

When using browsers or other clients that do not support the PUT and DELETE methods, the
parameter _method may be used along with a POST request to request the server to treat
the request as a PUT or DELETE.

For example, to simulate a delete of order 21 you would use:

POST/orders/21?_method=DELETE
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Custom Actions

Custom actions are avoided as much as possible. However, certain operations are exposed
as custom actions. Custom actions on a given resource are appended to the base URL and
are documented along with the details of each Resource.

For example, say an execute action for an Order 23 will be represented as

/orders/23/execute
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Requesting data formats

By default, the BSS APIs will return JSON. To request a specific format, the API call can be
appended with a suffix, currently only .json and .xml, which will return JSON and XML
respectively. Alternatively, the BSS API will also support the Content-Type header to set
format. When both Content-Type and the suffix are provided, the suffix will take
precedence.
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Standard query parameters

Where supported, the API uses standard query parameters to support search, filter,
pagination and expansion. All APIs will use these parameters when they support the
specified functions.

These parameters are detailed in the table below:

Parameters Description

q search string for a search, typically used in the list calls
(e.g. GET /orders)

page Used to paginate, represents page number

pagesize No. of items to return per page

expand Request expansion of nested entities

(Expand is optional comma separated list of one or more
inner objects of REST resource)

order asc|desc. Order by specified field in ascending /
descending order

<name>=<value> Filter by field specified by name with value provided.

sort <field>, field to sort

Example for expand
Suppose we have object "foo", which contains list of "bar" Objects. foo object expanded
view:

name

fooid

uuid

bar

bar Object expanded view

bar Object expanded view

name (minimal)

displayname

address

pincode



country

emailed (minimal)

phone (minimal)

address Object expanded view

name (minimal)

street1

street2

city (minimal)

state

Response for the query listFOO, gives the expanded representation of foo, but minimal
representation of bar object.

In request query, if there is no expand, such as http://<IP:Port/api/listFOO ?>, then the
response will be:

{
   "count":1,
   "foolist":[
      {
         "uuid":"9fc7754c-6d46-11e0-a026-065287aed31a",
         "name":"SERVICE",
         "fooid":"00000000",
         ”barlist”:[
            {
               " name  ":"SYSTEM",
               “emailid”:”abc@xyz.com”,
               “phone”:”213412341”
            }
         ]
      }
   ]
}

In request query, if expand = bar, such as http://<IP:Port/api/listFOO?expand=bar > then
the response will be :

{
   "count":1,
   "foolist":[
      {
         "uuid":"9fc7754c-6d46-11e0-a026-065287aed31a",
         "name":"SERVICE",
         "fooid":"00000000",
         "barlist":[

Standard query parameters
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            {
               "name":"SYSTEM",
               "displayname":"System",
               "address":{
                  ”city”:”cityname”
               },
               ”pincode”:”213123”,
               “Country”:”someCountry”,
               “emailid”:”abc@xyz.com”,
               “phone”:”213412341”
            }
         ]
      }
   ]

In request query, if Address along with "bar" needs to be expanded, then the query should
contain expand = bar.address, such as

< http://<IP:Port/api/listFOO?expand=bar.address >, then the response
will be:

{
   "count":1,
   "foolist":[
      {
         "uuid":"9fc7754c-6d46-11e0-a026-065287aed31a",
         "name":"SERVICE",
         "fooid":"00000000",
         ”barlist”:[
            {
               "name":"SYSTEM",
               "displayname":"System",
               address”:{
                  “stree1”:”1st street”,
                  ”street2”:”street2”,
                  ”city”:”cityname”,
                  ”state”:”state”
               },
               ”pincode”:”213123”,
               “Country”:”someCountry”,
               “emailid”:”abc@xyz.com”,
               “phone”:”213412341”
            }
         ]
      }
   ]
}

Multiple expand:

Suppose "qux" is another object in foo along with "bar", that can be expanded as well, then
the query should be expand=bar,qux as in:

< http://<IP:Port/api/listFOO?expand=bar,qux >

Standard query parameters
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Root API Path and Versioning

The root path will be /api/orders which in turn hit the latest version of the API. All earlier
versions will be available as /api/<version no>/orders.

APIs will have only one major revision number. All changes within a given version will
remain backward compatible. Backward compatible changes include:

1. Addition of new entities and custom actions.

2. Support for additional verbs for resources that previously did not support them.

3. Addition of new fields in responses.

4. Mandatory request parameters may be made optional.
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Sample Responses

BSS API supports two formats as the response to an API call. The default response is JSON.
To request a specific format, the API call can be appended with a suffix, currently only
.json and .xml which will return JSON and XML respectively.

Customization of date format is also supported and this can be done by setting the date
format from the Administration > Configuration > Portal > Server page.

Sample JSON response:

Request URL:

http://10.102.153.50:8080/portal/api/accounts?expand=owner&q=retail&p
age=1&pagesize=5&sort=name&order=asc&_=<timestamp>&apiKey=<apikey>&si
gnature=<generatedSignatureUsingSecretKey> or http://10.102.153. 50:80
80/portal/api/accounts.json?expand=owner&q=retail&page=1&pagesize=5&s
ort=name&order=asc&_=<timestamp>&apiKey=<apikey>&signature=<generated
SignatureUsingSecretKey>

Response:

{
   "accounts":[
      {
         "uuid":"6477e245-db16-4863-9b2f-aef2cb984d21",
         "name":"abhai@retail",
         "accountId":"AA000011",
         "state":"ACTIVE",
         "sourceChannel":{
            "uuid":"0ed2ca51-2421-4df7-971e-70d7a2d3321d",
            "name":"channel",
            "code":"channel",
            "description":"channel"
         },
         "accountType":{
            "name":"RETAIL",
            "displayName":"Retail",
            "description":"Retail customer type. Credit card will be charged automatically when payments are due."
         },
         "spendLimit":1000,
         "initialDeposit":0,
         "spendBudget":0,
         "owner":{
            "firstName":"Abhai",
            "email":"k.abhai@citrix.com",
            "lastName":"Kumar",
            "phone":"91-9379682039",
            "username":"abhai@retail",
            "uuid":"3651d8ba-ffdd-46ec-88ae-22b70ff0c204",



            "address":{
               "city":"sbc",
               "country":"IN",
               "postalCode":"560075",
               "state":"KAR"
            },
            "apiKey":"XUyCQVb7S_WOGsDiEBG1wqNKyCqJmk6e97ZnOycU8-8HEaJjqqztEdZOpXF2cb1EOzZ-Vr1423iNajNJYV2gXA",
            "countryCode":"91",
            "gravatarUrl":null,
            "profile":{
               "name":"Master User",
               "description":"Master user"
            },
            "enabled":true,
            "secretKey":"3FRXeqBtzu61aoGEVDPxyK4T1MXAE8dwJxb8TwX7qld8BccrKgfwlqFOTFy9iLTyM-ZTDntXtDHaeNr8t6uO0w",
            "spendBudget":0,
            "title":null,
            "timeZone":"GMT"
         },
         "address":{
            "city":"sbc",
            "country":"IN",
            "postalCode":"560075",
            "state":"KAR"
         },
         "secondaryAddress":null,
         "currency":{
            "currencyCode":"USD",
            "currencyName":"US Dollar"
         },
         "memo":null,
         "trialAccount":null,
         "tenantExtraInformation":{
            "anniversaryDate":"24 Apr 2013 12:00:00 UTC",
            "nextInvoiceDate":null,
            "discountPercent":"0.0000"
         },
         "deposit":null,
         "remoteAddress":"10.252.240.188",
         "removed":null,
         "removedBy":null,
         "imagePath":null,
         "faviconPath":null,
         "usernameSuffix":null,
         "users":[
            {
               "firstName":"Abhai",
               "lastName":"Kumar",
               "username":"abhai@retail",
               "uuid":"3651d8ba-ffdd-46ec-88ae-22b70ff0c204"
            },
            {
               "firstName":"Normal",
               "lastName":"Kumar",
               "username":"retail@normal",
               "uuid":"a2856513-b3bd-4034-b9a2-5bc4fe74164d"
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            },
            {
               "firstName":"Power",
               "lastName":"Kumar",
               "username":"retail@power",
               "uuid":"48f123c4-4ece-425f-a320-73f212262fca"
            },
            {
               "firstName":"Billing",
               "lastName":"Kumar",
               "username":"retail@billing",
               "uuid":"b4c0a44e-3060-4e5c-b290-3ea37329ae3a"
            }
         ]
      },
      { "accountId":"AA000001",
         "state":"ACTIVE",
         "sourceChannel":{
            "uuid":"0ed2ca51-2421-4df7-971e-70d7a2d3321d",
            "name":"channel",
            "code":"channel",
            "description":"channel"
         },
         "accountType":{
            "name":"RETAIL",
            "displayName":"Retail",
            "description":"Retail customer type. Credit card will be charged automatically when payments are due."
         },
         "spendLimit":1000,
         "initialDeposit":0,
         "spendBudget":0,
         "owner":{
            "firstName":"Retail",
            "email":"d.aditya@citrix.com",
            "lastName":"Account",
            "phone":"91-9886319282",
            "username":"Retail",
            "uuid":"0f1a4222-7d96-4d7e-946a-6cfb05e57200",
            "address":{
               "city":"Bangalore",
               "country":"IN",
               "postalCode":"560001",
               "state":"KAR"
            },
            "apiKey":"retailapi123",
            "countryCode":"91",
            "gravatarUrl":null,
            "profile":{
               "name":"Master User",
               "description":"Master user"
            },
            "enabled":true,
            "secretKey":"retailsecret123",
            "spendBudget":0,
            "title":null,
            "timeZone":"GMT"
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         },
         "address":{
            "city":"Bangalore",
            "country":"IN",
            "postalCode":"560001",
            "state":"KAR"
         },
         "secondaryAddress":null,
         "currency":{
            "currencyCode":"USD",
            "currencyName":"US Dollar"
         },
         "memo":null,
         "trialAccount":null,
         "tenantExtraInformation":{
            "anniversaryDate":"17 Apr 2013 12:00:00 UTC",
            "nextInvoiceDate":null,
            "discountPercent":"0.0000"
         },
         "deposit":null,
         "remoteAddress":"10.252.249.72",
         "removed":null,
         "removedBy":null,
         "imagePath":null,
         "faviconPath":null,
         "usernameSuffix":null,
         "users":[
            {
               "firstName":"Retail",
               "lastName":"Account",
               "username":"Retail",
               "uuid":"0f1a4222-7d96-4d7e-946a-6cfb05e57200"
            }
         ]
      },{"..."},{"..."},{"..."},    
   ]
}

Sample XML response:

Request URL:

http://10.102.153.50:8080/portal/api/accounts.xml?expand=owner&q=reta
il&page=1&pagesize=5&sort=name&order=asc&_=<timestamp>&apiKey=<apikey
>&signature=<generatedSignatureUsingSecretKey>

Response:

<?xml version="1.0"?>
-<root>
-<accounts>
-<account>
<uuid>6477e245-db16-4863-9b2f-aef2cb984d21</uuid>
<name>abhai@retail</name>
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<accountId>AA000011</accountId>
<state>ACTIVE</state>
-<sourceChannel>
<uuid>0ed2ca51-2421-4df7-971e-70d7a2d3321d</uuid>
<name>channel</name>
<code>channel</code>
<description>channel</description>
</sourceChannel>
-<accountType>
<name>RETAIL</name>
<displayName>Retail</displayName>
<description>Retail customer type. Credit card will be charged
automatically when payments are due.</description>
</accountType>
<spendLimit>1000.0000</spendLimit>
<initialDeposit>0.0000</initialDeposit>
<spendBudget>0.0000</spendBudget>
-<owner>
<firstName>Abhai</firstName>
<email/>
<lastName>Kumar</lastName>
<phone>91-9379682039</phone>
<username>abhai@retail</username>
<uuid>3651d8ba-ffdd-46ec-88ae-22b70ff0c204</uuid>
-<address>
<city>sbc</city>
<country>IN</country>
<postalCode>560075</postalCode>
<state>KAR</state>
</address>
<apiKey>XUyCQVb7S_WOGsDiEBG1wqNKyCqJmk6e97ZnOycU8-
8HEaJjqqztEdZOpXF2cb1EOzZ-
Vr1423iNajNJYV2gXA</apiKey>
<countryCode/>
<gravatarUrl/>
-<profile>
<name>Master User</name>
<description>Master user</description>
</profile>
<enabled>true</enabled>
<secretKey>3FRXeqBtzu61aoGEVDPxyK4T1MXAE8dwJxb8TwX7ql
d8BccrKgfwlqFOTFy9iLTyM-ZTDntXtDHaeNr8t6uO0w</secretKey>
<spendBudget>0.0000</spendBudget>
<title/>
<timeZone>GMT</timeZone>
</owner>
-<address>
<city>sbc</city>
<country>IN</country>
<postalCode>560075</postalCode>
<state>KAR</state>
</address>
<secondaryAddress/>
-<currency>
<currencyCode>USD</currencyCode>
<currencyName>US Dollar</currencyName>
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</currency>
<memo/>
<trialAccount/>
-<tenantExtraInformation>
<anniversaryDate>24 Apr 2013 12:00:00 UTC</anniversaryDate>
<nextInvoiceDate/>
<discountPercent>0.0000</discountPercent>
</tenantExtraInformation>
<deposit/>
<remoteAddress>10.252.240.188</remoteAddress>
<removed/>
<removedBy/>
<imagePath/>
<faviconPath/>
<usernameSuffix/>
-<users>
-<user>
<firstName>Abhai</firstName>
<lastName>Kumar</lastName>
<username>abhai@retail</username>
<uuid>3651d8ba-ffdd-46ec-88ae-22b70ff0c204</uuid>
</user>
-<user>
<firstName>Normal</firstName>
<lastName>Kumar</lastName>
<username>retail@normal</username>
<uuid>a2856513-b3bd-4034-b9a2-bc4fe74164d</uuid>
</user>
-<user>
<firstName>Power</firstName>
<lastName>Kumar</lastName>
<username>retail@power</username>
<uuid>48f123c4-4ece-425f-a320-73f212262fca</uuid>
</user>
-<user>
<firstName>Billing</firstName>
<lastName>Kumar</lastName>
<username>retail@billing</username>
<uuid>b4c0a44e-3060-4e5c-b290-3ea37329ae3a</uuid>
</user>
</users>
</account>
+<account>
+<account>
+<account>
</accounts>
</root>
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Localization

The BSS API will respect the Content-Language header and return any human readable data
in the appropriate language.

Note: This is currently not supported, responses will be in default language entered, but
it is a good practice to pass the appropriate Content-Language header, for when the API
will support this feature.
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Using the API

Before you begin to use the BSS API, you should have:

• Access to the CloudPortal server you wish to integrate with.

• Both the API Key and Secret Key for a user

Authentication

Every REST request against the BSS API requires the inclusion of a specific authorization
through API Key and Secret Key and timestamp. The authentication process requires various
HTTP Header parameters to be submitted with a request.

Note: Timestamp (_) is system current time in milliseconds. By default. timestamp is
valid for 5 minutes. This can be configured on a need basis.

Requests that need security have to include a signature. This signature changes with every
requests and includes elements from the request.

User needs to pass the APIkey & append the encoded signature (using secret key &
parameters) to the generated URL.

Every API request has the following format: Base URL+Base API Path+ REST API
Path+Parameter String+Signature

where,

Base URL: Base URL to the CPBM Server. http://localhost:8080

Base API Path: Path to the base API Servlet that processes the incoming requests.
/portal/api

REST API Path: Path to CPBM rest api controller./foo
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Enabling the BSS API playground

In order to enable ease of development and ease of use of the CPBM BSS APIs, CPBM
provides a utility known as CPBM BSS API DOCS which has the following:

• Contains generated documentation for BSS API

• Exposed with a clear user html interface

• Test API methods with the provided playground

This utility provides users or developers a live playground on which they can:

1. Select top level API. For example, Users.

2. Select/choose one API call available in the top level API. For example, "/users".

3. Provide inputs as required by the API .

4. Execute the API.

5. See/Observe/Validate the response from the server.

The CPBM BSS API DOC is disabled, by default, during the installation. To enable this
feature, perform the following steps:

1. Stop the cloud-portal service on all active nodes using the command:

service cloud-portal stop

2. Go to VIRGO_HOME/pickup directory.

3. Open com.citrix.cpbm.plan.

4. Uncomment the below configuration:

<artifact type="bundle" name="citrix.cpbm.api.doc" version="[2.0.0, 3.0.0)">
      <property name="header:Web-ContextPath" value="/portal/api/doc" />
  </artifact>

5. Repeat Step 2 through Step 4 on all active nodes.

6. Start the cloud-portal service on all active nodes using the command:

service cloud-portal start
CPBM BSS API DOC will be accessible using this URL:

http[s]://<ip of cpbm host>:<port>/portal/api/doc
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Generating the signature

The signature is built by applying a keyed-HMAC (Hash Message Authentication Code) on
parameter string prefixed by REST API path. The secretKey is provided as a parameter to
the keyed-HMAC method.

1. For each field-value pair (as separated by a '&') in the Parameter String, URL ,encode
each value so that it can be safely sent via HTTP GET.

Note: Make sure all spaces are encoded as "%20".

2. Lower case the entire Parameter String and sort it alphabetically via the field for each
field-value pair. =1368420672402&apikey=mivr6x7u6bn_sdahobpjnejpgest35e
xq-jb8cg20yi3yaxxcgpyuairmfi_ejtvwz0nukkjbpmy3y2bcikwfq

3. Prefix the parameter string with the REST API path as shown below: /foo_=13684206
72402&apikey=mivr6x7u6bn_sdahobpjnejpgest35exq-jb8cg20yi3yaxxcgpyu
airmfi_ejtvwz0nukkjbpmy3y2bcikwfq

4. Take the prefixed Parameter String and run it through the HMAC SHA-1 hashing
algorithm with the user's Secret Key.

After reconstructing, the final URL looks like:

http://localhost:8080/portal/api/foo? _=1368420672402&apiKey=mivr6x7u
6bn_sdahobpjnejpgest35exq-jb8cg20yi3yaxxcgpyuairmfi_ejtvwz0nukkjbpmy3
y2bcikwfq&signature=Cxx1DN401BjmXU%2FcaiK8RAPo02xU%3D

Sample code to generate the signature:

  public String signRequest(String parameterString, String SecretKey) {
    try {
      Mac mac = Mac.getInstance("HmacSHA1");
      SecretKeySpec keySpec = new SecretKeySpec(SecretKey.getBytes(), "HmacSHA1");
      mac.init(keySpec);
      mac.update(parameterString.getBytes());
      byte[] encryptedBytes = mac.doFinal();
      return URLEncoder.encode(Base64.encodeBytes(encryptedBytes), "UTF-8");
    } catch (Exception ex) {
      logger.debug(ex);
    }
    return null;
  }

Channel: While it is possible to invoke the API via HTTP or HTTPS, it is strongly
recommended that it be executed only through HTTPS with mutual certificate based
authentication. This allows the CloudPortal Business Manager to establish a trusted link with
the calling portal.
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Example

The BSS APIs represent the set of business-related services exposed by the CPBM that are
used to implement a cloud service. The BSS API provides a ReSTful (Representational State
Transfer) web service interface and supports four possible actions (Get, Put, Post, and
Delete) on exposed resources and supports responses in either XML or JSON response
formats. A resource is an individual data entity with a unique identifier. All the resources
support an expanded view and a minimal view of the data structure.

By default, the BSS APIs return JSON. To request a specific format, the API call can be
appended with a suffix, currently only .json and .xml, which will return JSON and XML
respectively.

When the client sends a request to the server for a particular action, the server performs
the action and sends a response in the form of a representation of the specified resource. It
is possible to invoke the API via HTTP or HTTPS through a certified authentication.

Every API request has the following format: Base URL+Base API Path+ REST API
Path+Parameter String+Signature. The following example illustrates the typical values of an
API request:

1. Base URL: Base URL to the CPBM Server-

http://<IP of CPBM server>:<port>

2. Base API Path: Path to the base API Servlet that processes the incoming requests-

/portal/api

3. REST API Path: Path to CPBM rest api controller-

for example, /accounts

4. Parameter String: Includes the Timestamp + API key. Additional parameters depend on
the resource requested-

_=1368420672402&apiKey=mivr6x7u6bn_sdahobpjnejpgest35exq-jb8cg20yi3yaxxcgpyuai
rmfi_ejtvwz0nukkjbpmy3y2bcikwfq

(Timestamp (_) is system current time in milliseconds. By default, timestamp is valid
for 5 minutes. This can be configured on a need basis)

5. Signature: The signature changes with every request and is generated using a
keyed-HMAC method with the secret key, REST API path, and the contents of the
parameter string. The secret key is provided as a parameter to the keyed-HMAC
method. Generated signature (example)-

Cxx1DN401BjmXU%2FcaiK8RAPo02xU%3D

Note: Refer to Generating the signature to understand how to generate the signature
& link it to the corresponding location.

http://support.citrix.com/proddocs/topic/cpbm-23-map/cpbm-generatingsigntre-task.html#ccpb-manage-tasks


6. The final URL:

http://<IP of CPBM server>:<port>/portal/api/accounts.json?_=<timestamp>&apiKey=<
apikey>&signature=<generatedSignatureUsingSecretKey>

Before you begin to use the BSS API, you should have:

• Access to the CloudPortal server that you wish to integrate with.

• Both, the API key and Secret key for a user.

Generating a BSS API request
1. Get the API key and Secret key for a user:

Get these keys by following the steps given below:

a. Log in to CloudPortal Business Manager.

b. Click Root user in the top right hand corner of the UI.

c. Click My Profile > API Credentials.

d. Enter your password and click Proceed.

e. Note the API key and Secret key.
2. Generate the signature:

a. For each field-value pair (as separated by a '&') in the Parameter String, URL,
encode each value so that it can be safely sent via HTTP GET.

b. Lower case the entire Parameter String and sort it alphabetically via the field for
each field-value pair.

=1368420672402&apikey=mivr6x7u6bn_sdahobpjnejpgest35exq-jb8cg20yi3yaxxcgpy
uairmfi_ejtvwz0nukkjbpmy3y2bcikwfq

c. Prefix the parameter string with the REST API path as shown below:

/accounts_=1368420672402&apikey=mivr6x7u6bn_sdahobpjnejpgest35exq-jb8cg20yi
3yaxxcgpyuairmfi_ejtvwz0nukkjbpmy3y2bcikwfq

d. Take the prefixed Parameter String and run it through the HMAC SHA-1 hashing
algorithm with the user's Secret Key.

e. The resulting signature: Cxx1DN401BjmXU%2FcaiK8RAPo02xU%3D
3. Generate the timestamp.

4. Construct the final URL: Base URL+Base API Path+ REST API Path+Parameter
String+Signature

http://localhost:8080/portal/api/accounts?_=1368420672402&apiKey=mivr6x7u6bn_sda
hobpjnejpgest35exq-jb8cg20yi3yaxxcgpyuairmfi_ejtvwz0nukkjbpmy3y2bcikwfq&signatu
re=Cxx1DN401BjmXU%2FcaiK8RAPo02xU%3D
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Sample JSON response:
{
   "accounts":[
      {
         "uuid":"9fc7754c-6d46-11e0-a026-065287aed31a",
         "name":"SERVICE",
         "accountId":"00000000",
         "state":"ACTIVE",
         "sourceChannel":null,
         "accountType":{
            "id":"1",
            "name":"SYSTEM",
            "displayName":"System",
            "description":"system account type"
         },
         "spendLimit":0,
         "initialDeposit":0,
         "spendBudget":0,
         "owner":{
            "firstName":"ROOT",
            "email":"t.rajkumar@citrix.com",
            "lastName":"USER",
            "phone":"(000) 000 0000",
            "username":"root",
            "uuid":"62153c00-6d48-11e0-830c-8bca523c3555",
            "address":null,
            "apiKey":"hlz8Qvn03gvCy2rcwj5v-w_NPcfcXDe3USOVFRbEvl6-

rST_YoIbVkgL9geO6Ykt-csZkIhXTOA6_BxDEX18Tw",
            "countryCode":"",
            "gravatarUrl":null,
            "profile":{
               "name":"Root",
               "description":"Root"
            },
            "enabled":true,
            

"secretKey":"VXxhHXAhsFY_XBwThUs9CnS7vv5fiFtVfgVMmZq3_h9JTJHoBzEBHzf6v2p14ci5McgKV

-vxVLQVQ9F9cTXrGg",
            "spendBudget":0,
            "title":null,
            "timeZone":"Pacific/Tongatapu"
         },
         "address":{
            "city":"Any Town",
            "country":"US",
            "postalCode":"12345",
            "state":"DE"
         },
         "secondaryAddress":null,
         "currency":{
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            "currencyCode":"USD",
            "currencyName":"US Dollar"
         },
         "memo":null,
         "trialAccount":null,
         "tenantExtraInformation":null,
         "deposit":null,
         "remoteAddress":"0.0.0.0",
         "removed":null,
         "removedBy":null,
         "imagePath":"9fc7754c-6d46-11e0-a026-065287aed31a/images2.jpg",
         "faviconPath":null,
         "usernameSuffix":"root",
         "users":[
            {
               "firstName":"ROOT",
               "lastName":"USER",
               "username":"root",
               "uuid":"62153c00-6d48-11e0-830c-8bca523c3555"
            },
            {
               "firstName":"PORTAL",
               "lastName":"PORTAL",
               "username":"portal",
               "uuid":"74ed2fc2-6d48-11e0-830c-8bca523c3555"
            },
            {
               "firstName":"ops",
               "lastName":"admins",
               "username":"opsadmin",
               "uuid":"d7f249df-4f1b-4b55-90c7-67f53a2cbd77"
            },
            {
               "firstName":"Ops",
               "lastName":"admin",
               "username":"opsMonis",
               "uuid":"ffc61a28-fd57-48bc-82ac-860022eeee2f"
            },
            {
               "firstName":"Sales",
               "lastName":"Support",
               "username":"SSmonis",
               "uuid":"2e61bda6-d2ef-498f-9645-b6d2748d83ff"
            },
            {
               "firstName":"Product",
               "lastName":"Manager",
               "username":"pMMonis",
               "uuid":"29569924-4855-477a-b655-f9b99920aebe"
            },
            {
               "firstName":"Help",
               "lastName":"Desk",
               "username":"hdMonis",
               "uuid":"109a9485-34b4-42a5-938c-b42d6dd91458"
            },
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            {
               "firstName":"Finance",
               "lastName":"Admin",
               "username":"faMonis",
               "uuid":"11c3c10a-0e64-45ad-8147-8b08c8240dab"
            },
            {
               "firstName":"Palanivel Rajan",
               "lastName":"RK",
               "username":"pal_ops",
               "uuid":"8ad7e3b9-d4df-42a0-98ae-fb6b07c0f6d0"
            },
            {
               "firstName":"ops",
               "lastName":"admin",
               "username":"ops001",
               "uuid":"91282e5a-4275-4aeb-afc1-e2a988b1792e"
            }
         ]
      }

Sample XML response

<root>
<accounts>
<account>
<uuid>9fc7754c-6d46-11e0-a026-065287aed31a</uuid>
<name>SERVICE</name>
<accountId>00000000</accountId>
<state>ACTIVE</state>
<sourceChannel></sourceChannel><accountType>
<id>1</id>
<name>SYSTEM</name>
<displayName>System</displayName>
<description>system account type</description>
</accountType>
<spendLimit>0.0000</spendLimit>
<initialDeposit>0.0000</initialDeposit>
<spendBudget>0.0000</spendBudget>
<owner>
<firstName>ROOT</firstName>
<email>t.rajkumar@citrix.com</email>
<lastName>USER</lastName>
<phone>(000) 000 0000</phone>
<username>root</username>
<uuid>62153c00-6d48-11e0-830c-8bca523c3555</uuid>
<address></address>
<apiKey>hlz8Qvn03gvCy2rcwj5v-w_NPcfcXDe3USOVFRbEvl6-rST_YoIbVkgL9geO6Ykt-csZkIhXTOA6_BxDEX18Tw
</apiKey>
<countryCode></countryCode>
<gravatarUrl></gravatarUrl>
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<profile>
<name>Root</name>
<description>Root</description>
</profile>
<enabled>true</enabled>
<secretKey>VXxhHXAhsFY_XBwThUs9CnS7vv5fiFtVfgVMmZq3_h9JTJHoBzEBHzf6v2p14ci5McgKV-vxVLQVQ9F9cTXrGg
</secretKey>
<spendBudget>0.0000</spendBudget>
<title></title>
<timeZone>Pacific/Tongatapu</timeZone>
</owner>
<address><city>Any Town</city>
<country>US</country>
<postalCode>12345</postalCode>
<state>DE</state></address>
<secondaryAddress></secondaryAddress>
<currency>
<currencyCode>USD</currencyCode>
<currencyName>US Dollar</currencyName>
</currency>
<memo></memo>
<trialAccount></trialAccount>
<tenantExtraInformation></tenantExtraInformation>
<deposit></deposit>
<remoteAddress>0.0.0.0</remoteAddress>
<removed></removed>
<removedBy></removedBy>
<imagePath>9fc7754c-6d46-11e0-a026-065287aed31a/images2.jpg</imagePath>
<faviconPath></faviconPath>
<usernameSuffix>root</usernameSuffix>
<users>
<user>
<firstName>ROOT</firstName>
<lastName>USER</lastName>
<username>root</username>
<uuid>62153c00-6d48-11e0-830c-8bca523c3555</uuid>
</user>
<user>
<firstName>PORTAL</firstName>
<lastName>PORTAL</lastName>
<username>portal</username>
<uuid>74ed2fc2-6d48-11e0-830c-8bca523c3555</uuid>
</user>
<user>
<firstName>ops</firstName>
<lastName>admins</lastName>
<username>opsadmin</username>
<uuid>d7f249df-4f1b-4b55-90c7-67f53a2cbd77</uuid>
</user>
<user>
<firstName>Ops</firstName>
<lastName>admin</lastName>
<username>opsMonis</username>
<uuid>ffc61a28-fd57-48bc-82ac-860022eeee2f</uuid>
</user>
<user><firstName>Sales</firstName>
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<lastName>Support</lastName>
<username>SSmonis</username>
<uuid>2e61bda6-d2ef-498f-9645-b6d2748d83ff</uuid>
</user>
<user><firstName>Product</firstName>
<lastName>Manager</lastName>
<username>pMMonis</username>
<uuid>29569924-4855-477a-b655-f9b99920aebe</uuid>
</user>
<user>
<firstName>Help</firstName>
<lastName>Desk</lastName>
<username>hdMonis</username>
<uuid>109a9485-34b4-42a5-938c-b42d6dd91458</uuid>
</user>
<user>
<firstName>Finance</firstName>
<lastName>Admin</lastName>
<username>faMonis</username>
<uuid>11c3c10a-0e64-45ad-8147-8b08c8240dab</uuid>
</user>
</users>
</account>
</accounts>
</root>
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Known issues

This following section list some of the known issues:

• If the List is empty, then json response will come as {} and xml will come as empty xml
document.

• Error codes are not yet finalized.

• Security has not been fully applied for the APIs.

• A normal user cannot fetch accountstatement uuid and, therefore, cannot fetch any
object which requires account statement uuid. Only the master user, billing admin, and
finance admin can do that.
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BSS API Reference

CloudPortal Business Manager BSS API Reference is published in HTML format.

To access the CPBM BSS API Reference pages:

1. Download the zip file for the CPBM release.

2. Uncompress it and extract all files.

3. Double-click the index.html file.

BSS API Reference

• CloudPortal Business Manager 2.3 BSS API Reference

• CloudPortal Business Manager 2.3.1 BSS API Reference

http://support.citrix.com/article/CTX141716
http://support.citrix.com/article/CTX141843
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Connector Development Kit

Cloud Service Connector implementers should use this specification to realize integration
between the Cloud Service and CPBM.

• Terminology

• Target Audience

• Overview

• Service Installation and Bootstrap

• Product Management

• Development Using SDK
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Terminology

Connector Implementer: Any third party that is using this SDK to implement a connector
for integration between a cloud service and CPBM

CPBM: CloudPortal Business Manager

Cloud Service: A capability delivered as a cloud-enabled service

Service Provider/Operator: The entity managing and operating a cloud, which is installing
CPBM along with other Cloud services for self-service delivery.

SPI: Service Provider Interface. A technically correct name for a Java interface that the
connector will have to implement and will be called by CPBM at appropriate points as
specified in this specification. These implementations will have to conform to the semantics
specified in this specification.
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Target Audience

Cloud Service Connector implementers should use this specification to realize integration
between the Cloud Service and CPBM. The intended audience is developers implementing
the integration. Developers attempting to integrate a Cloud Service using this SDK are
required to be proficient in:

• The Java programming language and libraries

• Spring Framework

• Basic understanding of OSGi and the Virgo platform

• The API and capabilities of the target cloud service
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Overview

CloudPortal Business Manager (CPBM) is a multi-lingual; multi-currency self-service portal
product that enables cloud-enabled and delivered services to be vended to end consumers.
It provides a comprehensive business and operational support system for operators to use to
deliver these cloud services to their audience.

Figure 1. CloudPortal Business Manager

The above figure shows CPBM with the connector for an IaaS cloud service built for the
Citrix CloudPlatform product. Other Cloud services may integrate with CPBM by developing
a custom built connector for their own service that conforms to the specifications described
in this document. To facilitate the development of this connector, CloudPortal Business
Manager provides a Software Development Kit (SDK) that can be used to ease the
development of this connector.

To implement a connector, an implementer will have to consider multiple aspects of the
integration. The following figure describes the steps needed to integrate a Cloud Service
with CPBM.



Figure 2. Steps for Cloud Service Integration

The specification includes descriptions of the metadata that needs to be provided, the SPI
interfaces that the Cloud Service connector will have to implement as well as the CPBM
facilities available for the connector to use in order to realize the integration. We will
discuss each step in the following sections.

At a very high level, a Cloud Service Connector will have to provide the following:

• Metadata: This is vital information describing the capabilities of the underlying Cloud
Service along with information needed to successfully connect and orchestrate actions
against an instance of a Cloud Service. This will typically be represented as an XML file
that is bundled as part of the package.

• SPI Implementation: A set of implementations to the various SPIs defined in CPBM.
Some of these SPIs are mandatory while others will be able to leverage CPBM
capabilities to deliver additional functionality, if implemented.

• Resource Files: A set of resource files that provide language specific translations for
any UI visible elements of this Cloud Service.

The connector will be packaged as one or more OSGi bundles for deployment into the CPBM
footprint.

Overview
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Multiple Instances

It is important to note that while a connector implements the mechanisms needed to
communicate with a cloud service, the expectation should be that CPBM might initialize
multiple instances of the connector to communicate with multiple instances of the cloud
service. Typically, this would mean that the information provided in the connector is
merely metadata that will be replicated for each instantiation of this connector. Services
that are delivered as SaaS applications, as opposed to installed applications, will of course
be, by definition, limited to one instance.
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Onboarding

The CPBM platform is a Java based application infrastructure that heavily uses the Spring
Framework and is built on the Virgo OSGi container to enable modular deployment of its
capabilities. A Cloud Service connector is required to conform to this model to enable
seamless integration. A cloud service connector is packaged as a set of Virgo OSGi bundles.
These bundles will then be deployed as part of a CPBM installation to deliver this cloud
service as a capability that can be vended and billed for using CPBM.

Figure 1. CloudPortal Business Manager Runtime Architecture

The above figure depicts the runtime architecture of the CPBM platform with multiple cloud
service connectors installed. The following figure describes what a connector contains.

Figure 2. Cloud Service Connector
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Metadata

A cloud service connector implementer provides the configuration details of the cloud
service to CPBM in order for the cloud service to be correctly integrated with CPBM. The
metadata required is comprised of many parts. These include:

• Metadata about the configuration properties needed for the connector to effectively
communicate with the target cloud service. This will minimally include properties that
will identify the end point for the specified Cloud Service.

• Metadata about the resource types, usage types (usage metrics collected by the target
cloud service) and filters (used to scope resource and usage types) of the target cloud
service.

• Metadata about the resource UI contribution requirements for the target cloud service.
This is essentially a list of UI elements that can be embedded in various sections of the
CloudPortal UI.

• Metadata about custom security roles that control access to the target cloud service.
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SPI

A Cloud Service Connector implementer needs to implement certain SPIs to hook into CPBM
to participate in the customer onboarding and service provisioning aspects, in addition to
providing information to CPBM to generate appropriate usage metrics and bills to the end
customer. These are:

• Bootstrap: Set of interfaces required by CPBM to bootstrap and interact with the
service. These interfaces allow CPBM to configure cloud service instances and get
access to the implementations of the SPIs described below.

• Account Lifecycle Handler: Called by CPBM at appropriate times, this SPI allows the
connector to synchronize its state with that of CPBM. For example, CPBM will call this
adapter to synchronize state when a CPBM account (tenant) is created, restricted,
suspended, activated, terminated, etc.

• User Lifecycle Handler: Called by CPBM at appropriate times during a user lifecycle,
this SPI allows the connector to synchronize its user state with that of CPBM. For
example, when user is locked, disabled etc.

• Subscription Provisioning Handler (Mandatory): Called by CPBM to provision and
de-provision resources that are subscribed to (or cancelled).

• Usage Collection (Mandatory): Called by CPBM periodically to collect usage related
information for billing.

• Event Collection: Called by CPBM at periodic intervals to collect salient events from
the underlying service. While optional, when implemented this will allow end customers
to subscribe to notifications when certain things occur either via email or SMS etc.

Note: This capability will be implemented in CPBM in a future release.

• ViewResolver (Mandatory): Allows CPBM to drop the end user into the cloud service UI
with the appropriate context, for example, account settings, user settings, resource
management etc.

• SSO Handler (Mandatory): Allows CPBM to initiate and maintain single-sign on so that
users don’t have to login again when being redirected to the cloud service UI.

• APIProxyHandler: Used if the service has an API and the API needs to be fronted by
CPBM. This allows CPBM to allow business rules and other technical constraints (such as
blacklisting APIs that should not be called when integrated with CPBM).
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Cloud service down exceptions

When any cloud service instance is down, CloudPortal Business Manager user interface
displays the appropriate error message. The connectors will throw specific errors when the
cloud service is down or there is a network disruption. The messages displayed are
according to the specific errors thrown by the connectors. Any exception thrown by the
connector sets a message code. The resource string of that message code must be present
in that connector's bundle.

CloudServiceException is super class of all the exceptions thrown by connector.

CloudServiceException Class

public class CloudServiceException extends ServiceException {
   public CloudServiceException() {
     super();
   }
  public CloudServiceException(String message) {
    super(message);
  }
  public CloudServiceException(String message, Throwable cause) {
   super(message, cause);
  }
  public CloudServiceException(Throwable cause) {
   super(cause);
  }}

Exception hierarchy and class diagram:

The following table provides the details of the exceptions:

Exception Description



CloudServiceException Base class of all the cloud service exceptions
known to CPBM. It also contains a message field
.If any connector wants to show localized
message then connector developer should put
localized message into this.

CloudServiceDownException Raised when cloud service is down becuase of
network unreachable, network time out and so
on.

CloudServiceConnectionException Raised when there is configuration issue in
accessing the service instance.

CloudServiceMetadataRegistryExcepti
on

Raised when there is an error while executing
method of MetadataRegistry SPI.

CloudServiceAccountLifecycleExcepti
on

Raised when there is an error while executing
method of AccountLifecycleHandler SPI.

CloudServiceUserLifecycleException Raised when there is an error while executing
method of UserLifecycleHandler SPI.

CloudServiceSubscriptionLifecycleExc
eption

Raised when there is error in operating anything
related to lifecycle of resource such as
Reconfigure subscription, terminate
subscription, subcribe and so on.

CloudServiceRegistrationException Raised when connector's bundle is registered,
after reading its definition from
serviceDefinition.xml.

Cloud service down exceptions
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Resource Bundles

In order to support localization, a cloud service implementer should provide resource
bundles in supported languages to allow the display of the service entities in appropriate
languages to the service operator as well as the end customer.

Example: CloudServiceApplicationResources.properties

#About the Cloud Service
<UniqueServiceName>.service.name=#Name of the Serice
<UniqueServiceName>.service.description=#Description about the service

#Property section
<UniqueServiceName>.property.id.name=#Name of the Property
<UniqueServiceName>.property.id.tooltip =#Tool tip for the property
<UniqueServiceName>.property.id.errortext=#In case of validation error, the error message to be used
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Service Installation and Bootstrap

A connector package includes metadata and OSGi bundles that include SPI implementations
for the above-mentioned SPIs, in addition to any resource bundles.

The OSGi bundle includes the following components:

• /serviceDefinition.xml: – contains the service metadata information, which includes
BootStrap, Products, Views sections.

• /images/: contains the images, icons, banner files.

• /OSGI-INF/l10n/resources/CloudServiceApplicationResource[_lang].properties: contains
the resource properties per language supported.

• /TermsAndConditions.txt: contains the terms and conditions text for your connector.
Currently locale specific terms and conditions cannot be specified.
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Installing a Cloud Service Connector

As a service operator, perform the following steps to install a cloud service connector:

1. Drop the connector OSGi service bundle in the Virgo's /connectors_ext directory.

2. Add the line <artifact type="bundle" name="<bundle.artifact.id>" version="[<x.x.x>,
<x.x.x>]"/> within the plan tag in the file com.citrix.cpbm.connector.ext.plan located
at /usr/share/vts3/connectors_ext.

3. You can now instantiate the service in the CloudPortal Business Manager Configuration
UI.

Note: For installing multiple connectors, you must repeat the steps mentioned above.
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Service Bootstrap

In order to install and bootstrap a service into CPBM, CPBM requires some metadata and SPI
implementations. This information is used by CPBM to display the available services in the
configuration UI and allow the instantiation of the connector implementation to interface
with one or more instances of each service.
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Service Metadata

The following information is required by CPBM to enable instantiation and configuration of
service instances. This information is provided as XML sections in the serviceDefinition.xml
file.

Element (items in italics are attributes) Description

Id A unique identifier for the
service. Similar to java
package conventions. For
example, com.citrix.ccp

type (CLOUD|OSS*) The type of
service (For cloud services,
this should always be set to
CLOUD)

Singleton Boolean(default: false)
Indicates if this cloud
service is a singleton or
not.

category (IaaS|STaaS|PaaS|…)
Predefined values that
determine the service
category

CloudConnectorFactory The service id of the
connector factory
implementation. This is the
primary SPI for the
bootstrap process.

Image An image reference URL for
use in the UI. Depending on
the type it will be used
under different
circumstances

type Banner: Displayed when
showing the service in the
configuration UI

Logo: Displayed when
listing service instances

Locales List of languages supported
by the cloud service. For
example: <Locales>en_US,
ja_JP, ko_KR</Locales>

Vendor The name of the connector
implementer

version The connector version
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Configuration Metadata

A cloud service connector must specify the set of properties needed for the connector to
successfully communicate with an instance of the cloud service. These set of properties will
be configured in the administration UI for each cloud service instance that is instantiated.
For a singleton instance, there will be only one instance of the cloud service that can be
configured. NOTE: It is important to note the point that when instances are configured
there will be one set of properties that will be instantiated per instance of the cloud
service that is configured. The configuration properties are specified as a collection of
Property elements enclosed in a Properties element. The definition of each
Property element is described below:

Element (items in italics are
attributes)

Description

Property A property that needs to be configured

Id Dot separated identifier of property (for example,
endpoint.url)

Type (Integer/String/url/Boolean/Number/Date/Password)

Encrypted (true/false)

Validation JSON validation string. Syntax same as for
jquery.validation plugin, formal specification.
Validations described here will be applied both on the
Client and Server side.

List of supported validations:

required,

min-value,

max-value,

regex,

maxlength,

minlength

alphanumeric

email
The property element under configuration now has new attributes, namely default and
unique. The default attribute contains the default value for a given property, and if a
property has unique = true, then no two service instances for the given service can have the
same value for the given property.
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CloudConnectorFactory Interface

The CloudConnectorFactory interface is the primary class that's used to bootstrap a cloud
service.

The CloudConnectorFactory implementation for a service acts as a factory for
CloudConnector objects. Each CloudConnector object represents a connection to one
instance of the CloudConnector. The CloudConnectorFactory interface is defined as follows:

package com.citrix.cpbm.platform.spi;

public interface CloudConnectorFactory<T extends BaseConnector> {
  /* Initialize a CloudConnector instance with instance specific data */
  public T initialize(ServiceInstanceConfiguration config);
  public enum ConnectorType {
    CLOUD,
     …
  }
  public ConnectorType getConnectorType();
}

CPBM will call the initialize method on the CloudConnectorFactory implementation
providing a ServiceInstanceConfiguration object. This will be done for each instance
configured in CPBM for this cloud service. The ServiceInstanceConfiguration object will
contain values for each property described in the previous section. Note that the values will
be specific to this instance of the cloud service.

Cloud Service CloudConnectorFactory objects should always return CLOUD for their
ConnectorType.
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ServiceInstanceConfiguration

The ServiceInstanceConfiguration object is the holder of all instance specific configuration
values. The connector is initialized with a ServiceInstanceConfiguration instance that
contains all the properties configured for this instance. The list of properties available is
dependent on the property types declared in the service metadata.

ServiceInstanceConfiguration has methods that allow the connector to gain access the
property values to connect to a specific instance of the cloud service. It is defined as
follows:

public class ServiceInstanceConfiguration {

  /* Returns the Service UUID */
  public String getServiceUUID();
  
  /* Returns the Service Instance UUID */ 
  public String getInstanceUUID();

  /* Returns the map of property name id and Instance Property */
  public Map<String, ServiceInstanceProperty> getInstanceProperties();
}

public class ServiceInstanceProperty {

  /* Returns the type of property */
  public String getType();

  /* Returns whether the property is encrypted or not */
  public Boolean isEncrypted();

  /* Returns the value of property */
  public Object getValue();

  /* Returns the validation string for the property */
  public String getValidation();
}

When the operator configures a service instance, CPBM will request the operator to
configure the set of properties required for that service instance. These properties can be
managed in the CPBM configuration UI. Once initialized, any changes to these
configurations are NOT reflected in the running instance. Therefore, CPBM will have to be
restarted when a service instance is reconfigured. Further, once configured to point to a
particular service instance, changes to configuration cannot modify the target instance.
This is due to the fact that CPBM has handles and references to resources in that service
instance and will fail if those handles and references are no longer valid.
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CloudConnector Interface

The CloudConnector interface represents a connection to a specific instance of a cloud
service. Implementations of this interface will provide CPBM handles to the various SPI
implementations that interface with CPBM as described in later sections. Since these
implementations are instance specific, ensure that they use the instance specific
configuration values to connect to the appropriate instance of the cloud service. In
addition, make sure that they are both thread-safe and have no shared state (across
instances). How instance specific information is shared between the various SPI
implementations is out of scope of this document. There are various ways this can be
achieved and is left to the implementer to decide how they wish to architect this. The
CloudConnector interface extends the Connector interface. For the purposes of this
conversation, Connector itself is not pertinent except to say that the methods in it are
applicable to CloudConnector. The CloudConnector interface is defined as follows:

/**
 * BaseConnector is the base interface for all connectors. Cloud Service Connectors
 * should always implement CloudConnector interface
 */
public interface BaseConnector {
  /**
   * Sets the ServiceInstanceConfiguration corresponding to the service instance this
   * is configured for
   */
  public void setServiceInstanceConfiguration(ServiceInstanceConfiguration config);
/**
   * Gets the instance configuration
   * 
   * @return the current service instance's configuration
   **/
  public ServiceInstanceConfiguration getServiceInstanceConfiguration();
  /**
   * Returns the service UUID for the configured service instance
   */
  public String getServiceUUID();
  /**
   * Returns the service instance UUID for the configured service instance
   */
  public String getServiceInstanceUUID();
  /**
   * Returns the service status (and verifies connectivity) of this service instance
   */
  public boolean getStatus();
}

/**
 * The Connector expects basic account and user lifecycle 
 * capabilities. Cloud Services are expected to implement the  
 * extended CloudConnector interface instead.
 */
public interface Connector extends BaseConnector {



  
  /* Gets the account life cycle handler. */
  public AccountLifecycleHandler getAccountLifeCycleHandler();
  
  /* Gets the user life cycle handler. */
  public UserLifecycleHandler getUserLifeCycleHandler(); 
  
}

public interface CloudConnector extends Connector {  

  /* Gets the metadata registry */
  public MetadataRegistry getMetadataRegistry();

  /* Gets the subscription lifecycle handler */
  public SubscriptionLifecycleHandler getSubscriptionLifecycleHandler();

  /* Gets the event collection service */
  public EventCollector getEventCollector();

  /* Gets the usage collection service */
  public UsageCollector getUsageCollector();
  
  /* Returns the view resolved configured for this service instance*/
  public ViewResolver getViewResolver();

 /* Get API handler for the api group */
  public APIHandler getAPIHandler(String apiGroupName);

 /*Get a map of API handles
   */
  public Map<String, String> getAPIHandles();

 /*Returns the Sso handler */
  public SsoHandler getSSOHandler();

}

All methods in the CloudConnector (and the Connector) interfaces are essentially factory
methods that return service instance specific instantiations of their corresponding SPI
interfaces.

CloudConnector Interface
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Security Roles

In order to allow Cloud services to model their user privilege models in CPBM, a cloud
service is able to introduce security roles that can be used by the connector to determine
the level of privilege to be accorded to users being represented in the cloud service. These
roles can then be added to appropriate profiles defined in CPBM that can then be granted
to individual users in CPBM. In CPBM, roles are scoped by the level of visibility they have in
the system. There are four defined scopes in CPBM. They are:

• GLOBAL_ADMIN: Represents the super user scope. There are two and only two users in
the system that have profiles of this scope. ‘root’ and ‘portal’. ‘portal’ represents the
CloudPortal Business Manager portal itself, and any operations done by the system are
done as the ‘portal’ user.

• GLOBAL: Has global visibility across multiple tenants. These roles require that the user
be a service operator user (i.e, is a member of the SERVICE tenant), which will be
tested by the security system before granting users access.

• TENANT_ADMIN: Tenant scoped role that represents a tenant administrator. This user,
as a rule, should have visibility across users in this tenant.

• TENANT: Tenant scoped roles are granted to users who have visibility across all users in
a tenant. Roles in this scope are used to manage resources within a given tenant.

• USER: User scoped roles are roles that are granted to users who should have visibility to
only what they own and manage.

When users are created, they are associated with a profile. This profile has a list of roles
associated with the profile. Connectors should use these roles to determine the level of
privilege the user should be provided when the user is created in their system.

Security roles specific to a connector/cloud service are described in the metadata.

Semantics of adding/removing roles from profiles and how that is reflected in the
underlying service.
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Channel Settings

A cloud service may require certain information to be defined at the channel level. A
mechanism is provided to allow a connector developer to define settings in the service
definition by using the ChannelSettings tag. The channel settings are available in the CPBM
user interface under the channel details in the tab Service Controls, filterable by each
instance of the cloud service.

The ChannelSettings are defined in the service definition using a set of Property tags. The
definition of each Property is as described below:

Element (items in italics are
attributes)

Mandatory Description

Property     A property that needs to be configured

  id Yes Dot separated identifier of property (for
example, endpoint.url)

  type Yes (Integer/String/URL/Boolean/Number)

  encrypted No (Default
is false)

(true/false)

  reconfigurable No (Default
is false)

(true/false) . This property is
reconfigurable as long as no accounts
from the channel have been registered
on the cloud service.

  validation No JSON validation string. Syntax same as
for jquery.validation plugin, formal
specification. Validations described here
will be applied both on the Client and
Server side.

List of supported validations:

required,

min-value,

max-value,

regex,

maxlength,

minlength

alphanumeric

email

  Default No Default value of the property



Sample use:

<!-- Define channel settings -->
  <ChannelSettings>
    <Property id="setting1" type="String" encrypted="true" reconfigurable="false" validation='{"required":true}' />
    <Property id="setting2" type="Integer" encrypted="false" reconfigurable="true" validation='{"required":false}' default="5" />
    <Property id="setting3" type="URL" encrypted="false" reconfigurable="true" validation='{"required":false}' default="http://www.google.com" />
    <Property id="setting4" type="Boolean" encrypted="false" reconfigurable="true" validation='{"required":false}' default="http://www.google.com" />
    <Property id="setting5" type="Number" encrypted="false" reconfigurable="true" validation='{"required":false}' default="5.5566" />
  </ChannelSettings>

Methods added in channelService to get channelSettings:

/**
   * @param channel
   * @param serviceInstanceUuid
   * @return a map of ChannelSettingServiceConfigMetadata
   */
  public Map<String, String> getChannelSettings(Channel channel, String serviceInstanceUuid);

  /**
   * @param tenant
   * @param serviceInstanceUuid
   * @return a map of ChannelSettingServiceConfigMetadata
   */
  public Map<String, String> getChannelSettings(Tenant tenant, String serviceInstanceUuid);

  /**
   * 
   * @param channel
   * @param serviceInstanceUuid
   * @return List of ServiceInstanceConfig
   */
  public List<ServiceInstanceConfig> getChannelSettingsList(Channel channel, String serviceInstanceUuid);

Channel Settings

323



324

Product Management

CPBM natively bills users for usage accrued by an account. Ideally this usage accrual is
scoped by user (if the service supports that notion) or at the account level. In order to
support this, a connector has to provide sufficient information to CPBM for it to be able to
do the following actions:

• Appropriate selection of resource type components which make up the information that
needs to be specified for provisioning a resource

• Appropriate input of optional provisioning time configuration information for each
resource that's provisioned.

• Ability to identify and display prices for resources that are being provisioned

• Ability to filter resource components based on domain specific filters (in the case of
resource component options being large or pricing being different)

• Ability to segregate usage information into appropriate pricing buckets

• Ability to describe technical constraints with respect to provisioning (such as once per
account only or require X to be provisioned before Y can be provisioned etc)

• Ability to describe 'add-on' relationships where a resource is provisioned as an 'add-on'
to an existing resource.

Before delving into the details of the metadata and SPI implementations that needs to be
provided by a connector to achieve the above, it is useful to understand a little bit about
how CPBM provisions and bills for resources consumed by a customer. We will discuss the
CPBM product management model in the following section.
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CPBM Product Management Primer

CPBM models resources in terms of Products and Product Bundles. While the CPBM billing
engine contains other entities such as Catalogs, Channels, Campaigns etc, these have no
bearing on what the cloud service connector and therefore be left out of this conversation.
Please refer to the Service Operator's Guide for details on those entities.
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Products

In CPBM, anything that can be measured and has a unique unit price is modeled as a
Product. A Product is associated with a set of mediation rules that allows CPBM to
segregate collected usage into appropriate product buckets. Service operators will create
products guided by metadata provided by the underlying cloud service connector but based
on their unique requirements for how they would like to charge for the service.

Note that Products represent anything that can be charged for. It is NOT REQUIRED that
these be resources that are explicitly provisioned by CPBM. For example, in an IaaS service,
one may provision one or more virtual machines, but may also get charged for data transfer
that is not explicitly provisioned but gets accrued nevertheless. Products are defined
specific to a given service instance (i.e., different instances of the service may have
different products).

Mediation Rules
As discussed above, a given product can have one or more mediation rules.

All usage that matches any of the mediation rules will be attributed to that product. The
mediation rule determines how usage record matches are done by the mediation strategy. A
mediation rule contains among other things the usage type (a unique cloud service specific
identifier that distinguishes usage of different types) and a list of discriminator attributes
and corresponding values that need to match for usage to be attributed to this product.
When CPBM collects usage from the cloud service, the collector will also provide values for
all the discriminator attributes. CPBM will then match those values with those specified in
the mediation rules to determine a match.

Mediation rules also allow CPBM to determine which products are likely to be used when
provisioning resources. Based on the selections during provisioning, one or more products
may be applicable. Using the available selections, CPBM will identify the set of products
that are applicable and will be able to display appropriate pricing for the same.
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Product Bundles

Product Bundles are essentially what is sold to an end customer. End customers always buy
product bundles. A product bundle is composed of five parts.

Type
The bundle type essentially represents the resource that is being provisioned when
purchasing this bundle. Type can be null indicating that this bundle does not provision
anything but provides an entitlement for a price.

Provisioning Constraints
Provisioning constraints describe any constraints that restrict what can be provisioned.
Typically, this would be used to constrain resources to a subset of possible choices for that
resource. See Resource Components metadata for more details. Provisioning constraints are
described in terms of resource component constraint rules.

Business rules
These are attributes that essentially reflect the operator's business rules. They include:

• published: Whether this bundle is published, ie available for purchase or not

• constraint: Any kind of purchasing constraint for this bundle. Typically inherited from
the resource being provisioned, this constraint can also be manually applied when no
resource is being provisioned. For example, whether this bundle can be purchased once
per account, once per user, many times but at the account scope or many times at the
user scope.

Pricing
These are attributes that reflect the operator's pricing for a given bundle. They include:

• recurrence: The frequency at which the prices will be charged (Monthly, Annually or
none which implies utility (or pay for what you use) pricing)

• one-time charges: Charges applied at subscription time

• recurring charges: Charges applied at the recurrence frequency



Entitlements
Entitlements reflect what is 'bundled' with the purchase of a subscription to this bundle.
Entitlements are essentially usage that comes free with the purchase of this bundle.
Entitlements are described in terms of amount of units of a given product that is bundled.
Entitlement can be unlimited in which case all usage of that product is free for this
subscription. Some entitlements are scoped by subscription whereas user or account scopes
other entitlements.

Product Bundles
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Product Metadata and Metadata Registry

In order to support the above functionality in CPBM, the connector implementer has to
provide some product metadata as well as implement some SPIs.

There are three main elements that describe product metadata for CPBM to use. These are:

• Resource Type: Resource type represents resources that require an explicit
provisioning action and optionally additional configuration for provisioning.

• Usage Type: Usage type represents distinct measurements made related to usage by a
cloud service. Examples include number of mailboxes, number of hours of VM running
time, amount of storage consumed, amount of data transfer, and so on.

• Filter: Filters are used to subset resource components or segregate usage based on
domain specific distinctions. Examples include availability-zone, delivery location,
operating system, and so on.
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ccpb-cssdk-resource-type-22-con
Due to technical difficulties, we are unable to display this topic. Citrix is currently fixing
this problem. In the meantime, you can view this topic online:

http://support.citrix.com/proddocs/index.jsp?lang=en&topic=/cpbm-23-map/ccpb-cssdk-re
source-type-22-con.html

http://support.citrix.com/proddocs/index.jsp?lang=en&topic=/cpbm-23-map/ccpb-cssdk-resource-type-22-con.html
http://support.citrix.com/proddocs/index.jsp?lang=en&topic=/cpbm-23-map/ccpb-cssdk-resource-type-22-con.html
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UsageType

UsageType represents distinct measured usage metrics generated by the cloud service.
UsageTypes may be generated by provisioned resources such as hours of VM running time
generated by the VM or implicitly, such as data transfer, which does not get explicitly
provisioned but usage is incurred nevertheless. When generated by provisioned resources,
usage can be attributed to that resource. Otherwise, usage is typically accrued at the
ownership scope, which could be user or account.

To understand cloned usage types, consider monitoring which is would be modeled as an
add-on resource type to a VM. The actual monitoring usage is derived from running VM
hours. However, such usage is not generated unless monitoring is provisioned on a target
VM. So, CPBM will automatically generate a cloned usage type identical to the target usage
type but only if the resource type that generates it has been provisioned as an add on. As
with resource types, cloned usage types may refer to usage types from another service
using the syntax <service_id/name>.

Table 1. UsageType

Element (Items in italics are attributes) Description

UsageType name The name of the usage type

[clone] Indicates the usage type is a clone of another usage type. If
generated by a resource type, this kind of usage is generated only
if the associated resource type has been provisioned

uom Unit of measure reported by usage collector

Discriminators List of discriminator attributes that can be used to mediate this
resource type. Possible values can be acquired from
getDiscriminatorValues method of the MetadataRegistry
interface

Attribute Name of a discriminator attribute

[discrete] This is an optional attribute that indicates whether the usage type
is discrete or not. Possible values are "true" and "false". The
default value is "false". If the value is set to

• True: The usage type is "discrete"

• False: The usage type is "metered"
It is useful to note that there are a few implicit discriminators for usage types. All filters
and all resource component selections (based on their corresponding discriminator
attributes) are valid discriminators for usage types. Cloned usage types inherit all
discriminators of their target.
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Declaring Discrete Usage Type

Usage type has an optional attribute, discrete. The possible values are either "true" or
"false". If the value is not defined, it is set to "false" by default and the usage type will be
"metered". While creating a product, usage type of same kind (either metered or discrete)
can be combined or excluded.

<UsageType name="DISCRETE_USAGE_TYPE" uom="discrete_uom" discrete="true"/>

The unit of measure (uom) of a UsageType has an optional attribute, discrete. The
possible values are either "true" or "false". If the value is not defined, it is set to "false" by
default. If the uom has the discrete attribute set to "true", it will not have any scales.
The scales will be ignored, If specified.

Note: A uom can be either discrete or metered but not both.

The UsageType and uom must have same value for the discrete attribute, if specified.
The values of the discrete attribute of UsageType and the corresponding uom are
compared.

The following is a valid example of the discrete attribute values specified for the
UsageType and uom:

<UsageType name="DISCRETE_USAGE_TYPE" uom="discrete_uom" discrete="true"/>
.
.
.
.
<uom raw="discrete_uom" discrete="true"/>

Invalid declaration of discrete usage type

The connector will not get registered and the service will be down if

• a UsageType has a different value for the discrete attribute from the corresponding
uom. The following are invalid examples of the discrete attribute values specified
for the UsageType and uom:

<UsageType name="DISCRETE_USAGE_TYPE" uom="discrete_uom" discrete="true"/>
.
.
.
.
<uom raw="discrete_uom" discrete="false"/>

<UsageType name="DISCRETE_USAGE_TYPE" uom="discrete_uom"/>
.
.
.



.
<uom raw="discrete_uom" discrete="true"/>

<UsageType name="DISCRETE_USAGE_TYPE_1" uom="discrete_uom" discrete="true"/>
<UsageType name="DISCRETE_USAGE_TYPE_2" uom="discrete_uom"/>
.
.
.
.
<uom raw="discrete_uom" discrete="true"/>

• If the discrete attribute is set to true for an existing UsageType. Refer the following
example.

<UsageType name="ROOT_VOLUME" uom="Byte-Hours" discrete="true">

Declaring Discrete Usage Type

333



334

Unit of Measure (Uom)

Unit of Measure is the unit of a UsageType, which is specified along the UsageType
definition. Each Uom can have multiple scales, and each scale has a conversion factor. Each
Uom has a implicit scale which is the Uom itself, which has a conversion factor of 1, and it
may have other scales which have other conversion factors. Each Uom has a default scale
which is specified using the default attribute, and if no scale has a default attribute, then
the implicit scale is considered as default. Each Scale has a monthly attribute, which if set
as true would imply the conversion factor specified in the scale is a monthly unit and will
be multiplied with number of hours in a month, which is specified in CPBM as a global
configuration.

Uom for discrete usage type
The <uom> tag has an optional attribute "discrete". The possible values are "true" or "false".
When not defined the value is set to "false" by default. A uom can be either discrete or
metered but not both. If the discrete attribute is set to true, the uom will not have any
scales. If the scales are specified, it will be ignored. Both the usage type and uom should
have same value for the discrete attribute, if specified. The connector will not get
registered and the service will be down if the

• Usage type and uom have different values for the discrete attribute

• Discrete attribute for uom is set to "true" for an existing usage type

Element
(Items in
italics are
attributes)

Description



Uom raw Name of the Uom, Same as the uom
attribute specified in a UsageType

[discrete] Value of the discrete attribute, same
as the discrete attribute specified in
a UsageType. This is an optional
attribute for which the value is
either "true" or "false"

Scale

Note: If the
value of the
discrete
attribute is
"true", the
Uom will
not have
any scales.
If the scales
are
specified, it
will be
ignored by
the system.

Name Name of the
scale

conversionFactor The
conversion
factor, which
is used to
convert the
usage into
different
scales

monthly Attribute
which
specifies
whether scale
is monthly and
whether
conversion
factor needs
to be
multiplied
with the
number of
hours in a
month
(specified by
CPBM)

Unit of Measure (Uom) 
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Filter

A Filter can be considered a global discriminator. It can be used to classify all resource
components as well all usage. Use filters only when it is applicable to all resources and
usage types declared for a cloud service.

A filter can be used to filter resource components. This allows scoping of resource
component options based on filter values. For example, in Citrix CloudPlatform, a Zone
would be a filter allowing templates or service offerings to be filtered by Zone.

In addition, a filter can also be used to discriminate usage, and as such is considered an
implicit discriminator for any usage type in a given service.

Possible filter values can be acquired dynamically from getFilterValues method of the
MetadataRegistry interface.

Table 1. Filter

Element(Items in italics are attributes) Description

Filter name (Attribute) the name of the
filter

discriminator discriminator property
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MetadataRegistry Interface

The MetadataRegistry interface is the runtime product metadata view into the target cloud
service. Actual list of available options for resource components, filters, discriminators are
dependent on multiple factors, such as who the calling user is and what options are visible
to them or not. Due to this constraint, CPBM will use the metadata registry to query the
target cloud service at runtime to determine exact set of options available for each case.
This allows the service operator to make changes to available options without having to
reflect that explicitly in CPBM.

ResourceComponent

A representation of ResourceComponent is used by the MetadataRegistry and is defined
as follows:

public class ResourceComponent {

  public ResourceComponent(String resourceType, String name, String value, ResourceComponent parent,
      Map<String, String> attributes, Set<DisplayAttribute> displayAttributes);

  public String getResourceType();
  public String getName();
  public String getValue();
  public Map<String, String> getAttributes();
  public ResourceComponent getParent();
  public Set<DisplayAttribute> getDisplayAttributes();
  public String getAttributesString();
  public String getDisplayAttributesString();

}

A ResourceComponent object is a representation of a resource component. It contains
the following properties:

• resourceType: The name of the resource type that this component is a part of

• name: The service defined name of this component option

• value: The service defined value that needs to be passed back to the service to
provision a resource with this component

• attributes: additional descriptors for that resource component, if any.

• parent: can usually be null, but under some advanced use cases, resource
components may be derived from another resource component. This field defines the
parent

A new field has been added in ResourceComponent, called displayAttributes. This is a set
of name-value pairs (DisplayAttribute), used to show additional details for a given
ResourceComponent in the following places:

• While adding or editing provisioning constraints for a Product Bundle.



• While end user provisions a resource using the default UI. (can also be used by
connector in custom UI).

The getDisplayAttributesString() is a helper method which returns a comma separated
string representation of displayAttributes field.

FilterComponent

public class FilterComponent{

  public FilterComponent(String name, String value,
      Map<String, String> attributes, Set<DisplayAttribute> displayAttributes);

  public String getName();
  public String getValue();
  public Map<String, String> getAttributes();
  public Set<DisplayAttribute> getDisplayAttributes();
  public String getAttributesString();
  public String getDisplayAttributesString();

}

The getFilterValues() method has been updated, it now returns a list of filterComponent.

MetadataRegistry

The MetadataRegistry as we described earlier is used by CPBM to query the underlying
service at runtime to determine dynamically the value space for resource component
options, filters, discriminators etc. The metadata registry itself will be used in three
different contexts and it is important to understand these. They are:

• At product management time: In order to set pricing, it is important for CPBM to
understand the various resource type component options, filter options, possible
discriminator attribute values. These help CPBM build the products, define their
mediation rules and define product bundles and any constraints they may want to
specify.

• At provisioning time: When provisioning a resource type, the user will have to select
specific resource component values (optionally filtered by the available filters) for
each resource component. The actual list of options can vary depending on the user,
account, filter selections or other resource component selections. Resource types
may not have components or variations. Selection of product bundles that can be
subscribed to will match these selections with bundle constraints to show the set of
bundles that match the selections.

• At mediation time: At mediation time, usage can be received for a specific resource
type with specific resource component values. At that time, CPBM will need to
determine ancestry of resource components to correctly bucket usage into
appropriate products. CPBM will query the MetadataRegistry to determine this
ancestry.

public interface BaseMetadataRegistry {

public List<FilterComponent> getFilterValues(String tenantHandle, String userHandle, String name);

MetadataRegistry Interface
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public Map<String, String> getDiscriminatorValues(String name);

public List<ResourceComponent> getResourceComponentValues(String resourceType, String name);

public List<ResourceComponent> getResourceComponentValues(String resourceType, String name, String tenantHandle,
      String userHandle, Map<String, String> context, Map<String, String> filters);

public ResourceComponent getResourceComponent(String resourceType, String resourceComponent, String componentValue);
}

public interface MetadataRegistry extends BaseMetadataRegistry {

  @Deprecated
  public Map<String, String> getResourceTypeValues(String tenantHandle, String userHandle, String name,Map<String, String> context, Map<String, String> filters);
}

DynamicResourceTypeMetadataRegistry will enable the connector to filter out resource
types dynamically from the static super set of resource types defined in the service
definition. When invoked from the product management, CPBM will pass the portal
tenant handle and user handles. Else, it will be the respective tenant and user handle.

public interface DynamicResourceTypeMetadataRegistry extends BaseMetadataRegistry {
  public List<String> getResourceTypes(String tenantHandle, String userHandle);
}

getResourceComponentValues

This method is overloaded for two different contexts. One is used in product
management while the other is used at provisioning time.

The first form is called when the operator is defining products to determine the list of
system defined resource components. In this form, ancestry is not important (and will be
ignored), as ancestry is typically relevant only during provisioning (for price display) and
mediation. Also, in this form, the connector may return sentinel values (such as -1) to
designate classes of resource components that are available only to a specific custom
scope (since the actual resource component options are known only when the scope is
defined. For example, you may want to use -1 to designate all user defined templates.
The actual list of user defined templates, of course, can only be known given the user).
This form is used to build product mediation rules that use resource component values as
discriminators.

The second form is used during provisioning. At this time, the account, user, any other
components that have already been selected and any filters applied are known to the
system and will be passed to the call. Based on these parameters, the implementation
should return a list of specific resource components that are available to be used for
provisioning this resource type. In the case of IaaS, for example, this may include user
defined templates, templates owned by users, but derived from system templates, zone
or account specific templates etc.

getFilterValues

MetadataRegistry Interface
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This method is called during product management to use filters as usage discriminators
as well as during provisioning to filter out resource components. It should basically
return a list of legal values for that filter that can be used to filter a resource component
or categorize usage with. For example, you may declare availability zone as a filter and
this method would return the current list of availability zones.

getDiscriminatorValues

getDiscriminatorValues works similar to getFilterValues and returns possible values for a
given discriminator attribute. This is typically called only during product management. It
may return null, which would indicate that the actual discriminator value space is not
static or cannot be determined. In this case, CPBM will assume the value space is
undefined and allow the operator to enter free form text. The actual value of course,
will have to match the values that are configured by the operator for that usage type.
For example, this may be used to discriminate volume usage based on storage pool tags
(the list of tags potentially being infinite and not formally defined).

getResourceTypes

This method is overloaded for two different contexts. One is used in product
management, while the other is used at the time of provisioning.

The first form is called when the operator is creating product Bundle, listing anonymous
catalog or while previewing catalog from channels. In this form, CPBM will pass portal's
system tenant handle and user handle to the connector and connector will return list of
resource type name available for that service instance from the set of resource type
defined in service definition.

In the second form it will be called when end user is listing catalog. In this case,CPBM
will pass end user's tenant handle and user handle and the connector will return the
resource type available for that particular tenant user from the set of resource type
defined in service definition.

MetadataRegistry Interface
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Understanding How This Works

To understand how all this works, let's take a look at how they all fit together. The
following figure shows the relationship between these entities and what each of the
Consumer, the Service Operator and the Connector deal with.

To summarize at a high level, the Consumer can provision resources of a given resource
type either directly on a pay-as-you go basis or by purchasing a subscription to a Product
Bundle.

Service Operators define Products and Product Bundles. Products and Product bundles have
prices. You can pay as a utility, Pay-as-you-go, or recurring respectively. Bundles may also
provide free usage in terms of entitlements along with the purchase of a subscription.
Bundles in turn will also provision resources but subject to the pricing of the bundle.
Resources provisioned without a subscription will be charged on a utility basis. Products
have mediation rules that allow CPBM to mediate usage reported by the cloud service (via
the connector).

Connectors provide meta information, in terms of the Resource Types available, their
components, UsageTypes with their discriminators and Filters which allow Resource Types
to be classified and Usage to be mediated. Some usage is generated only when resources of
the corresponding resource type are provisioned. This usage is directly attributable to that
resource. Other usage can be generated based on other activity in the cloud service which
will be accrued at the user (or account) level.



Figure 1. Product Management Inter-relationships

The following sections describe how all of the above come together under various scenarios
and use cases.

Product Management
When creating products, CPBM will call getResourceComponentValues(first form),
getFilterValues and getDiscriminatorValues to create mediation rules based on all these
discriminators. Remember that resource component values as well as filter values are both
implicit discriminator candidates.

The interactions between CPBM, the connector metadata and the MetadataRegistry during
the creation of products is shown in the figures below.

Figure 2. Product creation

When creating product bundles, CPBM will use metadata to identify resource types and call
getResourceComponentValues to build provisioning constraints.

The interactions between CPBM, the connector metadata and the MetadataRegistry is
during the creation of product bundles is shown in the figure below.
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Figure 3. Product bundle creation

Subscription Process
When a customer buys a bundle, the system detects the provisioned resource type and uses
that to determine the launch experience. The following steps are performed:

• For a given resource type, the system first identifies the set of filters to present to the
user. This is extracted from the service metadata. The filter values are determined by
calling getFilterValues from the MetadataRegistry.

• Once filter values are selected, the system presents the possible choices of resource
components to select from. The components are presented in the order defined in
service metadata. The possible value choices (with filters applied) are acquired from
getResourceComponentValues in the MetadataRegistry (Note that the appropriate
tenant and user handles are passed to these methods.). Selections of prior resource
components may affect available choices for subsequent resource components. Bundle
choices are further filtered based on bundle provisioning constraints. A choice will not
be shown unless there's at least one corresponding bundle whose constraints allow the
current selection of resource components.

• Prices are shown for all bundles/products (see below for a discussion on how pricing
display is determined)

• Customer selects the bundle to subscribe to

• The subscription is created. If user requested immediate provisioning, then provisioning
flow kicks in. Otherwise user can navigate to the subscription and provision at a later
time.

Displaying prices
The following items are collected as discriminators:
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1. Applied filters and their values

2. Selected Resource components

Based on this, all products that match those discriminators (The match is non-unique, ie it
is possible that multiple products match for the above discriminators - this is because they
may be differentiated based on other discriminators) and their corresponding prices are
shown.

Provisioning Flow
If this resource type depends on another resource type as:

• ADDON: The system lists the resources of the target resource type for selection (the
handle to that resource is passed to the provisioning call).

• AVAILABLE: The system checks to see if a resource of a given target resource type is
already provisioned for this user/account (depending on the scope of the target
resource type) before proceeding, failing if the target resource type has not been
provisioned.

If custom fields are needed for provisioning, they are presented to the user for input. A
mechanism to customize the UI for this is available. See UI contributions for more details.
Any resource component selected may be modified at this time, but only within the
constraints of the subscribed bundle. The system provides subscription data to the
subscription provisioning handler of underlying service to provision the resource.

Sample Product Metadata
Example 1:

<?xml version="1.0" encoding="UTF-8"?>
<Service>
  <Bootstrap>
    <Id type="CLOUD" singleton="false" category="IAAS">com.citrix.cloudplatform</Id>
    <Connector ref="cloudPlatformConnector"/>
    <Image type="logo">logo.jpg</Image>  
    <Image type="banner">logo.jpg</Image> 
    <Vendor version="1.1.8">Citrix</Vendor>
    <Locales>en_US, ja_JP, ko_KR, fr, es, pt_BR, zh_CN</Locales>
    <Configuration>
    <!-- Any Properties that are added here must also be added to the ENUM in MetadataRegistryImpl -->
      <Property id="publicProtocol" type="String" encrypted="false" validation='{"required":true, "regex":"^(http|https)$"}' default='http' />
      <Property id="publicHost" type="String" encrypted="false" validation='{"required":true}' />
      <Property id="publicPort" type="Integer" encrypted="false" validation='{"required":true}' default='8080' />
      <Property id="cloud.jdbc.host" type="String" encrypted="false" validation='{"required":true}' />
      <Property id="cloud.jdbc.username" type="String" encrypted="false" validation='{"required":true}' default='cloud' />
      <Property id="cloud.jdbc.password" type="String" encrypted="true" validation='{"required":true, "confirmationRequired":true}' default='cloud' />
      <Property id="cloud.jdbc.database.schemaname" type="String" encrypted="false" validation='{"required":false}' default='cloud' />
      <Property id="cloud.usage.jdbc.host" type="String" encrypted="false" validation='{"required":false}' />
      <Property id="cloud.usage.jdbc.username" type="String" encrypted="false" validation='{"required":false}' default='cloud' />
      <Property id="cloud.usage.jdbc.password" type="String" encrypted="true" validation='{"required":false, "confirmationRequired":true}' default='cloud'/>
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      <Property id="cloud.usage.jdbc.database.schemaname" type="String" encrypted="false" validation='{"required":false}' default='cloud_usage' />
      <Property id="ssoKey" type="String" encrypted="true" validation='{"required":true}' />
      <Property id="apiKey" type="String" encrypted="false" validation='{"required":true}' />
      <Property id="secretKey" type="String" encrypted="true" validation='{"required":true}' />
      <Property id="parentDomainId" type="String" encrypted="false" validation='{"required":true}' default='1' />
      <Property id="adminServerList" type="String" encrypted="false" validation='{"required":true}' />
      <Property id="nonAdminServerList" type="String" encrypted="false" validation='{"required":true}' />
      <Property id="apiProxySuffix" type="String" encrypted="false" validation='{"required":true, "regex":"^[a-zA-Z0-9_]+$"}' unique="true"/>
      <Property id="apiWhitelist" type="String" encrypted="false" validation='{"required":false}' />
      <Property id="apiBlacklist" type="String" encrypted="false" validation='{"required":false}' />
      <Property id="default.vm.locale" type="String" encrypted="false" validation='{"required":false, "regex":"^(de|de-ch|es|fi|fr|fr-be|fr-ch|is|it|jp|nl-be|no|pt|uk|us)$"}' default='us'/>
      <Property id="max.custom.disk.offering.size" type="Integer" encrypted="false" validation='{"required":false}' default='1024'/>
    </Configuration>
  </Bootstrap>
  
  <AccountControls>
    <Property id="sharedAccount" type="Boolean" validation='{"required":false}'/>
    <Property id="defaultNetworkOffering" type="String" validation='{"required":false}'/>
       <Property id="perAccountPublicIPCount" type="Integer" validation='{"required":false, "minval":"-1"}' />
       <Property id="perAccountSnapshotCount" type="Integer" validation='{"required":false, "minval":"-1"}' />
       <Property id="perAccountTemplateCount" type="Integer" validation='{"required":false, "minval":"-1"}' />
       <Property id="perAccountVmCount" type="Integer" validation='{"required":false, "minval":"-1"}' />
       <Property id="perAccountVolumeCount" type="Integer" validation='{"required":false, "minval":"-1"}' />
       <Property id="perAccountNetworkCount" type="Integer" validation='{"required":false, "minval":"-1"}' />
       <Property id="perAccountVPCCount" type="Integer" validation='{"required":false, "minval":"-1"}' />
       <Property id="perAccountCPUCount" type="Integer" validation='{"required":false, "minval":"-1"}' />
       <Property id="perAccountRAMAmount" type="Integer" validation='{"required":false, "minval":"-1"}' />
       <Property id="perAccountPrimaryStorageAmount" type="Integer" validation='{"required":false, "minval":"-1"}' />
       <Property id="perAccountSecondaryStorageAmount" type="Integer" validation='{"required":false, "minval":"-1"}' />
       <Property id="perUserPublicIPCount" type="Integer" validation='{"required":false, "minval":"-1"}' />
       <Property id="perUserSnapshotCount" type="Integer" validation='{"required":false, "minval":"-1"}' />
       <Property id="perUserTemplateCount" type="Integer" validation='{"required":false, "minval":"-1"}' />
       <Property id="perUserVmCount" type="Integer" validation='{"required":false, "minval":"-1"}' />
       <Property id="perUserVolumeCount" type="Integer" validation='{"required":false, "minval":"-1"}' />
       <Property id="perUserNetworkCount" type="Integer" validation='{"required":false, "minval":"-1"}' />
       <Property id="perUserVPCCount" type="Integer" validation='{"required":false, "minval":"-1"}' />
       <Property id="perUserCPUCount" type="Integer" validation='{"required":false, "minval":"-1"}' />
       <Property id="perUserRAMAmount" type="Integer" validation='{"required":false, "minval":"-1"}' />
       <Property id="perUserPrimaryStorageAmount" type="Integer" validation='{"required":false, "minval":"-1"}' />
       <Property id="perUserSecondaryStorageAmount" type="Integer" validation='{"required":false, "minval":"-1"}' />
  </AccountControls>

  <ResourceMetadata>
    <ResourceType name="VirtualMachine" constraint="NONE" componentSelector="apachecloudstack.fragment.resource.virtual.machine.components.selection">
      <Properties editor="apachecloudstack.fragment.resource.virtual.machine.properties.selection">
        <Property id="hostName" type="String" validation='{"required":false, "regex":"^[a-zA-Z]{1}[a-zA-Z0-9\\-]{0,61}[a-zA-Z0-9]{1}$"}'/>
        <Property id="displayName" type="String" validation='{"required":false}'/>
        <Property id="group" type="String" validation='{"required":false}'/>
        <Property id="diskOfferingUuid" type="String" validation='{"required":false}'/>
        <Property id="keypair" type="String" validation='{"required":false}'/>
        <Property id="diskSize" type="Integer" validation='{"required":false}'/>
        <Property id="keyboard" type="String" validation='{"required":false, "regex":"de|de-ch|es|fi|fr|fr-be|fr-ch|is|it|jp|nl-be|no|pt|uk|us"}'/>
        <Property id="networkIds" type="String" validation='{"required":false}'/>
        <Property id="securitygroupIds" type="String" validation='{"required":false}'/>
        <Property id="userData" type="String" validation='{"required":false}'/>
        <Property id="ipAddress" type="String" validation='{"required":false, "regex":"^([0-9]{1,3}\\.[0-9]{1,3}\\.[0-9]{1,3}\\.[0-9]{1,3})*$"}'/>
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        <Property id="ipToNetworkList" type="String" validation='{"required":false, "regex":"^([0-9]{1,3}\\.[0-9]{1,3}\\.[0-9]{1,3}\\.[0-9]{1,3},[0-9a-zA-Z\\-]+;)*$"}'/>
      </Properties>
      <Component name="templateUuid" discriminator="templateUuid" />
      <Component name="hypervisorType" discriminator="hypervisorType" />
      <Component name="serviceOfferingUuid" discriminator="serviceOfferingUuid" reconfigurable="true"/>
      <Generates>
        <Usage>RUNNING_VM</Usage>
        <Usage>ALLOCATED_VM</Usage>
        <Usage>ROOT_VOLUME</Usage>
      </Generates>
    </ResourceType>

    <ResourceType name="Volume" constraint="NONE">
      <Properties>
        <Property id="name" type="String" validation='{"required":true}'/>
        <Property id="size" type="Integer" validation='{"required":false}'/>
      </Properties>
      <Group name="fromDiskOffering">
        <Component name="diskOfferingUuid" discriminator="diskOfferingUuid"/>
      </Group>
      <Generates>
        <Usage>VOLUME</Usage>
      </Generates>
    </ResourceType>
    
    <ResourceType name="Network" constraint="NONE">
      <Properties editor="apachecloudstack.fragment.resource.network.properties.selection">
        <Property id="name" type="String" validation='{"required":true}'/>
        <Property id="displayText" type="String" validation='{"required":true}'/>
        <Property id="gateway" type="String" validation='{"required":false, "regex":"^([0-9]{1,3}\\.[0-9]{1,3}\\.[0-9]{1,3}\\.[0-9]{1,3})*$"}'/>
        <Property id="netmask" type="String" validation='{"required":false, "regex":"^([0-9]{1,3}\\.[0-9]{1,3}\\.[0-9]{1,3}\\.[0-9]{1,3})*$"}'/>
        <Property id="networkDomain" type="String" validation='{"required":false}'/>
        <Property id="vpcId" type="String" validation='{"required":false}'/>
      </Properties>
      <Group name="fromNetworkOffering">
        <Component name="networkOfferingUuid" discriminator="networkOfferingUuid"/>
      </Group>
      <Generates>
        <Usage>NETWORK_BYTES_SENT</Usage>
        <Usage>NETWORK_BYTES_RECEIVED</Usage>
      </Generates>
    </ResourceType>
    
    <UsageType name="RUNNING_VM" uom="Compute-Hours">
      <Discriminator>isHaEnabled</Discriminator>
      <Discriminator>guestOsName</Discriminator>
      <Discriminator>isIso</Discriminator>
    </UsageType>
  
    <UsageType name="ALLOCATED_VM" uom="Compute-Hours">
      <Discriminator>isHaEnabled</Discriminator>
      <Discriminator>guestOsName</Discriminator>
      <Discriminator>isIso</Discriminator>
    </UsageType>
    
    <UsageType name="ROOT_VOLUME" uom="Byte-Hours">
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      <Discriminator>poolType</Discriminator>
      <Discriminator>volumeTags</Discriminator>
    </UsageType>
    
    <UsageType name="VOLUME" uom="Byte-Hours">
      <Discriminator>poolType</Discriminator>
      <Discriminator>volumeTags</Discriminator>
    </UsageType>
  
    <UsageType name="TEMPLATE" uom="Byte-Hours" />

    <UsageType name="ISO" uom="Byte-Hours"/>
    
    <UsageType name="SNAPSHOT" uom="Byte-Hours">
      <Discriminator>diskOfferingUuid</Discriminator>
      <Discriminator>poolType</Discriminator>
    </UsageType>
    
    <UsageType name="IP_ADDRESS" uom="IP-Hours"/>
  
    <UsageType name="NETWORK_BYTES_RECEIVED" uom="Bytes">
      <Discriminator>isRedundantRouterServiceEnabled</Discriminator>
      <Discriminator>isVlanEnabled</Discriminator>
      <Discriminator>networkType</Discriminator>
    </UsageType>
    
    <UsageType name="NETWORK_BYTES_SENT" uom="Bytes">
      <Discriminator>isRedundantRouterServiceEnabled</Discriminator>
      <Discriminator>isVlanEnabled</Discriminator>
      <Discriminator>networkType</Discriminator>
    </UsageType>
  
    <UsageType name="SECURITY_GROUP" uom="SecurityGroup-Hours"/>
  
    <UsageType name="LOAD_BALANCER_POLICY" uom="Policy-Hours"/>
  
    <UsageType name="PORT_FORWARDING_RULE" uom="Rule-Hours"/>
  
    <UsageType name="VPN_USERS" uom="Vpn-Hours"/>

    <Uom raw="Bytes">
      <Scale name="GB" conversionFactor="1073741824" default="true" />
      <Scale name="TB" conversionFactor="1099511627776" />
    </Uom>
    
    <Uom raw="Byte-Hours">
      <Scale name="GB-Months" conversionFactor="1073741824" default="true" monthly="true" />
      <Scale name="TB-Months" conversionFactor="1099511627776" monthly="true" />
      <Scale name="GB-Days" conversionFactor="25769803776" />
      <Scale name="TB-Days" conversionFactor="26388279066624" />
    </Uom>
    
    <Uom raw="Compute-Hours">
      <Scale name="Compute-Days" conversionFactor="24" />
    </Uom>
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    <Uom raw="Vpn-Hours">
      <Scale name="Vpn-Days" conversionFactor="24" />
      <Scale name="Vpn-Months" conversionFactor="1" monthly="true" />
    </Uom>
    
    <Uom raw="IP-Hours">
      <Scale name="IP-Days" conversionFactor="24" />
      <Scale name="IP-Months" conversionFactor="1" default="true" monthly="true" />
    </Uom>
    
    <Uom raw="Policy-Hours">
      <Scale name="Policy-Days" conversionFactor="24" />
      <Scale name="Policy-Months" conversionFactor="1" default="true" monthly="true" />
    </Uom>
    
    <Uom raw="Rule-Hours">
      <Scale name="Rule-Days" conversionFactor="24" />
      <Scale name="Rule-Months" conversionFactor="1" default="true" monthly="true" />
    </Uom>
    
    <Uom raw="SecurityGroup-Hours">
      <Scale name="SecurityGroup-Days" conversionFactor="24" />
      <Scale name="SecurityGroup-Months" conversionFactor="1" monthly="true" />
    </Uom>
    
    <Filter name="zoneUuid" />
  </ResourceMetadata>

  <Roles>
    <Role name="ROLE_CLOUD_MANAGEMENT" scope="GLOBAL" />
    <Role name="ROLE_ACCOUNT_CLOUD_MANAGEMENT" scope="TENANT" />
    <Role name="ROLE_USER_CLOUD_MANAGEMENT" scope="TENANT" />
  </Roles>
</Service>

Example 2:

<?xml version="1.0" encoding="UTF-8"?>
<Service>
  <Bootstrap>
    <Id type="CLOUD" singleton="false" category="SAAS">com.citrix.cpsm</Id>
    <Connector ref="cpsmServiceConnector">com.citrix.cpsm.connector.CPSMCloudServiceConnectorImpl</Connector>
    <Image type="logo">logo.jpg</Image> 
    <Image type="banner">logo.jpg</Image> 
    <Vendor version="1.0.1">Citrix</Vendor>
    <Locales>en_US</Locales>
    <Configuration>
      <Property id="hostURL" type="String" encrypted="false" validation='{"required":true}' />
      <Property id="username" type="String" encrypted="false" validation='{"required":true}' />
      <Property id="password" type="String" encrypted="true" validation='{"required":true}' />
      <Property id="cortexApiURL" type="String" encrypted="false" validation='{"required":false}' />
      <Property id="ecommerceApiURL" type="String" encrypted="false" validation='{"required":false}' />
      <Property id="ssoURL" type="String" encrypted="false" validation='{"required":false}' />
      <Property id="extendedProperties" type="String" encrypted="false" validation='{"required":false}' />
    </Configuration>
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    <AccountConfiguration editor="com.citrix.cpsm.fragment.customAccountConfigurationEditor">
      <!-- TODO: Can we allow a '-' character in the validation regex below ? -->
      <Property id="code" type="String" validation='{"required":true, "regex":"^[a-zA-Z0-9]{3,5}$"}' />
      <Property id="domain"  type="String" validation='{"required":true, "regex":"^([a-zA-Z0-9]([a-zA-Z0-9\\-]{0,61}[a-zA-Z0-9])?\\.)+[a-zA-Z]{2,6}$"}' />
      <Property id="cpsmUsername"  type="String" validation='{"required":true, "regex":"^[a-zA-Z0-9]{5,14}$"}' />
    </AccountConfiguration>
  </Bootstrap>
  <ResourceMetadata>
    <ResourceType name="HE" constraint="SINGLETON">
      <Group name="CustomerPlanGroup">
        <Component name="HECustomerPlanID" discriminator="HECustomerPlanID" reconfigurable="false"/>
      </Group>
      <Generates>
        <Usage>HE</Usage>
      </Generates>
    </ResourceType>
    <ResourceType name="HostedAppsandDesktops" constraint="SINGLETON">
      <Group name="CustomerPlanGroup">
        <Component name="HostedAppsandDesktopsCustomerPlanID" discriminator="HostedAppsandDesktopsCustomerPlanID" reconfigurable="false"/>
      </Group>
      <Generates>
        <Usage>HostedAppsandDesktops</Usage>
      </Generates>
    </ResourceType>
    <UsageType name="HE" uom="units per month" discrete="true"/>
    <UsageType name="HEUserPlan" uom="units per month" discrete="true">
      <Discriminator>HEUserPlanID</Discriminator>
    </UsageType>
    <UsageType name="HostedAppsandDesktops" uom="units per month" discrete="true"/>
    <UsageType name="HostedAppsandDesktopsUserPlan" uom="units per month" discrete="true">
      <Discriminator>HostedAppsandDesktopsUserPlanID</Discriminator>
    </UsageType>
    <UsageType name="HostedAppsandDesktopsOffering" uom="units per month" discrete="true">
      <Discriminator>HostedAppsandDesktopsOfferingID</Discriminator>
    </UsageType>
    <Uom raw="units per month" discrete="true"/>
  </ResourceMetadata>
  <Roles>
    <Role name="ROLE_CPSM_GLOBAL_MANAGEMENT" scope="GLOBAL" />
    <Role name="ROLE_CPSM_OPS_USER" scope="GLOBAL" />
    <Role name="ROLE_CPSM_TENANT_MANAGEMENT" scope="TENANT_ADMIN" />
    <Role name="ROLE_CPSM_USER" scope="TENANT_ADMIN" />
  </Roles>
  <ChannelSettings>
    <Property id="location" type="String" encrypted="false" validation='{"required":true}' reconfigurable="false" />
  </ChannelSettings>
 </Service>
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Sample Metadata

The sample metadata given below can be used as a reference by connector implementers to
build their connectors.

Connector with no resource types or usage types
A connector can be developed for a service that has no resource types or usage types. For
example, monitoring as a service that is being offered as a free service; in such a case,
there is no provisioning from the CPBM catalog and there are no charges for the service.

Sample metadata (with no resource metadata tags):

<Bootstrap>
      <!-- The value of this tag should be a unique identifier for the service. Refer to the documentation for attribute values -->     
    <Id type="CLOUD" singleton="false" category="MonaaS">com.citrix.basic.no.ut.rt</Id>
     
    <!-- The value for 'ref' specified below should be the same as defined in service-sdk-context-osgi.xml and service-sdk-context.xml -->
    <!-- The value of the tag itself is the class which implements the interface pbm.platform.spi.CloudConnectorFactory -->
    <Connector ref="com.citrix.basic.connector.monitoring">com.citrix.basic.connector.BasicConnectorFactory</Connector>
    <Image type="logo">logo.jpg</Image>
    <Image type="banner">logo.jpg</Image>
    <Vendor version="0.0.1">Citrix Demo Inc.</Vendor>
    <Locales>en_US</Locales>
    <Configuration>
      <Property id="MonServerURL" type="String" encrypted="false" validation='{"required":true}' />
    </Configuration>
  </Bootstrap>
   
  <Roles>
    <Role name="ROLE_ADMIN_MONITORING" scope="GLOBAL" />
    <Role name="ROLE_TENANT_MONITORING" scope="TENANT" />
     
  </Roles>
 </Service>

Connector with only usage type
Connectors can be developed where no provisioning happens from CPBM catalog, but the
usage is reported and charged accordingly. For example, VM protection as a service.

Sample metadata for ResourceMetadata tag:

<ResourceMetadata>                
     
    <UsageType name="VMProtection" uom="Hours" />       
     



    <Uom raw="Minutes">     
      <Scale name="Minutes" conversionFactor="1" default="true" />
    </Uom>
         
  </ResourceMetadata>

Connector with resource type, but no components
Connectors can be developed that offer a service such as simple object storage as a service.
In such a case, the resource type is just storage buckets and there are no components to
define the resource type further.

Sample ResourceMetadata:

<ResourceMetadata>                
     
    <ResourceType name="StorageBucket" constraint="NONE">
      <Properties>
        <Property id="name" type="String" validation='{"required":true}'/>
      </Properties>
    </ResourceType>
         
  </ResourceMetadata>
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Lifecycle Management

A connector integrated with CPBM is required to reflect entities created in CPBM in the
corresponding Cloud Service and is responsible for keeping these entities in sync with CPBM
during their lifecycle in CPBM. There are 4 entities created in CPBM that need
synchronization. They are:

• Channel: Channels represent customer segmentation in CPBM. They may refer to
Geographies, selling channels, resellers, partners etc.

• Account: Accounts (sometimes referred to as Tenants) represent customer billabile
entities. This is the entity against which usage is aggregated and invoices are
generated.

• User: Users represent actual people interacting with the system. Users can provision
and consume resources in an account. While CPBM can track usage at a user level,
billing is aggregated at an account level.

• Subscription: Subscriptions are specific commitments for resources that are purchased
by users. Users may acquire resources without commitments. These will not be
attached to subscriptions, and will be charged on a utility basis. Users own
subscriptions and resources.

While subscriptions are tied to resources from specific services, the Channel, Account and
User entities are cross service entities, and represent the core organizational structure in
CPBM. The following figure shows the organization of these entities in CPBM.

Figure 1. Organizational Structure of CPBM entities
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Account Lifecycle

A Connector package can implement account provisioning lifecycle handler so that accounts
in CPBM can be mapped to a corresponding entity in the underlying cloud service. CPBM has
accounts and each account minimally has an owner, who is called a master user. Users in
CPBM initiate all actions and if a service does not differentiate between an account and a
user then it should return same handle for both account as well as a user. In such a case the
service should not implement the User Provisioning Lifecycle handler. In this case, the
service will not be able to expose user specific access.

CPBM creates these mapping lazily i.e. the mapping is not created at CPBM account
creation time but rather at first subscription provisioning time. See Subscription Lifecycle
handling for details on provisioning.

Connectors should use the account lifecycle handler to be in synchronization with CPBM
account lifecycles. Connectors should implement all methods in AccountLifecycleHandler if
they need to represent an account in their service. Connectors may choose to not
distinguish between certain states (like restrict and suspend) or may choose to do nothing
for certain states.

TenantHandle
Tenant handles are represented as Handle objects which an account can set/get from a
Tenant object. A tenant handle is the representation of account information in the cloud
service in CPBM. For the most part, other than its existence, TenantHandles are opaque to
CPBM. A TenantHandle object is represented as follows.

public class TenantHandle {
  /* A unique opaque handle to identify the service specific entity corresponding to
     this account */
  public String getHandle();

  /* Can store any json/string data and CPBM will preserve this as it is. This field 
     may be used to store any additional data the connector would like to associate with 
     this account handle
  */
  public String getData();

  /* Connector can store apiKey/secret or username/passwords etc in this key and values 
     in this map would be displayed in the CPBM credentials section. 
  */
  public Map<String, String> getApiCredentials();

  /* Back reference to the tenant */
  public Tenant getTenant();
}

public class Tenant {
...
  /* Return the handle for the corresponding service instance if exists. Returns null 



     otherwise */
  public TenantHandle getHandle(String serviceInstanceId);
  /* Add an tenant handle to the tenant */
  public void addHandle(String serviceInstanceId, TenantHandle handle);
  /* Remove an tenant handle from the tenant */
  public void removeHandle(String serviceInstanceId);
...
}

The handle string should be the same one that is used to identify the tenant in the usage
record.

AccountLifecycleHandler
The AccountLifecycleHandler SPI is defined as follows:

/**
   * Handles account lifecycle. 
  */
public interface AccountLifecycleHandler {

  /* Registers an account as well as account owner user in cloud service and stores the 
     mapping of the account and account owner user as handles in tenant and 
     tenant.owner()passed */
  public void register(Tenant t);

  /* Restrict the account. */
  public void restrict(Tenant t);

  /* Suspend the account */
  public void suspend(Tenant t);

  /* Reactivate the account */
  public void reactivate(Tenant t);

  /* Deletes the account. Connector should clean the handle for tenant by calling   
     t.removeHandle(serviceInstanceObj) */
  public void terminate(Tenant t);

  /**
   * Sets service level controls at tenant level. Service level
   * controls are set under the following scenarios
   *
   * <ul>
   *   <li> When a tenant is newly created, the controls are applied from the tenant's account type
   *   <li> When a tenant is updated with new control values
   *   <li> when a tenant moves account types
   * </ul>
   * In all cases, the service is expected to do its best to apply the
   *   updated values by triangulating between the  tenant's current
   *   settings, the new settings and any current limitations. For
   *   example, a tenant's current quota, new quota and currently used
   *   amount (against that quota).
   *
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   * @param tenant The tenant to update
   * @param controls - Map of control names and their values; Not null when SP edits the service controls
   *                   and when a tenant moves account types
   */

  public void setControls(Tenant tenant, Map<String, String> controls);

  /**
   * Retrieves service level controls defined at tenant level
   * @param tenant
   * @return
   */

  public Map<String, String> getControls(Tenant tenant);

}

The SPI implementation should implement these methods as follows:

• register: Register service specific scope corresponding to an account in CPBM. It is
required that the account creation process also handle the master user (owner)
creation process as well. The UserLifecycleHandler will NOT be called for the master
user. Account handle MUST be added using Tenant.addHandle. The tenant owner can
be accessed using Tenant.getOwner() and user handle can be added using
User.addHandle() on the owner object. If the connector does not support users the user
handle need not be added.

• restrict: restrict all users from managing resources in the cloud service. The resources
may still be operational and may be accessible by other means. In general, it is
preferred that this state allow users to reduce their resource consumption. It may be
sufficient to allow master users access to perform this.

• suspend: prevent users from accessing their resources. The resources should as much as
possible cease to be operational. For example, VMs should be shut down but not
destroyed. Note that this is not a terminal state so the resources should remain
recoverable.

• reactivate: re-enable access to resources for all users in the account so that they can
get back in operational state. It is not required that the service make the resources
operational (Eg. VMs can be started but the service need not start the VMs).

• terminate: delete the account, all the users and remove all resources used by this
account.

For UserHandle structure and processing, see UserLifecycleHandler section. The same
applies to the master user as well.
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Figure 1. Account Lifecycle Handler

For information on service onboarding a customer, see Onboarding and managing a service.
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User Lifecycle

Connectors should implement the user lifecycle SPI if the cloud service supports users
within accounts and resources owned by users. This SPI will be called by CPBM to keep users
in services in sync with the user lifecycle in CPBM.

UserHandle
The UserHandle is an opaque handle that represents a given user in a service instance.

public class UserHandle {
  /* A unique opaque handle to identify the service specific entity corresponding to
     this user */
  public String getHandle();

  /* Can store any json/string data and CPBM will preserve this as it is. This field 
     may be used to store any additional data the connector would like to associate with 
     this user handle
  */
  public String getData();

  /* Connector can store apiKey/secret or username/passwords etc in this key and values 
     in this map would be displayed in the CPBM credentials section. 
  */
  public Map<String, String> getApiCredentials();

  /* Back reference to the user */
  public User getUser();

}
public class User {
...
  /* Return the user handle for the corresponding service instance if exists. Returns 
     null otherwise */
  public UserHandle getHandle(String serviceInstanceId);
  /* Add an user handle to the user */
  public void addHandle(String serviceInstanceId, UserHandle handle);
  /* Remove a user handle from the user */
  public void removeHandle(String serviceInstanceId);
}

The handle string should be the same one that is used to identify the user in the usage
record.

UserLifecycleHandler
The UserLifecycleHandler is defined as follows:



/**
  * Handles user lifecycle. 
  */
public interface UserLifecycleHandler {

  /* Registers a user in the cloud service and stores the mapping of the user as 
     handles in user object passed as parameter. User handle must be added as   
     User.addHandle. */
  public String register(User user);

  /* Lock the user */
  public void lock(User user);

  /* Disable the user */
  public void disable(User user);

  /* Unlock the user */
  public void unlock(User user);

  /* Enable the user */
  public void enable(User user);

  /* Terminate the user. In this case user handle should be cleaned. This can be done   
     as user.removeHandle */
  public void terminate(User user);

/**
   * Sets service level controls at user level. User level
   * controls are set under the following scenarios
   *
   * <ul>
   *   <li> When a user is newly created, the controls are applied from the tenant's account type
   *   <li> when a tenant moves account types
   * </ul>
   * In all cases, the service is expected to do its best to apply the
   *   updated values by triangulating between the  tenant's current
   *   settings, the new settings and any current limitations. For
   *   example, a tenant's current quota, new quota and currently used
   *   amount (against that quota).
   *
   * @param user The user to update
   * @param controls - Map of control names and their values; Not null when SP edits the service controls
   *                   and when a tenant moves account types
   */

  public void setControls(User user, Map<String, String> controls);

  /**
   * Retrieves service level controls defined at tenant level
   * @param user The user
   * @return
   */

  public Map<String, String> getControls(User user);
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}

The UserLifecycleHandler SPI methods are as follows:

• register: Register a scope corresponding to this user in the cloud service

• lock: Prevent the user from accessing their resources from the service UI/API. The
resources can remain operational.

• disable: Prevent user from accessing resources. Reduce all resource consumption while
allowing reactivation.

• unlock: allow users access to their resources again

• enable: allow users to access their resources again. Ideally, enable will remember the
lock state of the user. This allows blanket disable/enable without changing lock state.

• terminate: Remove the user from the service

A note on the difference between locking and disabling. Lock simply prevents access to
resources. It does not reduce resource consumption. It may be used for minor infractions
such as login failures etc. However, disable reduces resource consumption (say by shutting
down VMs etc) and is expected to put the user in a state of minimal resource consumption,
while still allowing the system to recover that user back to operational state. Disable is also
expected to remember (ideally) the lock state so that when a user is locked and then
disabled and re-enabled, they continue to be in the locked state. However, in practice, it is
not expected that all cloud services support this nuance. So, it is acceptable for disable to
behave exactly like lock.
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Figure 1. User Lifecycle Handler
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Subscription Lifecycle

For the most part resource lifecycles are decoupled from subscription lifecycles. However,
in order to enable CPBM to provision and de-provision a resource when subscriptions need
to be provisioned and terminated respectively, an connector should implement the below
interface to handle provisioning and termination of resources managed by them. As before,
CPBM expects the connector to maintain a handle on CPBM to refer to a resource that was
provisioned as part of a subscription.

SubscriptionHandle
A SubscriptionHandle for a subscription represents the resource in the service corresponding
to a subscription. It is defined as follows:

public class SubscriptionHandle {
  /* A unique opaque handle to identify the service specific entity corresponding to
     this resource */
  public String getHandle();

  /* Can store any json/string data and CPBM will preserve this as it is. This field 
     may be used to store any additional data the connector would like to associate with 
     this resource handle
  */
  public String getData();

  /* Back reference to the subscription */
  public Subscription getSubscription();
}
public class Subscription {
...
  /* Return the subscription handle if exists. Returns null otherwise */
  public SubscriptionHandle getHandle();
  /* Add a subscription handle to the resource */
  public void addHandle(SubscriptionHandle handle);
  /* Remove an subscription handle from this subscription */
  public void removeHandle();
  /* Returns provisioning data as a Map */
  public Map<String, String> getConfigurationMap();
}

Provisioning configuration data for a given subscription can be retrieved from the
subscription by calling getConfiguration(). This will contain all configuration information
(resource component selections, filters, custom configuration data) used to provision a
resource for this subscription.

The handle string should be the same one that is used to identify the resource in the usage
record.



SubscriptionLifecycleHandler
SubscriptionLifecycleHandlers are used to synchronize subscription states with the
underlying service. The SubscriptionLifecycleHandler is defined as follows:

/**
  * Handles subscription lifecycle. 
  */
public interface SubscriptionLifecycleHandler {

  /* Create a resource based on configuration provided in subscription. Set the handle  
     of the resource back to subscription object as s.addHandle(handle).  Note 
     that unlike tenants and users where the same CPBM entity has representation in 
     multiple services, you do not need to identify the service instance for a 
     subscription as a subscription is already tied to a single service instance. */
  public void provision(Subscription s);

  /* Validate if the resouce tied to this subscription is still active. */
  public void validate(Subscription s);

  /* Destroy the resource and remove the subscription handle field by calling 
     s.removeHandle. Subscription configuration is no longer valid. */
  public void destroy(Subscription s);
}

The SubscriptionLifecycleHandler methods should be implemented as follows:

• provision: Provision a resource corresponding to this subscription based on
configuration data provide by Subscription.getConfiguration()

• validate: Validate whether a resource (if exists) continues to be active for a given
subscription. This method will be called periodically or on demand to verify that the
underlying resource tied to this subscription remains active. It is possible that resource
is no longer active, if the resource failed to launch or if the resource was destroyed or
removed directly on the service through other means.

• destroy: Destroy the resource corresponding to this subscription as the subscription is
now terminated.
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Figure 1. Subscription Lifecycle Handler
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Usage Collection

In order for CPBM to accurately bill a customer for usage of resources from an underlying
cloud service, CPBM needs to periodically collect usage from the cloud service and be able
to understand and mediate it. Mediation is the process by which CPBM identifies the
product corresponding to usage received from an underlying cloud service. CPBM does this
based on a set of mediation rules attached to a product. A usage record is matched to a
product based on its usage type and matching discriminator values between what is
collected for the usage record and what is specified in a mediation rule for the product.

As described earlier, in order for this to happen, CPBM periodically collects usage in a
well-defined format that is understood by CPBM's mediation engine. It is the responsibility
of the Usage collector implementation to transform usage from the underlying resource to
the standard format recognized by CPBM.

A connector must implement a Usage collector for its underlying cloud service. The
connector (i.e., the Usage collector implementation) shall return usage in terms of
UsageData objects. Each UsageData object describes a distinct usage record and should
include values for all discriminators described in the product metadata (this includes
resource type, filter and additional discriminator values).

UsageData
UsageData is defined as follows:

public class UsageData {
  /* the usage type for this resource. Should match the type specified in the metadata 
   */
  String getUsageType();
  /* The tenant handle if any. Should match the handle for owning tenant associated 
     in the account lifecycle handler */
  String getTenantHandle();
  /* The user handle if any. Should match the handle for the owning user associated 
     in the user lifecycle handler */
  String getUserHandle();
  /* The resource handle, if any. Should match the handle for this tenant 
     associated in the subscription lifecycle handler */
  String getResourceHandle();
  /* Start date/time for this usage record */
  Date getStartDate();
  /* End Date/Time for this usage record */
  Date getEndDate();
  /* service specific reference id for this usage record. This should be the same 
     format used by the markers. */
  String getReferenceId();
  /* Discriminator values for *all* declared discriminators for this usage. This 
     includes resouce type ids, filter values and other discriminators declared for
     this usage type in the metadata */
  Map<String, String> getDisriminators ();
  /* Raw usage. Actual usage consumed, in the unit of measure described in metadata */



  Double getUsage();
}

UsageCollector
The UsageCollector SPI defines the protocol which CPBM uses to collect usage from the
underlying service on a periodic basis. It is defined as follows:

public interface UsageCollector {
  /* Returns a batch of usage data collected from the cloud service. */
  public UsageResultSet collect(String startMarker, Date endDate);
}

The UsageCollector is called periodically to collect data from the underlying cloud service.
CPBM will schedule a job to collect this data at an operator defined frequency. In any given
run CPBM will repeatedly call the UsageCollector to collect usage, until it exhausts
available data. The startMarker and endDate determines the range of usage data to collect.
When collect is called, the returned usage data:

• should start from after the startMarker and it must be generated on or before the
passed endDate. For better performance, we recommend all implementations of the
UsageCollector return usage data in small batches. The batch size should typically be in
hundreds. Any subsequent call to UsageCollector.collect() should return the next batch
of usageData. In case there is no usageData left, return UsageResultSet with the input
startMarker as the marker and null usageData list. CPBM will continuously call
UsageCollector.collect() for a given endDate, until all data is exhausted for this time
range.

• In case of conflicting usageData (i.e., duplicate referenceId) CPBM will resolve the
conflict by using the first record received.

• The UsageResultSet object contains List of UsageData. This list should be sorted by
UsageData.endDate from oldest to newest. Also, for any two calls to
UsageCollector.collect, all of UsageData collected in the later call should be newer
(have later UsageData.endDate, than the data collected in the earlier call).

The interaction between CPBM and Cloud Service for collecting usage is shown the figure
below
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Figure 1. Usage Collection Process
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Tenant Based Usage Collection

In order for CPBM to accurately bill a customer for usage of resources from an underlying
cloud service, CPBM needs to periodically collect usage from the cloud service and be able
to understand and mediate it. Mediation is the process by which CPBM identifies the
product corresponding to usage received from an underlying cloud service. CPBM does this
based on a set of mediation rules attached to a product. A usage record is matched to a
product based on its usage type and matching discriminator values between what is
collected for the usage record and what is specified in a mediation rule for the product.

As described earlier, in order for this to happen, CPBM periodically collects usage in a
well-defined format that is understood by CPBM's mediation engine. It is the responsibility
of the Usage collector implementation to transform usage from the underlying resource to
the standard format recognized by CPBM. Connectors can split collecting usage by tenant,
to help improve performance and efficiency. This collector is designed to support regular
metered and discrete usage types. A discrete usage type generates only whole number
usage. An example of the discrete usage type is a mailbox, which will be billed for the
whole billing period even though it is used partially. This is a crucial difference between
metered usage type and discrete usage type.

A connector must implement a Tenant Based Usage collector for its underlying cloud
service. The connector (i.e., the Usage collector implementation) shall return usage in
terms of UsageData objects. Each UsageData object describes a distinct usage record and
should include values for all discriminators described in the product metadata (this includes
resource type, filter, and additional discriminator values).

UsageData
UsageData is defined as follows:

public class UsageData {
  /* the usage type for this resource. Should match the type specified in the metadata 
   */
  String getUsageType();
  /* The tenant handle if any. Should match the handle for owning tenant associated 
     in the account lifecycle handler */
  String getTenantHandle();
  /* The user handle if any. Should match the handle for the owning user associated 
     in the user lifecycle handler */
  String getUserHandle();
  /* The resource handle, if any. Should match the handle for this tenant 
     associated in the subscription lifecycle handler */
  String getResourceHandle();
  /* Start date/time for this usage record */
  Date getStartDate();
  /* End Date/Time for this usage record */
  Date getEndDate();
  /* service specific reference id for this usage record. This should be the same 
     format used by the markers. */
  String getReferenceId();



  /* Discriminator values for *all* declared discriminators for this usage. This 
     includes resouce type ids, filter values and other discriminators declared for
     this usage type in the metadata */
  Map<String, String> getDisriminators ();
  /* Raw usage. Actual usage consumed, in the unit of measure described in metadata */
  Double getUsage();
}

TenantBasedUsageCollector
The TenantBasedUsageCollector SPI defines the protocol which CPBM uses to collect usage
from the underlying service on a periodic basis. To handle situations where usages needs to
be reported differently for different days in a billing period, this class of collector requires
implementingfollowing two methods:

• collect(...) - This method is called all the time for usage collection, except at the
beginning of the billing period for the tenant given

• inventory(...) - This method is only called at the beginning of a billing period for
the given tenant.

For discrete usage type, collect(...) should return only those usages which were
created new since the last timecollect(...) was called. This is possible since the
collector marker is stored and passed as an argument. It is defined as follows:

public interface TenantBasedUsageCollector {    
  public UsageResultSet collect(Tenant tenant, String startMarker, Date endDate);  
  public UsageResultSet inventory(Tenant tenant, String startMarker, Date billingPeriodStartDate);

}

The TenantBasedUsageCollector is called periodically to collect data from the underlying
cloud service. CPBM will schedule a job to collect this data at an operator defined
frequency. In any given run CPBM will repeatedly call the UsageCollector to collect usage,
until it exhausts available data. The startMarker and endDate determines the range of
usage data to collect. When collect is called, the returned usage data:

• should start from after the startMarker and it must be generated on or before the
passed endDate. For better performance, we recommend all implementations of the
UsageCollector return usage data in small batches. The batch size should typically be in
hundreds. Any subsequent call to UsageCollector.collect() should return the next batch
of usageData. In case there is no usageData left, return UsageResultSet with the input
startMarker as the marker and null usageData list. CPBM will continuously call
UsageCollector.collect() for a given endDate, until all data is exhausted for this time
range.

• In case of conflicting usageData (i.e., duplicate referenceId) CPBM will resolve the
conflict by using the first record received.

• The UsageResultSet object contains List of UsageData. This list should be sorted by
UsageData.endDate from oldest to newest. Also, for any two calls to
UsageCollector.collect, all of UsageData collected in the later call should be newer
(have later UsageData.endDate, than the data collected in the earlier call).

Tenant Based Usage Collection
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Collect method
This method is the same as UsageCollector.collect(String, Date) except that it
takes an extra argument that of tenant. Connectors can now split collecting usage by
tenant, to help improve performance and efficiency now and in the long run. CPBM will call
this method all the time except at the beginning of the billing period for the tenant given,
at which time the other method inventory(Tenant, String,
billingPeriodStartDate) will be called.

com.citrix.cpbm.platform.model.UsageResultSet collect(com.vmops.model.Tenant tenant,
                                                      java.lang.String startMarker,
                                                      java.util.Date endDate)
                                                      throws UsageCollectionException

• Parameters:

• tenant - Tenant object for which usage needs to collected

• startMarker - marker information specific to an implementor, which could be used
to mark the boundary for usage collected so far and helps define starting point for
usage to be collected. For example, time last collected.

• endDate - time up to which billing needs to be collected. This will always be the
previous evening 23:59:59

• Returns: UsageResultSet - Consist of lastMarker and UsageData list

• Throws: UsageCollectionException

Inventory method
This method is the same as collect(Tenant, String, Date) method, the only
difference being this method is only called at the beginning of a billing period for the given
tenant. On all other days, collect(Tenant, String, Date) is called for usage
collection.

Note: For

• metered usage types, this could be the same as the collect(Tenant, String,
Date) call

• discrete usages, this could be used to recalculate stocks in the inventory

com.citrix.cpbm.platform.model.UsageResultSet inventory(com.vmops.model.Tenant tenant,
                                                        java.lang.String startMarker,
                                                        java.util.Date billingPeriodStartDate)
                                                        throws UsageCollectionException

• Parameters:

• tenant - Tenant object for which usage needs to collected
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369



• startMarker - marker information specific to an implementor, which could be used
to mark the boundary for usage collected so far and helps define starting point for
usage to be collected. For example, time last collected.

• billingPeriodStartDate - the start date of the current billing period for the tenant

• Returns: UsageResultSet - Consist of lastMarker and UsageData list

• Throws: UsageCollectionException
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Event Collection

Similar to usage collection, CPBM periodically can collect events from the cloud service and
expose it to the end customer and operators from CPBM. While event log may be displayed
in the resource UI of the service, CPBM offers a rich set of notification capabilities allow
the end user to customize what events they would like to receive via one or more
notification channels including email and SMS.

The EventCollector model is very similar to that of the UsageCollector. CPBM will
periodically call the EventCollector to collect events in a normalized form for CPBM to store
and operate upon. It is the EventCollector's responsibility to map events from the
underlying cloud service to the normalized form prescribed by CPBM.

An implementation of the EventCollector SPI will be frequently (typically every few
minutes) to collect events from the cloud service. Because it is being called frequently,
EventCollectors should be fast as well as prudent in the set of events they expose.
Typically, since CloudServices will be SSO enabled, local login events in the underlying
service should, for example, be excluded. Otherwise, the event stream will get too noisy.
Each call of the EventCollector will return an EventResultSet containing one batch of
events.

EventResultSet
The returned Event objects are enclosed in an EventResultSet to allow for batch operations.
EventResultSet is defined as follows:

/**
  * A result set returned for each run of the collector
  */
public class EventResultSet {
  /* The marker for the last record fetched. This is stored and passed back by CPBM 
     during the collection process to identify the last record fetched.
  public String getMarker();
  /* List of Event objects in this batch */
  List<Event> getEvents();
}

The EventResultSet has the following elements:

• marker: Marks the last record returned by the collector. This is an opaque handle that
is passed back to the collector so it can continue collecting event data. This should
never be null. When data is exhausted for a given run, the marker should return the
input marker as the last marker as indication that there is no more data.

• Event List: The returned list of Events. Calls to EventCollector should return Event in
reasonable batch sizes. CPBM does not impose batch sizes except to offer guidance that
this should be small to prevent memory overruns.



Event
An Event is defined as follows:

public class Event {
  enum Severity { CRITICAL, ALERT, INFO };
  /* return the severity level */
  public Severity getSeverity();

  /* the time stamp of event generation */
  public Date getCreatedAt();

  /* Message code */
  public String getCode();

  /* handle of the user */
  public String getUser();

  /* Unique identifier of event in the Cloud service. Same format as the marker */
  public String getId();

  /* Event category as classified by the cloud service */
  public String getCategory();

  /* Dynamic attributes that represent the subject of this event */
  Map<String, String> getAttributes();
}

EventCollector
The EventCollector SPI defines the interface connectors have to implement to support
event collection. Note that this SPI is optional. It is defined as follows:

public interface EventCollector {
  /* Returns a list of events collected from the Cloud Service. */
  public EventResultSet collect(String startMarker, Date endDate);
}

The EventCollector is called periodically to collect event data from the cloud service. CPBM
will schedule a job to collect event data at an operator defined frequency. In a given run,
CPBM will repeatedly call the EventCollector until it exhausts all available data for the
range specified between startMarker and endDate. When collect is called, the returned
events list:

• should start from after the startMarker and it must be generated on or before the
passed endDate. For better performance, we recommend all implementations of
EventCollector return usage data in small batches. The batch size should typically be
under a hundred. Any subsequent call to EventCollector.collect() should return the next
batch of Events. In case there is no Events left, return EventResultSet with the input
startMarker as the marker and null events list. CPBM will continuously call
EventCollector.collect() for a given endDate, until all data is exhausted for this time
range.
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• In case of conflicting Event(i.e., duplicate id) CPBM will resolve the conflict by using
the first record received.

The interaction between CPBM and Cloud Service for collecting events is shown the figure
below

Figure 1. Event Collection Process
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UI Contributions

CPBM can allow the user to have a seamless experience moving from its UI in the resource
management UI of the cloud service. To support this capability, the connector needs to
provide some metadata and implement a ViewResolver. The role of the ViewResolver is to
resolve URLs in the target cloud service's UI to allow a user to navigate to a given context.
Connector implementer can contribute to four types of UI views and they are:

1. Resource View: There can be one or more resource views. Within the context of a
service instance, each resource view can be presented by CPBM as a sub navigational
element. Alternatively, a cloud service can use just one view and handle sub navigation
internally.

2. Subscriptions Details View: A view that provides information on a resource associated
with a subscription.

3. Account Settings View: A view that provides account level settings for this cloud
service.

User Settings View: A view that provides user level settings for this service.

ResourceView
A Connector can define multiple resource views, each of which will be presented as a
sub-tab or window with the navigation provided by CPBM. This allows for UIs built with
navigation menus that are incompatible to fit their leaf pages directly into CPBM. In the
serviceDefinition.xml file, a connector can list codes that represent each resource view
they wish to present to CPBM.

View
The View object represents a UI view contributed by the cloud service connector into
CPBM. It is defined as follows:

/*
* Used to represent a UI contribution to CPBM
 * 
 */
public class View{
  public enum ViewMode { WINDOW, IFRAME };
  /* Unique name for the View */
  String getName();

  /* Url of the View */
  public String getURL(); 

  /* The view mode (ie should it be embedded as an iFrame or shown as a window */
  public ViewMode getMode();



 /* Path to the image used to represent it in the UI */
  private String getIcon();
}

ViewResolver Interface
The ViewResolver interface allows CPBM to resolve URLs for specific contexts from the
underlying cloud service. This allows the connector to produce URLs in any style (query
string, REST style etc). Each of these methods essentially returns a View object that
includes a URL and additional metadata. The ViewResolver is defined as follows:

public interface ViewResolver {

  /** Returns list of resource view */
  public List<View> listResourceViews(User user);

  /* Returns the Subscription detail view */
  public View resolveSubscriptionDetailView(Subscription subscription);

  /* Returns the Account setting view */
  public View resolveAccountSettingsView(Tenant tenant);

  /* Returns the User setting view */
  public View resolveUserSettingsView(User user);
    
     /*Returns the Administrative view of the cloud service*/
  public View getConsoleView(User user);

}

The URLs to the Subscription Details, Account Settings and User Setting are resolved using
resolveSubscriptionDetailsView(), resolveAccountSettingsView(), resolveUserSettingsView()
respectively. Depending on the number of resources that the underlying cloud service
offers, listResourceViews() should return the list of Views.

Note: If there is only one section defined, it is assumed that a tabbed UI structure is not
required.
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Single Sign-on Setup

In order to enable a seamless experience switching between cloud service UIs and CPBM UI,
it is strongly encouraged that the connector implement or integrate with a single sign on
scheme. CPBM comes out of the box with support for a couple of ways to SSO into a target
cloud service system.
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Using CAS (Central Authentication
Service)

This is most preferred way to achieve SSO. CPBM also ships CAS, which runs on the same
server as CPBM. Any Cloud Service, which is capable of authenticating using CAS, can be
added to the CAS server to achieve SSO.

Steps for enabling SSO using CAS are as follows:

Add the service URL in the configuration file "deployerConfigContext.xml" as show below:

<bean id="serviceRegistryDao"     
      class="org.jasig.cas.services.InMemoryServiceRegistryDaoImpl">
  <property name="registeredServices">
    <list>
      <bean class="org.jasig.cas.services.RegisteredServiceImpl">
        <property name="id" value="0" />
        <property name="name" value="CloudPortal" />
        <property name="description" value="CloudPortal Service" />
        <property name="serviceId"      
                  value="http://CPBMHost/portal/portal/j_spring_security_check”/>
      </bean>

      <bean class="org.jasig.cas.services.RegisteredServiceImpl">
        <property name="id" value="1" />
        <property name="name" value="Cloud Service" />
        <property name="description" value="Cloud Service XaaS" />
        <property name="serviceId" value="<xaas.service.url>" />
      </bean>
    </list>
  </property>
</bean>

Set the login and logout URL in the Cloud Service as https://<CPBM host>/cas , and
https://<CPBM host>/cas/logout, respectively.

Import the CAS server certificate into the system truststore of the Cloud Service server.



378

Implementing “SsoHandler” Interface

This method is used to achieve SSO by creating Cookies and/or by making direct login calls
to Cloud Service. If the Cloud Service is running on the same domain or single level
sub-domain then setting the cookies would be sufficient to achieve SSO. Cloud Service can
extend the below interface to inject the cookies into the response object.

public interface SSOHandler {
    
  /* This method returns the SSO Object which contains list of Cookies that will be 
   * added to the response, and a string which will be used by the js file (The js 

    * file is provided by CloudConnector as part of meta data and injected into 
    * the UI) */
    public SsoObject handleLogin(User user);
}

public class SsoObject {
  /* List of cookies to set */
  List<Cookie> getCookies();

  /* callback method to call (optional) */
  String getCallback();

  /* SSO JSON String to return (optional) */
  String getSSOString();
}

Sample Implementation of SSOHandler interface:

public class XaasSSOHandler implements SSOHandler {

  @Override
  public SsoObject handleLogin(User user) {
    Cookie cookie = new Cookie("XAASUSER", "abcd-efgh");
    String ssoData = "{‘ssoData’:{'command':'login', 'signature':'qWErtYUiop/+='}}";
    ssoObject ssoObject = new SsoObject();
    ssoObject.getCookies().add(cookie);
    ssoObject.setCallback(‘handleSSO’);
    ssoObject.setSSOString(ssoData);
    return ssoObject;
  }
}

Along with implementing the "SSOHandler" interface , the Cloud Service can optionally
provide a javascript file as part of meta data which CPBM will inject into the UI just before
the iFrame of Cloud Service. This javascript file will have the implementation of the
callback method specified in the SSO object returned by SSOHandler, and this method will
take input parameters as the SSO data from SSO Object and the URL of the Cloud service
view along with a callback function to call. The callback method may then make a call to
the target service to single sign on. Typically, this should be a JSON-P call.



Steps to SSO into Cloud Service:

1. CPBM will inject the javascript, provided by the Cloud Service, into the UI.

2. CPBM will make an AJAX call to the SSOHandler implementation.

3. CPBM will set the cookies returned in the SSO Object into the response. If the cookies
are intra domain and have the correct path for the target service to read, this may be
sufficient to single-sign on. If not, the callback method mechanism (see below) offers
additional options to achieve SSO.

4. If callback property exists, CPBM will call the callback method as returned in the SSO
Object, it will pass the SSO data and view URL as input parameters to the callback
method.

5. Callback method will make JSONP call to Cloud Service for login, and use the returned
values to generate final view URL. It then calls the supplied callback function

A sample cloud service callback method is shown below:

function handleSSO(Var ssoData, Var iFrameURL, var callback){
  var finaliFrameURL;
  $.ajax({url: "http://xaas.service.com/api/login",
          dataType: 'jsonp',
          data: ssoData.ssoData,
          jsonp : "jsoncallback", 
          success: function(data) {
            finaliFrameURL = iFrameURL + “&sessionKey=” + data.sessionKey;
            callback(finaliFrameURL);
    }
  });
}

The interaction between CPBM and Cloud Service for achieving SSO is shown in the figure
below:Figure 1. Single Signon Process
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Development Using SDK

This section is for the developers/partners who would implement XAAS (Anything as a
service) Connector from CPBM. This document is divided in the following major categories.

1. System Requirements

2. Downloading and Installing the Cloud Service SDK

3. Downloading and Installing the CPBM Development Server

4. Creating the CS SDK Maven STS Project

5. Various package structures and their responsibilities

6. Default classes generated as part of the CPBM script and its function

7. Spring OSGI Service Registration Listeners

8. Location of serviceDefinition.xml

9. Writing Cloud Service Connector

System Requirements

The document assumes that the developer machine is installed with the following system
requirements and the developer is also aware of the same.

1. Windows XP (32-Bit), Windows Vista or Windows 7 (32- or 64-Bit), or MacOSX, or Linux

2. JDK Version 1.6

a. Set JAVA_HOME environment variable to the root of the JDK install path.

b. Add %JAVA_HOME%\bin to the PATH environment variable.
3. Spring Tool Suite (STS) Version 3.1.0 or higher.

4. Apache Maven Version 3.

a. Add <Maven Install Path>\bin to the PATH environment variable.
5. CPBM Server

Downloading and Installing the CS-SDK

1. Unzip the content to a local directory in your system.

2. Double-click cssdk-standard.jar or run the command java -jar cssdk-standard.jar to
launch CPBM Cloud Service SDK installer.
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Creating the CS-SDK Maven STS project

1. Start SpringSource Tool Suite.

2. Goto File->New->Project….

3. Select Maven->Maven Project.

4. In the New Maven Project Wizard Screen make sure Create a simple project is
unchecked.

5. Click Next.

6. On the next Screen for the Catalog selection, select Default Local.

7. From the table select item with

a. Group Id: com.citrix.cpbm

b. Artifact Id: com-citrix-cpbm-cssdk-archetype
8. Click Next.

9. On the next screen enter your values for the following fields:

a. GroupId - A group under which all services are offered. For instance, com.citrix in
case of Citrix.

b. ArtifactId - Name of the services which the above group offers. com.citrix.cpbm.cs
in case of CloudPlatform service from Citrix.

c. Version - Version of the service offered. For example, for CloudPlatform 3.0.2, the
version is 3.0.2.

d. Package - Base Java package for the maven project com.citrix.cpbm.cs.sdk in case
of Citrix CloudPlatform Service.

10. Set ClassNamePrefix to a preferred prefix for Class Names for the project generated by
the Maven archetype.

11. Click Finish. This will create a CPBM CS SDK Project.

Note: Updating Maven dependencies on the first project creation might take some
time. This is a one-time update.

Package Structure

Referring to the example mentioned above, we specified com.citrix.cpbm.cs.sdk to be the
base package for the service that this connector would offer. Taking
com.citrix.cpbm.cs.sdk as the base, the script will generate the below Java packages.

1. com.citrix.cpbm.cs.sdk.connector - Contains Connector Code



2. com.citrix.cpbm.cs.sdk.collectors - Contains Collector Code

3. com.citrix.cpbm.cs.sdk.cloud.service - Contains Implementation of Cloud Service

4. com.citrix.cpbm.cs.sdk.lifecycle.handlers - Contains various Life Cycle Handlers

5. com.citrix.cpbm.cs.sdk.views - Contains the View resolver

Default Classes

The project will generate five packages and will have default classes included in these
packages. You must rename these classes to suit the functionality provided by the class.

Note: It is a default project structure generated for the ease of use so that the
packages/classes can be reorganized.

Java package Class Name Functionality

com.citrix.cpbm.cs.sd
k.connector

<ClassNamePrefix>ServiceConnec
torImpl

Implementation class for co
m.citrix.cpbm.platform.spi
.CloudServiceConnector

<ClassNamePrefix>MetadataRegis
try

Implements com.citrix.cpb
m.platform.spi.
MetadataRegistry

com.citrix.cpbm.cs.sd
k.service

<ClassNamePrefix>ServiceImpl Implements CloudService.
Provides the actual service
that is offered by this
bundle.

com.citrix.cpbm.cs.sd
k.lifecycle.handlers

<ClassNamePrefix>AccountLifeCy
cleHandler

Implements com.citrix.cpb
m.platform.spi.AccountLife
CycleHandler.

<ClassNamePrefix>SubscriptionLi
fecycleHandler

Implements com.citrix.cpb
m.platform.spi. Subscriptio
nLifecycleHandler

<ClassNamePrefix>UserLifeCycle
Handler

Implements com.citrix.cpb
m.platform.spi.
UserLifeCycleHandler

com.citrix.cpbm.cs.sd
k.collectors

Creating the CS-SDK Maven STS project
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<ClassNamePrefix>UsageCollecto
r

Implements com.citrix.cpb
m.platform.spi.
UsageCollector

<ClassNamePrefix>EventCollecto
r

Implements com.citrix.cpb
m.platform.spi.
EventCollector

com.citrix.cpbm.cs.sd
k.views

<ClassNamePrefix>ViewResolver Implements com.citrix.cpb
m.platform.spi.ViewResolve
r

Location of Service Definition File

serviceDefinition.xml file is located inside
"/com.citrix.cpbm.cs/src/main/resources/serviceDefinition.xml". When the mvn install is
run, the config file is copied to the root folder of the package. By default, CPBM platform
searches for "serviceDefinition.xml" file in the root folder of the deployed bundle. On
locating the file, CPBM would parse the xml file and execute the steps to register the Cloud
Service.

Note:

Edit the default values under the following tags in the <Bootstrap> in the
servicedefinition.xml file:

• ID: Specify a unique ID

• Vendor: Specify the appropriate vendor name

Adding custom localized messages
The connector has the capability to define its own localized messages. All the custom
messages has to be defined in the CloudServiceApplicationResource.properties file, which
can be found under src/main/resources/OSGI-INF/l10n/resources.

The messages defined in the file can be accessed in JSP using the <spring:message /> tag
and in java using the getMessage method of the MessageSource interface of Spring.

For importing the messagesource osgi service exposed by CPBM, add an
osgi:reference for org.springframework.context.MessageSource interface with id =
"messageSource" in service-sdk-context-osgi.xml. Then the MessageSource can be autowired
in any of the beans in the connector.

Some message keys are dynamically generated according to the values in the
serviceDefinition.xml, thus deploy the connector once and add messages for all the dynamic
keys generated and update the value of Application-ResourceVersion in the pom.xml to
indicate CPBM to reload messages from the connector. This must be done every time new
messages are added or existing messages are updated.

CloudService Connector

CPBM invokes the initialize method of com.citrix.cpbm.cs.sdk.connector.
<ClassNamePrefix>ServiceConnectorImpl whenever required, to retrieve a CloudService

Creating the CS-SDK Maven STS project
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instance. On this instance, corresponding lifecycle handlers and collectors are invoked.

Building OSGi Bundle

Run mvn clean install at the root of the project path. An OSGI bundle jar will be generated
in the target folder.

Publishing the Connector to CPBM

1. Secure copy the created bundle jar to the CPBM Development Server at the location
/usr/share/vts3/connectors_ext.

Note: Ensure that the copied jar file has group and user set as cloud and cloud.

Use the following command: chown cloud:cloud <file name>

2. Add the line <artifact type="bundle" name="<bundle.artifact.id>" version="[<x.x.x>,
<x.x.x>]"/> within the plan tag in the file com.citrix.cpbm.connector.plan located at
/usr/share/vts3/connectors_ext within the section marked by the xml comment
<!--Cloud Service Connectors-->

3. To stop CPBM Development Server, run command:

service cloud-portal stop

4. To start CPBM Development Server, run command:

service cloud-portal start

Creating the CS-SDK Maven STS project
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Connector Fragment

Creation of connector fragment from Archetypes:

1. Create a new connector fragment maven project by following the steps given below:

a. Go to File->New->Project…

b. Select Maven->Maven Project.

c. In the New Maven Project Wizard screen, make sure Create a simple project is
unchecked.

d. Click Next.

e. In the next screen, for the Catalog selection, select Default Local in Catalog drop
down.

f. From the table select item with:

i. Group Id: com.citrix.cpbm

ii. Artifact Id: com-citrix-cpbm-connector-fragment-archetype
g. Click Next .

h. In the next screen, enter your values for the following fields:

i. GroupId: A group under which all services are offered. For instance, org.apache
in case of CloudStack.

ii. ArtifactId: Name of the services which the above group offers,
cloudstack.fragment in case of Apache CloudStack.

iii. Version: Version of the service offered. For example, for cloudstack.fragment,
the version is 1.0.0.

iv. Package: Base Java package for the maven project, org.apache.cloudstack in
case of Apache CloudStack.

i. Click Finish. This will create a Connector Fragment Project.

Note: If project does not get created, try restarting the STS once.
Default Structure:

    META-INF
        readme.txt
    src
        main
            java
                base package name



                    ExampleController.java
            resources
                css
                    ${artifactId}
                        example.css
                js
                    ${artifactId}
                        example.js
                images
                    ${artifactId}
                        example.png
                META-INF
                    MANIFEST.MF
                WEB-INF
                    default
                        ${artifactId}-tiles-defs.xml
                    jsp
                        ${artifactId}
                            example.jsp
                    applicationContext-${artifactId}-fragment.xml
    build.properties
    pom.xml
    template.mf

File Description:

• ExampleController.java: It is a Spring MVC controller which will contain the url
mapping, which is returned from the connector's view resolver. it returns a tiles view.

• MANIFEST.MF: It is the bundle manifest specifying the bundle information along with
the fragment host. It also contains package imports (if any).

• applicationContext-${artifactId}-fragment.xml: Spring Context file whose beans will be
loaded by the fragment host, Any spring beans should go here.

• ${artifactId}-tiles-defs.xml: An xml configuration file which contains tiles definitions for
custom views which is loaded by fragment-host by file name.

• example.jsp: An example jsp file which specifies which JSTL tags can be used in the JSP
and also provides an example to include a css or a javascript file.

• example.js: An example js file.

• example.css: An example css file.

• example.png: An example image file.

• pom.xml: The maven project file for dependency and build management.(Please add a
maven dependency for the connector project for which this fragment will provide
views).

General Guidelines:
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• Use unique filenames and tiles definitions to avoid conflicts with other connector
fragments.

• Use simple version numbers for bundle version to avoid bundle installation problems in
Virgo server. Use x.x.x style of versioning, for example 1.0.0.

Connector Fragment
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Contributing Custom UI for Configuring a
Subscription for Provisioning

When a resource type includes custom properties, CloudPortal Business Manager will
automatically generate a UI to collect values for these custom fields. However, because of
its generic nature, this UI cannot be anything more than simple text fields. In order to
support richer configuration, CloudPortal Business Manager allows connectors to define
custom editors for these custom fields.

These editors will be embedded into CloudPortal Business Manager (they are not external
windows or IFrames).

Each property defined in Service/ResourceMetadata/ResourceType/Properties is collected
from the user at the time of provisioning. This default UI can be overridden by specifying a
Service/ResourceMetadata/ResourceType Editor attribute which will be a reference to a jsp
which will replace the default editor. The relative path of jsp is given as a tile definition
defined in the fragment of the connector and this tile name is given in the service
definition of the connector. This editor can be as simple or as sophisticated, depending on
how the implementer wants it to be.

It can also interact with the back-end cloud service to provide a more interactive
experience. The only requirement from CPBM is that it updates the set of html input fields
with their names matching those of the property names specified in the metadata (and
trigger the change event afterwards which will indicate to CPBM to refresh bundles based
on selection as well as the selection summary shown in CPBM generic UI). CPBM will also
extract data from this set of input fields and add them to the subscription configuration for
provisioning. .

<Service name="CloudStack">
<ResourceMetadata>

<ResourceType name="VirtualMachine" constraint="NONE" componentSelector="apachecloudstack.fragment.resource.virtual.machine.components.selection">
<Properties editor="apachecloudstack.fragment.resource.virtual.machine.properties.selection" />
<Property id="hostName" type="String" validation='{"required":false}'/>
<Property id="displayName" type="String" validation='{"required":false}'/>

</Properties>

</ResourceType>
...

<ResourceType name="Volume" constraint="NONE">

<Properties>

<Property id="size" type="Number" validation='{"required":true}'/>
<Property id="tag" type="String" validation='{"required":false}'/>

</Properties>



</ResourceType>

</ResourceMetaData>

</Service>

Introduction

• Provisioning Resource is a 2 step process (with both steps with their own views, namely
'component selector' and 'editor'):

• First step allows the user to filter bundles based on selection of resource
components and pick one.

• In the second step (view) (appears after the user has picked a bundle from step 1),
the user gets to configure properties of the resource.

• CloudPortal Business Manager provides a default UI to the user for both steps, based on
the resource types, filters and resource components defined in the service definition.

• Custom UI can be provided by the connector for any or both steps. The UIs provided will
override the respective default ones.

• Resource Component Selection (Step 1):

• width: 650px

• height: auto (the CloudPortal Business Manager UI will adapt depending on the
height of the custom UI)

• Resource Properties Selection (Step 2):

• width: 650px

• height: auto (the CloudPortal Business Manager UI will adapt depending on the
height of the custom UI)

Fields made available by CloudPortal Business Manager

• tenantParam : The uuid of the tenant to which current user belongs

• serviceInstanceUuid : The uuid of the currently selected service instance

• Following parameters are only available in case the user has opted to reconfigure or
reprovision an existing subscription:

• subscriptionId : This parameter is available

• isReconfigure: If available, means that the user has chosen reconfigure and not
reprovision

• subscriptionConfJson : The json representation of the configuration data of the
given subscription (Used for prefilling the selectors and properties for custom UI

Functions expected by CloudPortal Business Manager for initialization

• For resource selection custom UI:
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// loadValuesForSelectedBundleOnly : It tell whether to load all resource components available or ask CPBM to list only those available for a selected bundle (used when user has moved to step 2 of provision resource by selecting a specific bundle) 
// currentPage : This tells the current page out of the 2 pages mentioned in the introduction for resource provision.
// selectedResourceComponentsForStep2 : In step1, when group is ambiguous based on the resource components selected, then CPBM asks the user to choose a group out of all. The resource components that belong to the chosen group are passed in this argument
void initializeComponentSelector(boolean loadValuesForSelectedBundleOnly, int currentPage, String[] selectedResourceComponentsForStep2) {
// initialize resource components
}

• For editor custom UI:

1void initializeEditor() {
 // initialize resource type properties editor
}

Functions provided by CloudPortal Business Manager

/**
 * If the user is on second page, that means, a bundle is selected. So, custom resource selection UI does not need to list all possible values for components.
 * This method should be used instead to get only allowed list of values for the given component name (as provided in the service definition).
**/
 List<ResourceComponent> getValuesForComponent(String componentName);

/**
 * enable tells whether to enable or disable the provision button on page 2. This can be disabled by custom UI if the selections made are invalid.
 * ‘msg’ is the info or warning message to be shown when the provision button is disabled
**/
 void enableProvisionButton(boolean enable, String msg);

Working with hidden input fields

CloudPortal Business Manager needs a way to be aware of the selections made by user
inside the custom UI (to generate selection summary, check bundle compatibility, and so
on. If the user has opted to re-provision or reconfigure an existing subscription, CloudPortal
Business Manager needs to provide the selections made while creating subscription to the
custom UI (for custom UI to pre-fill fields based on previous selections).

For solving both the above purposes, CloudPortal Business Manager uses hidden input fields.
The whole UI for resource provision (resource selection as well as properties editor) is
driven by these hidden input fields in the background. For each of the following (defined in
service definition), CloudPortal Business Manager auto generates a hidden input field:

• Filters

• Resource Components

• Resource Properties

The values of the hidden fields are preset in case the user has opted for reconfiguring or
reprovisioning an existing subscription. Other specific details about the hidden input DOM
element are as follows:
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Property Description Set by

attr("id") The id of the hidden input is set by
CloudPortal Business Manager as "conf_prop_"
+ name of the filters, components and
properties as given in the service definition.

CloudPortal Business
Manager

attr("name") The name of the hidden input is set by
CloudPortal Business Manager same as the
name of the filters, components and
properties as given in the service definition.

CloudPortal Business
Manager

val() The value of the filter, resource component
or property that will finally be used for the
resource provision.

CloudPortal Business
Manager (for
reprovision and
reconfigure) and
Custom UI

data("valueDi
splayName")

The display name for the selected value for
filter, component or property to be displayed
in the selection summary.

Custom UI

data("fieldDis
playName")

The title for the selected filter, component or
property to be displayed in the selection
summary

Custom UI

data("effectiv
eValue")

Required for resource components only, this
value signifies if charging of a component is
based on a different value than the one used
for resource provisioning. For all other
resource components this value is to be set
same as the value of the input field.

Custom UI

Irrespective of the fields and options in the custom UI, custom UI needs to call the
.change() method on the hidden input field after updating the above mentioned properties
of the input field. This is applicable for resource components as well as for the resource
properties.

Use Cases
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Upgrading custom UI written for CloudPortal Business Manager 2.0 release

1. Create a new connector fragment by following the steps given in the Connector
Fragment section.

2. Move the jsp into fragment in src/main/resources/WEB-INF/jsp/${artifactId}/ folder.

3. Spring messaging can be used after including appropriate JSTL tags which are specified
in example.jsp in the fragment.

4. Script from inside the custom UI can be moved out to another file in the fragment in
src/main/resources/js/${artifactId}/ folder.

Contributing Custom UI for Configuring a Subscription for Provisioning

392



5. The jsp needs to be declared in
src/main/resources/WEB-INF/default/${artifactId}-tiles-defs.xml of the fragment.

6. Mention the tile definition name in the service definition of connector instead the jsp
path.

7. Custom UIs no more need to declare the input fields themselves as they are now auto
generated by CloudPortal Business Manager.

Earlier for properties, CloudPortal Business Manager read input fields with "pp_" appended
to property name in the 'id' of the field. Now it uses the name of the field and expects it to
be same as the property name mentioned in the service definition file. The ids of the fields
are "conf_prop_" + name of field in service definition. This is applicable for filters, resource
components as well as resource properties.

Contributing Custom UI for Configuring a Subscription for Provisioning
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Customization Guide

This guide describes how to implement customization in Citrix® CloudPortal™ Business
Manager. This guide is for the implementors who want to implement the customization in
CPBM.

To use this guide, you should have a working knowledge of the following subjects:

• Knowledge of Java, Spring, MVC architecture, jQuery, javascript, jsp, VIRGO
framework, velocity templating language, quartz, hibernate, xml, json, and liquibase.
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Customization Overview

The Customization pack allows customer or professional services team to extend or
customize CloudPortal Business Manager.

Customization pack comes with two GIT repositories.

• cpbm-customization.git: This repository has three bundles which allows customization
of CloudPortal Business Manager product.

• cpbm-ccp-connector.git: This repository has one bundle which allows customization of
user interface of CCP connector.

Bundles in cpbm-customization.git:

• citrix.cpbm.custom.model

• This bundle consists of all the proxy model interfaces of the customizable entities.
These are Tenant, User, and Subscription proxy interfaces used for custom fields.

• This bundle also consists a package called com.citrix.cpbm.custom.model which can
contain any custom model required for customization.

• citrix.cpbm.custom.common

• All custom liquibase goes under this.

• Custom DAOs and Services are written here.

• Custom job is configured here.

• Custom workflow is configured here.

• Custom report is configured here.

• Custom email templates

• Topic Subscribers
• citrix.cpbm.custom.portal

• CPBM open sourced portal UI contents like controllers, view (JSPs, javascripts, css,
and so on).

• WebSecurity xml consisting of access based control for URL paths.
Bundle in cpbm-ccp-connector.git

• cloud.cloudplatform.fragment

• CCP connector UI contents like controllers, view (JSPs, javascripts, css, and so on).
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Installing and building custom
components

The four CloudPortal Business Manager components that can be customized are available in
two customization repositories:

• Bundles available in cpbm-<version>-customization.git are:

• Bundle citrix.cpbm.custom.model

• Bundle citrix.cpbm.custom.portal

• Bundle citrix.cpbm.custom.common
• Bundle available in cpbm-<version>-ccp-connector-ui.git is:

• Bundle cloud.cloudplatform.fragment

Note: These git repositories are released along with every CloudPortal Business Manager
release.

Any customer or service provider who is interested in customizing these components can
follow the steps given below.

Pre-requisites for setting up the development setup:
• GIT client: GIT downloads are available at http://git-scm.com/downloads and install

instructions are available at
http://git-scm.com/book/en/Getting-Started-Installing-Git.

• Maven 3.0.x Stable Version: Maven downloads and install instructions are available at
http://maven.apache.org/download.cgi.

• JDK 6: JDK downloads and install instructions are available at
http://www.oracle.com/technetwork/java/javase/index-137561.html.

http://git-scm.com/downloads
http://git-scm.com/book/en/Getting-Started-Installing-Git
http://maven.apache.org/download.cgi
http://www.oracle.com/technetwork/java/javase/index-137561.html


Setting up remote and local GIT repositories:
1. Download the latest CloudPortal Business Manager customization repositories tar ball:

cpbm-<version>-customization.git.tar.gz

2. Unzip the customization tar ball:

$ tar xvf cpbm-<version>-customization.git.tar.gz

This will be a bare GIT repository which you will use only to pull changes. For example,
call it pristine-cpbm-customization repo.

3. Create another bare repository from the above repository which will be your customer
specific repository where you will pull and push changes on daily basis: (Let us call it
xyz-cpbm-customization):

$ git clone --bare </path/to/pristine-cpbm-customization/repo>
xyz-cpbm-customization

4. Create a working directory on your development environment (Let us call it
'Workspace'), change directory to 'Workspace':

cd </path/to/Workspace>

5. Clone a normal repository from customer specific repository (created in Step 3,
xyz-cpbm-customization):

$ git clone </path/to/xyz-cpbm-customization>

This will create a working directory with name <xyz-cpbm-customization>.

6. Change directory to the one created in previous step:

cd xyz-cpbm-customization

7. Add the pristine-cpbm-customization as a remote into the repository on the
development instance. For example, call it pristine-remote:

$ git remote add pristine-remote </path/to/pristine-cpbm-customization/repo>

8. Create and check out a local development branch:

$ git checkout -b <local-dev-branch-name> tag-<release version>-GA

• Example: To create and check out a new branch at tag for CPBM-2.3.0 release, use
the command given below:

$ git checkout -b <local-dev-branch-name> tag-2.3.0-GA

• Note: By creating a new branch at the tag of the CPBM release, you make sure
that you are developing at the correct version of the customization SDK.

9. Make required changes in any of the custom projects. Commit your changes and push
them into your customer specific repository:

Installing and building custom components
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$ git push origin <local-dev-branch-name>

Merging existing customization with new version
CPBM customization

Once you have set up the repositories as shown above, follow the steps given below
whenever a new version of cpbm-customization repo is released:

1. Untar the customization tar ball into the existing pristine-cpbm-customization
repository:

$ tar xvf cpbm-<version>-customization.git.tar.gz -C
</path/to/parent/of/pristine-cpbm-customization/repo>

2. From your local development repository, fetch changes from pristine-remote:

$ cd </path/to/Workspace>/<xyz-cpbm-customization>

$ git fetch pristine-remote

3. Check out the local development branch where you intend to merge latest changes:

$ git checkout <local-dev-branch-name>

4. Merge the release tag into your development branch:

$ git merge tag-<release version>

Example: $ git merge tag-2.3.0-GA

5. Push your changes into customer specific repository after resolving conflicts (if any):

$ git push origin <local-dev-branch-name>
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Steps to generate custom jar files:
1. Make required changes in any of the custom projects. Commit your changes and push

them into your customer specific repository:

$ git push origin <local-dev-branch-name>

2. Before compiling the code, you need to clean your mvn repo for vmops and citrix by
using the following command:

rm -rf <user_home>/.m2/repository/vmops/*

rm -rf <user_home>/.m2/repository/citrix/*

3. Build the citrix.cpbm.custom.all project (without running tests):

mvn clean install -Dmaven.test.skip=true

4. Above command will create the custom jars under target directory of respective
projects.

Running Test Cases
To run the tests, you must create all tests schemas, as shown below, into your MySQL
database:

• cloud_portal_test

• cloud_reports_test

• cloud_test

• cloud_usage_test

You can use command given below to run tests:

mvn clean test
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Steps to deploy updated custom jar files:
1. Stop the CloudPortal Business Manager server using the command:

$ service cloud-portal stop

2. Go to /usr/share/vts3/config.

3. Open org.eclipse.virgo.repository.properties.

4. Comment the following lines:

default_impls.type=watched
default_impls.watchDirectory=default_impls

5. Uncomment the following lines:

custom_impls.type=watched
custom_impls.watchDirectory=custom_impls

6. Modify the line to have custom_impls instead of default_impls

chain=ext,patches,usr,connectors,connectors_ext,default_impls,prop

with
chain=ext,custom_impls,patches,usr,connectors,connectors_ext,prop

Note: Do not modify the jars under the default_impls directory.

7. Copy the updated custom jars from target directory of all four custom projects to:

/usr/share/vts3/custom_impls

8. Start the CloudPortal Business Manager server using the command:

$ service cloud-portal start

Installing and building custom components
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Customizing the CCP Connector UI
1. Setting up remote and local GIT repositories:

a. Download the latest CloudPortal Business Manager CCP Connector UI repository tar
ball:

cpbm-<version>-ccp-connector-ui.git.tar.gz

b. Unzip the CCP Connector UI tar ball:

$ tar xvf cpbm-<version>-ccp-connector-ui.git.tar.gz

c. This will be a bare GIT repository, which you will use only to pull changes. For
example, call it pristine-cpbm-ccp-connector-ui repo. Create another bare
repository from the above repository which will be your customer specific
repository where you will pull and push changes on daily basis:

$ git clone --bare </path/to/pristine-cpbm-ccp-connector-ui/repo>
xyz-cpbm-ccp-connector-ui

d. Create a working directory on your development environment (Let us call it
'Workspace'), change directory to 'Workspace':

cd </path/to/Workspace>

e. Clone a normal repository with working directory from customer specific repository
on development environment:

$ git clone </path/to/xyz-cpbm-ccp-connector-ui>

f. Change directory:

cd xyz-cpbm-ccp-connector-ui

g. Add the pristine-cpbm-ccp-connector-ui as a remote into the repository on
development instance. For example, call it pristine-remote:

$ git remote add pristine-remote </path/to/pristine-cpbm-ccp-connector-ui/repo>

h. Create and checkout a local development branch:

$ git checkout -b <local-dev-branch-name> tag-<release version>-GA

• Example: To create and checkout a new branch at tag for CPBM-2.3.0 release,
use the command given below:

$ git checkout -b <local-dev-branch-name> tag-2.3.0-GA

• Note: By creating a new branch at the tag of the CPBM release, you make
sure that you are developing at the correct version of the customization SDK.

2. Once you have set up the repositories as shown above, follow the steps given below
whenever a new version of cpbm-ccp-connector-ui repo is released:
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a. Untar the customization tar ball into the existing pristine-cpbm-ccp-connector-ui
repository (run the command on the remote repository):

$ tar xvf cpbm-<version>-ccp-connector-ui.git.tar.gz -C
</path/to/parent/of/pristine-cpbm-ccp-connector-ui/repo>

b. From your local development repository, fetch the pristine-remote:

$ git fetch pristine-remote

c. Check out the local development branch where you intend to merge latest changes:

git checkout <local-dev-branch-name>

d. Merge the release tag on pristine-remote into local master:

$ git merge tag-<release version>

Example:

$ git merge tag-2.3.0-GA

e. Push your changes into customer specific repository after resolving conflicts (if
any):

$ git push origin <development branch>

3. Steps to generate custom jar files:

a. Make the required changes in bundle cloud.cloudplatform.fragment.

b. Commit your changes and push them into your customer specific repository.

c. Build the cloud.cloudplatform.fragment project (without running tests):

$ mvn clean install -Dmaven.test.skip=true

d. Above command will create the custom jar under the:

cloud.cloudplatform.fragment/target directory
4. To run the tests, you must create all tests schemas, as shown below, into your MySQL

database.

• cloud_portal_test

• cloud_reports_test

• cloud_test

• cloud_usage_test
You can use command given below to run tests:

$ mvn clean test

5. Steps to deploy updated custom jar files:
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a. Stop the CloudPortal Business Manager server using the command:

$ service cloud-portal stop

b. Go to /usr/share/vts3/config.

c. Open org.eclipse.virgo.repository.properties.

d. Add the following lines after

"connectors_ext.watchDirectory=connectors_ext":

custom_connectors.type=watched
custom_connectors.watchDirectory=custom_connectors

e. Modify the chain to have custom_connectors included:

chain=ext,custom_connectors,patches,usr,connectors,connectors_ext,default_impls
,prop

Note: Do not modify the jars under the connectors directory.

f. Copy the updated custom jars from target directory of custom project to:

/usr/share/vts3/custom_connectors

g. Copy dependent bundles from /usr/share/vts3/connectors to
/usr/share/vts3/custom_connectors. Dependent bundles are:

• cloud.cloudplatform

• cloud.apachecloudstack

• cloud.apachecloudstack.fragment

Note: If you customize the CCP Connector UI (cloud.cloudplatform.fragment
bundle), then you must use the same version of all the dependent versions. This
means that you cannot have one version of CCP Connector UI and higher version
of dependent bundles.

h. Start the CloudPortal Business Manager server using the command:

$ service cloud-portal start

Installing and building custom components
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Customizing UI

Customers can customize the CloudPortal Business Manager UI by modifying any of the
below items in the custom bundle citrix.cpbm.custom.portal:

• CSS:

CloudPortal Business Manager provides a hook to insert customized CSS. Customer can
add any CSS property into the file
citrix.cpbm.custom.portal/src/main/resources/custom/css/custom.css. This file
overrides any CSS property avialable in CPBM core.

• Javascript:

All the JavaScript files are available in custom bundle citrix.cpbm.custom.portal at
src/main/resources/js/. Customers can customize these files if required.

• JSP:

All the JSP files are available in custom bundle citrix.cpbm.custom.portal at
src/main/resources/WEB-INF/jsp/ directory. CPBM uses Apache Tiles* templating
framework for development of user interfaces. We have provided a hook in the form of
custom tile definition
(citrix.cpbm.custom.portal/src/main/resources/WEB-INF/custom/tiles-defs.xml) which
takes precedence over default tiles definition
(citrix.cpbm.custom.portal/src/main/resources/WEB-INF/default/tiles-defs.xml). To
update any tiles view/definition , a customer can copy the view/definition from default
tiles XML into the custom tiles XML and then make any change there. Customers can
also add new definitions into the custom tiles XML.

• Controllers:

CPBM is using Spring MVC framework. And all controllers are available in custom bundle
citrix.cpbm.custom.portal at
src/main/java/com/citrix/cpbm/portal/fragment/controllers/ directory. Every
controller has one concrete implementation which extends the abstract implementation
of the controller. Customers can override the method in the concrete implementation
to modify any existing method or add new methods in the concrete implementation.

After making the required modification, customers can re-package the custom bundle and
deploy it into CloudPortal Business Manager server. For more information on how to
re-package and deploy the custom bundle, refer to Installing and building custom
components.

Example: To customize an image, we can put the respective image in the
citrix.cpbm.custom.portal\src\main\resources\images folder and change the respective
references in the *.css, *.js, *.jsp files.

Currently the jsp for footer is located at
citrix.cpbm.custom.portal\src\main\resources\WEB-INF\jsp\tiles\shared\footer.jsp. To
change the footer, you have to add the new jsp in the above location and change the

http://support.citrix.com/proddocs/topic/cpbm-23-map/cpbm-install-build-custom-components-23-con.html#cpbm-install-build-custom-components-23--tsk
http://support.citrix.com/proddocs/topic/cpbm-23-map/cpbm-install-build-custom-components-23-con.html#cpbm-install-build-custom-components-23--tsk


corresponding references in
citrix.cpbm.custom.portal\src\main\resources\WEB-INF\default\tiles-defs.xml.
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Customizing Channel-specific CSS

Whenever you add a channel and you want to have channel-specific css, follow these steps:

1. Refer to the Customization SDK: Customizing the UI.

2. Follow these steps:

a. In citrix.cpbm.custom.portal project

b. Under citrix.cpbm.custom.portal-x.x.x/custom/css directory, create a folder with
name channel (if not already created). x.x.x is the CPBM version.

c. Create a file <ChannelCode>.css with your channel specific css under channel
directory.

3. Build the citrix.cpbm.custom.portal jar and deploy into /usr/share/vts3/custom_impls
directory. Refer to Installing and building custom components.

http://support.citrix.com/proddocs/topic/cpbm-23-map/cpbm-install-build-custom-components-23-con.html#cpbm-install-build-custom-components-tsk
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Customizing Validation Rules

You can customize validation rules for predefined properties in a model or apply validation
rules on custom fields for an existing model.

Configuring validation Rules or Constraints

CloudPortal Business Manager ships a bundle citrix.cpbm.custom.common which contains a
file named validation-constraints.xml (path:
citrix.cpbm.custom.common/src/main/resources/validation-constraints.xml). Any new
validation constraints should be added or modified in this file. The file name should not be
changed as CloudPortal Business Manager looks for this file in this bundle to bootstrap the
validation constraints. As part of implementing validations, Hibernate Validator is used
which is an implementation of JSR-303 specification.

Sample validation-constraint.xml

<constraint-mappings xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" 
    xsi:schemaLocation="http://jboss.org/xml/ns/javax/validation/mapping validation-mapping-1.0.xsd" 
     xmlns="http://jboss.org/xml/ns/javax/validation/mapping">
  
      <bean class="com.citrix.cpbm.access.Tenant">
          <getter name="owner">
              <valid />
          </getter>
          <getter name="address">
             <valid />
         </getter>
     </bean>
     <bean class="com.citrix.cpbm.access.User">
         <getter name="firstName">
             <constraint annotation="com.citrix.cpbm.validator.constraint.NotBlank">
                 <message>com.citrix.cpbm.validator.constraint.impl.NotBlank.message
                 </message>
             </constraint>
             <constraint annotation="org.hibernate.validator.constraints.Length">
                <message>javax.validation.constraints.Size.message</message>
                 <element name="min">1</element>
                 <element name="max">255</element>
             </constraint>
         </getter>
         <getter name="lastName">
             <constraint annotation="com.citrix.cpbm.validator.constraint.NotBlank">
                 <message>com.citrix.cpbm.validator.constraint.impl.NotBlank.message
                 </message>
             </constraint>
             <constraint annotation="org.hibernate.validator.constraints.Length">
                 <message>javax.validation.constraints.Size.message</message>
                 <element name="min">1</element>
                 <element name="max">255</element>
             </constraint>



         </getter>
         <getter name="email">
             <constraint annotation="com.citrix.cpbm.validator.constraint.NotBlank">
                 <message>com.citrix.cpbm.validator.constraint.impl.NotBlank.message
                 </message>
             </constraint>
             <constraint annotation="org.hibernate.validator.constraints.Email">
                 <message>javax.validation.constraints.Email.message</message>
             </constraint>
             <constraint annotation="org.hibernate.validator.constraints.Length">
                 <message>javax.validation.constraints.Size.message</message>
                 <element name="min">5</element>
                 <element name="max">255</element>
             </constraint>
         </getter>
         <getter name="username">
             <constraint annotation="com.citrix.cpbm.validator.constraint.NotBlank">
                 <message>com.citrix.cpbm.validator.constraint.impl.NotBlank.message
                 </message>
             </constraint>
             <constraint annotation="javax.validation.constraints.Pattern">
                 <message>javax.validation.constraints.Pattern.message</message>
                 <element name="regexp">[a-zA-Z0-9_@\\-\\.]+</element>
             </constraint>
             <constraint annotation="javax.validation.constraints.Size">
                 <message>javax.validation.constraints.MinimumSize.message</message>
                 <element name="min">5</element>
             </constraint>
             <constraint annotation="org.hibernate.validator.constraints.Length">
                 <message>javax.validation.constraints.Size.message</message>
                 <element name="min">5</element>
                 <element name="max">255</element>
             </constraint>
         </getter>
         <getter name="phone">
             <constraint annotation="javax.validation.constraints.Pattern">
                 <message>javax.validation.constraints.Pattern.message</message>
                 <element name="regexp">(\d+)(-)(\d+)</element>
             </constraint>
             <constraint annotation="org.hibernate.validator.constraints.Length">
                 <message>javax.validation.constraints.Size.message</message>
                 <element name="min">1</element>
                 <element name="max">20</element>
             </constraint>
         </getter>
     </bean>
     <bean class="com.vmops.model.Address">
         <getter name="street1">
             <constraint annotation="com.citrix.cpbm.validator.constraint.NotBlank">
                 <message>com.citrix.cpbm.validator.constraint.impl.NotBlank.message
                 </message>
             </constraint>
             <constraint annotation="org.hibernate.validator.constraints.Length">
                 <message>javax.validation.constraints.Size.message</message>
                 <element name="min">1</element>
                 <element name="max">255</element>
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             </constraint>
         </getter>
         <getter name="city">
             <constraint annotation="com.citrix.cpbm.validator.constraint.NotBlank">
                 <message>com.citrix.cpbm.validator.constraint.impl.NotBlank.message
                 </message>
             </constraint>
             <constraint annotation="org.hibernate.validator.constraints.Length">
                 <message>javax.validation.constraints.Size.message</message>
               <element name="min">1</element>
                <element name="max">255</element>
            </constraint>
        </getter>
        <getter name="state">
            <constraint annotation="com.citrix.cpbm.validator.constraint.NotBlank">
                <message>com.citrix.cpbm.validator.constraint.impl.NotBlank.message
                </message>
            </constraint>
            <constraint annotation="org.hibernate.validator.constraints.Length">
                <message>javax.validation.constraints.Size.message</message>
               <element name="min">1</element>
                <element name="max">255</element>
            </constraint>
       </getter>
        <getter name="postalCode">
            <constraint annotation="com.citrix.cpbm.validator.constraint.NotBlank">
                <message>com.citrix.cpbm.validator.constraint.impl.NotBlank.message
                </message>
           </constraint>
            <constraint annotation="org.hibernate.validator.constraints.Length">
                <message>javax.validation.constraints.Size.message</message>
                <element name="min">1</element>
                <element name="max">255</element>
            </constraint>
        </getter>
        <getter name="country">
            <constraint annotation="com.citrix.cpbm.validator.constraint.NotBlank">
               <message>com.citrix.cpbm.validator.constraint.impl.NotBlank.message
                </message>
            </constraint>
           <constraint annotation="org.hibernate.validator.constraints.Length">
                <message>javax.validation.constraints.Size.message</message>
                <element name="min">1</element>
                <element name="max">255</element>
            </constraint>
       </getter>
    </bean>
    <bean class="com.citrix.cpbm.access.Subscription">

   </bean>

</constraint-mappings>

Built-in Constraints
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Annotation Part of
Bean Va
lidation 
Specific
ation

Apply On Use Metadata
impact

javax.validatio
n.constraints.A
ssertFalse

yes field/property check that the
annotated
element is false.

none

javax.validatio
n.constraints.A
ssertTrue

yes field/property check that the
annotated
element is true.

none

javax.validatio
n.constraints.D
ecimalMax

yes field/property.
Supported types are
BigDecimal,
BigInteger, String,
byte, short, int, long
and the respective
wrappers of the
primitive types.

The annotated
element must be
a number whose
value must be
lower or equal
to the specified
maximum. The
parameter value
is the string
representation
of the max value
according to the
BigDecimal
string
representation.

none

javax.validatio
n.constraints.D
ecimalMin

yes field/property.
Supported types are
BigDecimal,
BigInteger, String,
byte, short, int, long
and the respective
wrappers of the
primitive types.

The annotated
element must be
a number whose
value must be
higher or equal
to the specified
minimum. The
parameter value
is the string
representation
of the min value
according to the
BigDecimal
string
representation.

none

javax.validatio
n.constraints.D
igits(integer=,
fraction=)

yes field/property.
Supported types are
BigDecimal,
BigInteger, String,
byte, short, int, long
and the respective
wrappers of the
primitive types.

Check whether
the property is a
number having
up to integer
digits and
fraction
fractional digits.

Define column
precision and
scale.
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org.hibernate.v
alidator.constr
aints.Email

no field/property. Needs
to be a string.

Check whether
the specified
string is a valid
email address.

none

javax.validatio
n.constraints.F
uture

yes field/property.
Supported types are
java.util.Date and
java.util.Calendar.

Checks whether
the annotated
date is in the
future.

none

org.hibernate.v
alidator.constr
aints.Length(m
in=, max=)

no field/property. Needs
to be a string.

Validate that
the annotated
string is
between min
and max
included.

none

javax.validatio
n.constraints.M
ax

yes field/property.
Supported types are
BigDecimal,
BigInteger, String,
byte, short, int, long
and the respective
wrappers of the
primitive types.

Checks whether
the annotated
value is less
than or equal to
the specified
maximum.

Add a check
constraint on
the column.

javax.validatio
n.constraints.M
in

yes field/property.
Supported types are
BigDecimal,
BigInteger, String,
byte, short, int, long
and the respective
wrappers of the
primitive types.

Check whether
the annotated
value is higher
than or equal to
the specified
minimum.

Add a check
constraint on
the column.

javax.validatio
n.constraints.N
otNull

yes field/property. Check that the
annotated value
is not null.

Column(s) are
not null.

org.hibernate.v
alidator.constr
aints.NotEmpty

no field/property. Needs
to be a string.

Check if the
string is not null
nor empty.

none

javax.validatio
n.constraints.N
ull

yes field/property Check that the
annotated value
is null.

none

javax.validatio
n.constraints.P
ast

yes field/property.
Supported types are
java.util.Date and
java.util.Calendar.

Checks whether
the annotated
date is in the
past.

none

javax.validatio
n.constraints.P
attern(regex=,
flag=)

yes field/property. Needs
to be a string.

Check if the
annotated string
match the
regular
expression
regex.

none
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org.hibernate.v
alidator.constr
aints.Range(mi
n=, max=)

no field/property.
Supported types are
BigDecimal,
BigInteger, String,
byte, short, int, long
and the respective
wrappers of the
primitive types

Check whether
the annotated
value lies
between
(inclusive) the
specified
minimum and
maximum.

none

javax.validatio
n.constraints.Si
ze(min=, max=)

yes field/property.
Supported types are
String, Collection,
Map and arrays.

Check if the
annotated
element size is
between min
and max
(inclusive).

Column length
will be set to
max.

javax.validatio
n.constraints.V
alid

yes field/property . Perform
validation
recursively on
the associated
object.

none

Advanced CPBM Defined Constraints

Annotation Part of Bean
Validation
Specification

Apply On Use Metadata
impact

com.citrix.cpbm.validator.constraint.CreditCard no field/property. check that
the
annotated
element is a
valid credit
card.

none

com.citrix.cpbm.validator.constraint.DateRange no field/property. check that
the
annotated
element is in
between the
specified
range.

none

com.citrix.cpbm.validator.constraint.IPAddress no field/property. check that
the
annotated
element is a
valid
IpV4/IpV6.

none

com.citrix.cpbm.validator.constraint.List no field/property. check that
the
annotated
element is
one of the
element
defined in
the list.

none
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com.citrix.cpbm.validator.constraint.NotBlank no field/property. check that
the
annotated
element is
not empty or
blank or
null.

none

com.citrix.cpbm.validator.constraint.Url no field/property. check that
the
annotated
element is
valid URL.

none

Examples- Advanced Constraints

Date Range

<constraint annotation="com.citrix.cpbm.validator.constraint.DateRange" >
   <element name="startDate">2013-10-01</element>
   <element name="endDate">2013-12-01</element>
   <element name="format">yyyy-MM-dd</element>
</constraint>

List

<constraint annotation="com.citrix.cpbm.validator.constraint.List">
    <element name="value">
     <value>INDIA</value>
     <value>USA</value>
    </element>
</constraint>

Resolving Message Codes

Whenever a constraint violation happens, it is likely that we would like to support the same
via customized error message. Hence, in order to achieve the same, we can add message
codes to
src/main/resources/OSGI-INF/l10n/resources/CustomApplicationResources.properties and
corresponding error messages.

Now in case of constraint violation, error message codes would be resolved with proper
error message and gets its passed to subsequent layers i.e. API/JSP/Controllers.

<constraint annotation="com.citrix.cpbm.validator.constraint.List">
   <element name="message">list.validator.constraint.error.message.code</element>
    <element name="value">
    <value>INDIA</value>
     <value>USA</value>
    </element>
</constraint>
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Customizing Fields and Validations

This section describes the metadata and semantics for supporting custom validations and
custom fields in CloudPortal Business Manager. Often, service operators require custom
validation of tenants, users, or subscription fields. In addition, customers may require the
collection and management of additional custom fields. This specification describes the
metadata that a service operator provides to collect, validate, and manage custom fields,
in addition to providing custom validation rules for all customer or service provider editable
fields. This specification is provided by the service operator as part of customization in a
file called citrix.cpbm.custom.common/src/main/resources/validation-constraints.xml.

Requirements:

1. Services team should be able to define Custom Fields for Tenant, User, Subscription in
the Customization SDK.

2. Services team should be able to define Custom Validation for the Custom Fields in the
Customization SDK.

3. Custom Field values are stored in the custom_fields table.

4. Supported custom fields types are text, textarea, radio, checkbox, select, hidden.

Defining custom fields for customizable objects: Tenant, User, and Subscription

Addition of custom fields is supported using dynamic proxy. This makes it possible to access
custom fields objects in UI as the first level field from customizable objects.

To add a custom field for any customizable object, you need to add the getter and setter of
the field into the proxy customizable object.

An example of how to add a custom field "Alternate Mobile number" to User object is given
below. All the proxy customizable objects are located at
citrix.cpbm.custom.model/src/main/java/com/citrix/cpbm/access.

 package com.citrix.cpbm.access;
 
 import citrix.cpbm.custom.field.annotation.UniqueValue;
 
 public interface User extends UserEntity {
 
 public String getAlternatePhone();
 
   @UniqueValue
   public void setAlternatePhone(String phone);
}

As seen in the example, the custom field is annotated with @UniqueValue, which makes the
custom field value unique across users.



You can annotate custom fields in the following four different ways:

• @UniqueValue: To mark its value unique across the customizable object.

• @Default: To set a default value for the field. For example,

@Default(value="<defaultValue>")

• @Encrypt: To encrypt the value while saving it into DB.

• @Searchable: To add the custom field into the list of searchable fields in UI.

Once you have added the custom fields into the proxy interface, you can access it in the
code as follows:

com.citrix.cpbm.access.User user = (com.citrix.cpbm.access.User) CustomProxy.newInstance(new com.vmops.model.User());
user.setAlternatePhone("9886123456");

There are three-tile views, one for each customizable object, which is used various places
where we create/edit tenant, user or subscription. These three tile views are:

<definition name="tenant.custom.fields" template="/WEB-INF/jsp/tiles/shared/custom_fields_tenant.jsp"/>
<definition name="user.custom.fields" template="/WEB-INF/jsp/tiles/shared/custom_fields_user.jsp"/>
<definition name="subscription.custom.fields" template="/WEB-INF/jsp/tiles/shared/custom_fields_subscription.jsp"/>
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For the given example, custom_fields_user.jsp looks as follows:

<li>
  <span class="label">
      <form:label path="user.alternatePhone">
         <spring:message code="label.newUserStep1.alternatePhone" />
      </form:label>
    </span>
    <div class="mandatory_wrapper">
       <spring:message code="label.userInfo.alternatePhone.tooltip" var="i18nAlternatePhoneTooltip" />
       <form:input cssClass="text" tabindex="114" path="user.alternatePhone" title="${i18nAlternatePhoneTooltip}" maxlength="50"/>
    </div>
    <div class="main_addnew_formbox_errormsg_popup"  id="user.alternatePhoneError"> 
      <form:errors path="user.alternatePhone"></form:errors>
    </div>
  </li>

Create user with Custom Fields:

Adding custom field validation
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Custom field validation can be added into the validation-constraints.xml as described in
Validation Rules.

Sample contents of the custom_fields table:

Column Name Sample value

id 1

prefix test.user.custom.field

name test.user.custom.field.AlternatePhone

value 9886123456

entity_id 9

entity_type User

encrypt 00000000

updated_at 2013-07-13 22:15:57

updated_by 1

created_at 2013-07-13 22:13:08

created_by 1

version 0
You can configure custom field prefix by changing the following properties located at
citrix.cpbm.custom.common/src/main/resources/custom.properties:

tenant.custom.field.prefix=test.tenant.custom.field
user.custom.field.prefix=test.user.custom.field
subscription.custom.field.prefix=test.subscription.custom.field
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Customizing Resource Properties

Customers can add or update a resource property in the following places:

• Under citrix.cpbm.custom.common:

• For English: /src/main/resources/OSGI-INF/l10n/resources/CustomApplicationResou
rces.properties

• For other languages: /src/main/resources/OSGI-INF/l10n/resources/CustomApplica
tionResources_<languageCode>.properties

Note: Also refer to the properties and their default values listed in
/src/main/resources/OSGI-INF/l10n/resources/ApplicationResources.properties.

• Under citrix.cpbm.custom.portal:

• For English: src/main/resources/OSGI-INF/l10n/resources/PortalCustomApplication
Resources.properties

• For other languages: /src/main/resources/OSGI-INF/l10n/resources/PortalCustomA
pplicationResources_<languageCode>.properties

The language code is a valid ISO Language Code. These codes are the lower-case, two-letter
codes as defined by ISO-639. You can find a full list of these codes at a number of sites,
such as: http://www.loc.gov/standards/iso639-2/englangn.html

Typically, you should add all UI related custom resource properties in
citrix.cpbm.custom.portal bundle and the rest in citrix.cpbm.custom.common bundle.

Properties defined in citrix.cpbm.custom.portal take precedence over other properties in
the system.

After adding/updating resource properties, the property called
Application-ResourceVersion in bundle's manifest needs to be bumped up to a higher
version for the changes to take effect. For citrix.cpbm.custom.common bundle, this
property can be found in /src/main/resources/META_INF/MANIFEST.MF and for
citrix.cpbm.custom.portal bundle, this property can be found in
/src/main/resources/PortalCustomApplicationResourceVersion.properties.

Note: Single quote handling in message strings:

For each key-value pair, any single quote in a "value" string must be written as 2
consecutive single quotes to prevent the single quote from acting as a string delimiter.

http://www.loc.gov/standards/iso639-2/englangn.html
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Customizing Cookie Law Warning

Customer can customize the content of the warning pop up by customizing the following
strings using the customization SDK:

ui.title.cookie.law.warning=Cookie Policy
ui.label.header.cookie.law=CloudPortal Uses Cookies
content.cookie.law.warning=This is a place holder for the cookie usage policy.

For more information refer to Complying with Cookie Law.
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Customizing Workflows

In CloudPortal™ Business Manager, user can perform certain actions to achieve a desired
business purpose. These actions can be considered as business transactions that help in
achieving this business purpose. A workflow is a multi-stage process that consists of
multiple phases. Every phase consists of a set of activities, (smallest unit of work in a
workflow) that should be completed successfully in order to complete the phase. All phases
should be completed to complete a business transaction.

You can customize any existing workflow by performing any of the following:

• Move the activities into another phase.

• Change the order of the phases.

• Remove the activities from any phase.

Note: The above mentioned tasks can be edited in workflows.xml

• Add any new activity to any phase.

• Add a new phase with new activities or existing activities.

To perform the above mentioned tasks, follow the steps explained below:

How to create a new activity

1. Create an activity in citrix.cpbm.custom bundle by creating a new class which
implements the interface "com.citrix.cpbm.workflow.activity.Activity".

2. Create a task within the activity, so that the task will be opened when the activity is
started.

Consider the following example where AddSecondaryEmailActivity is the activity being
created, and ADD_SEC_EMAIL is the task within that activity and its status is being
checked for completion.

package com.citrix.cpbm.workflow.custom.activity;

import com.citrix.cpbm.core.workflow.model.BusinessTransaction;
import com.citrix.cpbm.core.workflow.model.Task;
import com.citrix.cpbm.core.workflow.model.Task.State;
import com.citrix.cpbm.workflow.activity.Activity;
import com.citrix.cpbm.workflow.activity.WorkflowActivityExecutionException;
import com.vmops.service.AuthorityService;
import com.vmops.service.UserAlertPreferencesService;

public class AddSecondaryEmailActivity implements Activity{
       
       private AuthorityService authorityService;         
       private UserAlertPreferencesService userAlertPreferencesService;         



       public void setUserAlertPreferencesService(
                     UserAlertPreferencesService userAlertPreferencesService) {
              this.userAlertPreferencesService = userAlertPreferencesService;
       }

       public AuthorityService getAuthorityService() {
           return authorityService;
       }

       public void setAuthorityService(AuthorityService authorityService) {
           this.authorityService = authorityService;
       }

       @Override
       public void start(BusinessTransaction businessTransaction,
                     Record activityRecord) throws WorkflowActivityExecutionException {
              
       }

       @Override
       public Status run(BusinessTransaction businessTransaction,
                     Record activityRecord) throws WorkflowActivityExecutionException {
              Status activityStatus;
           if (isActivityComplete(businessTransaction, activityRecord)) {
             activityStatus = Status.SUCCESS;
           } else {
             activityStatus = doActivity(businessTransaction, activityRecord);
           }
           
           if (activityRecord.getTask() == null && Status.WAITING == activityStatus) {
               Task action = createAction(businessTransaction);
               activityRecord.setTask(action);
           }
           
           return activityStatus;
       }
       
       protected Boolean isActivityComplete(BusinessTransaction businessTransaction,
                     Record record) throws WorkflowActivityExecutionException {
              if(userAlertPreferencesService.getCount(businessTransaction.getTenant().getOwner())>0){
                     return true;
              }else
                     return false;
       }
       
       public Task createAction(BusinessTransaction businessTransaction)
                     throws WorkflowActivityExecutionException {
              Task action = new Task("ADD_SEC_EMAIL", businessTransaction.getTenant(), businessTransaction.getTenant().getOwner(),
                      businessTransaction, State.PENDING, authorityService.findByAuthority("ROLE_ACCOUNT_USER_CRUD"),
                      Task.DisplayMode.POPUP);
                  return action;
       }
       
       protected Status doActivity(BusinessTransaction businessTransaction,
                     Record activityPayload) throws WorkflowActivityExecutionException {
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              Task action = activityPayload.getTask();
              if (action != null) {
                    if (action.getState() == Task.State.SUCCESS) {
                      return Status.SUCCESS;
                    } else if (action.getState() == Task.State.FAILURE) {
                      return Status.FAILURE;
                 }
              }
                  return Status.WAITING;
       }

}

3. Add the newly created custom activity bean in
applicationContext-workflow-customizations.xml file which is in
src/main/resources/META-INF/spring/ of citrix.cpbm.custom.common bundle.

For the above example, following bean is added:

<bean id="addSecondaryEmailActivity" class="com.citrix.cpbm.workflow.custom.activity.AddSecondaryEmailActivity">
        <property name="authorityService" ref="authorityService"/>
        <property name="userService" ref="userService"/>
        <property name="userAlertPreferencesService" ref="userAlertPreferencesService"/>
</bean> 

4. Add the activity reference in osgi-context.xml file which is in
src/main/resources/META-INF/spring/ of citrix.cpbm.custom bundle.

For the above example, following reference is added:

<osgi:service interface="com.citrix.cpbm.workflow.activity.Activity" ref="addSecondaryEmailActivity" />

Note: Also publish new service dependencies (if any).

5. Specify a user friendly name for the task label in
CustomApplicationResources.properties file in
src/main/resources/OSGI-INF/l10n/resources of citrix.cpbm.custom bundle for it to be
displayed in the UI task list.

For the above example, following labels are specified to display when secondary email
task is created

ui.widget.task.type.ADD_SEC_EMAIL.name= Add Secondary Email for {0}

ui.task.type.ADD_SEC_EMAIL.name= Add Secondary Email for {0}

You can add new workflow definitions also which can either replace existing definition or
can be started for a new rule by customizing the file transactionWorkflowMap.xml. To add a
new workflow for a transaction, perform the following steps:

1. Add a new workflow definition to the workflows.xml file available at
/usr/share/vts3/repository/prop directory. For example -
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  <Workflow name="credit-card-account-activation">
    <Bucket name="identity-verification" order="1">
      <Activity name="verifyMasterUserEmailActivity" ref="verifyMasterUserEmailActivity" />
      <Activity name="addSecondaryEmailActivity" ref="addSecondaryEmailActivity" />
    </Bucket>
    <Bucket name="billing-verification-and-accounts-creation" order="2">
      <Activity name="collectCreditCardInfoActivity" ref="collectCreditCardInfoActivity" />
      <Activity name="createOSSAccountActivity" ref="createOSSAccountActivity" />
    </Bucket>    
  </Workflow>

2. Add a new rule in transactionWorkflowMap.xml.

To write rules in transaction workflow map (transactionWorkflowMap.xml):

Whenever a business transaction is triggered, the system will apply the applicable rules
available in transactionWorkflowMap.xml on the business transaction and if the rule
matches, then it will return the corresponding workflow. If multiple rules gets
matched, then the system will return the workflow associated with a match that comes
first.

For example -

  <Match type="tenantStateChange" workflow="credit-card-account-activation">
    <Rule>{#transaction.tenantInitialState.name == 'NEW' and #transaction.tenantTargetState.name == 'ACTIVE' 
and  #transaction.tenant.accountType.paymentModes == 2}</Rule>
</Match>

In above snippet, when a business transaction of type tenantStateChange is triggered
for initial state "NEW" and target state "ACTIVE" for a tenant having payment mode as 2
(which internally means credit card), then system returns the
credit-card-account-activation workflow.

Writing a rule

For writing a rule, any direct or transitive property available in business transaction object
can be used.

Following are the properties available directly or transitively in different business
transactions:

TenantStateChangeTransaction

Name Type

tenant com.vmops.model. Tenant

tenantInitialState com.vmops.model.Tenant.State

tenantTargetState com.vmops.model.Tenant.State
TenantAccountTypeConversionTransaction

Name Type

tenant com.vmops.model. Tenant
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accountTypeInitial com.vmops.model.AccountType

accountType com.vmops.model.AccountType.State

paymentInfo String
PaymentInfoChangeTransaction

Name Type

tenant com.vmops.model. Tenant

accountTypeInitial com.vmops.model.AccountType

accountType com.vmops.model.AccountType.State

paymentInfo java.lang.String
SubscriptionActivationTransaction

Name Type

tenant com.vmops.model. Tenant

subscription com.vmops.model.Subscription

subscriptionInitialState com.vmops.model.Subscription.State

subscriptionTargetState com.vmops.model.Subscription.State

isProvisioned java.lang.String
CloudServiceActivationTransaction

Name Type

serviceInstance com.vmops.model.ServiceInstance

initialState com.vmops.model.TenantHandle.State

targetState com.vmops.model.TenantHandle.State

instanceProperty java.lang.String
com.vmops.model.Tenant

Name Type

sourceChannel com.vmops.model. Channel

accountType com.vmops.model.AccountType

spendLimit java.math.BigDecimal

initialDeposit java.math.BigDecimal

address com.vmops.model.Address

currency com.vmops.model.CurrencyValue

state com.vmops.model. Tenant.State

createdAt java.util.Date
Subscription

Name Type

state com.vmops.model. Subscription.State
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tenant com.vmops.model.Tenant

productBundle com.vmops.model.ProductBundle

createdAt java.util.Date

derivedFrom com.vmops.model.Subscription
AccountType

Name Type

name java.lang.String

paymentModes java.lang.Long

trial boolean

paymentInfoRequired boolean

autoPayRequired boolean

instantpayRequired boolean

vextendCredit boolean

selfRegistrationAllowed boolean

manualRegistrationAllowed boolean

notionalBilling boolean

manualActivation boolean
Channel

Name Type

name java.lang. String

code java.lang. String
ProductBundle

Name Type

name java.lang. String

code java.lang. String
com.vmops.model.CurrencyValue

Name Type

currencyCode java.lang. String

currencyName java.lang. String
com.vmops.model.Address

Name Type

city java.lang. String

state java.lang. String

postalCode java.lang. String

country java.lang. String
Service
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Name Type

Category java.lang.String

type java.lang.String

serviceName java.lang.String

vendor java.lang.String

adapterRef java.lang.String
ServiceInstance

Name Type

service com.vmops.model.Service

name java.lang.String

description java.lang.String

code java.lang.String
Creating Custom Action URL Resolver

If the Task created Type is NAVIGATE, then you have to specify the action Resolver URL.
Following are the steps to create custom action URL resolver:

1. Create a CustomActionUrlResolver.java and populate the parameters list.

For Example : Below is the sample code of creating the customActionUrlResolver for
above created adding secondary email activity.

/* Copyright (C) 2012 Citrix, Inc. All rights reserved. */
package com.citrix.cpbm.workflow.custom.resolver;

import java.util.ArrayList;
import java.util.HashMap;
import java.util.List;
import java.util.Map;
import java.util.Set;

import com.citrix.cpbm.core.workflow.model.Task;
import com.citrix.cpbm.workflow.pendingaction.resolver.impl.AbstractActionUrlResolver;

public class CustomActionUrlResolver extends AbstractActionUrlResolver {

  private Map<String, String> actionUrls = new HashMap<String, String>();

  @Override
  public Set<String> getSupportedTypes() {
    return actionUrls.keySet();
  }

  public void setActionUrls(Map<String, String> actionUrls) {
    this.actionUrls = actionUrls;
  }

  @Override
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  public List<String> getParams(Task action) {
    List<String> params = new ArrayList<String>();
    if ("ADD_SEC_EMAIL".equalsIgnoreCase(action.getType())) {
      params.add(action.getTenant().getOwner().getUuid());
    }
    return params;
  }

  @Override
  public String getActionUrl(Task action) {
    return actionUrls.get(action.getType());
  }

}

2. Add the bean for the newly created CustomActionUrlResolver in
applicationContext-workflow-customizations.xml file which is under
src/main/resources/META-INF/spring/ of citrix.cpbm.custom bundle. Provide the target
URL in the value field of <entry>

For the above example, following bean is added for newly created sample
CustomActionUrlResolver.

<bean id="customActionUrlResolver" class="com.citrix.cpbm.workflow.custom.resolver.CustomActionUrlResolver">
        <property name="actionUrls">
          <map>
            <entry key="ADD_SEC_EMAIL" value="users/%1$s/myprofile"></entry>
          </map>
        </property>
 </bean>

3. Add the reference of the newly created CustomActionUrlResolver in osgi-context.xml
file which is under src/main/resources/META-INF/spring/ of citrix.cpbm.custom
bundle.

For the above example, following reference is added:

<osgi:service interface="com.citrix.cpbm.workflow.pendingaction.resolver.ActionUrlResolver" ref="customActionUrlResolver"/>

Customizing Workflows
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Adding an existing activity to a workflow

All the activities that can be used in a workflow are defined in the
applicationContext-workflow-customizations.xml file. You can add a pre-existing activity
and customize a workflow.

Adding an existing activity into an existing workflow

You can customize the account activation workflow to include the activity
verifyDepositActivity for that account type. The verifyDepositActivity is an available
pre-existing activity.

Workflow definition for credit-card-account-activation workflow before
addingverifyDepositActivity:

<Workflow name="credit-card-account-activation">
    <Bucket name="identity-verification" order="1">
      <Activity name="verifyMasterUserEmailActivity" ref="verifyMasterUserEmailActivity"/>
    </Bucket>
    <Bucket name="billing-verification-and-accounts-creation" order="2">
      <Activity name="collectCreditCardInfoActivity" ref="collectCreditCardInfoActivity"/>
      <Activity name="createOSSAccountActivity" ref="createOSSAccountActivity"/>
    </Bucket>    
  </Workflow>

Workflow definition for credit-card-account-activation workflow after adding
verifyDepositActivity:

<Workflow name="credit-card-account-activation">
    <Bucket name="identity-verification" order="1">
      <Activity name="verifyMasterUserEmailActivity" ref="verifyMasterUserEmailActivity"/>
    </Bucket>
    <Bucket name="billing-verification-and-accounts-creation" order="2">
      <Activity name="collectCreditCardInfoActivity" ref="collectCreditCardInfoActivity"/>
      <Activity name="createOSSAccountActivity" ref="createOSSAccountActivity"/>
      <Activity name="verifyDepositActivity" ref="verifyDepositActivity"/>
    </Bucket>    
  </Workflow>

The activity is added to Bucket(Phase) 2 of the workflow.
If required, the activity can be added either to any existing phase or to a new phase in
the workflow.

Note: If the activity creates an approval task then make sure that there is a template of
type "approval" available in the email_templates table. The template name must be of
structure as shown below:

TASK_<UPPERCASE OF BUSINESS_TRANSACTION type which triggers the workflow>_<UPPERCASE of TASK type) 
For example: TASK_TENANTSTATECHANGE_FINANCE_APPROVAL.



To add a new template, refer to Customizing Task Templates.
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Creating approval workflow for
subscription creation with specific bundles

To create an approval workflow for subscription creation with specific bundles, you have to
create a new activity, a new workflow definition (that has the new activity), and a new rule
associated to the new workflow.

Assumption: Product bundles that require an approval workflow will have a code which
follows a standard format. For example, xxx_APP_REQ.

1. Create a new activity which creates an approval task with desired role (role who can
approve/reject the workflow). Steps to create new activity are available at:
Customizing workflows.

2. Create a new workflow definition. Steps to create a new workflow definition are
available at: Customizing workflows.

3. Add the activity (created in Step 1) into the workflow definition created in Step 2.

4. Create a new rule associated to the new workflow definition created in Step 2. This
rule will check for the bundle code having specific format. Steps to create new rule and
what fields are available in rule expression, are available at: Customizing workflows.

Example
<Rule>{#transaction.subscription.productBundle.code matches '^.*APP_REQ$'}</Rule>

To perform above steps you have to use the Customization SDK Guide.

http://support.citrix.com/proddocs/topic/cpbm-23-map/cpbm-customizingwf21-tsk.html#ccpb-manage-tasks
http://support.citrix.com/proddocs/topic/cpbm-23-map/cpbm-customizingwf21-tsk.html#ccpb-manage-tasks
http://support.citrix.com/proddocs/topic/cpbm-23-map/cpbm-customizingwf21-tsk.html#ccpb-manage-tasks
http://support.citrix.com/proddocs/topic/cpbm-23-map/cpbm-cust-wrapper-con.html#ccpb-ccp-conn-wrapper-con
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Customizing Task Templates

You can customize a template when a new task type is defined or an activity which creates
the task is associated to another business transaction.

Defining a new template

You can insert new custom template into cloud_portal.email_templates table directly from
the back end.

INSERT INTO email_templates ("template_name", template_text, category, locale, template_name_locale) VALUES ('TEMPLATE_NAME', 'TEMPLATE_TEXT', 4, 'LOCALE', 'TEMPLATE_NAME_LOCALE);

TEMPLATE_NAME: This must have the structure as shown below.
TASK_<UPPERCASE OF BUSINESS_TRANSACTION type>_<UPPERCASE of TASK type)
For example: TASK_TENANTSTATECHANGE_FINANCE_APPROVAL

TEMPLATE_TEXT: Its Apache Velocity template and can have HTML with CSS Styles.
Check existing template text as an example.
CATEGORY: It must be 4 for approval tasks.

LOCALE: It is java locale having naming conventions such as en_US and so on.

TEMPLATE_NAME_LOCALE: It is same as TEMPLATE_NAME but having the locale appended to
it. For example, TASK_TENANTSTATECHANGE_FINANCE_APPROVAL_EN

Editing an existing template

• Login as root.

• Navigate to Administration -> content templates -> Emails.

• Select the required template to edit.

• Click edit, then you will see a popup with the text to be edited. Click Save on edit.

The structure of the template name that CloudPortal™ Business Managerallows to show on
the POPUP UI will be:

TASK_<UPPERCASE OF BUSINESS_TRANSACTION type>_<UPPERCASE of TASK type) for example TASK_TENANTSTATECHANGE_FINANCE_APPROVAL. 

The available model objects to define/edit these content templates are:

• task

• task.businessTransaction

For other available model objects from businessTransaction, refer Writing a rule.
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Customizing Topic Subscriber

TopicSubscriber is a spring ApplicationContextListener, which listens to all events that are
raised by CloudPortal Business Manager.

This listener listen to the following events:

• TenantActivation

• TenantLock

• TenantSuspension

• TenantTermination

• TenantReactivation

• SubscriptionCreation

• SubscriptionDeletion

• SubscriptionTermination

• UserCreation

• UserDeletion

• CloudServiceEvent

• SubscriptionChangeEvent

• UtilitySubscriptionEvent

• MissingProductEvent

• UserDeactivateEmail

• SubscriptionActivation

• AccountConverted

• CreditCardFraudCheckEvent

• TrialExpiryWarning

• TrialSuspended

• DeviceFraudDetectionEvent

• ProvisionResourceFailedEvent



• PasswordResetRequest

• DepositReceived VerifyEmailRequest

• EmailVerified

• ServiceUserRegisterEvent

• ServiceAccountRegisterEvent

• CloudServiceActivation

In order to listen to these events customer or service provider has to extend
"AbstractTopicSubscriber" class and override any receive method as per the requirement.

Customer has to publish the new class into the OSGi registry.

To publish, follow below steps:

1. Create bean for the class:.

Example "<bean class="com.citrix.cpbm.admin.CustomTopicSubscriber"
id="customTopicSubscriber" />" in applicationContext-admin-customizations.xml
available at src/main/resources/META-INF/spring in bundle
citrix.cpbm.custom.common.

2. Publish the bean to OSGi registry:

Example "<osgi:service interface="com.citrix.cpbm.subscriber.TopicSubscriber"
ref="customTopicSubscriber"/>" in osgi-context.xml available at
src/main/resources/META-INF/spring in bundle citrix.cpbm.custom.common.

After making the necessary changes, the customer or service provider has to rebuild the
custom packages as documented in Installing and building custom components.

Customizing Topic Subscriber
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Customizing Payment Gateway and
Ticketing Service

This topic is for the developers/partners who would implement OSS Connector for
CloudPortal Business Manager.

System requirements

The document assumes that the developer machine is installed with the following system
requirements (and the developer is also aware of the same):

• Windows XP (32-Bit), Windows Vista or Windows 7 (32- or 64-Bit)

• JDK Version 1.6

• Set JAVA_HOME environment variable to the root of the JDK install path

• Add %JAVA_HOME%\bin to the PATH environment variable
• Spring Tool Suite (STS) Version 3.1.0 or higher

• Apache Maven Version 3

• Add <Maven Install Path>\bin to the PATH environment variable
• Running installation of CloudPortal Business Manager

Pre-Requisites



Read the Account Lifecycle, User Lifecycle, and Service Installation and Bootstrap sections
of the Connector Development Kit before proceeding.

Downloading and Installing the OSS Service SDK

• Download the CloudPortal Business Manager Cloud Service SDK.

• Unzip the content to a local directory in your system.

• Double-click cssdk-standard.jar or run the command java -jar cssdk-standard.jar to
launch CloudPortal Business Manager Cloud Service SDK installer.

Note: For downloading and installing CloudPortal Business Manager, refer to the
Installation and Administration Guide.

Creating the CS SDK Maven STS Project

• Start SpringSource Tool Suite.

• Go to File > New > Project.

• Select Maven > Maven Project.

• In the New Maven Project Wizard Screen, make sure Create a simple project is
unchecked.

• Click Next.

• In the Catalog selection, select Default Local.

• From the table select item with:

• Group Id: com.citrix.cpbm

• Artifact Id:

• For Payment gateway: com-citrix-cpbm-payment-gateway-archetype

• For Ticketing Service: com-citrix-cpbm-ticketing-service-archetype
• Click Next.

• Enter the values for the following fields:

• GroupId - A group under which all services are offered. For instance, com.
salesforce in case of Ticketing Service.

• ArtifactId - Name of the services, which the above group offers. Example,
com.salesforce.ticket in case of Ticketing Service for SalesForce.

• Version - Version of the service offered. For example, for SalesForce with API
version 27, the version is 27.

• Package - Base Java package for the maven project .com.salesforce.ticket in case
of SalesForce ticketing service.

• Click Finish. This will create a OSS SDK Project.

Customizing Payment Gateway and Ticketing Service 
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Note: Updating Maven dependencies on the first project creation might take some time.
This is a one-time update.

Various package structure and their responsibilities

Referring to the example mentioned above, we specified com.salesforce.ticket to be the
base package for the service that this connector would offer. Taking com.salesforce.ticket
as the base, the script will generate the below Java packages.

• com.salesforce.ticket .connector: Contains Connector Code

• com.salesforce.ticket.service: Contains Implementation of SalesForce ticketing Service

• com.salesforce.ticket.lifecycle: Contains various Life Cycle Handlers

Default classes generated by the project and their functions

The project will generate three packages and will have default classes included in these
packages. You must rename these classes to suit the functionality provided by the class.
And also as a note, it is a default project structure generated for the ease of use and so
packages/classes can be reorganized.

Java package Class Name Functionality

com.salesforce.ticket.connector

XServiceConnectorImpl Implementation class for com.citrix.cpbm.platform.spi
.CloudServiceAdapter

com.salesforce.ticket.service

XServiceImpl Implements respective OSS Service. In case of ticketing it
implements TicketService. Provides the actual service
that is offered by this bundle.

com.salesforce.ticket.lifecycle

XSAccountLifeCycleHandler Implements
com.citrix.cpbm.platform.spi.AccountLifeCycleHandler.

XSUserLifeCycleHandler Implements com.citrix.cpbm.platform.spi.
UserLifeCycleHandler

Note: You must rename the X prefix in the generated class to a suitable class name.

Servicedefinition.xml

ServiceDefinition.xml file is located inside
/com.salesforce.ticket/src/main/resources/ServiceDefinition.xml. When the mvn install is
run, the config file is copied to the root folder of the package. By default, CloudPortal
Business Manager platform searches for "ServiceDefinition.xml" file in the root folder of the
deployed bundle. On locating the file, CloudPortal Business Manager parses the xml file and
executes the steps to register the OSS Service.

OSS Service Connector
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You may rename com.salesforce.ticket.connector.XServiceConnectorImpl to an
appropriate Cloud Service Connector Implementation and provide its corresponding
implementation.

CloudPortal Business Manager invokes this initialize method whenever required, to retrieve
a OSS Service instance. On this instance, corresponding lifecycle handlers and collectors are
invoked.

Configuring Connector and ServiceDefinition.xml

At this stage, we are ready with the connector and various class implementations required
by the OSS Service connector.

Locate the sample ServiceDefinition.xml file and modify the parameters as per your needs.
Most important parameters would be the Connector xml tag, ref attribute in the Connector
xml tag and vendor version. Ref attribute should be the bean name of the implementation
of "CloudConnectorFactory" interface, and version in the vendor should match with the
version defined in the pom.xml file of the STS project.

Building OSGI Bundle from the project

Run mvn clean install at the root of the project path. An OSGI bundle jar will be generated
in the target folder.

Publishing the OSGI Bundle to CloudPortal Business Manager

• Stop CloudPortal Business Manager Development Serve by running the command:

service cloud-portal stop

• Copy the new bundle into /usr/local/vts3/connectors_ext directory on the CPBM
server.

• Add an entry for the new bundle into the plan
/usr/local/vts3/connectors_ext/com.citrix.cpbm.connector.ext.plan.

• Start CloudPortal Business Manager Development Server by running the command:

service cloud-portal start

Customizing Payment Gateway and Ticketing Service 
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Customizing Reports

CloudPortal Business Manager supports creation of custom reports. Custom reports can be
scheduled for periodic generation and can be generated on demand from the CloudPortal
Business Manager UI.

You can create the following two categories of custom reports:

• Daily Custom Reports: These reports are generated every day at the scheduled time
that is defined in the cron trigger "dailyJobTrigger" in CloudPortal Business Manager.
The default scheduled cron expression for this job is "0 15 10 * * ?"

• Monthly Custom Reports: These reports are generated once a month at the scheduled
time that is defined in the cron trigger "monthlyJobTrigger" in CloudPortal Business
Manager. The default scheduled cron expression for this job is "0 15 10 1 * ?"

Information about the custom reports is saved in the following tables under "cloud_reports"
schema:

• custom_reports: Information about the new report that is customized is stored in this
table. It has the following columns:

• name: name of the custom report

• class: implementation class name of the custom report including package name
which is the fully qualified class name

• sched_custom_reports: Information about custom report that you define is stored in
this table. It has the following columns:

• customreportid: ID of the report in custom_reports table

• frequency: type of custom report, daily or monthly

• deliveryURL: url to deliver the generated custom report
The custom reports are delivered to the "deliveryURL" mentioned in the
sched_custom_reports table in the following two ways:

• FTP

• Local File System

The format of the delivery URL is as follows <TransferType>://<FilePath Based on the
TransferType>.

FTP

ftp://abc(ftpuserid):abc(password)@localhost(ftphost)/pub(ftpdirectorypath)/

Local File System

file:///E:/Work/reports_sequence(File system Path platform specific)/
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Adding a new Custom Report Class to
CloudPortal Business Manager

There are two ways in which you can create a custom report, by implementing the
"GenericReport" or by extending the "AbstractReport."

Generic Report Interface
CloudPortal Business Manager defines the following interface to support creation of custom
reports:

package com.vmops.portal.reports;
public interface GenericReport {
  public Report getReport();
  public Report getFusionReport();
}

The above interface is directly implemented and the object com.vmops.model.Report is
returned. For custom reports, you can add implementation for the first method declaration
and leave for the second method declaration blank.

Abstract Report Class
CloudPortal Business Manager has an abstraction layer to implement custom reports. The
abstract class, that implements the above interface, is as follows:

public abstract class AbstractReport

This allows the following class member variables to be accessed by the sub class:
• reportDataSource: Underlying data base connection source

• report: Instance of the com.vmops.model.Report

• recordCount: Number of records added to the Report File till now

If Custom Report class extends this abstract class, the following declarations from this
abstract class have to be implemented:

• protected abstract Statement getStatement(Connection connection) throws
SQLException;

The abstract class gets the statement that needs to be executed to fetch the records
from the underlying database cloud_portal which are going to be included in the final
report. Because only the sub class knows how to fetch the records from the underlying
database, the sub class implements this method. For example,



 StringBuilder query = new StringBuilder("SELECT * FROM users WHERE id > 10 LIMIT 10");
 Return connection.prepareStatement(query.toString())

• protected abstract ResultSet executeQuery(Statement statement) throws SQLException

Once the statement is got from the sub class, the statement is executed. Because the
statement has been created by the sub class, only the sub class knows how to execute
the statement. Therefore, the sub class defines this method also. Once it gets the
required set of results from the above execution, the abstract class generates the
report. As part of the report file, the first record is the header of that report and last
record is the footer of that report if any. And all results fit in between these two
records. Therefore, the abstract class gets the Header and Footer from the sub class
because only the sub class knows what should be there in these two records. Also, only
the sub class knows how to create a records from the results above.

In the above example, the implementation of this method looks like this:

PreparedStatement pstmt = (PreparedStatement) statement;
return pstmt.executeQuery();

• protected abstract String getHeader(Statement pstmt) throws SQLException

As mentioned above, only sub class knows what the header for this report should be.
So, the sub class defines this method and if there is no header you can return null. This
will be called for each report file only once. For example, return "column1, column2,
column3,…";

• protected abstract List<String> getRecord(Statement statement, ResultSet rs) throws
SQLException

This is called by the abstract class for every next call of ResultSet. Therefore, the
pointer in ResultSet always points to the current row in the result set. Generally, only
one record is returned for one ResultSet. However, based on the ResultSet, at times
more than one record can be returned. The underlying implementation adds all records
from this list to the report that is going to be generated.

• protected abstract getFooter(Statement statement, ResultSet rs) throws SQLException

Because only the sub class knows what should be the footer for this report, the sub
class should define this method and if there is no footer you can return null. This will
be called for each report file only once. For example, return "End of the Report";

• protected abstract void setFileType();

Only the sub class knows what type of file is going to be generated at the end, as
records are returned by the sub class in a specific format. For example xml, csv, and so
on. For example, report.setFileType("csv");

• protected abstract void updateWithLastAddedRecrod();

Once the report is generated, the abstract class should return a set of attributes as
mentioned in the table above. The only information that is put in the attributes is the
last added record. And this is used by the report service to generate multiple report
files instead of generating one big report file. The Report service passes back this
attribute in params to tell the corresponding report that records are already included
till that last check point. Therefore, the Custom report generates report for records

 Adding a new Custom Report Class to CloudPortal Business Manager
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after that record.

If sub class does not use the key limit which gets passed as part of the params (the
variable in com.vmops.model.Report) or not even getting passed then leave empty
implementation for this method in sub class as all records are included in a single
report file. For example, this.report.getParams().put("last_record_id",
lastAddedRecord); // Where lastAddedRecord is maintained by the sub class as part of
each getRecord() call.

• protected abstract Object getUniqueId(ResultSet rs) throws SQLException

Currently, as this is not being called, there is a blank implementation for this.

Report Class
Both the above mentioned methods return the com.vmops.model.Report object.

The following are the key variables declared in com.vmops.model.Report:

Variable Definition

Format Format the file content. Currently this is not set.

reportFile File that is going to be generated. It is populated by the abstract layer if at
all extending the abstract class to implement a custom report.

fileType Format of the file which is generated, for example csv, xml, and this is the
file extension used to name the file once it is generated.

params Initial parameters passed to generate a report file. Currently the following
will be passed:

type: type of the custom report (DAILY/MONTHLY)

sequenceService: bean reference for sequenceService

config: bean reference to Config Service

messageSource: bean reference to messageSource service

For Daily Type Custom Reports, date: date for which report need to be
generated

For Monthly Type Custom Reports, month: month for which report need to
be generated, year: year for which report need to be generated

limit: number of records need to be generated per file if at all passed by
the caller

attributes Attributes that are populated at the end of the report generation.
Currently, only the following attribute:

number_of_records: number of records generated as part of the custom
report file

Custom reports, created by either implementing GenericReport interface or by extending
AbstractReport class, must be added into the custom_reports and sched_custom_reports
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table as shown below:

Run the following queries:

• INSERT INTO custom_reports (name, class) VALUES ('<Report Name>',
'<Fully qualified name of Report Class>');

• INSERT INTO sched_custom_reports (customreportid, frequency,
deliveryurl) VALUES (<ID of the above insert> '<MONTHLY/DAILY>',
'<The FTP path to transfer as in <TransaferType>://<FilePath Based
on the TransferType>

 Adding a new Custom Report Class to CloudPortal Business Manager
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Scheduling custom reports

By default, CloudPortal Business Manager schedules two types of cron jobs to enable custom
report scheduling. You do not have to schedule each custom report individually in quartz.
You can add Custom reports to these scheduled cron jobs.

The two types of cron jobs are as follows:

• dailyJobTrigger: The cron expression for this is "0 15 10 * * ?"

• monthlyJobTrigger: The cron expression for this is "0 15 10 1 * ?"

These expressions can be customized in the application context file
applicationContext-customJobs.xml available in the citrix.cpbm.custom.common bundle.

The daily scheduler generates all daily reports together once every day and the monthly
scheduler generates all monthly reports together once every month, by reading information
from the above entries.
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Generating custom reports from the UI

You can generate and view custom reports on an ad-hoc basis from CloudPortal Business
Manager UI.

1. Log in to CloudPortal Business Manager UI as Root user.

2. Click Reports > Custom Reports.

3. Select the report that you want to view and click Generate.

You can also download these reports and forward them via email.



446

Customizing Jobs

To create a custom job follow the steps explained below:

1. Create a custom job file in citrix.cpbm.custom.common bundle.

2. In the newly created custom job file, extend AbstractPortalJob and provide an
implementation for the abstract run method.

Below example shows the creation of custom job called "ResetLoginFailedAttempts"
which will reset the login failed attempts for any user to 0 if the value exceeds 1, the
logic for the same was implemented in run method.

package com.citrix.cpbm.custom.job;
import java.util.List;
import org.quartz.JobExecutionContext;
import org.quartz.JobExecutionException;
import com.vmops.admin.jobs.AbstractPortalJob;
import com.vmops.model.User;
import com.vmops.model.UserAlertPreferences;
import com.vmops.service.UserAlertPreferencesService;
import com.vmops.service.UserService;
public class ResetLoginFailedAttemptsJob extends AbstractPortalJob {
    @Override
    public void run(JobExecutionContext context) throws JobExecutionException {
        System.err.println("@@@@@@@@@@@@@@@@@@ in custom job");
        List<User> usersList = userService.listUsers(0, 1000, null, null, true, null);
        for(User user : usersList){
            int loginAttempt = user.getFailedLoginAttempts();
            if(loginAttempt>1){
                user.setFailedLoginAttempts(0);
                userService.update(user);
            }
        }
}   }

3. Create a bean for the newly created custom job implementation class in
applicationContext-Jobs.xml file present in src/main/resources/META-INF/spring.

Below is the bean added for the above created custom job -
"ResetLoginFailedAttempts".

<bean name="resetLoginFailedAttemptsJob" class="org.springframework.scheduling.quartz.JobDetailBean">
    <property name="jobClass" value="com.citrix.cpbm.custom.job.ResetLoginFailedAttemptsJob"/>
    <property name="requestsRecovery" value="false"/>
    <property name="volatility" value="false" />
  </bean>



4. Create a trigger bean for the newly created custom job and specify job reference, time
interval and other parameters.

Below is the trigger bean created for the above custom job.

<bean id="resetLoginFailedAttemptsJobTrigger" class="org.springframework.scheduling.quartz.SimpleTriggerBean">
    <property name="jobDetail" ref="resetLoginFailedAttemptsJob" /> 
    <property name="startDelay" value="10000" />
    <property name="repeatInterval" value="1200000" />
    <property name="volatility" value="false" /> 
    <property name="misfireInstructionName" value="MISFIRE_INSTRUCTION_RESCHEDULE_NEXT_WITH_EXISTING_COUNT"></property>
  </bean>

5. Add the newly created trigger reference in applicationContext-scheduler.xml file
present in src/main/resources/META-INF/spring under "triggers" property list.

Below sample shows the adding of trigger reference:

<ref bean="resetLoginFailedAttemptsJobTrigger"/>
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Customizing Country List

Customers can customize the list of countries to be displayed in the address and the order
in which they appear.

CloudPortal Business Manager reads the country list from table countries under cloud_portal
schema. This table has a column country_order of type INTEGER which decides if the
country be displayed and in what order in UI.

If the value of the column country_order is NULL, then the corresponding country will not
be displayed in UI. If the value is not null, then it shows the order in which the
corresponding country will be displayed in UI.

If you want to change the value of the column, then you can do so by writing a change set
in liquibase xml file located in citrix.cpbm.custom.common bundle at
src/main/resources/citrix/cpbm/custom/db/portal/custom-db-config-v0.1.xml.

Note: Liquibase is a tool which CloudPortal Business Manager uses to populate base data
or to perform any upgrade/migration during CloudPortal Business Manager upgrade. More
information about liquibase can be found at: http://www.liquibase.org/

Sample changeset shown below is to change order of a country with code 'CA':

<changeSet id="1373880932" author="Smith">
    <update tableName="countries">
          <column name="country_order" value="13"/>
          <where>country_code_2 = 'CA'</where>
      </update>
  </changeSet>

http://www.liquibase.org/
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You can add custom tables into CloudPortal Business Manager and extend this to use it in
CloudPortal Business Manager UI by following these steps:

1. Create schema and insert default values using liquibase.

2. Create model objects.

3. Write DAOs to query the model objects (using hibernate).

4. Write services to perform business operations.

5. Use these services in web controllers to create a view.

Step 1. Create schema and insert default values using liquibase

To do any sql operation into CloudPortal Business Manager DB customization, you can write
your liquibase change set into citrix.cpbm.custom.common/src/main/resources/citrix/cpb
m/custom/db/portal/custom-db-config-v0.1.xml.

A sample liquibase change set looks as follows:

 <changeSet id="1366711278999-1" author="authorname">
    <createTable tableName="user_login_audit">
     <column name="id" autoIncrement="true" type="BIGINT">
       <constraints nullable="false" primaryKey="true"/>
     </column>
     <column name="userid" type="BIGINT">
       <constraints nullable="false"/>
     </column>
     <column name="remote_ip" type="VARCHAR(100)">
      <constraints nullable="true"/>
    </column>
    <column name="created_at" type="DATETIME" remarks="The time at which user logged in.">
      <constraints nullable="false"/>
    </column>
    <column name="version" type="INT" defaultValue="0"/>
  </createTable>
  <modifySql dbms="mysql">
    <append value=" ENGINE=InnoDB DEFAULT CHARSET=utf8"/>
  </modifySql>
 </changeSet>

Note: For more information on writing liquibase change set, please refer to
http://www.liquibase.org/documentation/changes/index.html.

Step 2. Create model objects

http://www.liquibase.org/documentation/changes/index.html


To write the model object for this newly created table, add your java file under
citrix.cpbm.custom.model/src/main/java/com/vmops/custom/model package. All new
custom model should implement com.vmops.model.EntityBase.

An example model class looks as follows:

/* Copyright (C) 2013 Citrix, Inc. All rights reserved. */

 package com.citrix.cpbm.custom.model;
 import java.util.Date;
 import javax.persistence.Column;
 import javax.persistence.Entity;
 import javax.persistence.FetchType;
 import javax.persistence.GeneratedValue;
 import javax.persistence.GenerationType;
 import javax.persistence.Id;
 import javax.persistence.JoinColumn;
 import javax.persistence.ManyToOne;
 import javax.persistence.Table;
 import javax.persistence.Temporal;
 import javax.persistence.TemporalType;
 import javax.persistence.Version;
 import javax.validation.constraints.NotNull;
 import javax.validation.constraints.Size;
 
 import com.vmops.model.EntityBase;
 import com.vmops.model.User;
 
 /**
  * UserLoginAudit model to capture user login details like
  * <ul>
  * <li>ip address from which the user has logged in.</li>
  * <li>time at which user has logged in.</li>
  * </ul>
  * 
  * @author authorname
  */
 @Entity
 @Table(name = "user_login_audit")
 public class UserLoginAudit implements EntityBase {
 
   /** The Constant serialVersionUID. */
   private static final long serialVersionUID = 1L;
 
   /**
    * Primary key.
    */
   @Id
   @GeneratedValue(strategy = GenerationType.AUTO)
   private Long id = 0L;
 
   /** The user. */
   @ManyToOne(fetch = FetchType.EAGER)
   @JoinColumn(name = "userid", nullable = false, updatable = false)
   @NotNull
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   private User user;
 
   /** The remote ip. */
   @Column(name = "remote_ip", length = 255)
   @Size(max = 100)
   private String remoteIp;
 
   /** The created at. */
   @Column(name = "created_at", nullable = false, updatable = false)
   @Temporal(TemporalType.TIMESTAMP)
   @NotNull
   private Date createdAt = new Date();
 
   /**
    * Version number. used for Optimistic Concurrency Control.
    */
   @Column(name = "version")
   @Version
   private long version = 0;
 
   /**
    * Instantiates a new user login audit.
    */
   public UserLoginAudit() {
     super();
   }
 
   /**
    * Instantiates a new user login audit.
    * 
    * @param user the user
    * @param remoteIp the remote ip
    */
   public UserLoginAudit(User user, String remoteIp) {
     super();
     this.user = user;
     this.remoteIp = remoteIp;
   }
 
   /**
    * Gets the id.
    * 
    * @return the id
    * @see com.vmops.model.EntityBase#getId()
    */
   @Override
   public Long getId() {
     return null;
   }

  /**
   * Sets the id.
   * 
   * @param id the new id
   */
  public void setId(Long id) {
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    this.id = id;
  }

  /**
   * Gets the user.
   * 
   * @return the user
   */
  public User getUser() {
    return this.user;
  }

  /**
   * Sets the user.
   * 
   * @param user the new user
   */
  public void setUser(User user) {
    this.user = user;
  }

  /**
   * Gets the remote ip.
   * 
   * @return the remote ip
   */
  public String getRemoteIp() {
    return this.remoteIp;
  }

  /**
   * Sets the remote ip.
   * 
   * @param remoteIp the new remote ip
   */
  public void setRemoteIp(String remoteIp) {
    this.remoteIp = remoteIp;
  }

  /**
   * Gets the created at.
   * 
   * @return the created at
   */
  public Date getCreatedAt() {
    return this.createdAt;
  }

  /**
   * Sets the created at.
   * 
   * @param createdAt the new created at
   */
  public void setCreatedAt(Date createdAt) {
    this.createdAt = createdAt;
  }
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  /**
   * Gets the version.
   * 
   * @return the version
   */
  public long getVersion() {
    return this.version;
  }

  /**
   * Sets the version.
   * 
   * @param version the new version
   */
  public void setVersion(long version) {
    this.version = version;
  }

  /**
   * Hash code.
   * 
   * @return the int
   * @see java.lang.Object#hashCode()
   */
  @Override
  public int hashCode() {
    final int prime = 31;
    int result = 1;
    result = prime * result + ((this.createdAt == null) ? 0 : this.createdAt.hashCode());
    result = prime * result + ((this.remoteIp == null) ? 0 : this.remoteIp.hashCode());
    result = prime * result + ((this.user == null) ? 0 : this.user.hashCode());
    return result;
  }

  /**
   * Equals.
   * 
   * @param obj the obj
   * @return true, if successful
   * @see java.lang.Object#equals(java.lang.Object)
   */
  @Override
  public boolean equals(Object obj) {
    if (this == obj) {
      return true;
    }
    if (obj == null) {
      return false;
    }
    if (getClass() != obj.getClass()) {
      return false;
    }
    UserLoginAudit other = (UserLoginAudit) obj;
    if (this.createdAt == null) {
      if (other.createdAt != null) {
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        return false;
      }
    } else if (!this.createdAt.equals(other.createdAt)) {
      return false;
    }
    if (this.remoteIp == null) {
      if (other.remoteIp != null) {
        return false;
      }
    } else if (!this.remoteIp.equals(other.remoteIp)) {
      return false;
    }
    if (this.user == null) {
      if (other.user != null) {
        return false;
      }
    } else if (!this.user.equals(other.user)) {
      return false;
    }
    return true;
  }

  /**
   * To string.
   * 
   * @return the string
   * @see java.lang.Object#toString()
   */
  @Override
  public String toString() {
    StringBuilder builder = new StringBuilder();
    builder.append("UserLoginAudit [");
    if (this.id != null) {
      builder.append("id=");
      builder.append(this.id);
      builder.append(", ");
    }
    if (this.user != null) {
      builder.append("user=");
      builder.append(this.user);
      builder.append(", ");
    }
    if (this.remoteIp != null) {
      builder.append("remoteIp=");
      builder.append(this.remoteIp);
      builder.append(", ");
    }
    if (this.createdAt != null) {
      builder.append("createdAt=");
      builder.append(this.createdAt);
      builder.append(", ");
    }
    builder.append("version=");
    builder.append(this.version);
    builder.append("]");
    return builder.toString();
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  }

}

Step 3. Write DAOs to query the model objects (using hibernate)

To write custom DAO interface, create your DAO interface under
citrix.cpbm.custom.common/src/main/java/com/citrix/cpbm/custom/persistence
package. You have to extend the GenericDAO interface.

GenericDAO represents a DAO interface to interact with model objects persisted in the
database. Typically, DAOs are created only for so-called root objects: model objects that
are directly accessible. Dependent objects are traversed from these root objects.

An example of the DAO interface and its implementation is shown below:

 /* Copyright (C) 2013 Citrix, Inc. All rights reserved. */
 package com.citrix.cpbm.custom.persistence;
 
 import java.util.List;
 
 import com.citrix.cpbm.custom.model.UserLoginAudit;
 import com.vmops.model.User;
 import com.vmops.persistence.GenericDAO;
 
 /**
 * The Interface UserLoginAuditDAO.
 * 
 * @author authorname
 */
 public interface UserLoginAuditDAO extends GenericDAO<UserLoginAudit> {

 /**
   * Find login audit records.
   * 
   * @param user the user
   * @return the list
   */
  List<UserLoginAudit> findLoginAuditRecords(User user);

}

 /* Copyright (C) 2013 Citrix, Inc. All rights reserved. */
 package com.citrix.cpbm.custom.persistence.hibernate;
 
 import java.util.List;
 import java.util.Map;
 
 import org.springframework.stereotype.Repository;
 
 import com.citrix.cpbm.custom.persistence.UserLoginAuditDAO;
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 import com.citrix.cpbm.custom.model.UserLoginAudit;
 import com.vmops.model.User;
 import com.vmops.persistence.hibernate.GenericHibernateDAO;

 /**
 * The Class UserLoginAuditDAOImpl.
 * 
 * @author authorname
 */
 @Repository("userLoginAuditDAO")
 public class UserLoginAuditDAOImpl extends GenericHibernateDAO<UserLoginAudit> implements UserLoginAuditDAO {

  /**
   * Find login audit records.
   * 
   * @param user the user
   * @return the list
   * @see com.citrix.cpbm.custom.persistence.UserLoginAuditDAO#findLoginAuditRecords(com.vmops.model.User)
   */
  @Override
  public List<UserLoginAudit> findLoginAuditRecords(User user) {
    Map<String, Object> conditions = getConditionsTemplate();
    conditions.put("user", user);
    return findByCriteria(null, conditions);
  }

}

Step 4. Write services to perform business operations

To create custom service layer API, you have to write your service interface under
citrix.cpbm.custom.common/src/main/java/com/custom/service.

An example test service and its implementation is as shown below:

  /* Copyright (C) 2013 Citrix, Inc. All rights reserved. */
 package com.citrix.cpbm.custom.service;
 
 import java.util.Date;
 import java.util.List;
 
 import com.citrix.cpbm.custom.model.UserLoginAudit;
 import com.vmops.model.User;
 
/**
 * The Interface UserLoginAuditService.
 * 
 * @author authorname
 */
public interface UserLoginAuditService {

  /**
   * Find user login audit records.
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   * 
   * @param date the date
   * @return the list
   */
  public List<UserLoginAudit> findUserLoginAuditRecords(Date date);

  /**
   * Find user login audit records.
   * 
   * @param user the user
   * @return the list
   */
  public List<UserLoginAudit> findUserLoginAuditRecords(User user);

  public void saveAudit(UserLoginAudit userLoginAudit);

}

 /* Copyright (C) 2013 Citrix, Inc. All rights reserved. */
 package com.citrix.cpbm.custom.service.impl;
 
 import java.util.Date;
 import java.util.HashMap;
 import java.util.List;
 import java.util.Map;
 
 import org.springframework.beans.factory.annotation.Autowired;
import org.springframework.stereotype.Service;

import com.citrix.cpbm.custom.persistence.UserLoginAuditDAO;
import com.citrix.cpbm.custom.service.UserLoginAuditService;
import com.citrix.cpbm.custom.model.UserLoginAudit;
import com.vmops.model.User;

/**
 * The Class UserLoginAuditServiceImpl.
 * 
 * @author authorname
 */
@Service("userLoginAuditService")
public class UserLoginAuditServiceImpl implements UserLoginAuditService {

  /** The user login audit dao. */
  @Autowired
  private UserLoginAuditDAO userLoginAuditDAO;

  /**
   * Find user login audit records.
   * 
   * @param date the date
   * @return the list
   * @see com.citrix.cpbm.custom.service.UserLoginAuditService#findUserLoginAuditRecords(java.util.Date)
   */
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  @Override
  public List<UserLoginAudit> findUserLoginAuditRecords(Date date) {
    Map<String, Object> conditions = new HashMap<String, Object>();
    conditions.put("createdAt", date);
    return userLoginAuditDAO.findByCriteria(null, conditions);
  }

  /**
   * Find user login audit records.
   * 
   * @param user the user
   * @return the list
   * @see com.citrix.cpbm.custom.service.UserLoginAuditService#findUserLoginAuditRecords(com.vmops.model.User)
   */
  @Override
  public List<UserLoginAudit> findUserLoginAuditRecords(User user) {
    return userLoginAuditDAO.findLoginAuditRecords(user);
  }

  /**
   * Save audit.
   *
   * @param userLoginAudit the user login audit
   * @see com.citrix.cpbm.custom.service.UserLoginAuditService#saveAudit(com.citrix.cpbm.custom.model.UserLoginAudit)
   */
  @Override
  public void saveAudit(UserLoginAudit userLoginAudit) {
    userLoginAuditDAO.save(userLoginAudit);

  }
}

Once you add a service, you have to export this service from citrix.cpbm.custom.common
bundle, so that it can be used in citrix.cpbm.custom.portal bundle, where we have web
controllers and views. To do this, you need to make and entry into
citrix.cpbm.custom.common/src/main/resources/META-INF/spring/osgi-context.xml.

A sample entry looks as follows:

<osgi:service interface="com.citrix.cpbm.custom.service.UserLoginAuditService" ref="userLoginAuditService" />

Step 5. Use these services in web controllers to create a view

To use the services exported from citrix.cpbm.custom.common bundle, you have to first
import them into citrix.cpbm.custom.portal bundle. To do this you have to make an entry
into citrix.cpbm.custom.portal/src/main/resources/WEB-INF/portal-osgi-context.xml.

A sample entry looks as follows:

<osgi:reference interface="com.citrix.cpbm.custom.service.UserLoginAuditService" id="userLoginAuditService" />
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To use the imported service in web controller and pass it to the view, access it by any other
spring bean.

For example,

@Autowired
 @Autowired private UserLoginAuditService userLoginAuditService;
 .
 .
 .
  /**
    * creates a login audit record for current logged in user.
    * @param user
    * @param request
   */
  private void createLoginAuditRecord(User user, HttpServletRequest request) {
    UserLoginAudit userLoginAudit = new UserLoginAudit(user, getRemoteUserIp(request));
    userLoginAuditService.saveAudit(userLoginAudit);
  }

Miscellaneous

• The custom liquibase setting is available at citrix.cpbm.custom.common/src/main/reso
urces/META-INF/spring/applicationContext-custom-liquibase.xml.

The bean which runs the custom liquibase file looks as follows:

<bean id="liquibaseportalcustomization" class="liquibase.integration.spring.SpringLiquibase">
     <property name="dataSource" ref="dataSource" />
     <property name="contexts" value="${liquibase.custom.context:basedata}"/>
     <property name="changeLog" value="classpath:citrix/cpbm/custom/db/portal/cloud_portal-custom.xml" />
     <property name="changeLogParameters">
       <map>
         <entry key="key-needed" value="to-avoid-npe-bug"></entry>
         <entry key="portal_db" value="${profile.jdbc.database.schemaname}"/>
         <entry key="field_encryption_key" value="${field.encryption.key}"/>
      </map>
    </property>
    <property name="resourceLoader" ref="resourceLoader"  />
  </bean>

The properties used in this bean are defined in cloud.properties located in your
virgo-home>/repository/prop/cloud.properties.

• Custom DAOs and Services bean are created in citrix.cpbm.custom.common/src/main/r
esources/META-INF/spring/applicationContext-custom-service.xml.

  <context:annotation-config />
  <context:component-scan base-package="com.citrix.cpbm.custom.persistence" />
  <context:component-scan base-package="com.citrix.cpbm.custom.service" />
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If you choose to change the custom service package name, you need to make the package
entry in the exported package list in MANIFEST.MF file of citrix.cpbm.custom.common
bundle as well imported package list in MANIFEST.MF file of citrix.cpbm.custom.portal
bundle. Also, as specified above in Step 4 and Step 5, you need to make the necessary
changes in osgi-context.xml of both these bundles.
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Customizing Email Templates

Customers can modify existing email templates or add new email templates that can be
used to send emails from CloudPortal Business Manager.

Follow these steps to modify existing email templates:

1. Log in to CloudPortal Business Manager UI a ROOT user.

2. Navigate to Administration > Content Templates.

3. Select the category of content templates that you want to modify.

4. Select any template from the list of templates (in the left pane).

5. Move the cursor over the manage icon (that looks like a gear wheel) and click Edit.

A dialog box opens that contains the code for the template.

6. Make the changes as required and click OK.

This modified template can now be used to send emails. This template gets persisted into
the DB so it does not get reverted when CloudPortal Business Manager is re-started.

Adding new templates:

To add new templates, you must have the development setup as described in Installing and
building custom components.

1. Add new templates in liquibase xml file located in citrix.cpbm.custom.common bundle
located at
src/main/resources/citrix/cpbm/custom/db/portal/custom-db-config-v0.1.xml.

A sample liquibase change set for adding a custom email template will look as follows:

<changeSet id="1373375974" author="John">
      <insert tableName="email_templates">
        <column name="template_name" value="SAMPLE_TEMPLATE"/>
        <column name="template_text">
          <![CDATA[ 
            #parse("EMAIL_HEADER_EN")

               <h2 style="${style_h2}">Hello #if($user.firstName)${user.firstName}#{else}${user.username}#end,</h2>

              <p style="${style_p}">
              This is a sample email.
              </p>
              <br>

              #parse("SIGNATURE_EN")
              #parse("EMAIL_FOOTER_EN")

http://support.citrix.com/proddocs/topic/cpbm-23-map/cpbm-install-build-custom-components-23-con.html#cpbm-install-build-custom-components-tsk
http://support.citrix.com/proddocs/topic/cpbm-23-map/cpbm-install-build-custom-components-23-con.html#cpbm-install-build-custom-components-tsk


        ]]>
        </column>
        <column name="category" valueNumeric="0"/>
        <column name="locale" value="en_US"/>
        <column name="template_name_locale" value="SAMPLE_TEMPLATE_EN"/>
      </insert>
      
        <update tableName="email_templates">
        <column name="sort_order" valueComputed="LAST_INSERT_ID()"/>
        <where>template_name='SAMPLE_TEMPLATE'</where>
      </update>
    </changeSet>

2. In code, an email template can be sent using emailService as shown below:

/**
   * @param template - the template location
   * @param model - model object required for the template
   * @param subjectKey - key code in messageSource for the subject
   * @param user - user to him the email has to be sent
   */
  public void sendEmail(final String template, final Map<String, Object> model, final String subjectKey, final String[] toAddresses);

  eg:
  Map<String, Object> model = new HashMap<String, Object>();
  model.put("locale", LocaleUtils.toLocale(config.getDefaultLocale()));
  model.put("user", user);
  emailService.sendEmail("SAMPLE_TEMPLATE", model, "email.template.SAMPLE_TEMPLATE.subject", <email addresses>);

Note: The above code uses the same value of template_name as provided in Step 1.

Stop emails sent with an email template

Service provider can choose not to send email associated with any email template by simply
making the content of the email template as NULL or empty. When content of any email
template is nullified, then the email is not sent and is ignored.

Note: Liquibase is a tool which CloudPortal Business Manager uses to populate base data
or perform any upgrade or migrate operations during a CloudPortal Business Manager
upgrade. More information about liquibase can be found at: http://www.liquibase.org/.
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Objects and Properties for Email
Templates

The following table provides the list of Email Templates with the available objects and
properties in each template. The properties within the template can be directly used. For
example:

${customEmailText} : for the property customEmailText in VERIFY_EMAIL template.

The objects in the templates are used to get the property values within them for the
template. For example:

($user.firstName) : to get the first name of the user, use the object user from the
template.

Email Template Name Objects Properties

WELCOME_EMAIL User :: user

VERIFY_EMAIL User :: user verifyEmailLink

customSubject

customEmailText

subject

VERIFY_ALERT_EMAIL User :: user verifyEmailLink

locale

RESET_PASSWORD User :: user resetPasswordLink

TRIAL_SERVICE_EXPIRY_WARN
ING

TrialAccount :: trial

User :: user

Date :: days

TRIAL_SERVICE_EXPIRED TrialAccount :: trial

User :: user

Locale :: locale

termination

TRIAL_SERVICE_EXPIRED_NOT
IFICATION

TrialAccount :: trial

User :: user

termination

CREDIT_LIMIT_CROSSED_SERV
ICE_SUSPENDED_NOTIFICATIO
N

User :: user

Tenant :: tenant



SPEND_BUDGET_WARNING User :: user

SpendCheckCriteria ::
criteria

threshold

percentConsumption

CREDIT_LIMIT_CREDIT_NOTIF
Y

User :: user

Tenant :: tenant

threshold

percentConsumption

CREDIT_LIMIT_BREACH_ALERT User :: user

Tenant :: tenant

CREDIT_LIMIT_CROSSED_SERV
ICE_SUSPENDED

User :: user

Tenant :: tenant

PAYMENT_RECEIVED User :: user currency

paymentAmount

PAYMENT_FAILED User :: user

Tenant :: tenant

updateBillingLink

restricteddays

suspendeddays

PAYMENT_FAILED_NOTIFY User :: user

Tenant :: tenant

body

subject

DEPOSIT_RECEIVED User :: user

Locale :: locale

currency

depositAmount

SUPPORT_TICKET_NOTIFY Ticket :: ticket name

time

CORPORATE_ACCOUNT_REQU
EST

Tenant :: tenant

User : user

userAgent

remoteAddress

referer

time

CREDIT_EXPOSURE_MARKER_L
EVEL

Tenant :: tenant

User : user

SEND_PROMOTIONAL_TOKEN PromotionSignup :: signup registerlink

ACCOUNT_RESTRICT User :: user

Tenant :: tenant

Locale :: locale
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ACCOUNT_ACTIVATE User :: user

Tenant :: tenant

Locale :: locale

ACCOUNT_SUSPEND User :: user

Tenant :: tenant

Locale :: locale

ACCOUNT_TERMINATE User :: user

Tenant :: tenant

Locale :: locale

ACCOUNT_REACTIVATE User :: user

Tenant :: tenant

Locale :: locale

ACCOUNT_CONVERTED User :: user

Local :: locale

accountTypeName

ACCOUNT_CONVERTED_ADMI
N

User :: user accountTypeName

PENDING_CHANGE_REJECTED User :: user

PendingChangeRejected ::
pendingChangeRejected

VM_CREATION User :: user password

username

vmDisplayName

REPORT URL :: reportImageURL subject

JOB_FAILED Date :: startTime

Date :: endTime

jobName

desc

hostname

DESTROY_VM_FAILED User :: user message

ORPHANED_VM_CREATED vmid

accountName

domainId

accountId
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CREDITCARD_FRAUD_CHECK_
EVENT

FraudCheckInfo ::
fraudCheckInfo

Date :: date

details

ACCOUNT_ACTIVATION_REQU
EST

User :: user

Tenant :: tenant

DEVICE_FRAUD_DETECTION_E
VENT

DeviceFraudDetectionAudi
t :: fraudDetectionAudit

login

email

phone

firstName

lastName

CREDIT_LIMIT_WARNING User :: user

SpendCheckCriteria ::
criteria

threshold

percentConsumption

VM_PASSWORD_RESET password

firstName

username

vmDisplayName

INCOMPATIBLE_RESOURCE_TY
PE

Locale :: locale bundleName

utilitySubscriptionUrl

oldSubsciptionUrl

resourceType

INTERNAL_APPROVAL User :: user

Tenant :: tenant

noOfRetries

INVOICE_EMAIL Locale :: locale billing_start_date

billing_start_time

billing_end_date

billing_end_time

subject
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JOB_WARNING Date :: startTime

Date :: endTime

desc

hostname

subject

jobName

MISSING_PRODUCT Set<Long> :: usageDatas

NEW_RESOURCE_TYPE User :: user

Locale :: locale

utilitySubscriptionUrl

resourceType

resourceHandle

PENDING_CHANGE_REJECTED PendingChangeRejected ::
pendingChangeRejected

User :: user

PROVISION_RESOURCE_FAILE
D

Subscription ::
subscription

message

updateResource

SUBSCRIPTION_ACTIVATION_S
ERVICE_PROVIDER_NOTIFICAT
ION

List<Entitlements> ::
entitlements

ServiceInstance ::
serviceInstance

Subscription ::
subscription

ProductBundle ::
productBundle

Tenant :: tenant

User :: user

ServiceInstance :: service

userRecurringChargeName

spRecurringChargeName

recurringPrice

userOneTimeChargeName

spOneTimeChargeName

oneTimePrice
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SUBSCRIPTION_ACTIVATION_
USER_NOTIFICATION

List<Entitlements> ::
entitlements

ServiceInstance ::
serviceInstance

Subscription ::
subscription

ProductBundle ::
productBundle

Tenant :: tenant

User :: user

ServiceInstance :: service

userRecurringChargeName

spRecurringChargeName

recurringPrice

userOneTimeChargeName

spOneTimeChargeName

oneTimePrice

cloudProvider

SUBSCRIPTION_TERMINATION
_SERVICE_PROVIDER_NOTIFIC
ATION

Subscription ::
subscription

ProductBundle ::
productBundle

Tenant :: tenant

User :: user

ServiceInstance :: service

SUBSCRIPTION_TERMINATION
_USER_NOTIFICATION

Subscription ::
subscription

ProductBundle ::
productBundle

Tenant :: tenant

User :: user

ServiceInstance :: service

cloudProvider

TENANT_ADMIN_APPROVAL User :: user

Tenant :: tenant

noOfRetries

USER_ACTIVATE_EMAIL User :: user

User :: masterUser

Locale :: locale

USER_DEACTIVATE_EMAIL User :: user

User :: masterUser

Locale :: locale
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For each object in the template, the following table provides details of the properties/child
objects for the specified templates.

Object Child Objects Properties

SpendCheckCriteria displayName

fraudCheckInfo User :: user ipaddress

city

country

postalCode

riskScore

DeviceFraudDetectionAudit Date :: callDate policyScore

reasonCode

riskRating

reviewStatus

deviceId

fuzzyDeviceId

accountName

Address street1

street2

city

state

postalCode

country
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CreditCard Address :: creditCardAddress creditCardType

creditCardNumber

creditCardExpirationMonth

creditCardExpirationYear

creditCardMaskedExpDate

creditCardCVV

nameOnCard

firstNameOnCard

lastNameOnCard

pendingChangeRejected User :: user changedStateTo

changeType

memo

URL host

port

path

PromotionSignup PromotionToken :: promotionToken

Currency :: currency

CampaignPromotion ::
campaignPromotion

name

company

email

phone
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Tenant Channel :: sourceChannel

AccountType :: accountType

Date :: lastUsageUpdate

User :: owner

Address :: address

Address :: secondaryAddres

CurrencyValue :: currency

TrialAccount :: trialAccount

DepositRecord :: deposit

name

spendLimit

prepaidBalance

initialDeposit

spendBudget

currentUsage

oldUsage

syncBillingAddress

state

memo

paymentAlertsCounter

accountSuspensionCounter

usageQuery

remoteAddress

ownerProvisionalId

ownerSpendLimit

ownerCurrentUsage

ownerOldUsage

isManualActivation

Ticket Tenant :: tenant

User :: owner

Date :: createdAt

Date :: lastUpdateAt

caseNumber

caseId

creatorName

companyName

email

description

subject

status

caseOrigin
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TrialAccount Tenant :: tenant

Date :: expiryDate

state

User Channel :: sourceChannel

Address :: address

Tenant :: tenant

Profile :: profile

firstName

lastName

email

username

phone

timeZone

enabled

locked

trial

spendBudget

currentUsage

oldUsage

spendLimit

countryCode

failedLoginAttempts

locale

PromotionToken User :: createBy

Date :: createDate

CampaignPromotion ::
campaignPromotion

code

Currency currencyCode
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CampaignPromotion Date :: createDate

Set<CampaignPromotionsInChannels> ::
campaignPromotionsInChannels

Date :: startDate

Date :: endDate

code

title

durationDays

discountType

percentOff

maxAccounts

promoCode

customerType

enabled

trial

Channel uuid

name

domainId

description

code

removed

removedBy
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AccountType name

displayName

description

paymentModes

trial

paymentInfoRequired

autoPayRequired

instantInvoicing

private boolean notionalBilling

manualActivation

defaultSelfRegistered

defaultRegistered

maxUsers

perAccountVmCount

perAccountPublicIPCount

perAccountVolumeCount

perAccountSnapshotCount

perAccountTemplateCount

perUserVmCount

perUserPublicIPCount

perUserVolumeCount

perUserSnapshotCount

perUserTemplateCount

accountRestrictionGracePeriod

preAuthRequired

depositRequired
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CurrencyValue currencyCode

currencyName

rank

longCurrencyName

sign

altSign

active

conversionFactor

TrialAccount Tenant :: tenant

Date :: expiryDate

Date :: lastChange

state

DepositRecord Date :: receivedOn

Tenant :: tenant

User :: recordedBy

amount

Profile name

description

operationsProfile

userCRUD

accountAdmin

CampaignPromotionsInChannels CampaignPromotion ::
campaignPromotion

Channel :: channel
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CampaignPromotion Set<CampaignPromotionsInChannels> ::
campaignPromotionsInChannels

Date :: startDate

Date :: endDate

Date :: createDate

code

title

durationDays

discountType

percentOff

maxAccounts

promoCode

customerType

enabled

trial

Subscription Tenant :: tenant

User :: user

Date :: terminationDate

ProductBundle :: productBundle

Date :: createdAt

User :: createdBy

List<Entitlement> ::
effectiveEntitlements

Date :: activationDate

Date :: nextRenewalDate

ServiceInstance :: serviceInstance

ServiceResourceType :: resourceType

uuid

state

vmId

preAuthTransId

preAuthAmount

configurationData

Entitlements ProductBundle :: productBundle

Product :: product

includedUnits

allowedUnlimitedEntitlement

ServiceInstance Service :: service uuid

name

description

code
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ProductBundle ServiceInstance :: serviceInstanceId

ServiceResourceType :: resourceType

User :: createdBy

User :: updatedBy

Date :: createdAt

Date :: updatedAt

Date :: removed

User :: removedBy

name

description

code

trialEligibility

publish

notificationEnabled

ServiceResourceType Service :: service resourceTypeName

constraint

Product User :: createdBy

User :: updatedBy

Date :: createdAt

Date :: updatedAt

Date :: removed

User :: removedBy

ServiceInstance :: serviceInstance

name

code

price

isReplaced

description

allowedUnlimitedEntitlement

Service Date :: createdAt

Date :: updatedAt

Set<ServiceInstance> ::
serviceInstances

List<ServiceResourceType> ::
serviceResourceTypes

uuid

category

type

vendor

locales

singleton

adapterRef

serviceName

vendorVersion

enabled
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Customizing Connector UI

From CloudPortal Business Manager 2.1 onwards, the connector UI can be customized using
an OSGI fragment bundle. This bundle will contain assets (jsp, js, css, tiles, MVC
controllers) for connector UI customization.

Creation of connector fragment from Archetypes

1. Run the cssdk-standard.jar installer and follow on-screen instructions.

2. Create a new connector fragment maven project by following the steps:

a. Goto File->New->Project.

b. Select Maven->Maven Project.

c. In the New Maven Project Wizard Screen, make sure Create a simple project is
unchecked.

d. Click Next.

e. In the Catalog selection, select Newly added Archetype in Catalog dropdown.

f. From the table select item with

i. Group Id: com.citrix.cpbm

ii. Artifact Id: com-citrix-cpbm-connector-fragment-archetype
g. Click Next .

h. Enter the values for the following fields:

i. GroupId - A group under which all services are offered. For instance,
org.apache in case of CloudStack.

ii. ArtifactId - Name of the services which the above group offers
.cloudstack.fragment in case of Apache CloudStack.

iii. Version - Version of the service offered. For example, for cloudstack.fragment,
the version is 1.0.0.

iv. Package - Base Java package for the maven project .org.apache.cloudstack in
case of Apache CloudStack

i. Click Finish. This will create a Connector Fragment Project.

Note: If project is not getting created try restarting the STS once.
Default Structure

META-INF
 readme.txt
 src



 main
  java
    base package name
     ExampleController.java
  resources
   css
    ${artifactId}
     example.css
   js
    ${artifactId}
     example.js
    images
     ${artifactId}
      example.png
   META-INF
    MANIFEST.MF
    WEB-INF
     default
      ${artifactId}-tiles-defs.xml
      jsp
       ${artifactId}
        example.jsp
      applicationContext-${artifactId}-fragment.xml
 build.properties
 pom.xml
 template.mf

File Description

• ExampleController.java: It is a Spring MVC controller which will contain the url
mapping, which is returned from the connector's view resolver. It returns a tile view.

• MANIFEST.MF: It is the bundle's manifest specifying the bundle's information along with
the fragment's host, it also contains package imports (if any).

• applicationContext-${artifactId}-fragment.xml: Spring Context file whose beans will
be loaded by the fragment's host. Any spring beans should go here.

• ${artifactId}-tiles-defs.xml: An xml configuration file which contains tiles definitions
for custom views which is loaded by fragment-host by file name.

• example.jsp: An example jsp file which specifies which JSTL tags can be used in the
JSP and also provides an example to include a css or a javascript file.

• example.js: An example js file.

• example.css: An example css file.

• example.png: An example image file.

• pom.xml: The maven project file for dependency and build management.(Add maven
dependency for the connector project for which this fragment will provide views).
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Customizing Billing Exports

CloudPortal Business Manager has a built-in functionality of exporting billing information in
xml everyday such as account statements, invoices, payment and credit statements, and
payment failures.

Billing export is driven by a xml configuration named billing-export-config.xml located in
the citrix.cpbm.custom.common bundle. CloudPortal Business Manager allows you to
customize various factors before exporting a file. Customization includes the following:

• File name pattern

• Sequencing of records

• sftp/ftp configuration

• batch size

• xslt transformation config file that needs to be applied on the generated xml

Billing export engine

Supported streams

• AccountStatement Stream

The AccountStatement Stream is capable of generating data with different types of
sequencing. Sequence can be altered in the configuration settings file. Valid Sequences
for AccountStatement Stream are:

• ACCOUNT_TYPE

• CHANNEL

• TENANT

<?xml version="1.0" encoding="UTF-8" standalone="yes"?>
<AccountStatements>



<AccountStatement>
        <uuid>22c1aede-614d-4be4-8cf3-4737853111a7</uuid>
        <Tenant>
            <Uuid>890077fe-6844-4732-8199-215566da083f</Uuid>
            <Name>nageshp</Name>
            <AccountType>Corporate</AccountType>
            <Channel>Channel-14-8-2013</Channel>
            <State>ACTIVE</State>
            <CreationDate>2013-09-03T08:22:33Z</CreationDate>
            <Currency>US Dollar</Currency>
            <Owner>
                <Uuid>d34c5ee3-e3e0-4772-a5fb-d0377ffd6e14</Uuid>
                <Name>nageshp</Name>
                <Username>nageshp</Username>
            </Owner>
            <Address>
                <City>bangalore</City>
                <Country>IN</Country>
                <PostalCode>560073</PostalCode>
                <State>KAR</State>
                <Street1>1stAvenue</Street1>
            </Address>
        </Tenant>
        <State>POSTED</State>
        <StartDate>2013-09-09T00:00:00Z</StartDate>
        <EndDate>2013-09-11T23:59:59Z</EndDate>
        <PostedAt>2013-09-12T01:06:15Z</PostedAt>
        <BalanceForward>-43709.4</BalanceForward>
        <NewCharges>6301.69</NewCharges>
        <Credits>0.0</Credits>
        <Discounts>0.0</Discounts>
        <TotalTaxes>572.88</TotalTaxes>
        <FinalCharges>50011.09</FinalCharges>
        <SubscriptionCharges>137.99</SubscriptionCharges>
        <UtilityCharges>5590.82</UtilityCharges>
        <RenewalCharges>0.0</RenewalCharges>
        <Invoices>
            <Invoice>
                <uuid>750b8fc4-2ffd-474e-b779-c2aac284e4fd</uuid>
                <GenerationDate>2013-09-12T01:06:14Z</GenerationDate>
                <ServiceStartDate>2013-09-11T00:00:00Z</ServiceStartDate>
                <ServiceEndDate>2013-09-11T23:59:59Z</ServiceEndDate>
                <PostedAt>2013-09-12T01:06:14Z</PostedAt>
                <State>Posted</State>
                <RawAmount>2865.39</RawAmount>
                <Discount>0.0</Discount>
                <SubTotal>2865.39</SubTotal>
                <Tax>286.54</Tax>
                <FinalAmount>3151.93</FinalAmount>
                <Subscription/>
                <InvoiceItems>
                    <InvoiceItem type="Charge" chargeableUsage="48.0" unitPrice="12.1234">
                        <Amount>581.9232</Amount>
                        <Description>Charge</Description>
                    </InvoiceItem>
                    <InvoiceItem type="Charge" chargeableUsage="0.020237457" unitPrice="6.0">
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                        <Amount>0.121424735</Amount>
                        <Description>Charge</Description>
                    </InvoiceItem>
                    <InvoiceItem type="Charge" chargeableUsage="0.0" unitPrice="4.0">
                        <Amount>0.0</Amount>
                        <Description>Charge</Description>
                    </InvoiceItem>
                    <InvoiceItem type="Charge" chargeableUsage="48.0" unitPrice="3.0">
                        <Amount>144.0</Amount>
                        <Description>Prod-16-8-2013</Description>
                    </InvoiceItem>
                    <InvoiceItem type="Charge" chargeableUsage="0.0" unitPrice="5.0">
                        <Amount>0.0</Amount>
                        <Description>Charge</Description>
                    </InvoiceItem>
                    <InvoiceItem type="Charge" chargeableUsage="0.0" unitPrice="4.0">
                        <Amount>0.0</Amount>
                        <Description>Charge</Description>
                    </InvoiceItem>
                    <InvoiceItem type="Charge" chargeableUsage="15.026944" unitPrice="80.0">
                        <Amount>1202.1555</Amount>
                        <Description>Running-VM-CentOS</Description>
                    </InvoiceItem>
                    <InvoiceItem type="Charge" chargeableUsage="48.0" unitPrice="2.0">
                        <Amount>96.0</Amount>
                        <Description>Charge</Description>
                    </InvoiceItem>
                    <InvoiceItem type="Charge" chargeableUsage="0.032258064" unitPrice="2.0">
                        <Amount>0.06451613</Amount>
                        <Description>Charge</Description>
                    </InvoiceItem>
                    <InvoiceItem type="Charge" chargeableUsage="15.056945" unitPrice="6.0">
                        <Amount>90.34167</Amount>
                        <Description>Charge</Description>
                    </InvoiceItem>
                    <InvoiceItem type="Charge" chargeableUsage="15.026944" unitPrice="7.0">
                        <Amount>105.18861</Amount>
                        <Description>prod-26-8-2013</Description>
                    </InvoiceItem>
                    <InvoiceItem type="Charge" chargeableUsage="1.54227E-5" unitPrice="6.0">
                        <Amount>9.25362E-5</Amount>
                        <Description>Charge</Description>
                    </InvoiceItem>
                    <InvoiceItem type="Charge" chargeableUsage="15.026944" unitPrice="5.0">
                        <Amount>75.13472</Amount>
                        <Description>Prod-27-6-2013</Description>
                    </InvoiceItem>
                    <InvoiceItem type="Charge" chargeableUsage="0.40475658" unitPrice="0.0">
                        <Amount>0.0</Amount>
                        <Description>Charge</Description>
                    </InvoiceItem>
                    <InvoiceItem type="Charge" chargeableUsage="0.030000687" unitPrice="10.0">
                        <Amount>0.30000687</Amount>
                        <Description>stopped_VM</Description>
                    </InvoiceItem>
                    <InvoiceItem type="Charge" chargeableUsage="48.0" unitPrice="10.0">
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                        <Amount>480.0</Amount>
                        <Description>Prod_RunningVM</Description>
                    </InvoiceItem>
                    <InvoiceItem type="Charge" chargeableUsage="15.026944" unitPrice="6.0">
                        <Amount>90.16167</Amount>
                        <Description>Charge</Description>
                    </InvoiceItem>
                    <InvoiceItem type="Charge" chargeableUsage="0.0" unitPrice="6.0">
                        <Amount>0.0</Amount>
                        <Description>Charge</Description>
                    </InvoiceItem>
                    <InvoiceItem type="Charge" chargeableUsage="1.54227E-5" unitPrice="100.0">
                        <Amount>0.00154227</Amount>
                        <Description>internetcharges</Description>
                    </InvoiceItem>
                    <InvoiceItem type="Subtotal" chargeableUsage="0.0" unitPrice="0.0">
                        <Amount>2865.39</Amount>
                        <Description>Subtotal</Description>
                    </InvoiceItem>
                    <InvoiceItem type="Discounts" chargeableUsage="0.0" unitPrice="0.0">
                        <Amount>0.0</Amount>
                        <Description>Discounts</Description>
                    </InvoiceItem>
                    <InvoiceItem type="Tax" chargeableUsage="0.0" unitPrice="0.0">
                        <Amount>286.539</Amount>
                        <Description>Tax @ 10.00%</Description>
                    </InvoiceItem>
                    <InvoiceItem type="Taxes" chargeableUsage="0.0" unitPrice="0.0">
                        <Amount>286.54</Amount>
                        <Description>Taxes</Description>
                    </InvoiceItem>
                    <InvoiceItem type="Net" chargeableUsage="0.0" unitPrice="0.0">
                        <Amount>3151.93</Amount>
                        <Description>Net</Description>
                    </InvoiceItem>
                </InvoiceItems>
            </Invoice>
        </Invoices>
    </AccountStatement>
</AccountStatements>

• All invoices for the day:

<?xml version="1.0" encoding="UTF-8" standalone="yes"?>
<Invoices>
    <Invoice>
        <uuid>b36d0c37-1324-485b-8049-36b534754986</uuid>
        <GenerationDate>2013-09-12T01:04:11Z</GenerationDate>
        <ServiceStartDate>2013-09-11T00:00:00Z</ServiceStartDate>
        <ServiceEndDate>2013-09-11T23:59:59Z</ServiceEndDate>
        <PostedAt>2013-09-12T01:04:11Z</PostedAt>
        <State>Posted</State>
        <RawAmount>2327.99</RawAmount>
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        <Discount>931.2</Discount>
        <SubTotal>1396.79</SubTotal>
        <Tax>139.68</Tax>
        <FinalAmount>1536.47</FinalAmount>
        <Subscription/>
        <InvoiceItems>
            <InvoiceItem type="Charge" chargeableUsage="48.0" unitPrice="5.0">
                <Amount>240.0</Amount>
                <Description>Prod-14-8-2013</Description>
            </InvoiceItem>
            <InvoiceItem type="Charge" chargeableUsage="0.058015037" unitPrice="5.0">
                <Amount>0.29007518</Amount>
                <Description>Charge</Description>
            </InvoiceItem>
            <InvoiceItem type="Charge" chargeableUsage="80.36278" unitPrice="12.1234">
                <Amount>974.2701</Amount>
                <Description>Charge</Description>
            </InvoiceItem>
            <InvoiceItem type="Charge" chargeableUsage="96.0" unitPrice="2.0">
                <Amount>192.0</Amount>
                <Description>Charge</Description>
            </InvoiceItem>
            <InvoiceItem type="Charge" chargeableUsage="0.032258064" unitPrice="2.0">
                <Amount>0.06451613</Amount>
                <Description>Charge</Description>
            </InvoiceItem>
            <InvoiceItem type="Charge" chargeableUsage="32.362778" unitPrice="3.0">
                <Amount>97.08833</Amount>
                <Description>Prod-16-8-2013</Description>
            </InvoiceItem>
            <InvoiceItem type="Charge" chargeableUsage="0.0" unitPrice="4.0">
                <Amount>0.0</Amount>
                <Description>Charge</Description>
            </InvoiceItem>
            <InvoiceItem type="Charge" chargeableUsage="2.580645" unitPrice="5.0">
                <Amount>12.903226</Amount>
                <Description>Charge</Description>
            </InvoiceItem>
            <InvoiceItem type="Charge" chargeableUsage="1.2903225" unitPrice="6.0">
                <Amount>7.7419353</Amount>
                <Description>Charge</Description>
            </InvoiceItem>
            <InvoiceItem type="Charge" chargeableUsage="80.36278" unitPrice="10.0">
                <Amount>803.6278</Amount>
                <Description>Prod_RunningVM</Description>
            </InvoiceItem>
            <InvoiceItem type="Charge" chargeableUsage="3.57069E-5" unitPrice="4.0">
                <Amount>1.428276E-4</Amount>
                <Description>Charge</Description>
            </InvoiceItem>
            <InvoiceItem type="Subtotal" chargeableUsage="0.0" unitPrice="0.0">
                <Amount>2327.99</Amount>
                <Description>Subtotal</Description>
            </InvoiceItem>
            <InvoiceItem type="Discount" chargeableUsage="0.0" unitPrice="0.0">
                <Amount>931.196</Amount>
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                <Description>Discount @ 40.0000%</Description>
            </InvoiceItem>
            <InvoiceItem type="Discounts" chargeableUsage="0.0" unitPrice="0.0">
                <Amount>931.2</Amount>
                <Description>Discounts</Description>
            </InvoiceItem>
            <InvoiceItem type="Tax" chargeableUsage="0.0" unitPrice="0.0">
                <Amount>139.679</Amount>
                <Description>Tax @ 10.00%</Description>
            </InvoiceItem>
            <InvoiceItem type="Taxes" chargeableUsage="0.0" unitPrice="0.0">
                <Amount>139.68</Amount>
                <Description>Taxes</Description>
            </InvoiceItem>
            <InvoiceItem type="Net" chargeableUsage="0.0" unitPrice="0.0">
                <Amount>1536.47</Amount>
                <Description>Net</Description>
            </InvoiceItem>
        </InvoiceItems>
    </Invoice>
</Invoices>     
                
  

• Payments and credits

<?xml version="1.0" encoding="UTF-8" standalone="yes"?>
<Payments>
    <Payment>
        <Uuid>8a80262e-3d52-4079-adda-1301362fa613</Uuid>
        <Tenant>
            <Uuid>8822c76b-0a98-4e37-864a-31508eccec72</Uuid>
            <Name>anusha</Name>
            <AccountType>RETAIL</AccountType>
            <Channel>Channel-14-8-2013</Channel>
            <State>SUSPENDED</State>
            <CreationDate>2013-08-28T09:31:55Z</CreationDate>
            <Currency>US Dollar</Currency>
            <Owner>
                <Uuid>a08a9bb6-6644-4971-8812-8211eb6b2d87</Uuid>
                <Name>anusha b</Name>
                <Username>anusha</Username>
            </Owner>
            <Address>
                <City>bangalore</City>
                <Country>IN</Country>
                <PostalCode>560078</PostalCode>
                <State>KAR</State>
                <Street1>MajesticAvenue</Street1>
            </Address>
        </Tenant>
        <type>AUTO</type>
        <TransactionAmount>2170.04</TransactionAmount>
        <memo>Making Auto Payment</memo>
        <AccountStatement uuid="69911443-bf90-408b-9331-443a0b23a822"
        <PaymentTransaction>
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            <Uuid>257cc015-49a2-40aa-aed5-4a32b6bfe773</Uuid>
            <Type>CHARGE</Type>
            <TransactionId>3789481256760176056470</TransactionId>
            <TransactionTime>2013-09-12T01:05:16Z</TransactionTime>
            <TransactedAmount>2170.04</TransactedAmount>
            <Amount>2170.04</Amount>
            <State>COMPLETED</State>
            <StatusCode>0</StatusCode>
            <Memo>Making Auto Payment</Memo>
        </PaymentTransaction>
    </Payment>
<Payments>

• Payment failure

<PaymentFailures>
    <PaymentFailure>
        <Uuid>f5892323-ad4c-4439-8b46-3687f1e0192d</Uuid>
        <Tenant>
            <Uuid>f132a5e3-f1ae-478b-999f-ddaf68e2b711</Uuid>
            <Name>peter</Name>
            <AccountType>RETAIL</AccountType>
            <Channel>Default</Channel>
            <State>ACTIVE</State>
            <CreationDate>2012-04-30T00:00:00Z</CreationDate>
            <Currency>Euro</Currency>
            <Owner>
                <Uuid>13c1d293-9dbc-4408-abd6-2190e72de091</Uuid>
                <Name>peter</Name>
                <Username>peter</Username>
            </Owner>
            <Address>
                <City>bangalore</City>
                <Country>IN</Country>
                <PostalCode>560002</PostalCode>
                <State>KAR</State>
                <Street1>FrazerTown</Street1>
            </Address>
        </Tenant>
        <type>CHARGE</type>
        <PaymentTransaction>
            <Uuid>f5892323-ad4c-4439-8b46-3687f1e0192d</Uuid>
            <Type>CHARGE</Type>
            <TransactionId>3678348733330176056442</TransactionId>
            <TransactionTime>2013-05-06T09:57:23Z</TransactionTime>
            <TransactedAmount>100.0</TransactedAmount>
            <Amount>100.0</Amount>
            <State>ERRORED</State>
            <StatusCode>0</StatusCode>
            <Memo></Memo>
        </PaymentTransaction>
    </PaymentFailure>
</PaymentFailures>
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Global stream configuration

There are 2 configurations which can be applied at global level for all the streams:

• com.citrix.cpbm.portal.billing.export.URL - URL refers to the configuration to which
generated stream file would be uploaded. It has to be a valid URL pattern supported by
apache VFS. For example, sftp://root:root1234@localhost/.

• com.citrix.cpbm.portal.billing.export.directory: Directory (CloudPortal Business
Manager installed system) on which all the streams will be generated locally.

Both these settings can be applied from the configuration screen.

Stream configuration

Stream configuration consists of the following:

• Batch size: Number of records that should be written to the batch file as output.

• File:

• pattern: File pattern is the name of the file to be generated during the batch
process. For example, cloudportal_subs_%d.log.%s, where %d gets replaced by the
current date and %s gets replaced by the last file sequence + 1.

CloudPortal Business Manager supports only %d and %s replacement of runtime
variables in the file name pattern.

• trasformxsl: Path of the xslt configuration file, that will be used to generate the
batch file in various formats like csv, xslt, and so on.

System has the capability of reading a file from classpath. Path should prefixed
with appropriate config:

• classpath:
• Sequence algorithms: Sequence algorithm defines the logical grouping of billing export

data that is by type-1 and then by type-2.

• Export file: Value of the element can be:

<Export url=""/> 

• Full URL path, if global settings are not applied.

• Directory location in the remote system assigned to the stream.
This is implemented using Apache VFS. All file systems in Apache VFS that allow file
upload and create in a remote system are supported.

• http://commons.apache.org/proper/commons-vfs/filesystems.html

• http://commons.apache.org/proper/commons-vfs/
• Configuration:

<BillingExport>
    <ExportStream name="AccountStatement">
        <file pattern="cpbm_account_stmt_%d_%s" transformxsl="classpath:/opt/billing/xsl/transform.xsl"/>
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        <batch size="10"/>
        <sequence id="channel"/>
        <sequence id="accounttype"/>
        <Export url=""/>
    </ExportStream>
    <ExportStream name="invoice">
        <file pattern="cpbm_invoice_%d_%s" transformxsl="classpath:/com/citrix/cpbm/custom/transform.xsl"/>
        <batch size="10"/>
        <Export url=""/>
    </ExportStream>
</BillingExport>

Class Diagram
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Customizing Pricing Filters

Pricing filters can be customized. By customization, CloudPortal Business Manager allows
the removal of filters.

Customizing pricing filters consists of the following:

Step 1

Open the applicationContext-admin-customizations.xml file in citrix.cpbm.custom.common
bundle.

Step 2

There are 2 spring beans which refer to a collection of discounting engines and tax engines:

• discountEngineList

• taxEngineList

<bean name="adhocDiscountEngine" class="${discount.adhoc.engine.implementation:com.vmops.component.discount.policy.NonPromotionalDiscountEngine}" > 
    </bean>
    <bean name="percentDiscountEngine" class="${discount.percent.engine.implementation:com.vmops.component.discount.policy.PercentDiscountEngine}">
    </bean>
    <bean name="amountDiscountEngine" class="${discount.amount.engine.implementation:com.vmops.component.discount.policy.AmountDiscountEngine}" /> 
    <bean name="taxEngine" class="${tax.engine.implementation}" > 
      <property name="flatTaxPercent" value="${tax.engine.flat.percent:10.0}" />
    </bean>

    <bean id="discountEngineList" class="java.util.ArrayList">
        <constructor-arg>
            <list>
                <ref bean="adhocDiscountEngine" />
                <ref bean="percentDiscountEngine" />
                <ref bean="amountDiscountEngine" />
            </list>
        </constructor-arg>
    </bean>
    
    <bean id="taxEngineList" class="java.util.ArrayList">
        <constructor-arg>
            <list>
                <ref bean="taxEngine" />
            </list>
        </constructor-arg>
    </bean>

Step 3



Remove the bean reference from the list which is not required or is not applicable. Any
bean reference removed from the above mentioned list will also remove the bean
declaration as this bean is not used any more.

Customizing Pricing Filters
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Customizing Profiles

Customers can add more profiles to CloudPortal Business Manager, if required.

Below are the steps to create new profile.:

1. Create new entry for the profile in database. Add a liquibase change set to file
custom-db-config-v0.1.xml located in bundle citrix.cpbm.custom.common at
src/main/resources/citrix/cpbm/custom/db/portal/.

A sample liquibase change set is as follows:

<changeSet id="1373375974" author="John">
      <insert tableName="profiles">
        <column name="name" value="SuperUser"/>
        <column name="description" value="This is a super user"/>
        <column name="scope" value="<TENANT/TENANT_ADMIN/GLOBAL/GLOBAL_ADMIN>"/>
      </insert>
</changeSet>

Note: In above example, "SuperUser" is the sample name of the profile and "This is a
super user" is the sample description of the profile.

2. Add value of the profile to be displayed in UI. CloudPortal Business Manager looks for
value of code "profileName.<profile name>" in application resource. Add a property
"profileName.<profile name>" into the application resource. See Customizing Resource
Properties for details.

Example: profileName.SuperUser=Super User

3. Restart the CPBM server:

service cloud-portal stop
service cloud-portal start

4. Login to CloudPortal Business Manager as Root user and navigate to Administration >
Profiles.

5. If the scope provided by you in Step 1 is TENANT or TENANT_ADMIN, then your new
profile will appear in the Customer tab, else it will appear in the Service Provider tab.

6. Select the new profile and check all the roles you want in the profile and click Save.

you can select this profile when creating new users.

To understand the scope in detail, refer to Security Roles.

Note: Liquibase is a tool which CloudPortal Business Manager uses to populate base data
or to perform any upgrade/migration during CloudPortal Business Manager upgrade. More
information about liquibase can be found at: http://www.liquibase.org/

http://www.liquibase.org/
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Customizing Account Types

Customer can add more account types to CloudPortal Business Manager, if required.

Below are the steps to create new account type:

1. Create a new entry for the new account type in the table account_types under schema
cloud_portal. Add a liquibase change set to file custom-db-config-v0.1.xml located in
bundle citrix.cpbm.custom.common at
src/main/resources/citrix/cpbm/custom/db/portal/.

A sample liquibase change set is as follows:

<changeSet id="1373375974" author="John">
  <insert tableName="account_types">
<insert tableName="account_types">
            <column name="name" value="CUSTOM_AT"/>
            <column name="display_name" value="Custom Account Type"/>
            <column name="description" value="Custom account type for doc"/>
            <column name="trial" valueBoolean="false"/>
            <column name="payment_info_required" valueBoolean="true"/>
            <column name="instantpay_required" value="0"/>
            <column name="autopay_required" valueBoolean="true"/>
            <column name="extend_credit" valueBoolean="true"/>
            <column name="self_registration_allowed" valueBoolean="true"/>
            <column name="manual_registration_allowed" valueBoolean="true"/>
            <column name="notional_billing" valueBoolean="false"/>
            <column name="manual_activation" valueBoolean="false"/>
            <column name="credit_exposure_breach" valueNumeric="3"/>
            <column name="default_self_registered" valueBoolean="true"/>
            <column name="default_registered" valueBoolean="true"/>
            <column name="payment_modes" valueNumeric="2"/>
            <column name="max_users" valueNumeric="10"/>
            <column name="account_restriction_grace_period" valueNumeric="1"/>
            <column name="pre_auth_required" valueBoolean="false"/>
            <column name="deposit_required" valueBoolean="false"/>
            <column name="enable_secondary_address" valueBoolean="false"/>
            <column name="version" valueNumeric="0"/>
        </insert>
  </insert>
</changeSet>

Note: In above example "CUSTOM_AT" is sample name , "Custom account type" is
sample display name and "Custom account type for doc" is sample description of the
account type. You must select other values as per your requirement. For more
information, refer to Account Properties.

2. Add required resources into custom application properties. Add the below mentioned
properties:



registration.accounttype.custom_at=Custom Account Type
registration.accounttype.description.custom_at=Custom account type with special privileges
page.level2.custom_at=Custom Account Type

Note: custom_at is shown on above properties as an example only. You should add
the name used for the account type and corresponding description.

For details, refer to Customizing Resource Properties.

3. Restart the CPBM server:

service cloud-portal stop
service cloud-portal start

Note: Liquibase is a tool which CloudPortal Business Manager uses to populate base data
or to perform any upgrade/migration during CloudPortal Business Manager upgrade. More
information about liquibase can be found at: http://www.liquibase.org/
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Customizing Discount Adjusters

Customers can change the way discounts are applied to a CPBM invoice.

1. Change the engine to customized implementation:

a. Customizing the way percent discount engine works:

i. Implement a new DiscountEngine by extending the abstract class
DiscountEngine (com.vmops.component.discount.policy.DiscountEngine) and
put it inside the citrix.cpbm.custom bundle.

ii. Edit the cloud.properties at /usr/share/vts3/repository/prop to point to the
new entry by editing the property discount.percent.engine.implementation.
Point it to the new implementation.

b. Customizing the way amount discount engine works:

i. Implement a new DiscountEngine by extending the abstract class
DiscountEngine (com.vmops.component.discount.policy.DiscountEngine) and
put it inside the citrix.cpbm.custom bundle.

ii. Edit the cloud.properties at /usr/share/vts3/repository/prop to point to the
new entry by editing the property discount.amount.engine.implementation.
Point it to the new implementation.

c. Customizing the way non promotional discount engine works:

i. Implement a new DiscountEngine by extending the abstract class
DiscountEngine (com.vmops.component.discount.policy.DiscountEngine) and
put it inside the citrix.cpbm.custom bundle.

ii. Edit the cloud.properties at /usr/share/vts3/repository/prop to point to the
new entry by editing the property discount.adhoc.engine.implementation. Point
it to the new implementation.

Restart the CPBM service.
2. Adding new engines over and above the existing engine:

a. Implement a new DiscountEngine by extending the abstract class DiscountEngine
(com.vmops.component.discount.policy.DiscountEngine) and put it inside the
citrix.cpbm.custom bundle.

b. Add one or more such implementations.

c. Open the application context file applicationContext-admin-customizations.xml
inside the citrix.cpbm.custom bundle.

Define a bean for each implementation:

<bean name="discountEngineCustom" class="<Newly added class>" />

Add the above created bean to the list 'taxEngineList':



<bean id="discountEngineList" class="java.util.ArrayList">
        <constructor-arg>
            <list>
                <ref bean="adhocDiscountEngine" />
                <ref bean="percentDiscountEngine" />
                <ref bean="amountDiscountEngine" />
                <ref bean="discountEngineCustom" />
            </list>
        </constructor-arg>
    </bean>

or

<bean id="taxEngineList" class="java.util.ArrayList">
        <constructor-arg>
            <list>
                <ref bean="discountEngineCustom" />
            </list>
        </constructor-arg>
    </bean>

Note: You can remove the default implementation and/or add multiple such
beans in the list. Beans will be called in the same order as defined in the list.

d. Restart the CPBM service.

3. Example:

public interface RateAdjuster {

  /**
   * @param invoice A read only (not enforced) invoice for the rate adjuster to get info related to this invoice such as
   *          tenant, billing period etc.
   * @param newInvoiceItems Every RateAdjuster should process the newInvoiceItems and replace them with adjusted items
   *          for the next adjusters for further processing. The first adjuster sees the invoiceItems of
   *          ChargeType.CHARGE
   * @param serviceStart is the billing period start for the moment, it can be any day in the billing period if we
   *          decided to support number of days for a promotion (as oppose to number of billing period)
   * @param serviceEnd is the billing period end for the moment, it can be any day in the billing period if we decided
   *          to support number of days for a promotion (as oppose to number of billing period)
   * @param previewMode if true, nothing will be written to db or the billing activity file. Plan to remove this soon.
   * @return
   */
  
public abstract BigDecimal compute(Invoice invoice, List<InvoiceItem> invoiceItemsToBeProcessed, Date serviceStart,
      Date serviceEnd, boolean previewMode);

}

public class ExampleDiscountEngine extends DiscountEngine {

  @Override
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  public BigDecimal compute(Invoice invoice, List<InvoiceItem> invoiceItemsToBeProcessed, Date serviceStart,
      Date serviceEnd, boolean previewMode) {
    …… [Put your implementation here ]
}
}
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Customizing Tax Adjusters

Customers can change the way tax rates are applied to a CPBM invoice.

1. Change the engine to customized implementation:

a. Implement a new TaxEngine by implementing the interface TaxEngine
(com.vmops.service.TaxEngine) and put it inside the citrix.cpbm.custom bundle.

b. Edit the cloud.properties at /usr/share/vts3/repository/prop to point to the new
entry by editing the property tax.engine.implementation. Point it to the new
implementation.

c. Restart the CPBM service.
2. Adding new engines over and above the existing engine:

a. Implement a new TaxEngine by implementing the interface TaxEngine
(com.vmops.service.TaxEngine) and put it inside the citrix.cpbm.custom bundle.

b. Add one or more such implementations.

c. Open the application context file applicationContext-admin-customizations.xml
inside the citrix.cpbm.custom bundle.

Define a bean for each implementation:

<bean name="taxEngineCustom" class="<New Implementation path>" > 
           
    </bean>

d. Add the above created bean to the list 'taxEngineList':

<bean id="taxEngineList" class="java.util.ArrayList">
        <constructor-arg>
            <list>
                <ref bean="taxEngine" />
                <ref bean="taxEngineCustom" />
            </list>
        </constructor-arg>
    </bean>

or

<bean id="taxEngineList" class="java.util.ArrayList">
        <constructor-arg>
            <list>
                <ref bean="taxEngineCustom" />
            </list>
        </constructor-arg>
    </bean>



e. Restart the CPBM service.

Note: You can remove the default implementation and/or add multiple such
beans in the list.Beans will be called in the same order as defined in the list.

3. Example:

public interface RateAdjuster {

    /**
   * @param invoice A invoice for the rate adjuster to get info related to this invoice such as tenant, billing period
   *          etc.
   * @param invoiceItemsToBeProcessed Every RateAdjuster should process the invoiceItemsToBeProcessed and replace them
   *          with adjusted items for the next adjusters for further processing. The first adjuster sees the
   *          invoiceItems of ChargeType.CHARGE
   * @param serviceStart is the billing period start for the moment, it can be any day in the billing period if we
   *          decided to support number of days for a promotion (as oppose to number of billing period)
   * @param serviceEnd is the billing period end for the moment, it can be any day in the billing period if we decided
   *          to support number of days for a promotion (as oppose to number of billing period)
   * @param previewMode if true, nothing will be written to db or the billing activity file. Plan to remove this soon.
   *          implementation of this interface should create invoice item for discount or tax and add to the invoice
   *          items and should adjust the invoice's discount/tax and amount due field.
   * @return {@link BigDecimal}
   */

  public abstract BigDecimal compute(Invoice invoice, List<InvoiceItem> invoiceItemsToBeProcessed, Date serviceStart,
      Date serviceEnd, boolean previewMode);

}

public interface TaxEngine extends RateAdjuster {

    /**
   * this method is get called from CPBM catalog UI at the time of subscribing product bundle. and it should return the
   * proper tax
   * @param amount
   * @return {@link BigDecimal}
   */
  public BigDecimal compute(BigDecimal amount);

}

Example Custom Tax Rate Adjuster

package com.citrix.cpbm.custom.service.impl;

import java.math.BigDecimal;
import java.util.Date;
import java.util.List;

import org.springframework.beans.factory.annotation.Autowired;

import com.vmops.internal.service.ActorService;
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import com.vmops.model.Invoice;
import com.vmops.model.InvoiceItem;
import com.vmops.model.InvoiceItem.ChargeType;
import com.vmops.model.User;
import com.vmops.service.TaxEngine;

public class ChannelSpecificTaxPolicy implements TaxEngine {

  @Autowired
  ActorService actorService;

  @Override
  public BigDecimal compute(Invoice invoice, List<InvoiceItem> invoiceItemsToBeProcessed, Date serviceStart,
      Date serviceEnd, boolean previewMode) {
    BigDecimal taxPercent = BigDecimal.TEN;
    BigDecimal taxableAmount = invoice.getAmount();
    BigDecimal totalTaxOnInvoice = BigDecimal.ZERO;
    if (!previewMode) {
      if ("usachannel".equalsIgnoreCase(invoice.getTenant().getSourceChannel().getName())) {
        taxPercent = BigDecimal.ONE;
      }
      if ("indiachannel".equalsIgnoreCase(invoice.getTenant().getSourceChannel().getName())) {
        taxPercent = BigDecimal.TEN;
      }
      totalTaxOnInvoice = taxableAmount.multiply(taxPercent).divide(BigDecimal.valueOf(100));
      InvoiceItem taxItem = new InvoiceItem(invoice, totalTaxOnInvoice, null, ChargeType.TAX, serviceStart, serviceEnd,
          null, null, null, null, "Tax @ " + taxPercent + "%");
      invoice.getInvoiceItems().add(taxItem); // adding tax to the invoice items
      invoice.setTaxAmount(invoice.getTaxAmount().add(totalTaxOnInvoice));// adjusting total tax amount of the invoice
      invoice.setAmount(invoice.getAmount().add(totalTaxOnInvoice));// adjusting total amount of the invoice
      invoice.setAmountDue(invoice.getAmountDue().add(totalTaxOnInvoice));// adjusting total amount due of the invoice
    }
    return totalTaxOnInvoice;
  }

 // this method is called from CPBM Catalog UI at the time of subscribing the product bundle. 
  @Override
  public BigDecimal compute(BigDecimal amount) {
    BigDecimal taxPercent = BigDecimal.TEN;
    BigDecimal totalTax = BigDecimal.ZERO;
    User effUser = actorService.getDelegateActor();
    if (effUser != null && effUser.getTenant().getSourceChannel() != null) {
      if ("usachannel".equalsIgnoreCase(effUser.getTenant().getSourceChannel().getName())) {
        taxPercent = BigDecimal.ONE;
      }
      if ("indiachannel".equalsIgnoreCase(effUser.getTenant().getSourceChannel().getName())) {
        taxPercent = BigDecimal.TEN;
      }
      totalTax = amount.multiply(taxPercent).divide(BigDecimal.valueOf(100));
    }
    return totalTax;
  }
}

Customizing Tax Adjusters
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Account Statement Adjuster

The service provider can adjust an account statement prior to posting, in case any
additional invoices or credits need to be applied to the account statement. A hook for
customization is provided to plug in custom code that can take an account statement and
either add credits or debits to it.

The following interface AccountStatementAdjuster has been added:

public interface AccountStatementAdjuster
{ public void afterCreate(AccountStatement accountstatement); 
  public void beforePost(AccountStatement accountstatement); } 

There is no default implementation for this interface. It can be implemented as
customization. You may chose to implement just one or both methods. The implementation
should be put in the citrix.cpbm.custom.common package.

This functionality can be configured by editing the file
applicationContext-admin-customizations.xml inside the citrix.cpbm.custom package:

1. Add the entry:

<bean name="accountStatementAdjuster" class="<Above mentioned implementation>" />

2. Publish the bean to OSGi registry. Add entry-

<osgi:service interface="com.citrix.cpbm.filters.AccountStatementAdjuster" ref="accountStatementAdjuster"/>

in osgi-context.xml available at src/main/resources/META-INF/spring in the
citrix.cpbm.custom.common bundle.

3. After making the necessary changes, rebuild the custom packages as documented in
Installing and building custom components.

http://support.citrix.com/proddocs/topic/cpbm-23-map/cpbm-install-build-custom-components-23-con.html#cpbm-install-build-custom-components-tsk
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CPBM backward compatibility support
matrix

The following table lists the backward compatibility support matrix for Citrix CPBM
adaptations:

Component Major version

(for example 2.0 ->
3.0)

Minor version

(for example: 2.1 ->
2.2)

Maintenance
release

(for example: 2.2.1
-> 2.2.2)

Customization
Repository

(CPBM UI
Adaptations,
Workflows, Message
strings, and so on)

No No Yes

(Merge
recommended)

CCP Connector UI
Fragment
Repository

No No Yes

(Merge
recommended)

Note: This is not
supported for
Connector
feature releases
like 2.2.1

Cloud Connector
SDK

No Yes Yes

OSS Connector SDK No Yes Yes

Connector SDK
All connector APIs are fully backward compatible but the UI code (JSP, JS CSS, and so on)
requires merge in every feature (dot) release.

Merging is not required in maintenance releases, but it is recommended to merge in order
to get all bug fixes.

BSS APIs
All BSS APIs are fully backward compatible.



Customization SDK
Customization SDK code is backward compatible only in maintenance releases and requires
a merge in every feature release. It is recommended to merge even for maintenance
releases in order to get all bug fixes.

 CPBM backward compatibility support matrix
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Citrix® CloudPlatform™ Connector Guide

The Citrix CloudPlatform Connector is installed in CloudPortal Business Manager during
installation of CloudPortal Business Manager. This guide describes the steps necessary to
enable the cloud service, add instances of the services, typical product and bundle
definitions, usage types, and resources available through the CloudPortal Business Manager
UI. The guide also explains how resources can be managed from the CloudPortal Business
Manager UI.

Supported CCP versions are: 3.0.5, 3.0.6, 3.0.7, 4.2.0, 4.2.1, 4.3.0, 4.3.0.1, 4.3.0.2

CPBM 2.3.1 also supports CCP 4.5.0, 4.5.1.

Installing CCP Connector

Sending CCP APIs

Onboarding and Managing the CCP service

CCP Connector User Roles

Mapping of CPBM and CCP entities

CCP Product Onboarding

CCP Connector Resource Provisioning

Managing Resources

Setting Service Instance Specific User Settings

Known Issues

FAQs

http://support.citrix.com/proddocs/topic/cpbm-23-map/cpbm-ccp-connector-install-con.html#concept_78B2E207822049E28D10AEE7652A778D
http://support.citrix.com/proddocs/topic/cpbm-23-map/cpbm-onboarding-ccp-instance-con.html#concept_62085A803EC4496F93B3166EBE59BACB
http://support.citrix.com/proddocs/topic/cpbm-23-map/cpbm-ccp-set-service-inst-user-settings.html#ccpb-set-service-inst-user-settings
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Installing Citrix CloudPlatform Connector

The CCP connector is installed, by default, when you install CloudPortal Business Manager.
The CCP connector is deployed into VIRGO's directory. CloudPortal Business Manager
extracts the information from the connector and copies the serviceDefinition.xml, logo,
terms and condition files and UI implementation files to the /usr/share/cloud/portal/data
directory.
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Sending Citrix CloudPlatform APIs

The API access to Citrix CloudPlatform (CCP) managed by CloudPortal Business Manager
(CPBM) is enabled by proxying API request through the CPBM server. This section provides
the syntax for sending API calls to cloud endpoints.

The API endpoint to access CCP APIs through the API proxy is as follows:

http://<Hostname of the CPBM server>:<port>/portal/client/apis/<API Proxy suffix name>/?command=<CCP API command>&apiKey=<CCP API key>&response=<json or xml>&timestamp=<Timestamp>&signature=<Signature>

Refer to Adding an instance to the CCP service for information on the API Proxy suffix name
parameter.
All the parameters specified to the API proxy are forwarded to the specific CCP server.

For more information on each API parameter, see CloudPlatform Developer's guide and API
Reference.
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Onboarding and Managing the Citrix
CloudPlatform service

Onboarding a service refers to the process of:

• Deploying a CCP connector into CloudPortal Business Manager.

• Enabling a CCP connector and adding a CCP service instance.

CCP Connector
The CCP connector is a Java based OSGi bundle which:

• Implements the CloudPortal Business Manager Cloud Service Interfaces

• Defines the following metadata:

• Endpoint and credential parameters

• Resource Metadata: Various resources that can be provisioned and metered

• Custom UI Views for Subscription provisioning

• Service Controls
The CCP connector implements set of hooks and CloudPortal Business Manager invokes
these hooks at appropriate stages. The stages include:

1. Account Creation

2. User Creation

3. Resource provisioning

4. Product definition

5. Usage collection

6. Event collection

Multiple instances of Citrix CloudPlatform (CCP) can be added in CloudPortal Business
Manager. You have to first enable the CCP connector. After enabling, roles defined by the
CCP service are mapped to appropriate CloudPortal Business Manager profiles.

Note: The service onboarding for customer and customer's users depends on these role
mapping. Ensure that roles are appropriately mapped to profiles.
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Preparing Citrix CloudPlatform to work
with CloudPortal Business Manager

Pre-requisite: Citrix CloudPlatform (CCP) is installed and fully operational.

1. Log in to CloudPlatform Management Server as Admin user.

2. Navigate to Accounts > Admin.

3. Select View users > Admin.

4. Click Generate Keys. This generates the API key and secret key.

5. Copy these keys to a text file.

6. Navigate to Global Settings:

a. Search for security.singlesignon.key value. Copy it to a text file.

b. Search for integration.api.port.

i. Specify the default api port value as 8096.

ii. Click Save and then, click OK.
7. Restart the CloudStack service:

a. SSH to the Citrix CloudPlatform Linux server.

b. Log in and type the command: service cloudstack-management restart.
8. Refresh the CCP UI page and log in as Admin user.

9. Install the Cloud Usage server on CCP. After the installation is complete start the
cloud-usage server by typing this command: service cloudstack-usage restart.

10. Configure CloudPlatform database to support CloudPortal Business Manager. Create a
new MySQL user and configure the proper permissions for this user, as this will allow
CloudPortal Business Manager to access the CCP database.

a. Login to MySQL using the command:

mysql -u root (use -p if you defined password for the MySQL root user).

b. At the mysql prompt,

create user cpbm  identified by 'ANY PASSWORD';
GRANT ALL PRIVILEGES ON *.* TO 'cpbm'@'%' WITH GRANT OPTION; 
FLUSH PRIVILEGES;

c. Exit MySQL by running to command: quit.



11. Configuring iptables on CCP: Allow incoming TCP ports 8096, 20400 and 3306 on the CCP
Server by editing the iptables file.

a. Run the command:

vi /etc/sysconfig/iptables

b. Add these lines:

-A INPUT -p tcp -m tcp --dport 3306 -j ACCEPT
-A INPUT -p tcp -m tcp --dport 8096 -j ACCEPT
-A INPUT -p tcp -m tcp --dport 20400 -j ACCEPT

c. Save and exit the file and restart the iptables service using the command: service
iptables restart .

Preparing Citrix CloudPlatform to work with CloudPortal Business Manager
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Integrating CloudPortal Business
Manager with Citrix CloudPlatform for
Single Sign-on

As an Admin user, if you do not want to provide usename and password while launching the
Citrix CloudPlatform (CCP) UI Console from CloudPortal Business Manager, you have to
provide Single Sign-on (SSO) integration between CloudPortal Business Manager and CCP.

On each CloudPlatform server, run the ./install.sh script and select Integrate with
CloudPlatform from the menu. This will place files within CloudPlatform that are needed
for single sign-on integration with CloudPortal. Note that after the files are copied over for
integration, you will no longer be able to access the CloudPlatform management server
using http://<hostname>:8080/client. It is recommended to access the CloudPlatform
management UI by first logging into CloudPortal and clicking the "Launch Cloud Console"
button on the dashboard. As an alternative, the CloudPlatform management UI can be
accessed directly by using http://<hostname>:8080/client/?direct=true.

# ./install.sh
Welcome to the Citrix CloudPortal Business Manager Installer.
What would you like to do?
D) Install the database server
I) Install & Configure CloudPortal Business Manager
C) Integrate with Citrix CloudPlatform
Q) Quit
> C

Choose option C and press Enter and wait for the process to complete. Please note that no
confirmation will be displayed. Click q to exit the installer.
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Integrating CloudPortal Business
Manager with Apache CloudStack for
Single Sign-on

As an Admin user, if you want to wish to block direct UI and API access to ACS and redirect
it through CPBM API proxy, perform the following steps on CloudStack node(s), run
install.sh. This will show the following menu:

# ./install.sh
Welcome to the Citrix CloudPortal Business Manager Installer.
What would you like to do?
D) Install the database server
I) Install & Configure CloudPortal Business Manager
C) Integrate with Citrix CloudPlatform
Q) Quit
> C

Choose option C and press Enter and wait for the process to complete. This operation will
place files within CloudStack that are needed for single sign-on integration with
CloudPortal. Choose option Q to exit the installer.

Go to the scripts folder of CloudStack management (usually found in
/usr/share/cloud/management/webapps/client/scripts or
/usr/share/cloudstack-management/webapps/client/scripts).

Make the following changes:

1. In cloud.core.callbacks.js:

a. Replace first occurance of clientApiUrl=/client/api with
clientApiUrl=/portal/client/apis/<APISUFFIX_OF_ACS>

b. Replace first occurance of clientConsoleUrl=/client/console with
clientConsoleUrl=/portal/client/apis/<APISUFFIX_OF_ACS>/console

c. Replace var url = "/client/api?command=login&domainid=" + credentials.domainid +
"&response=json&timestamp=" + credentials.timestamp + "&username=" +
credentials.username + "&signature=" + credentials.signature; with var url =
"/portal/client/apis/<APISUFFIX_OF_ACS>?command=login&domainid=" +
credentials.domainid + "&response=json&timestamp=" + credentials.timestamp +
"&username=" + credentials.username + "&signature=" + credentials.signature;

2. In cloud.core.init.js:

a. Replace url: "/client/api" to url: "/portal/client/apis/<APISUFFIX_OF_ACS>"

Note: After the above changes, you will no longer be able to access the CloudStack 
management server using http://<ACS_IP>:8080/client. It is recommended to access the



CloudStack management UI by logging in to CloudPortal and clicking the "Launch Cloud
Console" button on the dashboard. As an alternative, the CloudStack management UI can
be accessed directly by using http://<ACS_IP>:8080/client/?direct=true.

Refer to the Proxy Server configuration in Installation Guide > Setting up CloudPortal >
Installing and Configuring CloudPortal Business Manager > Setting up a Proxy Server,
before proceeding further.

If the proxy server is configured, make the following changes in the cloud.conf file:

1. For a two-node installation where Apache and CloudPortal are run on separate nodes,
append the following rules:

a. ProxyPass /client/api
http://<CloudPortalNode>:8080/portal/client/apis/<APISUFFIX_OF_ACS>

b. ProxyPass /client http://<ACS-IP>:8080/client
2. For a three-node installation where Apache is on one node and CloudPortal is on two

additional nodes, append the following rules:

a. ProxyPass /client/api
balancer://portalcluster/portal/client/apis/<APISUFFIX_OF_ACS> stickysession=rte

b. ProxyPass /client http://<ACS-IP>:8080/client
After these rules are added do either of the following to bring the new rules in effect:

# apachectl graceful or # service httpd restart

Note: ACS-IP is the internal ip of ACS, APISUFFIX_OF_ACS is the api suffix which was given
while adding the ACS service instance in CPBM. CloudPortalNode is the internal IP of
CPBM. Also make sure the public protocol, host and port of the ACS service instance
should be same as CPBM's public protocol, host and port.

Integrating CloudPortal Business Manager with Apache CloudStack for Single Sign-on
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Enabling the Citrix CloudPlatform
Connector

1. Log in to CloudPortal Business Manager UI as Root user.

2. Go to Home > All Services.

3. Select the Citrix CloudPlatform connector and click Enable.

4. Accept the Terms & Conditions defined by the CCP cloud service and click Accept.

5. Map the roles defined by the CCP cloud service to the appropriate CloudPortal Business
Manager profiles.

Note: The service onboarding for customer and customer's users depends on these
role mapping. Ensure that roles are appropriately mapped to profiles.

6. Click Submit and then click Close.
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Adding an instance to the CCP service

The Add Service Instance wizard enables you to add an instance of the service. You can
specify the parameters required to connect to the service, add products, and specify the
utility prices for the products.

Pre-requisites:

• Citrix CloudPlatform IP

• Citrix CloudPlatform Database credentials

• Admin API key

• Admin Secret Key

• Single.Signon key

• Ensure the 8096 port is enabled and IPtables updated on Citrix CloudPlatform

1. Log in to CloudPortal Business Manager UI as Root user.

2. Click Home > All Services > Cloud Services. You will find the CCP service of the category
IaaS.

3. Click Add. The Add Service Instance wizard opens.

4. Specify the identifying information for the instance such as name, code, and description
and click Next.

5. In the Configuration page, specify the details:

• Protocol (http or https): http

• Public hostname: Public IP of Citrix CloudPlatform

• Public Port: 8080

• Cloud JDBC hostname: IP of the MySQL server where Citrix CloudPlatform is hosted.
This JDBC host will be used for usage collection also if usage JDBC details are not
provided in advance settings.

• Cloud JDBC username: Citrix CloudPlatform DB user

• Cloud JDBC password: Citrix CloudPlatform DB user password

• SSO key: Citrix CloudPlatform single.signon.key value (which is used by root user for
single sign on into Citrix CloudPlatform)

• API key: Administrator's user API key



• Secret key: Administrator's user Secret key

• CloudPlatform domain Uuid: ID of the CloudPlatform ROOT domain or any other
domain you wish to use to create accounts and users

• CloudPlatform IP List (administration port): Citrix CloudPlatform IP:8096 (for
example. 192.168.1.17:8096)

• CloudPlatform IP List: Citrix CloudPlatform IP:8080 (for example.
192.168.1.17:8080)

• API Proxy suffix: csapi (or any other suffix you wish to use)

Click Advanced Settings (optional) and specify the details:

• Cloud database schema name:

• Cloud Usage JDBC Hostname: Enter the cloud JDBC hostname or IP.

• Cloud Usage JDBC username: Enter the cloud JDBC username

• Cloud Usage database schema name: Enter the cloud database schema name

• API Whitelist Suffix: Enter a comma separated white-list of API names.

• API Blacklist Suffix Enter a comma separated black-list of API names.

• Default keyboard device type for virtual machines: Valid value can be any one type
from this list - de, de-ch, es, fi, fr, fr-be, fr-ch, is, it, jp, nl-be, no, pt, uk, us

• Custom disk offering maximum size in GB.

Note: If no value for "Custom disk offering max size in GB" is entered, a default
value of 1024 GB will be set. Hence no disk offerings greater than 1024 GB will be
displayed in the Start VM Wizard.

6. Click Next. The Default Product Selections page is displayed. This is a list of products
based on defined UsageTypes. For more information on usage types, refer to the
section on Usage Types.

7. Select the products that you want to create at the time of creation of the service
instance. You can also edit the product name, product code, category, and required
product units for each of the default products.

8. Click Next and specify the utility charges (in all active currencies) for the products that
you have selected.

9. Review and confirm the details.

10. Click Add and then, click Close.

Adding an instance to the CCP service
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Region support configuration

For supporting multiple CCP regions, the following is a sample configuration:

In the figure, portal.cloud.com, usa.cloud.com and canada.cloud.com map to the same
proxy server which has the corresponding routing configuration. cpbm-ip is the IP of the LB
to the CloudPortal Business Manager nodes, usa-ccp-ip is IP of the LB to USA region nodes,
and canada-ccp-ip is the IP of the LB to Canada region nodes.

Here is a sample Apache HTTP proxy configuration for the proxy server to achieve the
same:

NameVirtualHost *:80

<VirtualHost *:80>
    ServerName portal.cloud.com
    ProxyPass /portal http://cpbm-ip/portal
</VirtualHost>



<VirtualHost *:80>
    ServerName usa.cloud.com
    ProxyPass /client http://usa-ccp-ip/client
    ProxyPass /client/api http://cpbm-ip/portal/client/apis/usa
</VirtualHost>

<VirtualHost *:80>
    ServerName canada.cloud.com
    ProxyPass /client http://canada-ccp-ip/client
    ProxyPass /client/api http://cpbm-ip/portal/client/apis/canada
</VirtualHost>

Note: Here we have assumed that this proxy server is not load balancing the CPBM and
the CCP nodes. For load balancing CPBM and CCP servers, refer to the Setting up a Proxy
Server section of Installing and configuring CloudPortal Business Manager.

Region support configuration
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Service Controls

The CCP connector supports the following set of service controls at the tenant level:

The limits are set for each account type.

You can over-ride these limits for a particular account from the Accounts tab.
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Editing a CCP instance

1. Log in to CloudPortal Business Manager UI as Root user.

2. Click Home > All Services > Cloud Services. You will find the CCP service of the category
IaaS.

3. Click the gear wheel icon next to the instance and select Edit Configuration.

4. Edit the respective fields and click on Save.
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CCP Connector user roles

After enabling the CCP service, roles defined by the CCP service are mapped to the
appropriate CloudPortal Business Manager profiles. The CCP connector supports three kinds
of roles.

• CloudPlatform Administrator: This role is available to CloudPortal Business Manager
users in the Service Provider scope. This role has global admin privileges in CloudPortal
Business Manage. This is enabled by default for the Service Provider administrator. This
role has the ability to configure and manage the cloud infrastructure and manage all
resources through CloudPlatform console.

• CloudPlatform Domain Administrator: This role is available to CloudPortal Business
Manager users in the Customer scope. This role will have customer admin privileges in
CloudPortal Business Manager. This role is enabled by default for the Master User
profile. This role has the ability to create, read, update, and delete resources in a
tenant.

• CloudPlatform User: This role is available to CloudPortal Business Manager users in the
Customer scope. This role will have normal user privileges in CloudPortal Business
Manager. This is the default role for CloudPlatform user.
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Mapping of CPBM and CCP entities

CPBM entities:

• Channel: A channel usually represents a market segment or a geographic area
(depending on the segmentation done by the service provider).

• Account: An account typically represents a customer of the service provider and is the
basic unit of isolation. Accounts are grouped by channels (every account is tied to a
specific channel). Accounts can be of different types, the characteristics of each type
are decided by the service provider.

• Master user: Each account has a master user who can perform administrative operations
for users who belong to that account.

• User: Each account has one or more users.

CCP entities:

• Domain: Domains usually contain multiple accounts that have some logical relationship
to each other. Domain can have arbitrary levels of sub-domains.

• Account: An account typically represents a customer of the service provider. Accounts
are grouped by domains.

• For each account created, the Cloud installation creates three different types of user
accounts: root administrator, domain administrator, and user.

• User: Users are like aliases in the account.

• Domain Administrators: Domain administrators can perform administrative
operations for users who belong to that domain.

• Root Administrator: Root administrators have complete access to the system, including
managing templates, service offerings, customer care administrators, and domains.

Mapping of CPBM and CCP entities:

The mapping between CPBM and CCP entities is decided by the resource sharing mode. The
resource sharing mode is a setting that is specific to an account type and is set to either
True or False by the service provider. When set to true, the shared account mode is
enabled. This property is configured for an account type for a specific CCP instance by the
administrator by clicking Administration > Account Types > Selected Account Type >
Service Controls > CCP Service Instance > Edit. While the initial setting for an account
depends on account type, resource sharing mode can be changed for specific accounts by
editing the account.

Mapping between CPBM and CCP when resource sharing mode is set to True:

CloudPortal Business Manager entity maps to Citrix CloudPlatform entity

Channel Domain



Customer account Sub Domain

Master User

• Manages the customer account

• Can view VMs of all users in the customer
account

• Can create new users in the customer
account

Domain admin account

Users

• All resources of the customer account are
accessible

• Cannot create new users in the customer
account

Users in the master user Domain admin
account

When the resource sharing mode is set to true:

• For each account in CPBM, a sub domain is created in CCP - where every user is the
Domain Admin.

• Every user's usage gets accumulated at the tenant level.

• All the entitlements across all users are scoped to tenant level.

• Normal User can see resources launched by Master user as well, on resources tab.

• Unlimited entitlements are always scoped to subscription level.

Mapping between CPBM and CCP when resource sharing mode is set to False:

CloudPortal Business Manager entity maps to Citrix CloudPlatform entity

Channel Domain

Customer account Sub Domain

Users

• Each user gets his own VLAN network,
public IP and Virtual router

• Normal users can access their VMs only

Account

Master User

• Manages the customer account

• Can view VMs of all users in the customer
account

• Can create new users in the customer
account

Domain admin account

When Resource Sharing mode is set to false:

Mapping of CPBM and CCP entities
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• For each tenant in CPBM, a sub domain is created in CCP, where master user is the
Domain Admin.

• For each user, a user account is created in the sub domain of CCP.

• Entitlements and usages are scoped to user level. Hence, each user gets an invoice for
his usage charges.

• Normal User can view only the VMs launched by him.

• Unlimited entitlements are always scoped to subscription level.

Mapping of CPBM and CCP entities
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Product Onboarding

Products can be created in two ways:

• Basic products for CCP usage types are created, at the time of creation of service
instance, from the Default Product Selections page of the Add Service Instance wizard.
You can specify the name, code, category, and unit of the product.

• Advanced products are created from the Catalog tab, when you plan the next version.
The Add Product wizard is used to create advanced products.
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CCP Usage Types

The connector collects usage data for the following usage types so that they are billable in
CloudPortal Business Manager. Each Usage Type's generated usage unit can be converted to
other predefined scales in CloudPortal Business Manager which is provided by the CCP
connector. Each Usage Type can have multiple discriminators, and these are attributes
which are used to uniquely identify a usage data of a Usage Type.

Usage Type Generates usage
in

Description Predefined
Scales

Discriminators

Running VM Compute-Hours Running VM Compute-Days HA Enabled

Guest OS

ISO Image

Allocated VM Compute-Hours Allocated VM -
the VM can be in
any state

Compute-Days HA Enabled

Guest OS

ISO Image

Root Volume Byte-Hours Root volume in
primary storage

GB-Months

TB-Months

GB-Days

TB-Days

Pool Type

Volume Tag

Data Volume Byte-Hours Non-root volume
(i.e. data volume)
in primary storage

GB-Months

TB-Months

GB-Days

TB-Days

Pool Type

Volume Tag

Template
Storage

Byte-Hours Storage consumed
by user created
templates in
secondary storage

GB-Months

TB-Months

GB-Days

TB-Days

 

ISO Storage Byte-Hours Storage consumed
by user created
ISOs in secondary
storage

GB-Months

TB-Months

GB-Days

TB-Days

 



Volume
Snapshot
Storage

Byte-Hours Storage consumed
by user created
snapshots in
secondary storage

GB-Months

TB-Months

GB-Days

TB-Days

Pool Type

Disk offering

VM Snapshot
Storage

Byte-Hours Storage consumed
by user created
snapshots

GB-Months

TB-Months

GB-Days

TB-Days

Pool Type

Volume Tags

IP Address IP-Hours Acquired public IP
address

IP-Days

IP-Months

 

Network
Bytes
Received

Bytes Network bytes
received from
internet

GB, TB Redundant
Router
Service
Enabled

VLAN Enabled
Network Type

Network
Bytes Sent

Bytes Network bytes
sent to internet

GB, TB Redundant
Router
Service
Enabled

VLAN Enabled
Network Type

Security
Group

SecurityGroup-H
ours

Security group SecurityGroup-
Days SecurityGr
oup-Months

 

Load
Balancer
Policy

Policy-Hours Load balancer
policy

Policy-Days

Policy-Months

 

Port
Forwarding
Rule

Rule-Hours Port forwarding
rule

Rule-Days

Rule-Months

 

VPN Users Vpn-Hours VPN users Vpn-Days

Vpn-Months

 

CCP Usage Types
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CCP Resource Types

CCP has three Resource Types which can be provisioned, namely Compute, Storage, and
Networking. Each Resource Type can generate multiple Usage Types.

Each Resource Type can also specify multiple groups, which specify the multiple ways that
the Resource Type can be provisioned. Each group can contain multiple components which
are the requirements of that group which needs to be satisfied at the time of provisioning.

The Usage Types and Groups of Resource Types are as follows:

Resource Type Generated Usage Types Resource can be provisioned
using

Compute • Running VM

• Allocated VM

• Root Volume

• Template, ISO, and
Hypervisor

Storage • Data Volume • Disk Offering

Networking • Network Bytes Received

• Network Bytes Sent

• Network Offering

While creating a product bundle for a Resource Type, any usage that can be attributed to
that Resource Type can be given as unlimited entitlement in that bundle.

Entitlements are accounted either to usage accrued to a given subscription or in a
consolidated manner at the user level. Whether usage is accrued to a subscription or to the
user is dependent on the specific product being entitled and the specific type of the bundle
being subscribed to. For example, VM running time, can be accrued to a virtual machine,
but data transfer is usually not attributable to the virtual machine as it shares the network
on which the traffic is being generated and accounting for data transfer is done at the
router. So, when purchasing a virtual machine, data transfer entitlements in the associated
bundle will be added to the user's overall entitlements for data traffic, whereas when
purchasing a network, the data transfer on that network will be tied specifically to that
subscription.

In a Compute bundle, any products based on a combination of Running VM/Allocated VM
usage type or only Root Volume Usage type can be given as unlimited entitlement.

In a Storage bundle, any products based on Data Volume usage type only can be given as
unlimited entitlement.

For Networking bundle, any products based on combination of Network Bytes
Received/Network Bytes Sent usage type can be given as unlimited entitlement.

The following network offerings are the supported network offerings and are visible in the
UI:

• Network offering that has VPC enabled:



It must have the following:

• SourceNat service is present.

• Isolated network offering.

• Public LB service is present.
• Network offering that has VPC disabled (non-VPC network offering):

It must have the following:

• SourceNat service is present.

• Isolated network offering.

• Converse mode is true.

Note: For VPC network offerings with Public LB providers, only those VPCs, that are
currently not being used by a network offering with Public LB providers, are visible.

CCP Resource Types
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Sample CCP Products

You can create basic products from the Add Service Instance wizard.

Examples:

• To create a Stopped VM product, combine Allocated VM and exclude Running VM.

• To create a Network Bandwidth product, combine Network Bytes Sent and combine
Network Bytes Received.

• To create a ROOT VOLUME product, use Root Volume usage type.

The following are some typical products defined:

Product Unit Description Price

Small Instance per
Hour

Small running VM (1 CPU@500MHz,
512MB RAM)

Specified in active
currencies

Network Bytes
Received

per GB Data transfer from Internet Specified in active
currencies

IP Address per
Month

Public IP address Specified in active
currencies

Root Volume Per GB
per
Month

Storage used by root volume of
the VM

Specified in active
currencies

CentOS 5.6
Template

per
Hour

CentOS 5.6 template used by
running VMs

Specified in active
currencies

Product configuration for a sample product "Small Instance"

Small Instance    

Product Description:    

Name Small Instance  

Code CloudPlatformCloud_SMALL_INS
TANCE

 

Category Infrastructure: Compute  

Product Details:    

1. Usage Type Generates Usage in Units Aggregation Handling

Running VM Compute-Hours Combine

2. Mediation Rules    

Compute Offering INCLUDES Small Instance

3. Conversion Factor    



Generates Usage in
Units

Required Product Units Conversion Factor

Compute-Hours Compute-Hours 1

Product Charges    

EUR (€) US ($)  

0.0300 0.0400  

Sample CCP Products 
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Sample CCP Product Bundles

To create a Compute bundle (which can be used to launch only windows template), Choose
Template provisioning constraint and include all Windows templates.

Note: To a compute bundle, only products created using "Running VM", "Allocated VM",
and "Root Volume" usage type can be assigned unlimited entitilements.

The following are some typical product bundles defined:

Product Bundle Description One-time charge Recurring charge,
Unit

Small CentOS
Instance Bundle

Includes small
instance, CentOS
OS, 20GB root
volume

Specified in active
currencies

Specified in active
currencies, Month

20GB Data Volume Includes 20GB data
volume

Specified in active
currencies

Specified in active
currencies, Month

Silver Network
Package

Includes 10GB of
network bytes sent
and 10GB of
network bytes
received

Specified in active
currencies

Specified in active
currencies, Month

Standard Support Include a standard
support package for
the customer

nil Specified in active
currencies, Month

Product bundle configuration for a sample product bundle "Small CentOS Instance Bundle"

Small CentOS Instance    

Bundle Description:    

Name Small CentOS Instance  

Code CloudPlatformCloud_SmallCentOSIn
stance

 

Description This is a small CentOS instance (1
CPU@500MHz, 512MB RAM) charged
at monthly rate.

 

Bundle Details:    

Resource Type: Compute  

Allow Subscriptions: At any level; no limits on number
of subscriptions

 

Charge Frequency: Monthly  

Eligible for Trial: Yes  

Enable Notification: Yes  



Provisioning
Constraints:

   

Template INCLUDES CentOS 5.6 (64-bit) no
GUI

Compute Offering INCLUDES Small Instance

Hypervisor INCLUDES XenServer

Bundle Charges:    

Charges EUR (€) US ($)

One-time 4.0000 5.0000

Recurring 20.0000 26.0000

Entitlements:    

Small Instance Unlimited Compute-Hours  

CentOS 5.6 Template Unlimited Compute-Hours  

Root Volume 20 GB-Months  

Sample CCP Product Bundles
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CCP Resource Provisioning

The CCP connector has three Resource Types, which are Compute, Storage and
Networking. These resources can be provisioned by subscribing to the corresponding
bundle.

A Resource Type can be provisioned by satisfying one of the groups.

A Compute resource type can be provisioned by specifying a Template and a Compute
Offering or by specifying an ISO and a Compute Offering.

A Storage resource type can be provisioned by specifying a Disk Offering.

A Networking resource type can be provisioned by specifying a Network Offering.

Compute and Networking Resource Types can also be provisioned using the manage
resource UI, which are charged as a utility subscription in CloudPortal Business Manager.

To Provision a Compute Resource Type using a Template and Compute Offering:

1. Log in to CloudPortal Business Manager UI as a normal user.

2. Click Catalog.

3. Select the Compute resource type from the selection box and use the Compute Offering
drop down list to choose the desired Compute Offering.

4. Use the Template/ISO drop down list to filter/select the desired Template.

The product bundles will be filtered based on the selection.

5. Fill in the details (optional): For the compute resource, select a Disk offering(optional),
a network using which the compute resource will be provisioned and a SSH key
(optional).

6. After providing all the required information, accept the terms and conditions by
checking in the corresponding checkbox and click on subscribe and provision button to
provision the compute resource.
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Async Job

The Citrix CloudPlatform Connector Async job, is an asynchronous scheduled job which polls
on CloudPlatform's async jobs list for resource provisioning and reset password requests and
sends out different emails in case of their success or failure.

In case of a resource provisioning, if it is a success then it sends out an email to the user
that the resource has been provisioned successfully and it also sends out the password in
case of compute resource if it is provisioned using a password enabled template. If the
provisioning fails, then it sends out an email reporting the same.

If there is a reset password for VM request, then it sends out the new password to the
requestor and to the owner of the VM, if they are not same.
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Managing resources

This section describes the CCP resources available through CloudPortal Business Manager. It
also gives you a list of activities that can be performed in the CloudPortal Business Manager
UI. The CPBM UI also displays the status of the resource which maps to the state of the CCP
resource (each CCP resource has its states).

Instances

Volumes

Snapshots

IP Addresses

Networks

Templates

ISOs

VPCs

VPN Connector Gateways

http://support.citrix.com/proddocs/topic/cpbm-23-map/cpbm-instances-23-con.html#ccpb-instances
http://support.citrix.com/proddocs/topic/cpbm-23-map/cpbm-networks-22.html#ccpb-networks
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Instances

An instance is another term used for a virtual machine. Virtual machines are software
implementations of physical computers, and can execute computer programs. You can
power on, power off, or suspend a virtual machine just like you would a physical computer.

VM Details tab
Display Name: A unique name given to your VM by your service provider.

Group: The group to which the VM belongs. This is set when the VM is created.

Zone: A unique zone in which your VM is placed.

Template: The template from which your VM was created.

Compute Details: Details about the compute resources. CPU, RAM, and so on.

Account: The account this VM was created in.

Domain: The domain in which this VM resides.

Created: The date on which this VM was created.

HA enabled: HA stand for High Availability. If this is enabled for the selected VM, the
downtime for the VM is minimal.

Attached ISO: If the value is Yes, it means that the VM container has an attached ISO.

Filter Instances
The Filter menu shows a list by which you can order your VMs:

• All Instances: Select this menu option to view all your VMs regardless of their state.

• My Instances: VMs that you created.

• Running Instances: The VMs that are currently running (powered on).

• Stopped Instances: The VMs that are currently stopped (powered off, but available to
be powered on again).

• Destroyed Instances: The VMs that are destroyed (no longer available).



Tasks performed
Move your cursor over the gear wheel icon. You see a list of actions that you can perform
for the selected VM.

Edit VM: Click this option and change the Display Name. You can also change the Group to
which this VM belongs.

Reboot VM: Click this option to reboot the selected VM.

Start VM: Click this option to start (power on) the selected VM. Only VMs in stopped state
can be started.

Stop VM: Click this option to stop the selected VM. Only VMs that are running can be
stopped.

Restore VM: Click this option to restore the VM to its original template.

Destroy VM: Click this option if you want to remove the VM completely. You cannot destroy
a VM that is running.

Note: The system provides an option to terminate the associated subscription. If you
choose to terminate the subscription as well then the subscription will be in the expired
state else it will be Active(Unused).

Note: Recover VM: You have an option to recover the destroyed VM. On recovery of the
VM, if you have terminated the associated subscription, a utility subscription gets created
for this resource only in the next billing period. This is because the entitlement is
available for the resource in the current billing period.

Reset Password: Click this option to reset the password for this VM. The VM must be
password enabled for you to be able to reset the password.

Attach/Detach ISO: An ISO image is an exact copy of an existing file system. You can attach
an ISO to your VM with this option. Attached ISOs can be detached. The ISO that you select
must be compatible with the VM hypervisor for the ISO to be attached successfully. Click
the option to attach or detach an ISO.

Scale up VM: Click this option to modify the level of compute resources available to a VM.
You can change the service offering without stopping the VM. Scale down CPU and/or RAM
are currently not supported.

Note: This option is not available from CPBM 2.2.1 onwards. You must use the 'Change
Service' option.

Change service: This option is seen only for stopped VMs. Change service is always
performed on stopped VM. Both scale up and scale down CPU and/or RAM can be
performed.

Note:

• This option is available for running VMs from CPBM 2.2.1 onwards.

• When the Scale up VM and Change service operations are performed, if you select the
service offering compatible with same bundle, then the subscription remains same. But
if service offering is not compatible with same bundle, then this subscription moves to

Instances
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active (unused) state and a new utility subscription is created.

• The 'Change Service' wizard lists the compute offerings that are compatible and
incompatible to the current bundle separately.

Reset SSH Key: Click this option to reset the SSH Key for the selected VM.

Add Network to VM: This task is supported from CPBM 2.2.1 onwards. Click this option to
add any additional networks to the VM. This option is shown for running and stopped VMs.

Note: This option is not available for running Hyper-V VMs.

Take VM Snapshot: This task is supported from CPBM 2.2.1 onwards. Click this option to
take snapshot of the entire VM, including its volumes, memory, and CPU state.

Note: This option is not available for Hyper-V VMs.

Volumes tab

Click the Volumes tab to view details of the volumes attached with the instance that is
selected. In addition to viewing the details, you can also take snapshots by clicking the
Take Snapshot option in the gear wheel menu. Click the View Snapshots option to view all
the snapshots. This action will take you the Snapshots page.

NICs tab

Click the NICs tab to view details of the Network Interface Cards associated with the
selected instance. The details shown are IP, Gateway, Netmask, Type (isolated or shared
network), Network ID (system generated), and Network Name (that you provide).

Snapshots tab

Click the Snapshots tab to view details of the VM snapshots attached with the selected
instance. In addition to viewing the details, you can revert the selected instance to the
desired VM snapshot by clicking the Revert Snapshot option in the gear wheel menu. You
can delete the selected VM snapshot by clicking the Delete Snapshot option in the gear
wheel menu. Click the View Details option to view all the details of the selected snapshots.
This action will take you the Snapshots page.

Subscriptions tab

Click the Subscriptions tab to view the details of the subscription associated with the VM.
The ID is the UUID of the subscription. The 'View Details' link displays the included
entitlements. The name of the subscription links to the subscription in the Subscriptions
page.
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Filtering Instances/VMs

Users can view their instances/VMs and filter them by VM name or IP address, Zone, and
state of the VMs.

1. Log in to CloudPortal Business Manager UI as a user.

2. Click My Services and select the CCP service instance.

3. Click Manage Resources.

4. In the Instances tab, specify the VM name or IP address. You can also specify the zone
to filter the VMs. You can also filter the VMs by All instances, My instances, Running
instances, Stopped instances, and Destroyed instances.

5. Click Go!

6. View the instances/VMs based on your filter criteria.
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Accessing the VM Console

Any user can access their own VMs and perform actions on the VMs.

1. Log in to CloudPortal Business Manager as user.

2. Click My Services.

3. Select the cloud service and the service instance.

4. Click Instances and select the VM that you want to access.

5. Click View Console.
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Resource properties for provisioning VM

The properties used to provision a VM are described in detail in the table below. For
provisioning VM, following resource properties are needed.

Resource Property Name Description Required/Optional

displayName User generated name for the virtual
machine

Optional

group Group for the virtual machine Optional

diskOfferingUuid The ID of the disk offering for the
virtual machine. If the template is of
ISO format, the diskOfferingId is for
the root disk volume. Else, this
parameter is used to indicate the
offering for the data disk volume. If
the templateId parameter passed is
from a Template object, the
diskOfferingId refers to a DATA Disk
Volume created. If the templateId
parameter passed is from an ISO
object, the diskOfferingId refers to a
ROOT Disk Volume created.

Optional

keypair Name of the ssh key pair used to login
to the virtual machine

Optional

diskSize The size for the DATADISK volume. Optional

keyboard Keyboard device type for the virtual
machine. Valid value can be one of de
,de-ch,es,fi,fr,fr-be,fr-ch,is,it,jp,nl-b
e,no,pt,uk,us

Optional

networkIds List of network ids used by virtual
machine. Cannot be specified with
ipToNetworkList parameter

Optional

securitygroupIds List of security groups id seperated by
comma that are going to be applied to
the virtual machine. Should be passed
only when vm is created from a zone
with Basic Network support.

Optional

userData Binary data that can be sent to the
virtual machine upon a successful
deployment. This binary data must be
base64 encoded before adding it to
the request. Currently only HTTP GET
is supported. Using HTTP GET (via
querystring), you can send up to 2KB
of data after base64 encoding.

Optional



serviceOfferingUuid The ID of the service offering for the
virtual machine

Required

templateUuid The template ID for the virtual
machine

Required

isoUuid The ID of the ISO attached to the
virtual machine

Required

hypervisorType The hypervisor on which to deploy the
virtual machine

Required

Resource properties for provisioning VM
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VM Snapshots

The VM snapshot features are supported from Citrix CloudPlatform 4.2.0 onwards. You can
now take a VM snapshot of the entire VM, including its volumes, memory, and CPU state.
VM snapshots reside on primary storage. VM snapshots can have a parent/child relationship.
Each VM snapshot can have one (or zero) parent snapshot. The succeeding snapshot of the
same VM is the child of the current snapshot. A current snapshot refers to the most recent
snapshot compared to the current state of the VM. There are two types of snapshots:

• Disk - This takes snapshot of all disks of specified VM

• Disk and Memory - This takes CPU/memory snapshot in addition to disks snapshot

Note:

• The Hyper-V VM does not support the VM snapshot feature.

• You cannot attach additional volume to a VM that has snapshots.

• Data disk associated with VM that has snapshots cannot be removed.

• When you destroy a VM, all snapshots are deleted.

Perform the following steps to create and manage a VM Snapshot.

To create a VM Snapshot

1. Log in to CloudPortal Business Manager as a user.

2. Click My Services.

3. Either click the cloud service instance tab or click the Manage Resources link of the
desired service instance.

4. In the Instances tab, specify the VM for which you want to create a snapshot.
Alternatively, you can select the required VM from the left pane.

5. Place the cursor over the manage icon (that looks like a gear wheel), and click Take VM
Snapshot. In the Take VM Snapshot wizard that appears:

a. Specify the name and description of the VM snapshot. These fields are optional.

b. Check the Snapshot Memory checkbox, if you want to take 'disk and memory'
snapshot.

Note:

• When the Snapshot Memory checkbox is unchecked, the VM snapshot taken is a
'disk' snapshot.

• When the state of VM is:



• Running: Both 'disk and memory' and 'disk' snapshots can be taken.

• Stopped: Only 'disk' snapshots can be taken.

c. Select the I agree to the Terms and Conditions check box.

d. Click OK.

The snapshot is created and labelled as 'Current'. The Snapshots tab in the details pane
displays the list of all the snapshots.

To revert a VM to a Snapshot

1. Log in to CloudPortal Business Manager as a user.

2. Click My Services.

3. Either click the cloud service instance tab or click the Manage Resources link of the
desired service instance.

4. In the Instances tab, select the required VM on the left pane.

5. Go to the Snapshots tab in the details pane.

6. Select the snapshot that you want the VM to revert to.

7. Click the icon (that appears as a gear wheel).

8. Click Revert VM to Snapshot.

Note:

• The snapshot must be in 'Ready' state.

• The snapshot to which a VM is reverted becomes the current snapshot.

• On reverting a VM snapshot of 'disk and memory' type, the VM will be in the 'Running'
state.

• On reverting a VM snapshot of 'disk' type, the VM will be in the 'Stopped' state.

To delete a VM Snapshot

1. Log in to CloudPortal Business Manager as a user.

2. Click My Services.

3. Either click the cloud service instance tab or click the Manage Resources link of the
desired service instance.

4. In the Instances tab, select the required VM on the left pane.

5. Go to the Snapshots tab in the details pane.

6. Select the snapshot that you want to delete.
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7. Click the icon (that appears as a gear wheel).

8. Click Delete VM Snapshot.

Note: If a current snapshot having a parent is deleted, then the parent snapshot becomes
the current snapshot.

To view details of a VM Snapshot

1. Log in to CloudPortal Business Manager as a user.

2. Click My Services.

3. Either click the cloud service instance tab or click the Manage Resources link of the
desired service instance.

4. In the Instances tab, select the required VM on the left pane.

5. Go to the Snapshots tab in the details pane.

6. Click the icon (that appears as a gear wheel).

7. Click View Details.

8. The page navigates to the Snapshots tab for the selected CCP instance.
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Add/Remove networks to a VM

You can add, update, or remove a Network Interface Card (NIC) on a VM from Citrix
CloudPlatform 4.1.0 onwards. This feature supports the following:

• Adding a NIC on a VM Instance

• Update the default NIC on a VM Instance

• Remove a NIC from a VM Instance

As a user, you can add or remove networks to a VM that belongs to you. Network must be
created to add a NIC to a VM. You cannot perform any actions for current default network
of the VM. You have the option to update the default NIC. The default NIC will be labelled
as 'Default'. You can remove a NIC added to a VM, if it is not the default.

Note:

• Add, Delete, and Update are not supported for Hyper-V VMs in running state

• When resource shared mode is set to false:

• The networks created by the current user will be listed in the Add Network to VM
wizard.

• Root and Master users cannot add or remove NIC to/from any other user's VM.

• Root user can add NIC to the VM launched by the Master user.
Perform the following steps to add and manage a NIC on a VM.

To add a NIC on a VM Instance

1. Log in to CloudPortal Business Manager as a user.

2. Click My Services.

3. Either click the cloud service instance tab or click the Manage Resources link of the
desired service instance.

4. In the Instances tab, specify the VM for which you want to add a network. Alternatively,
you can select the required VM from the left pane.

5. Place the cursor over the manage icon (that looks like a gear wheel), and click Add
Network to VM. In the Add Network to VM wizard that appears:

a. Select the required network from the Select Network drop-down list.

Note: Only those networks that are created in the same zone as that of the VM
are listed.

b. Select the I agree to the Terms and Conditions check box.



c. Click OK.

The NICs tab in the details pane displays the list of all the NICs added to the specific VM.

To update the default NIC on a VM Instance

1. Log in to CloudPortal Business Manager as a user.

2. Click My Services.

3. Either click the cloud service instance tab or click the Manage Resources link of the
desired service instance.

4. In the Instances tab, select the required VM from the left pane.

5. Go to the NICs tab in the details pane.

6. Select the desired NIC.

7. Click the icon (that appears as a gear wheel).

8. Click Set default NIC.

Note: Master user can set a NIC as default for any of his users.

To delete a NIC from a VM Instance

1. Log in to CloudPortal Business Manager as a user.

2. Click My Services.

3. Either click the cloud service instance tab or click the Manage Resources link of the
desired service instance.

4. In the Instances tab, select the required VM from the left pane.

5. Go to the NICs tab in the details pane.

6. Select the NIC that you want to delete.

7. Click the icon (that appears as a gear wheel).

8. Click Remove NIC.
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Changing Service

Users can change compute offering of the Virtual Machine. A compute offering is a set of
virtual hardware features such as CPU core count, speed, and memory. To upgrade or
downgrade the level of compute resources available to a virtual machine, you can change
the VM's compute offering using the 'Change Service' wizard.

Note: Change service action on a running VM is supported from CCP 4.2 onwards. You can
use this feature when the enable.dynamic.scale.vm setting is enabled on CCP.

• Hyper-V does not support the change service feature for running VM.

• You can scale up the compute offering for both running VM and stopped VM, but you
can scale down the compute offering only for stopped VM.

• The 'Change Service' wizard lists the compute offerings under the following two sections
separately:

1. Compatible with your existing subscription: Offerings listed under this section are
included in the VM's product bundle. Changing to any of these offerings will not
detach VM from its subscription and the user will continue to get bundle
entitlements, if any.

2. Incompatible with your existing subscription: Offerings listed under this section are
not supported by VM's product bundle. Changing to any of these offerings will
detach the VM from its subscriptions (on run of billing for that day). In this case,
the original subscription will become active (unused) and any further usage for this
VM will be charged on utility basis.

Perform the following steps to change service for a VM.

To change service for a VM Instance

1. Log in to CloudPortal Business Manager as a user.

2. Click My Services.

3. Either click the cloud service instance tab or click the Manage Resources link of the
desired service instance.

4. In the Instances tab, specify the VM for which you want to change service.
Alternatively, you can select the required VM from the left pane.

5. Place the cursor over the manage icon (that looks like a gear wheel), and click Change
Service. In the Change Service wizard that appears:

a. Select the required value from the Compute offering drop-down list.

Note: The values in the drop-down list are as follows:

• If the compute offering of the specific VM is of 'local' type then the list displays
all the compute offerings of 'local' type.



• For a running VM, the list displays the compute offerings with greater
configuration than the current compute offering.

• For a stopped VM, the list displays all the compatible compute offerings.

b. Select the I agree to the Terms and Conditions check box.

c. Click OK.

The Details tab in the details pane displays the new configuration for the specific VM.
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Volumes

Just like a physical computer has storage, a virtual machine also has a storage volume
associated with it. This is called the Root volume. You can choose to have additional
storage as well. In the Volumes section you can view the details of your VM volumes, attach
to, and detach volumes from your VMs, create volume templates and perform other tasks
related to storage volumes.

Details Pane
A red circle next to a volume indicates that the volume is allocated, but not ready yet. A
green circle indicates that the volume is ready to be attached, detached, downloaded and
so on. as is applicable to that volume.

To view the details of a volume, select it from the list of volumes in the left pane.

ID: The unique identification code assigned by your service provider.

Type: The volume type. Root volume, Data volume

Zone: The CloudStack zone in which this volume resides.

Device ID: A unique system generated identifier for this volume.

Size: The storage space in GB. For example, 8 GB.

Created: The date and time the volume was created.

Account: The user who created this volume.

Domain: The domain assigned by your service provider.

Managing volumes
The following section describes the menu items of the gear wheel icon. The menu shows
the actions that you can perform. The menu items change depending on the Type (Root,
Data etc.) and State (attached, detached) of the volume. For example, you cannot attach a
volume that is already attached to a VM. In such a case, only the Detach Volume is available
for that volume.

Select a volume. Move your cursor over the gear wheel icon. You see a list of actions that
you can perform for the selected volume:

Taking a Snapshot: In general, a snapshot is the representation of a storage volume at a
point in time. You can take a snapshot, revert to it later, and create volumes and templates
from existing snapshots. Click Take Snapshot and accept the terms and conditions. Click
Confirm.



Note: The 'Take Snapshot' option for a volume is not supported for the 'Hyper-V'
hypervisor.

Scheduling Snapshots: You can schedule the system to take snapshots at regular intervals.
For example, you can schedule the snapshots of the volume to be taken at six hour
intervals. If you enter ten in the Keep field, only the ten most recent snapshots will be
retained, and the earlier ones discarded. Depending on the time intervals at which you
specify the snapshots to be taken, the system sets an upper limit on the Keep field. For
example, if you choose hourly snapshots to be taken, the Keep field takes a maximum value
of eight. Click Recurring Snapshots and specify the details of the schedule. Accept the
terms and conditions and click Apply.

Note: The 'Recurring Snapshots' option for a volume is not supported for the 'Hyper-V'
hypervisor.

Subscriptions tab

Click the Subscriptions tab to view the details of the subscription associated with the
volume. The ID is the UUID of the subscription. The 'View Details' link displays the included
entitlements. The name of the subscription links to the subscription in the Subscriptions
page.

Attaching a volume: You can select a data volume and attach it to a VM. Click Attach
Volume and specify the details. Accept the terms and conditions and click OK.

Downloading Volume: You can select a data volume and download it. Click Download
Volume. Accept the terms and conditions and click OK.

Creating a Template: Click Create Template and specify the details for the template that
you want to create from the volume. Accept the terms and conditions and click OK.

Deleting a volume: Click Delete Volume. Click Confirm.

Note: The system provides an option to terminate the associated subscription. If you
choose to terminate the subscription as well then the subscription will be in the expired
state else it will be Active(Unused).

Adding a volume
To add a volume, follow these steps:

1. Log in to CloudPortal Business Manager as user.

2. Click My Services.

3. Select the cloud service and the service instance.

4. Click Manage Resources.

5. Click Volumes and then click Add New.

6. Specify the details for the new volume.

7. Select the checkbox to accept the terms and conditions and click OK.
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Resizing a volume
You can resize data disks. Depending on your need for data space, you can resize a data
volume. Volumes within the disk offerings with the same storage tag can be resized. You
can move a data volume from a static disk offering to a custom disk offering and specify the
size.

Considerations before resizing a volume:

• Volume should not be a root volume.

• The VMs associated with the volume are stopped or the volume itself should be
detached.

• When a volume is shrunk, the disk associated with it is simply truncated, and doing so
would put its content at risk of data loss. Therefore, resize any partitions or file
systems before you shrink a data disk so that all the data is moved off from that disk.

Note: Resizing volume for a data volume is not supported for the 'Hyper-V' hypervisor.

1. Log in to CloudPortal Business Manager as a user.

2. Click My Services.

3. Select the cloud service and the service instance.

4. Click Manage Resources.

5. Click Volumes.

6. Select the volume that you want to resize.

7. Move your cursor over the gear wheel icon and click Resize Volume.

8. Select the disk offering of the desired characteristic (size).

• If you reduce the size of the volume, select the check box to confirm your action.

• If you select the custom option, specify the custom size.
9. Select the check box to accept the terms and conditions and click OK.

Note: The 'Resize Volume' wizard lists the disk offerings that are compatible and
incompatible to the current bundle separately.
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Snapshots

In general, a snapshot is the representation (read-only copy) of a storage volume or a VM at
a point in time.

The snapshots that you take in the Volumes and Instances sections appear in the left pane.
You can filter the snapshots by Volumes and Virtual machines.

Note: VM Snapshots are applicable from CCP 4.2 onwards.

Volume Snapshots:

The Details Pane: To view the details of a snapshot, select it in the left pane.

ID: A unique ID assigned by your service provider.

Name: A name assigned by your service provider, with the date and time of creation of the
snapshot at the end.

Volume: The volume from which this snapshot was made.

State: Backed Up, In Progress, and so on.

Interval Type: This shows if the snapshot is a recurring snapshot.

Created: When this snapshot was created (time and date).

Account: The user who created this snapshot.

Domain: The domain assigned to this snapshot by your service provider.

The Gear Wheel Menu

In the snapshots tab, filter by volume, then select a snapshot and move your cursor over
the gear wheel icon to see the actions that you can perform. You can create a volume or a
template or both from this snapshot. You can also delete this snapshot.

Create Volume: Enter a unique name in the Name field. Select the check box to agree with
the terms and conditions, and click OK.

Note: The volume that you create here appears in the list of volumes in the Volumes
page.

Create Template: You can create a template from an existing snapshot. You can launch
virtual machines based on this template.

Name: A unique name.

Display Text: A descriptive text.

OS Type: The Operating System type (CentOS, Debian, Fedora etc.)



Public: If you set this to Yes, other users will be able to view and use this template. If you
set this value to No, only you can use this template.

Password Enabled: If you want this template to be password protected, set this to Yes.

Note: The templates that you create here appear in the Templates tab.

Virtual Machine Snapshots:

The Details Pane: To view the details of a snapshot, select it in the left pane.

ID: A unique ID assigned by your service provider.

Name: A name assigned by your service provider, with the date and time of creation of the
snapshot at the end.

Description: Description for the snapshot.

Parent Name: Name of the parent snapshot.

Current: Whether the snapshot is current or not.

Type: Either disk or disk and memory

Virtual Machine: The Virtual Machine that the snapshot belongs to.

State: State of the snapshot.

Created: When this snapshot was created (time and date).

The Gear Wheel Menu:

In the snapshots tab, filter by virtual machine, then select a snapshot and move your cursor
over the gear wheel icon to see the actions that you can perform. You can revert VM to this
snapshot. You can also delete this snapshot.

Revert VM to snapshot: Confirm your action by clicking Confirm.

Delete snapshot: Confirm your action by clicking Confirm.
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IP Addresses

To view information about your IP address allocations, click the IP Addresses tab. You see a
list of the public IP addresses allocated to your account.

Your virtual machines reside behind a virtual router. Subsequently this IP address could be
that of your virtual router, and not of a particular virtual machine (which in turn could have
a private IP address). You can see the following information in the Details section.

• ID: The unique ID for this IP address, assigned by your service provider.

• Account: The account to which the IP is assigned.

• Zone: The zone in which this IP address resides.

• VLAN: Information about the virtual local area network.

• Source NAT: Whether Network Address Translation is enabled on this virtual router.

• Network ID: The unique ID provided by your service provider.

• Associated Network ID: Associated network ID provided.

• Domain: The domain associated with the account.

• Allocated: The date and time at which this IP address was allocated.

• Static NAT: Is the NAT static or dynamic? (Request an additional IP address for your
virtual router if static NAT is Yes.)

Acquiring an IP address

To acquire a new IP address, click Acquire IP. Specify if it is for a VPC or network, select
the network or VPC, select the check box for terms and conditions, and click Confirm.

Firewall

Firewall rules defined. You can add more firewall rules.

Port Forwarding

Public Port: The port range that you would like to use.

Private Port: The corresponding private port range.

Protocol: The network protocol applicable. TCP, UDP, and so on.

Virtual Machine: The vitual machine to which to forward the port range.

Load Balancer



Name: A name for this Load Balancer rule.

Public Port: The externally accessible port that you would like to balance.

Private Port: The corresponding private port on a VM.

Algorithm: The process by which this balance will occur. Choose from the drop-down
options.

VPN

If your VPN is already enabled, you see the message below telling you so.

Tasks performed:

Select the IP address. Move your cursor over the gear wheel icon. You see a list of actions
that you can perform for the selected IP address.

Enabling or Disabling Static NAT: A static NAT rule maps a public IP address to the private
IP address of a VM to allow Internet traffic to it. You can enable or disable static NAT for a
particular IP address in a VPC. Click Enable Static NAT. Select the network and the VM and
click OK. To disable Static NAT, click Disable Static NAT and then, click Confirm.

Releasing an IP: If you no longer need a particular IP, you can disassociate it from its VPC
and return it to the pool of available addresses. Click Release IP and then, click Confirm.
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Networks

In the Networks tab, you see a list of networks offered by your service provider.

In the Details pane, you see the following details:

Network: The name of the network.

Zone: The zone in which this network resides; determined by your service provider.

ID: ID of the network.

Name: A descriptive name to help you identify the network

Type: If it a shared or isolated network.

VLAN: Information about the virtual local area network.

Gateway: Gateway used.

Netmask: Net mask in use on the subnet.

Network Domain: Domain where the network is available.

Domain: Domain to which the account belongs.

Account: User account.

Subscriptions tab

Click the Subscriptions tab to view the details of the subscription associated with the
network. The ID is the UUID of the subscription. The 'View Details' link displays the included
entitlements. The name of the subscription links to the subscription in the Subscriptions
page.

Adding a network
Network offerings:

The following network offerings are the supported network offerings and are visible in the
UI:

• Network offering that has VPC enabled:

It must have the following:

• SourceNat service is present.

• Isolated network offering.
• Network offering that has VPC disabled (non-VPC network offering):



It must have the following:

• SourceNat service is present.

• Isolated network offering.

• Converse mode is true.
To add a new network, follow these steps:

1. Log in to CloudPortal Business Manager UI as a user.

2. Click My Services and select the CCP service instance.

3. Click Manage Resources.

4. In the Networks tab, click Add New.

5. Specify the following (some details are optional):

• Network name: Name for the network

• Network Desc: Description of the network

• Zone: Zone to which the network will be added

• Network Offering: Network offering to use for the network

• Gateway: Gateway to be used

• Netmask: The netmask in use on the subnet

• Network Domain: Domain where the network will be available
6. Select the check box to accept the terms and conditions and click OK.

Note: For VPC network offerings with Public LB providers, only those VPCs, that are
currently not being used by a network offering with public LB providers, are visible.

Editing a network
To edit a network, follow these steps:

1. Log in to CloudPortal Business Manager UI as a user.

2. Click My Services and select the CCP service instance.

3. Click Manage Resources.

4. In the Networks tab, select the network that you want to edit.

5. Place the cursor over the manage icon (that looks like a gear wheel), and click Edit
Network or click the Edit Network icon.

6. Make the changes as required.
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7. Click OK.

Deleting a network
To delete a network, follow these steps:

1. Log in to CloudPortal Business Manager UI as a user.

2. Click My Services and select the CCP service instance.

3. Click Manage Resources.

4. In the Networks tab, select the network that you want to delete.

Note: The system provides an option to terminate the associated subscription. If you
choose to terminate the subscription as well then the subscription will be in the
expired state else it will be Active(Unused).

5. Click Confirm.

Filtering networks
Users can view their networks and filter them by VPC and non-VPC network types.

To filter networks, follow these steps:

1. Log in to CloudPortal Business Manager UI as a user.

2. Click My Services and select the CCP service instance.

3. Click Manage Resources.

4. In the Networks tab, specify your filter criteria: non-VPC networks ot VPCs.

Networks
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Templates

A template is a reusable configuration for virtual machines. When users launch VMs, they
can choose from a list of templates. A template is a virtual disk image that includes an OS
type and is associated with a hypervisor type.

Template details:

Name: Name of the template

Hypervisor: Hypervisor of the template

State: Description of the template

ID: Template ID

Zone ID: ID of the zone where the template is available

Display Text: Description of the template

Type: Type of template, whether public or private

OS Type: OS type of the template

Password Enabled: Whether the template has password change script installed

Public: Whether the template is accessible to all users of the service

Account: Account to which the template belongs

Domain: Domain to which the template belongs

Created: Timestamp when the template was created



Adding a Template
1. Click Add New.

2. Specify the following:

• Name: Name for the template

• Display Text: Description of the template

• URL: The URL that hosts the image

• Zone: Zone where the template will be available

• OS Type: Select the OS type of the image

• Hypervisor: Hypervisor type

• Format: Image format

• Password Enabled: Specify yes for password reset feature that allows users to set a
temporary admin or root password as well as reset the existing admin or root
password.

3. Select the check box to accept the terms and conditions and click OK.
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ISOs

An ISO is a read-only file that has an ISO/CD-ROM style file system. Users can upload their
own ISOs and mount them on their guest VMs. ISOs are uploaded based on a URL. ISOs may
be public or private, like templates. ISOs are not hypervisor specific.

Details
Name: Name of the ISO

ID: ID of the ISO

State: State of the ISO

Zone: Zone where the ISO is available

Zone ID: ID of the zone where the ISO is available

Display Text: Description of the ISO

Size: Size of the ISO in GB

Bootable: Whether or not a guest could boot off this ISO image

Public: Yes, if the ISO is available to other users

Featured: If the ISO is made more prominent for users to select

Cross Zones: If the ISO is available across zones

OS Type: OS of the ISO

Account: User who has created the ISO

Domain: Domain to which the ISO belongs

Created: Timestamp of creation of the ISO



Adding an ISO
1. Click Add New.

2. Specify the following:

• Name: Name for the ISO image

• Display Text: Description of the ISO

• URL: The URL that hosts the image

• Zone: Zone where the ISO will be available

• Bootable: Whether or not a guest could boot off this ISO image

• OS Type: Type of the OS
3. Select the checkbox to agree to the terms and conditions and click OK.

ISOs
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VPCs

The Virtual Private Cloud (VPC) is a private, isolated part of Citrix CloudPlatform. A VPC
can have its own virtual network topology that resembles a traditional physical network.
You can launch VMs in the virtual network that can have private addresses in the range of
your choice. You can define network tiers within your VPC network range, which in turn
enables you to group similar kinds of instances based on IP address range.

A VPC comprises the following network components:

• VPC: A VPC acts as a container for multiple isolated networks that can communicate
with each other via its virtual router.

• Network Tiers: Each tier acts as an isolated network with its own VLANs and CIDR list,
where you can place groups of resources, such as VMs.

• Public Gateway: The traffic to and from the Internet routed to the VPC through the
public gateway.

• Private Gateway: All the traffic to and from a private network routed to the VPC
through the private gateway.

• VPN Gateway: The VPC side of a VPN connection.

• Site-to-Site VPN Connection: A hardware-based VPN connection between your VPC and
your datacenter, home network, or co-location facility.

• Customer Gateway: The customer side of a VPN Connection.

In the VPC tab, you can see the list of VPCs. In the Details pane, you see the following
details:

VPC: Name of the VPC.

CIDR: CIDR range for all the tiers within the VPC.

Zone: Zone where the VPC is available.

Tiers tab: Details of the tiers within the VPC.

Instances tab: Details of the instances deployed to the tiers, filtered by tiers.

IP Address tab: IP addresses associated with the VPC.

VPN Connections tab: List of VPN connections between the VPC and VPN Customer
Gateways.

Private Gateways tab: List of private gateways added to the VPC (Private gateways are
added by the root administrator and this information is read only).



Adding a VPC
To add a VPC, follow these steps:

1. Log in to CloudPortal Business Manager as user.

2. Click My Services.

3. Select the cloud service and the service instance.

4. Click Manage Resources.

5. Click VPCs and then click Add VPC.

6. Specify the following:

• VPC Name: A name for the VPC that you are creating.

• Description: A brief description of the VPC.

• Zone: Choose the zone where you want the VPC to be available

• CIDR: Define the CIDR range for all the tiers (guest networks) within the VPC.

• Network Domain: DNS suffix, if you want to assign a special domain name.
7. Select the check box to accept the terms and conditions and click OK.

Note: The zone drop-down list does not display the name of the zone on which Hyper-V
hypervisor is present.

Managing VPCs
The following section describes the menu items of the gear wheel icon. The menu shows
four actions that you can perform. Select a VPC. Move your cursor over the gear wheel icon.
You see a list of actions that you can perform for the selected VPC.

Editing a VPC: Click Edit VPC to modify the name and description of the VPC.

Deleting a VPC: Click Delete VPC and confirm to delete a VPC.

Restarting a VPC: Click Restart VPC to restart the VPC.

Adding a Tier: Tiers are distinct locations within a VPC that act as isolated networks, which
do not have access to other tiers by default. Tiers are set up on different VLANs that can
communicate with each other by using a virtual router. Tiers provide inexpensive, low
latency network connectivity to other tiers within the VPC.

1. Click Add a Tier.

2. Specify the following details:

• Network name: Name for the network

 VPCs
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• Network Desc: Description of the network

• Zone: Zone to which the network will be added

• Network Offering: Network offering to use for the network

• Gateway: Gateway to be used

• Netmask: The netmask in use on the subnet

• Network Domain: Domain where the network will be available

3. Select the check box to accept the terms and conditions and click OK.

Acquiring an IP: When you acquire an IP address, all IP addresses are allocated to VPC, not
to the guest networks within the VPC. Click Acquire IP and select the check box to accept
the terms and conditions. Click Confirm.

Adding a VPN Connection:

A VPN connection helps you establish a secure connection from an enterprise datacenter to
the cloud infrastructure.

To set up a site-to-site VPN connection, you have to first create the VPC, a VPN Customer
Gateway, and a VPN connection from the VPC VPN gateway to the Customer VPN gateway
(a VPN gateway for the VPC is created automatically, if it does not already exist). If you
have not created the VPN Customer Gateway, you are prompted to create it from the VPC
Customer Gateway page. Currently, a single VPC can connect to multiple VPN Customer
Gateways.

To create a VPN Connection, follow the steps :

1. Select the VPC.

2. Move your cursor over the gear wheel icon and click Add VPN Connection. Alternately,
you can click Add VPN Connection in the VPN Connections tab.

3. Select the VPN Customer Gateway.

4. Accept the terms and conditions and click Confirm.

Resetting a VPN Connection: Select the VPN Connection from the VPN Connection tab and
click Reset.

Deleting a VPN Connection: Select the VPN Connection from the VPN Connection tab and
click Delete. Click Confirm.
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VPN Customer Gateways

You can add, modify, or delete a VPN Customer Gateway in CloudPortal Business Manager
for the CCP version 3.0.5 and above. You can view the name, gateway, CIDR list, and other
details under the tab My Services > VPN Customer Gateway for the selected CCP version.

To add a VPN Customer Gateway

Perform the following steps:

1. Login to CloudPortal Business Manager UI

2. Go to My Services tab

3. Click on the Manage Resources link for the required CCP

4. Click on the VPN Customer Gateway tab

5. Click Add New on the left pane

6. Specify the following details

UI Element Description

Name A unique name for the VPN customer gateway that you create

Gateway The IP address for the remote gateway

CIDR list The guest Classless Inter-Domain Routing (CIDR) list of the remote
subnets. Enter a CIDR or a comma-separated list of CIDRs. Ensure
that a guest CIDR list is not overlapped with the VPC's CIDR, or
another guest CIDR. The CIDR must be RFC1918-compliant

IPsec Preshared Key Preshared keying is a method where the endpoints of the VPN share
a secret key. This key value is used to authenticate the customer
gateway and the VPC VPN gateway to each other

Phase 1 Policy(IKE) • IKE Encryption: The Internet Key Exchange (IKE) policy for
phase-1. The supported encryption algorithms are AES128,
AES192, AES256, and 3DES. Authentication is accomplished
through the Preshared Keys

• IKE Hash: The IKE hash for phase-1. The supported hash
algorithms are SHA1 and MD5

• IKE Diffie Hellman Group(DH): A public-key cryptography
protocol which allows two parties to establish a shared secret
over an insecure communications channel. The 1536-bit
Diffie-Hellman group is used within IKE to establish session keys.
The supported options are None, Group-5 (1536-bit), and
Group-2 (1024-bit)



Phase 1
Lifetime(seconds)

The phase-1 lifetime of the security association in seconds. Default
is 86400 seconds (1 day). Whenever the time expires, a new phase-1
exchange is performed

Phase 2 Policy (ESP) • ESP Encryption:Encapsulating Security Payload (ESP) algorithm
within phase-2. The supported encryption algorithms are
AES128, AES192, AES256, and 3DES

• ESP Hash:Encapsulating Security Payload (ESP) hash for
phase-2. Supported hash algorithms are SHA1 and MD5

• Perfect Forward Secrecy: Perfect Forward Secrecy (or PFS) is
the property that ensures that a session key derived from a set
of long-term public and private keys will not be compromised.
This property enforces a new Diffie-Hellman key exchange. It
provides the keying material that has greater key material life
and thereby greater resistance to cryptographic attacks. The
available options are None, Group-5 (1536-bit), and Group-2
(1024-bit). The security of the key exchanges increase as the DH
groups grow larger, as does the time of the exchanges

Phase 2
Lifetime(seconds)

The phase-2 lifetime of the security association in seconds. Default
is 3600 seconds (1 hour). Whenever the value is exceeded, a re-key
is initiated to provide a new IPsec encryption and authentication
session keys

Dead Peer
Detection

A method to detect an unavailable IKE peer. Select this option if
you want the virtual router to query the liveliness of its IKE peer at
regular intervals. It is recommended to have the same configuration
of DPD on both side of VPN connection

7. Select the checkbox to accept the terms and conditions

8. Click OK

To modify a VPN Customer Gateway

Perform the following steps:

1. Login to CloudPortal Business Manager UI

2. Go to My Services tab

3. Click on the Manage Resources link for the required CCP

4. Click on the VPN Customer Gateway tab

5. From the left pane, select the specific VPN Customer Gateway that you want to edit

6. Click on the edit icon on the right pane

7. Edit the details as required

8. Click OK

To delete a VPN Customer Gateway

Perform the following steps:

VPN Customer Gateways

567



1. Login to CloudPortal Business Manager UI

2. Go to My Services tab

3. Click on the Manage Resources link for the required CCP

4. Click on the VPN Customer Gateway tab

5. From the left pane, select the specific VPN Customer Gateway that you want to delete

6. Click on the delete icon on the right pane

7. Click OK

VPN Customer Gateways
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Setting service instance specific user
settings

In addition to the username and password authentication, Citrix CloudPlatform supports
using SSH keys to log in to the cloud infrastructure for additional security for your cloud
infrastructure.

1. Log in to CloudPortal Business Manager UI.

2. Click on Root user at the top right hand corner of the UI.

3. Select My Profile from the drop-down.

4. Click My Services tab.

5. You can see the list of all applicable service instances (enabled for the user) on the
right pane. Select the desired service.

6. Click My Settings. This will redirect you to SSH Key settings page where you can
generate SSH Keys and upload SSH Keys.
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Known issues

The following is a list of known issues:

• In CPBM, when a VPC tier is created we do not associate it with any ACL list. Once the
tier is created, the ACL tab in the networks page lists four default acl rules for that
tier, which are:

Source/Destination     ype      Protocol    Allow/Deny

0.0.0.0/0             Egress      all         allow
0.0.0.0/0             Ingress     all         allow
0.0.0.0/0             Egress      all         deny
0.0.0.0/0             Ingress     all         deny

These ACL rules are misleading and are listed due to
http://bugs-ccp.citrix.com/browse/ES-1729. This is an api issue and the default iptable
rules are applied properly in the VPC's virtual router, i.e. all incoming traffic to the
guest networks is blocked and all outgoing traffic from guest networks is allowed.

To associate the tier with a new ACL list, create a new ACL rule from the ACL tab. Now
the tier is associated with an ACL list which contains the ACL rule you just created and
the same will be displayed in the ACL tab.
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FAQs

How to enable a shared account?

1. Login as root user.

2. Navigate to the Administration > Account types.

3. Select the Account Type.

4. Click Service Controls > Edit.

5. Enable Resource Sharing Mode.
What is the "Resource Sharing Mode" setting?

Resource Sharing Mode disabled by default. This means that each user of an account will
see his own resources. For example, user 1 creates a VM called "SQL" and user 2 creates a
VM called "webserver", user 2 cannot see "SQL" and user 1 cannot see "webserver". If
resource sharing mode is enabled, all users in an account share the resources used and
the VMs created. The second option is used for customers who act as managed service
providers and manage the environment for their customers to some extent. They could
have a service user in the customer account which has access to all resources and
simultaneously the customer can have users who views the same resources.
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CloudPortal Services Manager Connector
Guide

This document describes how to install and administer the Citrix CloudPortal Business
Manager connector for CloudPortal Service Manager (CPSM). The connector provides the
following functionalities:

• Customer admin (master user) self-service customer account creation in CPSM.

• Customer admin (master user) self-service customer plan provisioning for Hosted
Exchange, Hosted Apps and Desktops, DNS, Sharepoint 2013, Lync Hosted 2013 and Lync
Enterprise 2013.

• Single sign on into CPSM portal from CPBM, so that customer admin (master user) can
provision other users and provision user plans and offerings to users within CPSM.

• Usage collection and billing for Hosted Exchange, Hosted Apps and Desktops, DNS,
Sharepoint 2013, Lync Hosted 2013, and Lync Enterprise 2013 customer plans, user
plans, and offerings.

Supported CPSM version: v11.0.1.85

This document covers the following topics:

System Requirements

Installing the CPSM Connector

Connector Service Configuration

Connector User Roles

Configuring CPSM Usage Collection Jobs

Connector Usage Types

Connector Resource Types

Connector Channel to CPSM Location/Reseller Mapping

Channel Setting for SharePoint Farms and Feature Packs

Single Sign On (SSO)

Connector Account Configuration

http://support.citrix.com/proddocs/topic/cpbm-23-map/cpbm-cpsm-connector-install-con.html#cpbm-ccp-connector-install-con
http://support.citrix.com/proddocs/topic/cpbm-23-map/cpbm-cpsm-resource-types-con.html#cpbm-csm-resource-types-con
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System Requirements

The connector has the following system requirements:

• CloudPortal Business Manager v2.3

• Cloud Portal Service Manager v11.0.1.85 with eCommerce SDK

When the customer administrator is provisioned into CPSM from CPBM, CPSM automatically
generates a password. To email the CPSM generated default password to the customer
administrator, the email server has to be configured in CPSM.

It is recommended to create Customer Plans, User Plans, and Offerings in CPSM before
adding the service instance in CPBM. This will enable creating products and product bundles
in CPBM immediately after adding the Service. Customer Plans, User Plans, and Offerings
can be added later in CPSM.

Note: Ensure that names of Customer Plans, User Plans, and Offerings (when configured
or added) are unique in CPSM, so that they is no ambiguity when creating products and
product bundles in CPBM.
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Configuring CPSM Usage Collection Jobs

The CPSM usage collection jobs run on a daily basis to populate the CPSM data warehouse
with the CPSM usage data. The following CPSM usage jobs need to be configured so that the
CPSM usage collection completes before the CPBM triggers the billing job for the day.

To configure the CPSM jobs, the following are recommended:

1. On the CPSM Provisioning server, configure the job "Usage Data Collection - Daily (AM)"
to run at 00:15 A.M. every day.

2. On the CPSM Provisioning server, configure the job "Usage Data Collection - Daily (AM)"
to run at 00:15 A.M. every day.

Note: By default, the CPBM billing job is scheduled to run at 1:00 A.M. server time. For
CPBM deployments that have the CPSM connector configured, it is recommended to run
the CPBM billing job at 1:30 A.M. Refer to Jobs and Job Management to reconfigure the
billing job in CPBM.
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Installing CloudPortal Services Manager
Connector

The CPSM connector is installed, by default, when you install CloudPortal Business Manager.
The CPSM connector is deployed into VIRGO's connectors directory. CloudPortal Business
Manager extracts the information from the connector and copies the serviceDefinition.xml,
logo, terms and condition files, and UI implementation files to the
/usr/share/cloud/portal/data directory.
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Enabling the CloudPlatform Services
Manager Connector

1. Log in to CloudPortal Business Manager UI as Root user.

2. Go to Home > All Services.

3. Select the CPSM service and click Enable.

4. Accept the Terms & Conditions defined by the CPSM cloud service and click Accept.

5. Map the roles defined by the CPSM cloud service to the appropriate CloudPortal
Business Manager profiles.

Note: The service onboarding for customer and customer's users depends on these
role mapping. Ensure that roles are appropriately mapped to profiles.

6. Click Submit and then click Close.
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Adding an instance to the CPSM service

The Add Service Instance wizard enables you to add an instance of the service. You can
specify the parameters required to connect to the service, add products, and specify the
utility prices for the products.

1. Log in to CloudPortal Business Manager UI as Root user.

2. Click Home > All Services > Cloud Services. You will find the CPSM service of the
category SaaS.

3. Click Add. The Add Service Instance wizard opens.

4. Specify the identifying information for the instance such as name, code, and description
and click Next.

5. In the Configuration page, specify the details of the service instance. For more
information, refer to Connector Service Configuration.

6. Click Next. The Default Product Selections page is displayed. This is a list of products
based on defined UsageTypes. For more information on usage types, refer to the
section on Usage Types.

7. Select the products that you want to create at the time of creation of the service
instance. You can also edit the product name, product code, category, and required
product units for each of the default products.

8. Click Next and specify the utility charges (in all active currencies) for the products that
you have selected.

9. Review and confirm the details.

10. Click Add and then, click Close.

http://support.citrix.com/proddocs/topic/cpbm-23-map/cpbm-cpsmconn-servconfig-con.html#concept_B28EA9E8F3E6441D907847F41E208A91
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Connector Service Configuration

The following are the configuration items when adding a CPSM service instance to the
connector:

• Host URL: This is the hostname of the CPSM web server that can be reached from the
CPBM Server.

Note: The hostname also includes the protocol being used: For example,
https://cortexweb

• CPSM Admin User Name:The value provided for this property should be the admin
username in CPSM.

• CPSM Admin Password: The value provided for this property should be the admin
password in CPSM.

• Advanced settings:

• Cortex API URL: CPSM exposes an xml based RESTful API known as the Cortex API.
The value provided for this property should be the endpoint URL for the CPSM
instance's Cortex API.

This is an optional setting and will use the <Host URL>/CortexAPI/default.aspx, if it
is not defined.

• eCommerce API URL: In addition to the Cortex API, CPSM exposes another API,
called eCommerce API. The value provided for this property should be the endpoint
URL for the CPSM instance's eCommerce API. Please note that the Cortex APIs and
eCommerce APIs offer different capabilities and are not interchangeable.

This is an optional setting and will use <Host URL>/eCommerce/v1, if it is not
defined.

• Base SSO URL: CPSM exposes a Single Sign On (SSO) URL which the connector can
invoke with appropriate parameters to obtain a login token for a specified user. The
value provided for this property should be the SSO URL supported by CPSM.

This is an optional setting and will use <Host
URL>/CortexDotNet/Login/LoginwithToken.aspx, if it is not defined.

• Extended Properties: These are advanced configurations related to the CPSM
Connector. It is not recommended for customers to change these configurations
on their own. Contact Citrix Support to modify these settings.

These are a fixed set of configurations that is supported by the connector.

The extended settings include:

• Default roles assigned to customers in CPSM.

• Language mappings from CPBM to CPSM.



• CPSM Customer admin configurations, such as:

“ChangePasswordOnNextLogOn”
Sample Extended Properties configuration:
{
    "adminRoles": [
        "Advanced User View",
        "Partial User Administrator (Reset Passwords)",
        "Customer Administrator",
        "Service Administrator",
        "User Administrator",
        "User and Service Administrator",
        "Reporting Users"
    ],
    "languageMapping": {
        "en_us": "en",
        "en": "en",
        "fr": "fr_ca",
        "nl": "nl",
        "de": "de",
        "*": "en"
    },
    "changePasswordOnNextLogin": true
}

Connector Service Configuration
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Connector User Roles

The connector supports three kinds of roles, which are defined below:

• CPSM Cloud Management: This role is available to CloudPortal Business Manager (CPBM)
users in the Service Provider scope. This role has global admin privileges in CloudPortal
Services Manager (CPSM). This is enabled by default for the Service Provider admin.

• CPSM Cloud Account Management: This role is available to CPBM users in the
Customer scope. This role has customer admin privileges in CPSM. This role is enabled
by default for the Master User profile. As part of enabling the connector, the Service
Provider admin can enable this role for the Power User profile.

• CPSM Cloud User: This role is available to CPBM users in the Customer scope. This role
has normal user privileges in CPSM. As part of enabling the connector, the Service
Provider admin has to enable this role for the User profile.
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Connector Usage Types

The connector collects usage data for the following usage types so that they are billable in
CloudPortal Business Manager:

• Hosted Exchange Customer Plan Usage:

To create a Product for a Hosted Exchange Customer Plan and charge for it, select
'Hosted Exchange Customer Plan' as Usage Type, and use the mediation rule to narrow
it down to the specific 'Hosted Exchange Customer Plan'. The unit for this usage type
is discrete and is calculated on a 'Per Billing Period' basis.

• Hosted Exchange User Plan Usage:

To create a Product for a Hosted Exchange User Plan and charge for it, select 'Hosted
Exchange User Plan' as Usage Type, and use the mediation rule to narrow it down to
the specific 'Hosted Exchange User Plan'. The unit for this usage type is discrete and is
calculated on a 'Per Billing Period' basis.

• Hosted Apps and Desktops Customer Plan Usage:

To create a Product for a Hosted Apps and Desktops Customer Plan and charge for it,
select 'Hosted Apps and Desktops Customer Plan' as Usage Type, and use the
mediation rule to narrow it down to the specific 'Hosted Apps and Desktops Customer
Plan'. The unit for this usage type is discrete and calculated on a 'Per Billing Period'
basis.

• Hosted Apps and Desktops User Plan Usage:

To create a Product for a Hosted Apps and Desktops User Plan and charge for it, select
'Hosted Apps and Desktops User Plan' as Usage Type, and use the mediation rule to
narrow it down to the specific 'Hosted Apps and Desktops User Plan'. The unit for this
usage type is discrete and calculated on a 'Per Billing Period' basis.

• Hosted Apps and Desktops Offering Usage:

To create a Product for a Hosted Apps and Desktop Offering and charge for it, select
'Hosted Apps and Desktops Offering' as Usage Type, and use the mediation rule to
narrow it down to the specific 'Hosted Apps and Desktops Offering'. The unit for this
usage type is discrete and calculated on a 'Per Billing Period' basis.

• SharePoint 2013 Customer Plan Usage:

To create a Product for a 'SharePoint 2013 Customer Plan' and charge for it, select
'SharePoint 2013 Customer Plan' as Usage Type and use the mediation rule to narrow it
down to the specific 'SharePoint 2013 Customer Plan'. The unit for this usage type is
discrete and calculated on a 'Per Billing Period' basis.

• SharePoint 2013 User Plan Usage: To create a Product for a 'SharePoint 2013 User 
Plan' and charge for it, select 'SharePoint 2013 User Plan' as Usage Type and use the 
mediation rule to narrow it down to the specific 'SharePoint 2013 User Plan'. The unit



for this usage type is discrete and calculated on a 'Per Billing Period' basis.

• Lync Enterprise 2013 Customer Plan Usage: To create a Product for a 'Lync Enterprise
2013 Customer Plan' and charge for it, select 'Lync Enterprise 2013 Customer Plan' as
Usage Type and use the mediation rule to narrow it down to the specific 'Lync
Enterprise 2013 Customer Plan'. The unit for this usage type is discrete and calculated
on a 'Per Billing Period' basis.

• Lync Enterprise 2013 User Plan Usage: To create a Product for a 'Lync Enterprise 2013
User Plan' and charge for it, select 'Lync Enterprise 2013 User Plan' as Usage Type and
use the mediation rule to narrow it down to the specific 'Lync Enterprise 2013 User
Plan'. The unit for this usage type is discrete and calculated on a 'Per Billing Period'
basis.

• Lync Hosted 2013 Customer Plan Usage: To create a Product for a 'Lync Hosted 2013
Customer Plan' and charge for it, select 'Lync Hosted 2013 Customer Plan' as Usage
Type and use the mediation rule to narrow it down to the specific 'Lync Hosted 2013
Customer Plan'. The unit for this usage type is discrete and calculated on a 'Per Billing
Period' basis.

• Lync Hosted 2013 User Plan Usage: To create a Product for a 'Lync Hosted 2013 User
Plan' and charge for it, select 'Lync Hosted 2013 User Plan' as Usage Type and use the
mediation rule to narrow it down to the specific 'Lync Hosted 2013 user Plan'. The unit
for this usage type is discrete and calculated on a 'Per Billing Period' basis.

• DNS Service Usage: To create a Product for a 'DNS Service' and charge for it, select
'DNS Service' as Usage Type. The unit for this usage type is discrete and calculated on a
'Per Billing Period' basis.

The usage above are charged on a discrete "Named Users" per billing period basis. So, if a
user A subscribes to a user plan, the count of the specific user plan usage is incremented by
1 for that tenant for that billing period independent of how many days the user A's user
plan is active during that billing period. At the beginning of each billing period, CPBM
updates the inventory of the current users subscribed to different plans/offerings and then
updates the count accordingly each day based on new subscriptions being made.

For more information on discrete usage types in CPBM, refer to the Billing of Discrete
Products section in CPBM.

Connector Usage Types
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Connector Resource Types

The connector supports the following types of Resources that can be provisioned from
CPBM to CPSM. They are as follows:

• Hosted Exchange:

The connector supports provisioning the Hosted Exchange Customer Plan. This resource
type has a constraint of 'one per account', which means only one instance of this
resource type can be provisioned per account in CPBM.

• Hosted Apps and Desktops:

The connector supports provisioning the Hosted Apps and Desktops Customer Plan. This
resource type has a constraint of 'one per account'.

• SharePoint 2013:

The connector supports provisioning the SharePoint 2013 Site (Customer Plan). This
resource type has the constraints of 'one per account' or 'any number per account'.

To provision a SharePoint Site, the tenant that is provisioning has to provide the
following configuration:

1. Instance Name: Unique instance name for the SharePoint site.

2. Site Address: The address for the SharePoint site. Both http and https protocols are
supported. For the http protocol, valid site addresses are sub-domains of domains
registered to the CPSM customer. For the https protocol, valid address is the
address tied to the certificate dedicated to the customer by the CPSM administrator
or a sub-domain in case of a wild-carded domain certificate.

3. Site Template: SharePoint templates to provision in the site.

4. Language: Default language for the provisioned SharePoint site.
• Lync Enterprise 2013:

The connector supports provisioning the Lync Enterprise 2013 Customer Plan. This
resource type has a constraint of 'one per account'.

To provision Lync Enterprise 2013, the tenant has to provide the following information:

1. SIP Domains: Provide SIP domain(s) for the provisioned Lync instance.
• Lync Hosted 2013:

The connector supports provisioning the Lync Hosted 2013 Customer Plan. This resource
type has a constraint of 'one per account'.

To provision Lync Hosted 2013, the tenant has to provide the following information:

1. SIP Domains: Provide SIP domain(s) for the provisioned Lync instance.



• DNS:

The connector supports provisioning the DNS Service Plan. This resource type has a
constraint of 'one per account'.

Connector Resource Types
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CPBM Channel to CPSM
Location/Reseller mapping

By default, all accounts that are created in CPBM and for whom the CPSM Cloud service
instance has been enabled, their corresponding customers are provisioned in CPSM, in the
default CPSM location. This default CPSM location is the default location that is specified by
the CPSM administrator. The CPBM administrator can over-ride this behavior on a per
channel basis by setting the channel's Service Controls called 'Location or Reseller' for that
particular CPSM cloud service instance. The administrator can set it to a CPSM location
name or to a CPSM reseller customer. If it is to be set to the reseller, then the location
information must also be specified in this format: Location/Reseller Name. For example,
CPSM1.LOC/RESELLER.

Multiple channels can be mapped to the same location or reseller. The location or reseller
mapping indicates where the customers in CPSM are provisioned. If it is changed, then all
new customers will be provisioned to the new mapping.
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Channel setting for SharePoint farms and
feature packs

By default, when a customer provisions a SharePoint instance for the first time, the first
available SharePoint farm and SharePoint feature pack are configured and used to provision
the instance. All subsequent SharePoint instances will use the already configured farm and
feature pack. The service provider can override this behavior at the channel level by
specifying a specific farm and/or feature pack on which the SharePoint instances of all
accounts belonging to that channel get provisioned.
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Single Sign On

The connector supports single sign on (SSO) to the CPSM portal. A customer admin can
single sign on to the CPSM user interface and provision users and also provision user plans
and offerings for the users.
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Connector Account Configuration

When master user of an account enables CPSM service in CPBM, the connector creates a
CPSM customer and customer admin. The following are configuration parameters for
customer and customer admin creation:

• Company Code:

This property is the value of the company code, which is used as a unique identifier of
the customer in CPSM.

Note: Company code should be 3-5 alphanumeric characters.

• UPN domain:

This property is the value for the customer's UPN domain name (for example,
citrix.com). The domain name specified here is used to create an internal email for the
master user (and other users for this customer).

• Username:

This property is the username for the customer admin of the CPSM customer.

Note: The username string should be between 5 to 11 characters. It can contain
characters from a-z (both, upper and lower case), 0-9, and the '_' character.
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User Guide

This guide includes information that you need to understand the CPBM UI and describes the
activities that a user can perform in CloudPortal Business Manager UI.

CloudPortal Business Manager User Interface Overview

Understanding the Dashboard

User Management

Managing Company Setup

Managing User Profiles and Preferences

Viewing API Credentials

SSH Keys

Service Health and Support

Managing your Spend

Understanding your Bill

Browse Catalog and Subscriptions

My Services Tab

http://support.citrix.com/proddocs/topic/cpbm-23-map/cpbm-understand-dashboard-tsk.html#cpbm-view-service-health-tsk
http://support.citrix.com/proddocs/topic/cpbm-23-map/cpbm-user-mgmt-wrapper-con.html#ccpb-user-mgmt-wrapper-con
http://support.citrix.com/proddocs/topic/cpbm-23-map/cpbm-manage-company-setup-tsk.html#concept_B28EA9E8F3E6441D907847F41E208A91
http://support.citrix.com/proddocs/topic/cpbm-23-map/cpbm-managing-user-profile-preferences-tsk.html#concept_B28EA9E8F3E6441D907847F41E208A91
http://support.citrix.com/proddocs/topic/cpbm-23-map/cpbm-view-api-credentials.html#ccpb-viewapicredentials
http://support.citrix.com/proddocs/topic/cpbm-23-map/cpbm-user-guide-set-service-inst-user-settings.html#ccpb-set-service-inst-user-settings
http://support.citrix.com/proddocs/topic/cpbm-23-map/cpbm-user-guide-service-health-support-con.html#cpbm-user-guide-service-health-con
http://support.citrix.com/proddocs/topic/cpbm-23-map/cpbm-manage-spend-wrapper-con.html#concept_B28EA9E8F3E6441D907847F41E208A91
http://support.citrix.com/proddocs/topic/cpbm-23-map/cpbm-usageandbilling-understandyourbill-con.html#concept_B28EA9E8F3E6441D907847F41E208A91
http://support.citrix.com/proddocs/topic/cpbm-23-map/cpbm-browse-catalog-con.html#cpnm-browse-catalog-con
http://support.citrix.com/proddocs/topic/cpbm-23-map/cpbm-user-guide-my-services-tab-con.html#cpbm-user-guide-my-services-con
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CloudPortal Business Manager User
Interface Overview

CloudPortal Business Manager provides a standard web based user interface that allows you
to access the full range of cloud services of the service provider. Supported browsers
include:

• Microsoft Internet Explorer 8, 9, 10, and 11

• Mozilla Firefox 30

• Google Chrome 35.0.1916.153

• Apple Safari 7.0.5

The CloudPortal Business Manager UI displays the following top level tabs:

• Home

• My Services

• Users

• Catalog

• Support

Home tab
When you log in to CloudPortal Business Manager UI, the landing page is the dashboard. In
addition to the dashboard tab, the Home tab includes All Alerts, All Notifications, All Tasks,
and Usage and Billing tabs. You can access all information related to your account, the
services that you have subscribed to, and billing from this tab.

My Services tab
The My Services tab displays all the services that are enabled for your account. For each of
your enabled services, you can access the resource management console, subscribe to
packaged bundles, view utility rates, and manage your settings from this tab.

Users tab
The Users tab lists all users of your account. You can manage your users and their
information from this tab.



Catalog tab
The Catalog tab displays the various services and service instances enabled for your
account. You can view and subscribe to the service offerings of the service provider from
this tab.

Support tab
The Support tab gives you a view of the status of the service instances enabled for your
account. You can view the maintenance schedule and also submit support tickets for issues
to be resolved by the service provider from this tab.

CloudPortal Business Manager User Interface Overview
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Understanding the dashboard

When you log in to CloudPortal Business Manager, the landing page is the dashboard. The
dashboard gives you an at-a-glance view of your account. The dashboard provides a
summary view which varies depending on which user is logged in. Links are provided to
allow you to navigate to the pages to view more information or take necessary action.

Who can use the Dashboard

Every user, no matter their role, has a dashboard.

• The Master user can see information on service health, spend, spend vs budget, active
users and active subscriptions, the billing information, notifications, service tickets,
and so on.

• A normal user can see information on service health, active subscriptions (of that user
only), spend, notifications, and tickets.

How to Use the Dashboard
1. Log in to CloudPortal Business Manager UI as Master user (or normal user).

2. At any time, you can return to the dashboard by clicking Home > Dashboard.

Master user dashboard view

• Active users: Number of active users in the account .

• Active subscriptions: Number of active subscriptions for the account.

• Spend: The spend in the currency specified for the account.

• Spend vs Budget: You can view the budget set, the actual spend, and the net balance.
Click the appropriate links to set the budget and manage spend alerts.

• Understand your bill: You can see the start date of your billing period. Click the
appropriate links to help you understand and manage various aspects of your bill.

• Service Health: You can get an at-a-glance summary of the service health of the cloud
services enabled for your account. Click View All to see the details.

• Getting Started: You can click the link to browse the product catalog, see the product
offerings, and subscribe to product bundles.

• Notifications: You can view the notifications for events and issues, for the current date
and the previous date. Click the appropriate links to view all notifications and manage
your notification preferences.

• Tickets: You can view any outstanding support tickets that are not yet addressed. Click 
the appropriate links to view all tickets filed and the maintenance schedule or submit a



support ticket.

• My Tasks: You can see all the pending tasks (if any) for the master user. Click View all
Tasks to view all tasks.

• Users: You can view all the users present in that account. Click the appropriate links to
edit user information or to add a new user, respectively.

Normal user dashboard view

• Active subscriptions: Number of active subscriptions for the your user account. Does
not include the subscriptions of other users of your account.

• Spend: The spend in the currency specified for the account.

• Service Health: You can view the current service health of the cloud services enabled
for your account. Click View All to see the details, submit support tickets, and view the
maintenance schedule.

• My Tasks: You can view all the pending tasks for you. Click View all Tasks to view all
tasks.

• Notifications: You can view the notifications for events and issues, for the current date
and the previous date. Click the appropriate links to view all notifications and manage
your notification preferences.

• Tickets: You can view any outstanding support tickets that are not yet addressed. Click
the appropriate links to view all tickets filed or submit a support ticket.

• Getting Started: You can click the link to browse the product catalog, see the product
offerings and subscribe to the product bundles.

Understanding the dashboard
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User Management

This section describes the different aspects of user management.

Users and profiles

Adding a user

Managing information of your account users

Unlocking accounts

http://support.citrix.com/proddocs/topic/cpbm-23-map/cpbm-users-profiles.html#ccpb-users
http://support.citrix.com/proddocs/topic/cpbm-23-map/cpbm-users-add.html#ccpb-users-add
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Users and Profiles

About Users
A user is a computer's representation of a person who interacts with the computer
software. CloudPortal saves a variety of information about each of its users.

The minimum set of information that the portal needs to know about each user is:

• First and last name

• Email address

• Profile

• Username

• Password

Optionally, users can provide additional details:

• Photo

• Time zone

About Profiles
A profile is a set of permissions that is saved under a name, such as Administrator or
Manager. Every user of your portal is assigned a profile, including yourself. The profile is
assigned when the user is added to the portal.

Profiles are useful for saving a frequently-used set of permissions so that they can be easily
granted to a user in a single step. This is easier and less error-prone than setting each
individual permission for every user. Profiles also ensure that multiple users with equivalent
duties and needs are all granted the same permissions. For example, you might want to
grant the "Create Customer Account" permission for the Sales profile but not for the Help
Desk profile.

CloudPortal ships with a predefined set of profiles. You cannot add or delete a profile. If
you have the "Create/Manage Profile" permission, you can select which permissions to grant
under each profile name. Given below are the profiles in CloudPortal. The CloudPortal UI
includes a fair amount of information on the predefined profiles, role names and their
descriptions.

Customer Profiles

• Master User

• Billing Admin



• Power User

• User

Users and Profiles
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Adding a User

As a master user of a customer account, you can add users for the customer account. These
users can then access the full range of cloud services from CloudPortal Business Manager.

1. Log in to CloudPortal Business Manager UI as Master user.

2. Click Users > Add New.

3. Enter the user details such as name and email address of the user in the Add User page.

4. Select the user's profile.

5. If required, click Customize Welcome Email to add a subject and custom welcome
message in addition to the default welcome message that is provided by the system.

6. Click Finish.

The user will receive a email which contains a link to verify his email and to set the
password. The user must log in through this link the first time to confirm that the email
address was valid. If the user has lost the email or has not received the email, the master
user can resend the email once again by using the resend verification email link.

To resend the verification email:

1. Click Users. You can view all users of your customer account along with user details.

2. Select the user whose information you want to manage.

3. Place your cursor over the manage icon (that looks like a gear wheel) and click Re-send
Verification.

Note:

• Please note that the email id provided by user is not editable. Ensure that the email id
is valid and active.

• If you are just testing the Add User functionality and sending the welcome email to
yourself, log out of CloudPortal Business Manager before you click the email's login link.
Trying to log in as two different users simultaneously can cause the new user's details to
be stored incorrectly.
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Managing information of your account
users

As a master user, you can view user information, edit the information, deactivate a user, or
remove a user. You can manage user information such as user details, reset user passwords
and preferences, and email addresses for notifications.

1. Log in to CloudPortal Business Manager UI as Master user.

2. Click the Users tab. You can view all users of your customer account along with user
details.

3. Select the user whose information you want to manage.

4. Place your cursor over the manage icon (that looks like a gear wheel) and click Edit.

5. Make the desired changes. You can modify any of the user properties such as time zone,
language, user details, and user password.

6. To add an image, click Manage your profile image at Gravatar and follow the
instructions to upload a photo to gravatar.com.

7. To change the time zone and preferred language, follow these steps:

a. Click Edit in the Preferences pane.

b. Select the new time zone and preferred language and click Save.
8. To change the user details, follow these steps:

a. Click Edit in the Details pane.

b. Make the required changes and click Save.
9. To request the user for a password reset, follow these steps:

a. Click Reset Password in the Login Information pane.

b. Click Confirm to send a mail to the user to reset the password.
10. To configure the notification settings, click Notifications and if required, specify

additional email address to use for notifications.

11. To deactivate the user, click the Deactivate tab next to the user name.

12. To remove the user, click the Remove tab next to the user name.
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Unlocking accounts

CloudPortal Business Manager temporarily disables a user account and prevents a user from
logging in after a certain number of failed login attempts. The number of failed login
attempts is determined by the value that you have specified for the logins.lockThreshold
parameter during security configuration. The user can request for a password reset and
unlock the account.

1. Open the CloudPortal Business Manager UI.

2. Click Request a reset.

3. Specify your user name and click Submit. CloudPortal Business Manager sends an email
to your registered email address with instructions to reset your password.

4. Follow the instructions and reset your password. CloudPortal Business Manager resets
your password and unlocks your account. You can now log in.

Note: If the Phone Verification feature is enabled, CloudPortal Business Manager asks
you for your phone number for verification before you can reset your password.
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Enabling and Assigning Services to Users

The Master user can either enable the service for all normal users or choose to selectively
enable or disable the service for any user. When the Master user enables a service, by
default the service is enabled only for his account. If required, the master user can choose
to enable the service for all currently active users as well as any new user that will be
onboarded and activated.

The Master can also selectively enable or disable the service for specific user.

Assigning users to a service when a new service is enabled:

1. Log in to CloudPortal Business Manager UI as Master user.

2. Click My Services tab.

3. Select the service that you want to enable and click Enable.

4. Review the utility rates, accept the terms and conditions, and click Next.

5. In the Enable service for all users, specify if you wish for this service to be enabled for
all currently active users as well as any new user that will be onboarded and activated.

6. Review and verify the details and click Enable.

Enable service for a new user:

1. Log in to CloudPortal Business Manager UI as Master user.

2. Click Users.

3. Select the user for which you want to enable a service.

4. Select the services that you want to enable and click Enable selected services.
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Managing company settings

As a master user of a customer account, you can manage your company settings such as
company contact information, credit card information, and billing address. You can monitor
your account information and billing details. The actions that you can perform depend on
your account type.

1. Log in to CloudPortal Business Manager UI as Master user.

2. Click the drop-down menu icon in the top right corner next to your name and click
Company Setup.

3. Click the Contact tab.

4. In the Edit Company Info section, click Edit.

5. Make the changes as required and click Save.

6. You are required to provide a credit card number and other payment details when first
signing up with CloudPortal Business Manager. To edit your credit card information and
billing address:

a. Click the Billing and Payment tab.

b. To edit your credit card information, click Edit in the Credit Card section, make the
required changes, and click Save.

c. To edit your billing address information, click Edit in the Billing Address section,
make the required changes, and click Save.

Note:

• The Billing and Payment tab is not visible to a Trial Master user (if the account type
is trial).

• Credit Card information is visible to a Retail Master user (if the account type is
retail).

7. Retail and Trial account users can request for a conversion of their account type:

a. Click Request Account Type Conversion.

b. Select the account type and click Save. By default, the following conversions are
supported (can be customized by the service provider):

• Trial to Retail

• Trial to Corporate

• Retail to Corporate
8. To view your account details, click the General tab. You can view the activation

details, billing details, account information such as account type, customer ID, and the
master user of the customer account.
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Managing user profiles and preferences

Your personal profile stores details such as a photo, email address, contact information,
and login credentials. You can change your password and other data about yourself.

1. Log in to CloudPortal Business Manager UI as a user.

2. Click the drop-down menu icon in the top right corner next to your name and click My
Profile.

3. To add an image, click Manage your profile image at Gravatar and follow the
instructions to upload a photo to gravatar.com.

4. To change the time zone and preferred language, follow these steps:

a. Click Edit in the Preferences pane.

b. Select the new time zone and preferred language and click Save.
5. To change your personal details, follow these steps:

a. Click Edit in the Details pane.

b. Make the required changes and click Save.
6. To change your password, follow these steps:

a. Click Change Password.

b. Enter your old and new password and confirm

c. Click Save.
7. To provide an additional email address to use for notifications, follow these steps:

a. Click the Email Addresses tab.

b. Specify the email address and click Add Email.

Note: You can change your primary email address and also add secondary email
addresses.

To change your primary email address:

i. Add the secondary email address.

ii. Verify the secondary email address.

iii. Make this email address as your primary email address.
8. To configure your notification settings, click the Notification Preferences tab and

specify.

9. To view your API credentials, follow these steps:



a. Click the API Credentials tab.

b. Enter your password to proceed (as an additional security measure) and click
Proceed.

c. View your API credentials.

Managing user profiles and preferences
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Changing your primary email address

You can change your existing primary email address, if required, and provide a new email
address as the primary email address.

1. Log in to CloudPortal Business Manager UI as a user.

2. Click the drop-down menu icon in the top right corner next to your name and click My
Profile.

3. Provide the new email address:

a. Click the Email Addresses tab.

b. Specify the email address and click Add Email.
4. Verify the secondary email address.

5. Navigate to My Profile > Email Addresses.

6. Click Make Primary.
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Viewing API Credentials

When you access the CloudPortal Business Manager BSS APIs, the API request has to be
signed so that the user is authenticated and it is verified if the user is authorized to
execute the command. A user must have both, the API key (uniquely identifies the account)
and the secret key for the account before proceeding with the signing process.

The CPBM UI displays your BSS API credentials and the API credentials (for your account)
that enable you to make API requests to the enabled cloud service instances. Some cloud
services (such as CloudPortal Services Manager) do not have API credentials and for such
cloud instances you can only view your username.

To view the API credentials:

1. Log in as the root user of the account.

2. Click your username at the top right hand corner of the UI.

3. Select My Profile from the drop-down list.

4. Click the API Credentials tab.

5. Enter your password to proceed (as an additional security measure) in the pop-up box.

6. Click Proceed. You will see the API credentials.
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SSH keys

SSH keys are used for authentication into a newly launched VM. You can connect to a VM
without using a username and password, by using the SSH keys. For this to work, user has to
either upload a private key for which the public key is saved locally, or generate a key pair
and save the generated public key locally. And then, select any key while launching the VM.
This option is available for the CCP cloud service.

1. Log in to CloudPortal Business Manager UI as a user.

2. Click My Services tab.

3. You can see the list of all applicable service instances (enabled for the user) in the right
pane. Select the desired service instance.

4. Click My Settings. This will redirect you to SSH Key settings page where you can
generate SSH Keys and upload SSH Keys.

5. To generate the SSH key, provide the key name and click Generate.

6. To upload the SSH key, provide the key name and then upload the key.
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Service Health and Support

You can monitor the health and status of the services. The service health section of your
dashboard gives the current health status of the service instances enabled for your account.
Health status of a service instance for a particular day is determined by the latest service
health status for the day.

The Support tab enables you to view the service status and maintenance schedule. The
Support > Service Health tab displays the health status history for the day, including the
time, for each service instance enabled.
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Viewing service health

You can view the current status of your service from the Service Health pane of the
dashboard. You can view the service status on any particular day from the Support tab.
Service health is visible to users within your account and is a quick way to let your users
how the system is doing. You can also view when maintenance activity has been scheduled.

1. Log in to CloudPortal Business Manager UI as Master user.

2. You can view the current status from the Service Health pane. Alternatively, you can
click the Support tab. Service health status can be either issue, disruption, or
resolution.

• Issue: There is an issue with the service.

• Disruption: The service is not functioning.

• Resolution: The service issue has been resolved.
3. Click Maintenance to find out when maintenance is scheduled.

Note: Service Health is displayed for service instances which are enabled for that
particular account.

Health status for a particular day is determined by the latest service health status for
the day. The Status History in the right pane displays the health status history for the
day, including the time.
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Filing support tickets

As a tenant user (Master and his own users) you can file a support ticket to report an issue
and request for its resolution.

1. Log in to CloudPortal Business Manager UI as a Master user or normal user.

2. Click Support > Tickets.

3. Click Add New.

4. Enter a title and describe the issue for which the support ticket is being raised.

5. Click Submit.

Customer Users having "Account Ticket View" role can see all the tickets in their own
accounts. By default Account tickets view role is enabled for all customer users.

Customer Users having "Account Ticket Manage" role can create, comment, and close all the
tickets which are created by all the users in their own accounts. By default this role is
enabled for the Master User.

If the service provider wants any other customer user to have the ability to create,
comment, and close the tickets created by all the users in their account, then the "Account
Ticket Manage" role needs to be enabled for that customer user by the service provider.
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Viewing scheduled maintenance

As a user, you need to be aware of when maintenance activities are scheduled, when
possible service interruptions may happen, and when service improvements are expected.
You can view this information from the Maintenance tab of the Support.

1. Log in to CloudPortal Business Manager UI as a user.

2. Click Support > Maintenance.

3. View the maintenance schedule. In the Details section, read the description to
understand what will happen during the maintenance window.
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Managing your spend

As a master user, you can set your own account budget and spend alerts. You can track your
spend by setting alerts, so that you get a notification when your spend reaches a certain
percentage of your spend budget.
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Setting your budget

As a master user, you can set the spend budget for your account.

1. Log in to CloudPortal Business Manager UI as Master user.

2. Click the All Alerts tab or click the Set Budget link in the Spend vs. Budget area of the
dashboard.

3. Click Set Budget.

4. Specify the budget amount and click OK.
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Creating alerts

As a master user, create spend alerts so that you get notifications when your spend crosses
the set limit.

1. Log in to CloudPortal Business Manager UI as Master user.

2. Click the All Alerts tab or click the Manage Spend Alerts link in the Spend vs. Budget
area of the dashboard.

3. Click Add New.

4. Specify the percentage value of your spend budget after which you will receive the an
alert.
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Viewing spend summary

The Spend Vs. Budget pane shows your spend details. You can view your actual spend, last
month's spend and the net balance. You can click the Net Balance link to view your renewal
charges, new charges, payments and credits, and the net balance. the budget that you have
set, your renewal charges, new charges, and current balance. You can click the Usage &
Billing tab to view in detail your spend.

You can click the appropriate links to set your account budget and spend alerts.
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Viewing spend notifications

You can configure spend alerts and view the alert notifications that are generated when
your spend crosses pre-defined threshold limit. You will receive the notifications by email
or phone depending on your notification preferences. You can view the alerts in the
Notifications tab.

1. Log in to CloudPortal Business Manager UI as Master user.

2. Click the All Notifications tab. A list of all notifications is displayed.

3. View the notifications of category "Account Spend."
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Understand Your Bill

CloudPortal Business Manager generates invoices for products/product bundles that you
have used. It tracks the resources that you use, calculates the amounts owed, and handles
invoicing and payments for you automatically. Auto-payment is done in accounts with
payment information on file with CloudPortal Business Manager, such as CyberSource, using
your credit card information updated in CPBM. All the credit card details are stored by the
gateway provider.

The Usage & Billing tab provides information about your resource usage, billing,
subscriptions, and payments.

Note: Only certain administrative profiles, such as Finance Admin can view the billing
information of other users.

To navigate to the Usage & Billing tab

1. Click on the View Dashboard icon on the right pane

2. The Dashboard page appears

3. Click on the Usage & Billing tab

4. The information is displayed under four tabs, such as Activity, Subscriptions, Invoices,
and Payments

Activity

The Activity tab under the Usage & Billing tab displays all the account statements on the
left pane. Clicking on an invoice displays the following details:

UI Element Description

Balance Forward The amount carried forward from the previous invoice.

If there is no amount from the previous invoice, the amount will be
0.

Payments +
Credits

The sum of Payments and Credits.

• Payments: The payments that you have made towards the last
invoice.

• Credits: A credit adds funds to your balance in CloudPortal
Business Manager. Any future charges incurred by you will be
paid out of this credit balance first. Your Administrator can
issue credits.

Net Balance The amount for which you must make payment.

The amount is obtained using the formula:

Balance Forward - (Payments + Credits) + New Charges



Renewal Charges The amount that is associated for certain subscriptions.

Renewal charges are fixed charges.

Subscription
Charges

The amount that is associated with every product subscription such
as a one-time fee followed by monthly renewal fees.

Subscription Charges are fixed charges.

Utility Charges The amount charged for using the portal resources that is directly
proportional to the usage.

Utility Charge also includes debit notes for cancelled credits.

Note: To view more details about invoice, specific rows displays
additional information about the product and their charges.

Discount(s) The discount amount, if applicable.

Sub-total The sum obtained from the formula:

Subscription Charges + Utility Charges - Discount(s)

Taxes The tax amount that is applicable.

New Charges The amount obtained from the formula:

Sub-total + Taxes
In addition, a detailed computation of the following is displayed in the Activity tab:

• Payments + Credits

• New Charges

• Renewal Charges

Subscriptions

The Subscriptions tab under the Usage & Billing tab displays the list of all the subscriptions
on the left pane. For more information, refer to Browse Catalog and Subscriptions

Note:

• A green colored circle adjacent to a subscription indicates that it is active and the
resource has been provisioned

• An orange colored circle adjacent to a subscription indicates that it is active but the
resource is not provisioned

Clicking on a subscription from the left pane displays the following:

UI Element Description

Product Bundle The name of the product bundle.

Service The name of the cloud service for which an instance is created.

Understand Your Bill
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State The state of the specific subscription. The states will be one of the
following:

• Active

• Expired

• Cancelled

• New

Subscription
Charges

This tab displays the following details:

• Charges: The type of the subscription such as One-time and
Recurring

• Prices: The amount charged for the type of subscription

Entitlements This tab displays the following details:

• Item: The name of the resource used

• Unit Price: The rate for the specific resource

• No charges for usage up to: The number of units up to which
the resource usage is not charged

Resource Details This tab displays the following details:

• Service: Name of the cloud service

• Resource Type: Resource type (depends on the cloud service)

• Resource Handle: Value of the resource handle

• Resource Name: Name that you have given to the resource

• Resource State: State of the resource (error, provisioning,
active, or terminated)

• Resource Status: Status of the resource (whether running,
stopped, and so on. Each resource has its own status types.)

Configuration
Data

The configuration data of the resource that is subscribed and
provided by the underlying cloud service. For example, in case of
Citrix CloudPlatform, the configuration data for a storage type
resource includes the following:

• Zone: The name of the zone

• Disk Offering: The name of the disk offering

• Disk Size in GB (Only for Custom Disk Offerings): The size of
the disk

Invoices

Understand Your Bill
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The Invoices tab under the Usage & Billing tab displays the list of all the invoices
generated (both current and previous) in the left pane. Invoices have invoice line items that
detail the charges that make up the invoice.

Clicking on a invoice from the left pane displays the following:

UI Element Description

State The state of the invoice for the specific billing period, either
Provisional or Posted.

Type The type of the invoice. The types of invoices are:

• Subscription

• Close Out

• Renewal

• Debit Note

Subscription
Bundle

The name of the product bundle that you have subscribed

Detail The details of:

• Total Amount: The invoice amount

• Due Amount: The balance amount to be paid, if applicable
Payments

The Payments tab under the Usage & Billing tab displays the list of all the payments made
on the left pane. Clicking on a payment date from the left pane displays the following:

UI Element Description

Date The date when the payment was made.

UUID Universal Unique Identifier

Amount The amount for which the payment was made

Details This tab displays the following:

• Description: The detail about the specific payment

• Type: The type of payment

• State: The state of the payment transaction

• Transaction ID: The unique ID for the specific payment
transaction

Clicking on the Issue Charge Back link reverses the payment
transaction after confirmation from the user.

Understand Your Bill
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Browse Catalog and Subscriptions

Product catalogs are defined for each channel by the service provider. As a user, you can
browse through the product catalog to view the various offerings of the service provider. A
service provider can also access a customer account dashboard and view the product
catalog for that account.

A user can access the Catalog page by clicking either the Catalog tab or the Browse Catalog
link on the Dashboard. An account user registered in a particular channel will see the
product catalog defined for that particular channel, with product prices displayed in the
currency that is specified for that account.

The service provider decides how the service offerings are displayed to the users while
browsing the catalog. There are two modes of display, Pay-as-you-go and Product Bundle.
The service provider sets the pay-as-you-go configuration parameter to true or false, during
the installation of CloudPortal Business Manager. This setting controls how a user can view
the product offerings, in a pay-as-you-go mode or in a product bundle mode.

Pay-as-you-go mode:

When you browse the catalog, you will see the Utility Rate Card that lists the price for each
resource or product and you are charged for the amount of your actual consumption. For
each one of the resources (products) that generates a usage based on your activity, you are
charged by the prices shown in the rate card. When you provision a resource using this
option, a subscription is created by the name "Utility Bundle" and is listed in your list of
subscriptions that can be accessed from the Usage & Billings tab. You can terminate the
subscription at any time. However, you cannot reprovision or reconfigure the resource.

Product Bundles mode:

When you browse the catalog, you can view the product bundles that are defined for and
available to your channel. The bundles are further classified by the frequency of the
recurring charges, for example, monthly, quarterly, or annual. This information is displayed
in the tabs of the Pricing section.

Based on your resource needs, you can select the resource type that you want and filter by
provisioning constraints (or resource components) and frequency of recurring charges to get
a list of product bundles that match your selection criteria.

Each product bundle displays in its details, the bundle charges such as one time charge for
the activation of the bundle, the recurring charges and their frequency, and entitlements
that are given when you subscribe to the product bundle. The prices are specified in the
currency set for the account. Apart from the charges specified for the bundle, charges may
apply for any product consumption that is not covered by the bundle. The utility rates for
such usage are listed in the Utility Rate card that is accessible from the bundle details.

CloudPortal Business Manager enables you to select a product bundle, specify the resource
components, configure, and subscribe to the bundle.

You can either subscribe to a fresh subscription, reprovision an existing resource, or
reconfigure an existing subscription. After subscribing to a product bundle, you can choose



to provision the resources immediately or later.

Browse Catalog and Subscriptions
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Anonymous Browsing

An anonymous user can view the product offerings of the service provider, without logging
in to CloudPortal Business Manager UI. An anonymous user will view the catalog defined for
the default channel. As an anonymous user, you can view the product catalog to check if
the products offerings suit your resource needs and then choose to sign up with the cloud
service provider. The anonymous user can access the catalog by clicking the Browse Catalog
link on the Login page.
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Understanding the Subscription Cycle

A subscription is a plan that allows the customer to make recurring payments for the use of
a product or service. CloudPortal Business Manager enables you subscribe to the cloud
services that are offered by the service provider. These offerings are presented to the
customers in the form of various plans or product bundles. These are unique to the
underlying service instance and to the channel that a customer belongs to.

As a user, you can select the resource type and filter by provisioning constraints to get a list
of the product bundles that satisfy your selection criteria and business needs. You have to
select a bundle that best suits your requirements and configure and subscribe to it.

After you accept the terms and conditions of the customer agreement, you can subscribe to
a product bundle. CloudPortal Business Manager will invoke the connector calls to provision
the underlying resource. The subscription is created when the underlying provisioning
succeeds.

All subscriptions are charged from the time the subscription becomes active. If a user
chooses annual, the user is charged for twelve months up-front. Every product bundle has a
one-time charge and a recurring charge. You have to pay the recurring charge at the
interval specified (monthly, quarterly, or annual). Entitlements are always given for a
month.

Product bundles are grouped by the charging frequency:

• Monthly: Proration happens for recurring charges and entitlements of metered
products. No proration happens for entitlements of discrete products. Same
entitlements are given every month. If there is a change in the entitlements, it is not
reflected immediately (or in the current month), but only in the next month when you
pay the recurring charges for the bundle.

• Quarterly: No proration occurs. Same entitlements are given every month. If there is a
change in the entitlements, it is not reflected immediately (or in the current quarter),
but only at the start of the next quarter when you pay the recurring charges for the
bundle.

• Annual: No proration occurs. Same entitlements are given every month. If there is a
change in the entitlements, it is not reflected immediately (or in the current year), but
only at the start of the next year when you pay the recurring charges for the bundle.

• Monthly, no minimum recurring charges: Entitlements always be what they were when
you subscribed to the bundle initially.

A user can terminate a subscription at any time. However, if you terminate a subscription
at any time during a billing period, no refund is given as the subscription charges have
already been paid for, in advance.
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Subscription states

A subscription can be in any one of the following states:

• New

• Active

• Expired

• Cancelled

Figure 1. Subscription states

State Description

New The user has subscribed, but some action is pending before it can be moved
to the Active state (for example, approval is pending). This subscription may
move to the active state once the pending action is completed.

Active When all pending activities are completed and if resource needs to be
provisioned, on successful provisioning of resource, the subscription moves
to the active state. The subscription is now in use and the user is charged
for it.

Expired The subscription has been terminated by the user. A subscription moves
from New to Active and remains in the Active state until it is terminated by
the user. The user is charged for the subscription in the billing period in
which the subscription is terminated.

Cancelled The subscription is not approved either because the payment does not
happen or there is a workflow configured for subscription activation and the
master user does not approve or for any other reason. The subscription is
moved to the Cancelled state either by CPBM or by the user. The user is not
charged for the subscription.

Resource states
A Resource in CPBM can be in any of the following states:



• Provisioning

• Error

• Active

• Terminated

Figure 2. Resource states

State Description Actions available in the
UI

Provisio
ning

For a newly created subscription, when the
connector is provisioning a resource. Also, for an
Active (Unused) subscription, while provisioning
resource.

If subscription state is
New::

• Cancel subscription

If subscription state is
Active:

• Terminate
Subscription

Subscription states
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Error For a newly created subscription, when the
connector throws an exception from the provision
call. Also, for an active subscription, when the
connector's validate call returns an "errored"
state.

If subscription state is
New:

• Cancel Subscription

• Provision Resource

If subscription state is
Active:

• Terminate
Subscription

• Provision Resource

Active On successful provisioning of the resource. • Terminate
Subscription

Termina
ted

On cancellation of a new subscription or on
termination of an active subscription. Also, for an
active subscription, when the connector's validate
call returns a "terminated" state.

None

Subscription states
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Subscribing to a Product Bundle

As a user, you can select the resource type that you want and filter by provisioning
constraints to get a list of product bundles that satisfy your selection criteria. You can then
configure and subscribe to a product bundle.

1. Log in to CloudPortal Business Manager UI as a user.

2. Either click Catalog or click Home > Browse Catalog. The Catalog page displays the list
of services enabled for you, along with the service instances.

3. Select the service and the service instance.

4. Select the resource type and specify the filters and select the resource components.
The Pricing tab at the top left displays the bundles categorized by the frequency of
recurring charges. The prices are displayed in the currency that is set for your account.

5. Select the appropriate pricing tab to view the product bundles that match your
selection criteria.

6. Select the product bundle and click Configure & Subscribe.

7. In the Configure and Subscribe page, select the resource components if you have not
already selected them earlier and complete the configuration (optional). In the right
pane, you can view the following:

• Selections

• One-time charges

• Recurring charges

• Utility charges (for additional usage that may be generated for the resources that
you have selected)

8. Review the user policy and accept the terms and conditions of the Customer
Agreement.

9. Click Subscribe and provision. On subscribing, you can choose to navigate to the
dashboard, my resources page, catalog page, or subscriptions page. On successful
provisioning of the resource, the subscription becomes active; it is listed as ACTIVE in
the Subscriptions page and you are charged for the subscription.
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Provisioning a resource

A resource can be provisioned by subscribing to a bundle. All subscriptions are listed in the
Subscriptions page under the Billing and Usage tab. If resource provisioning has failed, the
subscription is listed as NEW (Resource State: Error). If there is no resource tied to the
subscription, the subscription is listed as ACTIVE (Unused). In both cases, you can provision
a resource for the subscription.

1. Log in to CloudPortal Business Manager UI as a user.

2. Click Usage & Billing > Subscriptions.

3. Select the subscription, move the cursor over the gear wheel and click Provision
Resource.

4. Select the resource components and provide the resource properties. Your selections
are listed in the right pane.

5. Accept the terms and conditions and click Provision.
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Filtering Subscriptions

Users can view their subscriptions and filter them based on the state of the subscription,
service, and product bundle. A master user can view all subscriptions of the account and
filter them based on user, subscription state, service, and product bundle.

1. Log in to CloudPortal Business manager as Master user or user.

2. Click Usage & Billing > Subscriptions.

3. Click the gear wheel icon next to the Filter label.

4. Select the user from the User drop down list. The option to filter by user is visible only
to the Master user.

5. To filter the subscriptions further, select the filter options from the drop down lists.

6. Click Go!

7. View the subscriptions based on your filter selection.
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Converting to Subscription

In the earlier versions of CPBM, the subscriptions UI used to list your purchased
subscriptions as well as subscriptions generated as a result of usage for a resource, which
did not belong to any of the purchased subscriptions.

From CPBM 2.3 onwards there is a provision to view 'purchased subscriptions' and 'resources
which do not belong to any of the purchased subscriptions' as separate links in the
Subscriptions tab under Usage & Billing.

• Purchased Bundles- When a resource is provisioned by subscribing a bundle through the
catalog page, the associated subscriptions are listed under this link.

• Resources eligible to be moved to Bundles- When a resource is added through
connector UI or is generated as a result of another resource, it is listed under this link.
This occurs when usage is reported for such resource and it cannot be associated with
any of the purchased subscriptions. The 'Convert to subscription' task allows the user to
associate such resources (in active state) to any of the unused purchased subscription or
buy a new subscription, if required.

Note:

• Earlier versions of CPBM used to have 'Change subscription' for all the active
subscriptions. It no longer exists since it is now replaced by 'Convert to subscriptions'
that will be available only for associating resources to purchased bundles.

• Unlike 'Change Subscription', 'Convert to subscription' does not allow to change any of
the resource configuration. However, if required the same can be done using the
connector UI.

To convert to subscription

1. Log in to CloudPortal Business Manager as a customer.

2. Click Usage & Billing.

3. Click on the Subscriptions tab.

4. Select a subscription under the Resources eligible to be moved to Bundles link.

5. Place the cursor over the manage icon (that looks like a gear wheel), and click Convert
to Subscription. In the Convert to Subscription wizard that appears:

a. Select one of the following options in the Purchase new or select existing
subscription step:

• Purchase a new subscription - The available product bundles are listed.

• Select an existing unused subscription - The available subscriptions which are
not associated with any resource are listed.



Note: The 'View Details' link displays product bundle / subscription's product
bundle name and description along with its entitlements in terms of product
name, the number of included units and the overage usage charges per unit.

b. Click Next.

c. Review your selection in the Review and Confirm step. Click Previous if you want to
change your selection.

d. Click Convert.

The newly converted subscription is listed under the Purchased Bundles link with a History
sub-tab that will have a link to view the parent resource listed under the Resources eligible
to be moved to Bundles link.

Impact on billing

The 'Convert to Subscription' wizard gives user the following choices:

• Purchase a new subscription - One-time charges as well as recurring charges as per the
billing frequency of the selected product bundle are applicable.

• Select an existing unused subscription - No additional charges are applicable.

Note: For both the cases above, entitlements of the resulting subscriptions will be
applicable for any further usage reported for that resource.

 Converting to Subscription
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Terminating a subscription

You can terminate a subscription if you no longer need the resource.

1. Log in to CloudlPortal Business Manager UI as a user.

2. Click Home > Usage & Billing.

3. In the Subscriptions tab, select the subscription that you want to terminate.

4. Place the cursor over the manage icon (that looks like a gear wheel) and click
Terminate Subscription.

5. Confirm your action.
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Cancelling a Subscription

You can cancel a subscription when the subscription is in a new state and provisioning of
resource has failed.

1. Log in to CloudPortal Business Manager UI as a user.

2. Click Usage & Billing > Subscriptions.

3. Select the subscription that you want to cancel, move the cursor over the gear wheel
and click Cancel Subscription.

4. Click Confirm.
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Provisioning a resource from the
pay-as-you-go mode

You can provision a resource using the pay-as-you-go mode. You are charged on the basis of
usage generated and the pricing is determined by the utility rate card.

1. Log in to CloudPortal Business Manager UI as a user.

2. Either click Catalog or click Home > Browse Catalog. The Catalog page displays the list
of services enabled for you, along with the service instances.

3. Select the service and the service instance.

4. Select the resource and click Go.

5. Click the resource components option that best suits your requirement.

6. Select the resource components and complete the configuration (optional). Your
selections and the utility rates are displayed in the right pane.

7. Accept the terms and conditions of the customer agreement and click Provision. The
subscription gets created and it is listed as Utility Bundle in your list of your
subscriptions, with the state shown as active.
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My Services Tab

The My Services tab allows the Master user to sign up for services offered by the service
provider. The various services offered by the service provider are listed by the cloud service
type and service instance.

The Master user can either enable the service for all normal users or choose to selectively
enable or disable the service for any user. Once a service instance is enabled for a user, the
user access the resource management console, subscribe to bundles, view the utility rates,
and manage their settings from this tab.

If service enabling fails, the Retry button is displayed that allows the Master user to
re-enable the service. In such cases, the Error Details link displays the reason for failure to
enable the service.

Enabling a service
As a Master user, you can enable a service for the users of your account. Refer to Enabling a
service.

Links
All services enabled for the account are listed in the My Services tab. For each service
instance enabled for your account, the user has the following links:

• Manage Resources

• Manage User Provisioning (This link is visible depending on the service enabled.)

• Subscribe to Bundles

• My Settings

• View Utility Rates

In addition, all enabled service instances are listed in different tabs. A user can also click
the links to directly access the resource management console of that service instance.

Managing Resources
You can access the resource management console and manage the resources. For more
information on managing the resources, contact your service provider for the user guide for
a particular service.

http://support.citrix.com/proddocs/topic/cpbm-23-map/cpbm-enable-a-service-tsk.html#cpbm-enable-service-tsk
http://support.citrix.com/proddocs/topic/cpbm-23-map/cpbm-enable-a-service-tsk.html#cpbm-enable-service-tsk


Managing User Provisioning
For each service enabled for the account, the Master user can choose the option to enable
the service for all new users that are onboarded and activated or to selectively enable
services for a specific user. By default, a service that is enabled for an account, is enabled
for all new users.

1. Log in to CloudPortal Business Manager UI as Master user.

2. Click My Services tab.

You can see the list of all applicable service instances (enabled for the user) on the
right pane. Select the desired service instance.

3. Click Manage User Provisioning.

4. Depending on your needs, select the option to enable or disable the service for all new
users.

Note: You can selectively enable the service for a user from the Users tab.

5. Click OK.

Subscribing to Bundles
For more information on subscribing to bundles, refer to the section on Subscriptions.

My Settings
The My Settings link allows you to generate SSH keys and upload them. This option is
available for the CCP and ACS cloud services.

SSH Keys:

SSH keys are used for authentication into a newly launched VM. You can connect to a VM
without using a username and password, by using the SSH keys. For this to work, user has to
either upload a private key for which the public key is saved locally, or generate a key pair
and save the generated public key locally. And then, select any key while launching the VM.
This option is available for the CCP cloud service.

1. Log in to CloudPortal Business Manager UI as a user.

2. Click My Services tab.

You can see the list of all applicable service instances (enabled for the user) in the right
pane. Select the desired service instance.

3. Click My Settings.

This will redirect you to SSH Key settings page where you can generate SSH Keys and
upload SSH Keys.

My Services Tab
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4. To generate the SSH key, provide the key name and click Generate.

5. To upload the SSH key, provide the key name and copy the public key in the text box,
and then click Upload.

Viewing Utility Rates
A product is a basic unit of consumption in CloudPortal Business Manager and every product
has a utility or unit price associated with it. You can view utility rates for all products of
the service instance.

1. Log in to CloudPortal Business Manager as a normal user.

2. Click My Services.

3. Select the service instance and click View Utility Rates.

4. View the products and their corresponding per unit rates.

My Services Tab
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Enabling a service

1. Log in to CloudPortal Business Manager UI as Master user.

2. Click My Services tab.

3. Select the service that you want to enable and click Enable.
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Utilities

This section describes the available Utility tools.

Active Directorty Import Tool

Removing a service completely from CPBM

CPBM Admin Utility
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Active Directory Import Tool

Introduction

The Active Directory Import Tool is shipped with CloudPortal Business Manager 2.x and
allows enterprise customers to auto-import users from their corporate Active Directory to
CPBM. The tool can also be scheduled to run at regular intervals and handle the syncing of
the users from Active Directory (AD) to CPBM.

This document covers the following topics:

Setting up the Customization Package

Setting up AD Import Tool

Triggering the AD Import Tool on Demand

Configuring AD CPBM Account Mapping

AD Configuration

AD Import Run Reports

http://support.citrix.com/proddocs/topic/cpbm-23-map/cpbm-ad-connection-config-con.html#cpbm-ad-configconnection-con
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Setting up the Customization Package

Follow the Customization Guide instructions to import the customization package. The tool
needs to be configured as custom job in the customization package
citrix.cpbm.custom.common.
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Setting up Active Directory Import Tool

Prerequisites: Follow the instructions in Active Directory Connection Configuration to
configure Active Directory in CloudPortal Business Manager. As a service provider, you must
configure adsync.workdirectory and adsync.report_email with appropriate values.

Note:

• All users created under AD must have email ids configured.

• ad-import-mapping.csv must be added to the location mentioned in
adsync.workdirectory

All setup instructions are to be done in
citrix.cpbm.custom.common/src/main/resources/META-INF folder

1. Add this import in Import-Package section in manifest.mf

com.citrix.cpbm.custom.adsync

2. Add this line to meta-inf/spring/osgi-context.xml

<osgi:reference interface="com.citrix.cpbm.custom.adsync.ADImportService" id="aDImportService" />

3. Add these lines to meta-inf/spring/applicationContext-jobs.xml

<bean name="adImportJob" class="org.springframework.scheduling.quartz.JobDetailBean">
<property name="jobClass" value="com.citrix.cpbm.custom.adsync.ADImportJob"/>
<property name="requestsRecovery" value="false"/>
<property name="volatility" value="false" />
</bean>

<bean id="adImportJobTrigger" class="org.springframework.scheduling.quartz.SimpleTriggerBean">
<property name="jobDetail" ref="adImportJob" />
<property name="startDelay" value="10000" />
<property name="repeatInterval" value="3600000" />
<property
name="volatility" value="false" />
<property
name="misfireInstructionName"
value="MISFIRE_INSTRUCTION_RESCHEDULE_NEXT_WITH_EXISTING_COUNT"></property>
</bean>

4. Add these lines to meta-inf/spring/applicationContext-scheduler.xml

<ref bean="adImportJobTrigger"/>

inside <property name="triggers">
<entry key="aDImportService"><ref bean="aDImportService"/></entry>

inside <property name ="schedulerContextAsMap">



5. Run maven clean install for the project and drop the
citrix.cpbm.custom.common.x-x-x.jar inside vts3/default_impl

Updating the CPBM plan to include the AD Import tool
bundle

1. Add this entry before the citrix.cpbm.custom.common entry in the
com.citrix.cpbm.plan file present in ../vts3/pickup directory

<artifact type="bundle" name="citrix.cpbm.custom.adsync" version="[2.0.0, 3.0.0)"/>

Also drop the citrix.cpbm.custom.adsync-x.x.x.jar file into vts3/default_impl folder

Setting up Active Directory Import Tool
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Triggering the Active Directory Import
Tool On Demand

Run the runImportNow.sh script found in the util folder of this tool. This script connects to
the CloudPortal Business Manager database and updates the nextTrigger time for the AD
Import Job.

Note:

• Be sure that cloud-portal service is in running state before running runImport.sh

• The script runImport.sh must run on the database server of CloudPortal Business
Manager.
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Configuring the Active Directory
CloudPortal Business Manager Account
Mapping

A group or OU in Active Directory (AD) maps to the CloudPortal Business Manager (CPBM)
tenant account. The account mapping is specified in ad-import-mapping.csv file. Be sure
about the name of the config file as we use the file name to pick-up the mapping file.
Configure the AD work folder in Administration > B/OSS adsync.workdirectory field.

Drop the ad-import-mapping.csv file in the {adsync.workdirectory} folder. Check the
ad-importmapping. csv.sample in the doc folder for the sample mapping. The CPBM account
can be mapped to either an OU in AD or a group in AD.
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Active Directory Connection Configuration

Active Directory configuration is to be done by using CloudPortal Business Manager portal.

1. Login as Root user.

2. Navigate to Administration > Configuration > B/OSS Integration.

3. Click Directory Server > Configure and set up the Active Directory.

It is not required to set “enable” variable to true.

Mapping attributes from AD to CPBM

The mapping of AD user’s fields to CPBM user’s fields is defined in the Administration >
Configuration > B/OSS Integration > Directory Server section. The fields such as
name.mapping, email.mapping can be edited to specify the AD to CPBM field mapping.

Also set the handle.to.match.in.directory.server field in the configuration to
(sAMAccountName={0})

sAMAccountName is the principal name/username field for a user in AD.

If you want to use the user's email address or any other field such as username for the user,
replace the sAMAccountName in the handle.to.match.in.directory.server expression with
the appropriate AD field name.

Tool Working

For a given CPBM AD Group/OU mapping, the import run:

• Creates a user if it is present in AD Group/OU but not present in CPBM. The following
fields from active directory is used while creating the user:

• login-name/accountName

• first-name

• last-name

• email

• phone number

• language preference
• Language preference is set only if the respective AD field contains the locale in the

format compatible to the ISO 639 alpha-2 or alpha-3 language code.

• Updates the user fields if the user is present in AD Group/OU as well as CPBM. The
fields that are updated are first-name, last-name, email, phone number and language
preference.



• If the user is present in CPBM but not in AD Group/OU, the tool gives a warning in the
report generated indicating that "Following CPBM users cannot be found in AD". The
admin has to take appropriate action on this. Same is the case if the user is moved from
an AD group to other.

Active Directory Connection Configuration
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Active Directory Import Run Reports

Each run of the Active Directory Import Job produces a report in the
{adsync.workdirectory}/report folder. Make sure appropriate permissions are set on
{adsync.workdirectory} folder so as to be writable by the cloud portal service.

The report is also mailed to the email address configured in adsync.report_email field in
under Active Directory > Configure section.
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Removing a service completely from
CPBM

The CPBM installer has a script which can be used to completely remove a service from the
CPBM database, including service instances, products, product bundles,
channel/account/user/subscription handles, invoice, invoice items, subscriptions, service
notifications, and so on. The purpose of the script is to remove any service if it is added for
testing and is no longer required. This script has some limitations and hence, should not be
run in a production environment.

Location of the script is: {CPBM_TAR}/etc/delete_service.sh

Note: It is important to note the following before you run the script:

• This script expects the database password as plain text in the cloud.properties file.

• This action will completely delete the service and all its instances.

• This will result in data mismatch in historical/current account statements.

• This action is irreversible and should not be used for production.

Steps:

1. Stop the CPBM server:

service cloud-portal stop

2. Run the script

./delete_service.sh

3. [Optional - To remove the connector]: Remove the connector from
com.citrix.cpbm.connector.plan:

a. Open the plan com.citrix.cpbm.connector.plan available at
/usr/share/vts3/connectors/, and remove the line that has the required connector.

b. Delete the connector from directory /usr/share/vts3/connectors/
4. Start the CPBM server

service cloud-portal start

Note: If you skip the optional Step 3, then the service will re-appear as a new service
after CPBM restarts.

The service and service instance ID can be fetched from the "id" column in the service and
service_instance table of the cloud_portal database.
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CPBM Admin Utility

CPBM Admin utility provides easy way to perform certain tasks required to be done by CPBM
admin. These tasks are usually like providing database dump, logs, and so on for analyzing
issues. This util is available from CPBM 2.2.1 onwards.

Location of the script is: /usr/share/vts3/tools/cpbm

Usage:

./cpbm [OPTIONS]

The util takes the following arguments:

• -p: Profile. Possible values are Perf and Other. Default is Other

1. Other profile collects below info:

• CPBM logs of last n days, where n is another argument passed

• Billing activity file of last n days, where n is another argument passed

• Foot print of entire /usr/share/vts3 directory

• JVM arguments with which CPBM was started

• Result of netstat

• Version of JDK

• Version of Python

• Hostname

• Operating system

• Date

• Timezone offset

• IP tables

• Network interfaces

• Memory and CPU utilization (using 'top')

• cloud.properties configuration file. (available at
/usr/share/vts3/repository/prop)

• org.eclipse.virgo.repository.properties (available at /usr/share/vts3/config)



• All virgo plan files available under /usr/share/vts3/pickup,
/usr/share/vts3/patches, /usr/share/vts3/connectors/, and
/usr/share/vts3/connectors_ext

2. Perf profile collects thread dump and heap dump in addition to the information
collected in Other profile

• -d: Flag to collect database dump. Default is n. If passed as "y", it collects CPBM
database dump. This should be passed as "y" only at one of the CPBM nodes in the
cluster. If passed "y" from all nodes it will generate same database dump once for each
node.

• -n: Number of days for which CPBM logs and billing activity file need to be collected.
Default is 1

• -h: Prints help for the CPBM util

The database dump, logs collected as output of the script will be available at
/usr/share/vts3/dumps/cpbm_dumps_<timestamp>, and if admin does not want to provide
any info then s/he can selectively delete any file from this dump. In such case admin must
inform support about the missing piece of information.
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Frequently Asked Questions

Setup and Configuration
How to setup redundant CPBM management server?

Both instances will need to be behind a load balancer and a few settings need to be
modified in cloud.properties:

vmops.jms.url=tcp://x.x.x.x:9125

(by default this is set to tcp://localhost:9125, you must change it to the IP of the server)

vmops.jms.client.url=failover:(tcp://server1:9125,tcp://server2:9125)

(you must add, in the same order on each server, the list of CPBM server(s) that are part of
the installation: server1 and server2 can be either FQDNs or IP addresses)

vmops.mgmt.server.publicHost=xxx

(this is the FQDN/IP on which the load balancer listens for incoming requests)

vmops.mgmt.server.publicPort=xxx

(this is the port on which the load balancer listens for incoming requests)

vmops.mgmt.server.publicProtocol=http/https

(this is the protocol on which the load balancer listens for incoming requests)
What functionality breaks if /client is not on the same FQDN as /portal?

If there is a different FQDN for CPBM and CCP, you will run into problems. For example, you
are using cpbm.company.com for CPBM and ccp.company.com for CCP. Admin logs into the
portal at https://cpbm.company.com/portal. After clicking the Launch Cloud Console
button, user is directed to https://ccp.company.com/client. However, CCP will now try to
make AJAX calls through the CPBM API proxy which it assumes is at
https://ccp.company.com/portal/client. This will fail because /portal is not a valid
location on the CCP server.

Which is the location to see the log for a Payment Gateway Charges failure?

The errors can be seen in regular logs such as catalina.out as well as specifically in
BillingActivity.log which is present in the same directory as catalina.out . So for your
reference you should be able to see it in /tmp/BillingActivity.log.

How to change the Service Provider logo in CPBM?

Change the logo as follows:

1. Set the image path in the global configuration, example: /custom/images



2. Create the folder /custom/images on each CPBM host

3. Login as root user and select customize logo

4. Select the logo that must be used

What is CAS? Why does CPBM need it?

CAS: CAS stands for Central Authentication Service. CAS is an authentication system
originally created by Yale University to provide a trusted way for an application to
authenticate a user. CAS became a Jasig project in December 2004. CAS provides enterprise
single sign on (SSO) service:

• An open and well-documented protocol

• An open-source Java server component

• A library of clients for Java, .Net, PHP, Perl, Apache, uPortal, and others

• Integrates with uPortal, BlueSocket, TikiWiki, Mule, Liferay, Moodle and others

• Community documentation and implementation support

• An extensive community of adopters

For more information, visit http://www.jasig.org/cas

What is CAS technically: CAS is an Enterprise Java solution to web application
authentication that also provides the benefit of SSO. Technically, SSO can be achieved
because the authentication can be removed from the web application and handled
centrally. And, when this authentication is handled by a single service, access to many
services can be granted once and "remembered" for the life of the web session or even
longer though not recommended. Also remember that the SSO feature does not have to be
employed and yet CAS authentication still provides a quality authentication mechanism.
CAS is a collaborative effort that has produced a very solid central authentication service
using the Java development platform. CAS also provides a broad selection of clients for use
with all of the enterprise and scripted web technologies. For more information, visit
https://wiki.jasig.org/display/CASUM/Technical+Overview

Why does CPBM need CAS: CPBM supports the use of CAS for SSO, which enables access to
multiple password protected systems after logging in just once.

What languages does CPBM support out-of-the-box (OOB)?

Languages supported by CPBM OOB:

• English, en_US

• Japanese, jp

• German, de_DE

• Simplified Chinese, zh_CN

• Korean, kr
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• International Spanish, es

• Brasilian Portuguese, pt_BR

• French, fr

How to change default channel?

1. Go to Configuration > Account Management > default.channel

2. Specify the channel name that you want to make default channel

The existing account will point to the old channel. You do not have to restart the server for
reflecting the changes.

How to configure CPBM to access internet via proxy address?

1. Go to the path /usr/share/vts3/bin/

2. Edit the dmk.sh file as follows:

$JAVA_OPTS \
-Dhttp.proxyHost=<IP Address of Proxy Host> \
-Dhttp.proxyPort=8080 \ 
-Xbootclasspath/p:$KERNEL_HOME/endorsed/com.springsource.javax.mail-1.4.0.jar \

How to update timezone in CPBM server?

1. Go to the path /usr/share/vts3/bin/

2. Edit the dmk.sh file as follows:

$JAVA_OPTS \
-Duser.timezone=<Update you timezone ID here> \
-Xbootclasspath/p:$KERNEL_HOME/endorsed/com.springsource.javax.mail-1.4.0.jar \

Note: The timezone id must be a valid timezone ID.

The Tomcat Server from a CPBM host is configured to use a fixed value of 1024MB of
RAM. Can I increase the assigned memory, if there is a lot of RAM available?

Yes. You can increase the -Xmx to half of the available RAM.

The values you see in the JVM options are default values and is the minimum requirement
for the CPBM to run for POC or demo purposes. In production environment higher
configurations are recommended.

What is the difference between "Scale up VM" and "Change Service" options?

• Scale up: This option enables you to increase the CPU and/or RAM size to change the
service offering without stopping the VM

Note: You cannot decrease the CPU and/or RAM size.
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• Change service: This option enables you to increase or decrease the CPU and/or RAM
size to change the service offering only when the state of the VM is stopped

How to setup ActiveMQ accurately in a multinode setup?

It is very important to make sure that ActiveMQ is accurately configured in a multinode
setup to prevent issues during CloudPortal startup. When a node gets started

• The ActiveMQ broker on the node comes up first and tries to acquire a lock on the
cloud_portalmq database. If it acquires the lock then the broker gets started
successfully, else it keeps on trying to acquire the lock. ActiveMQ broker uses the
following configurations to connect to the cloud_portalmq database:

# JDBC URL for the MQ database
vmops.mq.jdbc.url=jdbc:mysql://localhost/cloud_portalmq?relaxAutoCommit=true
vmops.mq.jdbc.username=cloud
vmops.mq.jdbc.password=cloud
mq.jdbc.database.schemaname=cloud_portalmq

When the ActiveMQ broker gets started it is available at the following configuration:
# URL to start the message broker at
vmops.jms.url=tcp://localhost:9125

Note: All the configurations specified earlier are available in the cloud.properties
file.

• The ActiveMQ listener comes up next and tries to connect to the available brokers. It
uses the following configuration to connect to the broker:

vmops.jms.client.url=failover:(tcp://cpbmhost1:9125,tcp://cpbmhost2:9125)

This configuration provides all of the broker URLs in the cluster. The listener tries to
connect to the broker in the 'failsafe' mode, which means that it tries to connect to first
broker and if it is not successful then tries to connect to the second broker.

Note: It is very important to note here that all the nodes must allow other nodes to
connect on port 9125. So make sure that nodes are able to connect to each other on
port 9125.

In a multinode setup, the node that comes up first gets the lock on the cloud_portalmq
database and becomes the master broker. The other nodes become slave and keep trying to
acquire the lock. If the master broker goes down, one of the slave, which gets the lock on
cloud_portalmq first, becomes the master broker. JMS listener on all the nodes starts
listening to the master broker. When the master broker is down the listener tries to listen
to next broker provided in config vmops.jms.client.url

Why does CloudPortal Business Manager service take too long to start?

From all the CPBM nodes in a cluster only one node has the ActiveMQ broker running on port
9125. The other nodes keep waiting and can start the ActiveMQ broker only when the first
node goes down. So, at any given moment of time only one node has the ActiveMQ broker
running on port 9125 and all the other nodes push their messages to this broker.
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Account Management
When does an account get suspended/restricted?

An account gets suspended/restricted due to one of the following reasons:

• The SpendLimit is crossed

• The campaign has expired

• The payment failure threshold has reached

How to reset the locked Root user account?

1. Set failed_login_attempts=0 in users table in cloud_portal schema as follows:

UPDATE cloud_portal.users SET failed_login_attempts = 0, enabled = 1, locked = 0
WHERE id = 1;

2. Open a new browser session (different browser or incognito window) to login

How to reset CPBM root password when it is not the default?

1. If the root email is set properly, reset password will work

2. If the root email is not set properly, run the following SQLquery:

update cloud_portal.users set salt='1300869425505AbRaCaDaBrA1943660404',password='b8bdee346e8d4eb0f02201e8751d24a324c89100'whereusername='root';

Product Management
Can there be bundles that include products from multiple cloud services?

A bundle can be used to provision only one resource. So you cannot have a bundle with
multiple resources from across services. However, you can entitle (that is give away as part
of) products from other services as part of a bundle. For example, you can create a VM
bundle and include a few mailboxes.

How does "This product is replacing one or more products" work?

When selected, this product will not be available in a catalog until the catalog is synced
and a new version is activated after that. This is done in conjunction with retiring one or
more products as being replaced. This is required because in scenarios where a set of
products are replaced by another set, the combined changes have to be automatically
visible to the catalog/end customer.

What is the "Sync with Reference Catalog" feature?

The feature syncs the channel catalog with the current plan of the reference catalog.
Charges are copied for the new products that come into being. Any new bundles created
can be consumed in the channel catalog. Also, retired products are marked as retired in the
channel catalog. Since syncing is a modification to the channel catalog plan, the changes
will take effect only in the next plan of the channel catalog.
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How to remove bundles in CPBM?

The service provider user with "Product create manage" role can unpublish the product
bundle under the "Catalog" tab. Unpublishing makes the specific bundle unavailable to the
user.

Why a service for a user cannot be enabled?

• If the user does not have appropriate cloud roles enabled, the services does not get
enabled for that user

• If the master user of the account has not enabled a cloud service for the account, then
the users in the specific account cannot see those services

• Sometimes if the cloud service instance is down/inaccessible while activating the user,
the services will not be registered. In that case contact your master user to enable
them manually

As a Product Manager, how to preview the catalog before activating the channel?

1. Login as root/product manager

2. Navigate to Channels > Select Channel > Catalog > Next Planned
Version/Current/History

3. Choose Preview Catalog option from the gear icon

How to modify prices for bundles and products?

1. Login as root

2. Navigate to Channels > Select Channel > Catalog > Next Planned Version

3. Click Utility Card > Edit Pricing if you want to modify the product price

4. Click Bundle > Edit Pricing if you want to modify the bundle price

5. Click Schedule Activation and specify the new date

6. Select Preview Catalog to verify the changes

How to upload product/bundle images?

1. Create a directory on the CPBM server and provide write permissions

2. Login as root

3. Go to Administration > Portal > Settings

4. Set the directory path

How to enable initial deposit for a account?

1. Login as root user

2. Navigate to the Administration > Account Types
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3. Select the Account Type

4. Click on On-boarding Controls > Edit

5. Enable Initial Deposit Required

When does the usage price show zero for a product?

The usage price for a product shows zero if

• The entitlements provided are unlimited/more than usage

• The utility price for the product is set to zero

How to cancel a credit that is issued?

1. Login as root/finance admin

2. Select the account for which credit is issued

3. Navigate to tenant's dashboard

4. Click Payments tab

5. Click Cancel Credit

How to improve the overall performance of the CPBM UI pages?

Customers can potentially improve the overall performance of UI pages by following the
recommendations given below:

1. Ensure that the connection is not getting closed in response to HTTP requests made
from CPBM pages. This can be verified by using tools such as Firebug and by looking into
response headers. The value of header "Connection" should be "keep-alive". If the value
of the header is "closed", then check the configuration at reverse proxy server (web
server) and make sure that connection is alive.

• Example: (Apache web server)

KeepAlive On
2. Enable compression of response at the reverse proxy server (web server).

• Example: (Apache web server)

SetOutputFilter DEFLATE
AddOutputFilterByType DEFLATE text/html text/css text/plain text/xml text/json application/x-javascript

Where can I find configuration files for workflows?

Workflow configuration files workflows.xml and transactionWorkflowmap.xml are available
under /usr/share/vts3/repository/prop/ directory.

How to change the server name that shows up in telnet response? By default the telnet
response shows "CloudPortal Business Manager" as server name:
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$ telnet localhost 8080
Trying ::1...
Connected to localhost.
Escape character is '^]'.
GET
HTTP/1.1 400 Bad Request
Transfer-Encoding: chunked
Date: Tue, 15 Jul 2014 21:57:52 GMT
Connection: close
Server: CloudPortal Business Manager

0

Connection closed by foreign host.

You can change the server name that shows up in telnet response by editing the file
/usr/share/vts3/config/tomcat-server.xml as follows:

<Connector port="8080" protocol="HTTP/1.1"
           connectionTimeout="20000"
           redirectPort="8443"
           URIEncoding="UTF-8" executor="tomcatThreadPool"
           compression="on"
           compressableMimeType="text/html,text/xml,text/plain,application/javascript, text/css,text/json"
           server=“<Your new value>"/>
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How do I set the binary logs configuration and save disk space?
The binary log files are stored in /var/lib/mysql. Binary log is used for recovering data and replication. 

Disabling MySQL binlogging 
1. Open my.cnf using the following command: # vi /etc/my.cnf
2. Find the following lines and remove or comment it.
 #log_bin                     = /var/log/mysql/mysql-bin.log
 #expire_logs_days       = 10
 #max_binlog_size        = 100M
3. Save and close the file. 
4. Restart mysql server using the following command: # service mysql restart
Note: Disabling MySQl binlogging is not recommended if you are replicating.

Purging Master Logs 
If you are replicating, then you need to periodically reset master or purge master logs to clear out the 
old logs as they are necessary for replication. mysql-bin.index stores a list of all binary logs which 
mysqld generates and auto-rotates. To clear the binlogs in conjunction with mysql-bin.index:
1. Purge the master logs using the following commands. 
 PURGE BINARY LOGS TO 'binlogname';
 PURGE BINARY LOGS BEFORE 'datetimestamp';
 For example, 
 PURGE BINARY LOGS TO 'mysql-bin.000123';
 This will erase all binary logs before 'mysql-bin.000123'.
 PURGE BINARY LOGS BEFORE DATE(NOW() - INTERVAL 5 DAY) + INTERVAL 0 SECOND;
 This will erase all binary logs before midnight 5 days ago.
2. To delete binlog automatically and store five days’ log, set the following:
 mysql> SET GLOBAL expire_logs_days = 5;
3. Add this to /etc/my.cnf file.
 [mysqld]
 expire-logs-days=5
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